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Introduction

Welcome!
Congratulations on your choice of WaveLab Essential, 
which is the audio editor of choice for any serious engi-
neer or musician. 

WaveLab Essential is continuously developed and refined, 
in collaboration with our users – from professional audio 
engineers to hobbyists. Your input helps making this pro-
gram one of the most flexible and user-friendly ever!

Find out about the ease of use and workflow that makes 
working with WaveLab Essential so effective.

Your Steinberg Team.

Key command conventions
Many of the default key commands in WaveLab Essential 
use modifier keys. For example, the default key command 
for Undo is [Ctrl]-[Z] under Windows.

When key commands with modifier keys are described in 
this manual, they are shown with the Windows modifier 
key first, in the following way:

[Win modifier key]-[key]

For example, [Ctrl]-[Z] means "press [Ctrl] , then press 
[Z]". 

Similarly, [Alt]-[X] means "press [Alt] then press [X]".

How you can reach us
After having installed and launched the program, you will 
find a number of useful Steinberg Web links on the Help 
menu (“Steinberg on the internet” submenu). These allow 
you to get online support, check for updates, get answers 
to frequently asked questions, etc.

! These features require that you have a working Inter-
net connection.
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Requirements

This is what you need…
To use WaveLab Essential you need the following:

• A PC with Windows XP or Windows Vista Home Pre-
mium or Ultimate (32-bit only) installed and ready.
An Internet connection is also required. For more details about the com-
puter requirements, see below.

• A Multimedia PC compatible, 16-bit (or better) audio 
card.
By audio card we mean a card capable of recording and playing back 
audio, using the computer’s hard disk as storage media. See “About au-
dio cards” on page 11.

To take advantage of WaveLab Essential’s more ad-
vanced features, you need the following:

• To utilize WaveLab Essential’s CD burning capabilities, 
you will need a CD recorder.
Your CD recorder must support the disc-at-once write mode.

• DirectX 9 or later must be installed.

Computer requirements
Below, the minimum computer requirements are listed, 
with recommendations where applicable. The following 
sections describe each system component (processor, 
RAM, etc.) in more detail.

Minimum requirements

• Intel Pentium III/AMD Athlon 800 MHz (Intel Pentium IV/AMD 
Athlon or AMD Opteron 2,4GHz or faster recommended). 

• 256 MB RAM (1GB recommended).
• A monitor and video card with a resolution of 24 bit 

(32bit recommended).
• Display resolution 1024 x 768 pixels (1280 x 1024 pixels and 

a dual-monitor setup are recommended).
• 80MB of free hard disk space.
• Windows XP or Windows Vista Home Premium or Ultimate 

(32-bit only).
• Windows MME compatible audio hardware (ASIO compatible 

audio hardware recommended).
• CD or DVD ROM drive for installation (CD/DVD writer recom-

mended).
• Internet connection required for product activation and the 

Podcast feature.
• The Product can only be used on the system on which it was 

activated.

RAM

Since WaveLab Essential is disk based, the amount of 
RAM does not limit the size of audio files you can work 
with. Even with moderate amounts of RAM, you can have 
many files open at the same time. However, when more 
RAM is available, some processes can be accelerated by 
WaveLab Essential.

Processing power

The difference between running WaveLab Essential on a 
faster computer and a slower one is noticeable in many 
cases:

• More real-time processing
The faster the computer, the more real-time plug-ins you will be able to 
use.

• Faster “off-line” processing and analysis tasks
Certain types of processing which make heavy demands on the com-
puter will be completed more quickly on a faster machine. 

• Screen updates
Scrolling, editing and manipulating objects is “snappier” on a faster ma-
chine.

Hard disk

Audio files are relatively big. Approximately 10.6 MB of 
hard disk space is used up for every minute of 16 bit ste-
reo/44.1 kHz audio recorded. For 24 bit/48 kHz audio or 
higher, the audio files are of course a lot bigger. Therefore 
we recommend that you get the largest hard disk you can 
afford. The speed of the hard disk will affect some of the 
processing operations. This is mainly noticeable when you 
work with very long files.

In addition, a fast hard disk is absolutely crucial for CD-R 
and DVD-R burning. If the hard disk is slow, your recorder 
might not be able to write at its maximum possible speed.

! Do not use file compression on hard disks where au-
dio files are stored!
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About audio cards
WaveLab Essential works with any Multimedia PC com-
patible audio card. However, the audio quality varies dra-
matically between cards.

For serious work with WaveLab Essential, we recommend 
that you get a card with the highest possible specifica-
tions.

However, if you use WaveLab Essential to edit files for 
use with other hardware (such as a hard disk based re-
cording system using its own audio converters) any loss in 
audio quality that you experience when listening to the 
files in WaveLab Essential (due to deficiencies in the au-
dio card) will not affect the final audio files in any way. 

For professional use (mastering, etc.) we recommend that 
you get a card capable of playing back files in 24 bit reso-
lution.

About the System Information 
feature
After having installed and launched WaveLab Essential, 
you can get a very detailed report describing your com-
puter system by selecting “System Information” on the 
Help menu. This function analyses your system and lists 
operating system specifics; processor(s), memory, hard 
drives, and much more. This is especially useful if you 
need to contact Technical Support, since this allows you 
to describe your computer configuration accurately.
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Installing and setting up

Setting up the computer
Before proceeding, your computer should be set up and 
the following items should be installed:

• Windows (see “This is what you need…” on page 10 for de-
tails on which version to use).

• The audio card and its driver.

Checking the audio card
To make sure the audio card will work as expected, you 
can perform the following two tests:

• Use the software included with the audio card to make 
sure you can record and play back without problems.

• Use the Media Player application (included with Win-
dows and described in the Windows documentation) to 
record and play back audio.

Colors
At this point you might want to check and for example 
change the number of colors you use on your computer 
screen. See your Windows documentation for instructions 
on how to do this. The recommended setting for WaveLab 
Essential is 24 or 32 bit mode (“True Color”).

Installation procedure

Installing the software 
The installation procedure unpacks all the files and auto-
matically puts them in the right places.

1. Insert the CD-ROM disk in the drive.
The installation program should start automatically after a few seconds. 
If, for some reason it doesn’t – for instance if you have “Auto Insert Noti-
fication” deactivated for your CD drive – perform steps 2-4 below. Oth-
erwise, proceed to step 5.

2. Launch the Explorer, open the “My Computer” window 
or select “Run” from the Start menu.

3. Locate and double click on the drive symbol for the 
CD-ROM drive.

4. Double click on the “setup” symbol (setup.exe).

5. Follow the instructions on screen.

6. Finally, a dialog informs you that the installation was 
successful.
A restart may be requested – but if no dialog requests a restart it is not 
necessary to do so.

When the installation is finished, the program is found 
among your other programs on the Start menu and/or the 
desktop.

This completes the installation of your WaveLab Essential 
program! But, you’re not really done yet…

Activating WaveLab Essential
After installing WaveLab Essential you can use the pro-
gram for 30 days without any restrictions. After this pe-
riod, you will have to enter your permanent activation 
code. You will find this code in the “Essential Product Li-
cence Information” document that is included in the 
WaveLab Essential package. Otherwise, WaveLab Es-
sential will not run anymore.

Proceed as follows:

1. Open the Syncrosoft License Control Center (which 
can be found in the Start/Programs menu under Windows 
or in the Applications folder on a Mac). 

2. In the Syncrosoft License Control Center, open the 
Wizards menu and select the “License Download” option. 
Follow the instructions and enter your WaveLab Essential 
activation code.

You are now ready to permanently run WaveLab Essen-
tial!

Register your software!
Registering your software will make sure you are entitled 
to technical support and kept aware of updates and news 
regarding WaveLab Essential.

Program settings
Before you start working, you should make some settings:



14

Installing and setting up

Audio card settings
You need to specify which audio card and driver you in-
tend to use. WaveLab Essential can communicate with 
the audio card via any of the standard protocols; ASIO, 
MME or WDM.

Selecting an ASIO driver

1. Open the Preferences–Audio device tab.

2. Select the ASIO driver from the “Playback device” 
pop-up menu.
Note that the “Playback device” menu heading has now changed to 
“Playback/Record device” and the Recording device section has been 
greyed out. This is because with ASIO, the same driver is always used 
both for output and input.

3. If you click the “Control Panel” button the audio card 
settings application (usually installed with the audio card) 
for the ASIO driver opens.
In the Control Panel you may find settings for buffer size, digital formats, 
additional I/O connections, etc. depending on the audio card and the 
driver.

4. Click on the “Connections” button.
The ASIO Audio connections dialog will appear, listing all available chan-
nel inputs and outputs in WaveLab Essential. Select the channels you 
want to use for stereo output and input.

5. Close the dialog.

• When using ASIO, the playback resolution is set from 
the ASIO driver (you may find a setting for this in the ASIO 
Control Panel, depending on the hardware and driver).
Therefore, the Playback Resolution settings will be greyed out.

Selecting an MME/WDM driver

1. Select “Preferences…” from the Options menu.

2. Click on the Audio device tab.

3. Select the audio card you want to use for recording 
and playback from the pop-ups.
If you only have one audio card you can also select the “Microsoft Sound 
Mapper” options (the sound mapper is a “virtual audio card” which “maps” 
all audio to your real card). However this does not let you take full advan-
tage of the card’s driver when recording audio and is not recommended.

4. Choose your “Playback Resolution”.

Additional audio settings

There are other settings in the Preferences that affect au-
dio playback and recording. We recommend that you try 
the default settings before you change anything, since 
these work well in most cases.

On the “Audio Card” tab, you will find the following set-
tings:

• Playback Buffer Number and Size.
These determine how much RAM memory is used for buffering when 
playing back. If you get playback problems such as dropouts or glitches, 
you should try to increase these values.

• Recording Buffer Number and Size (not available when 
using ASIO).
These determine how much RAM is used for buffering when recording. If 
you get dropouts in the recorded audio, you should try increasing these 
values.

On the Preferences–File tab, you will find the following 
settings:

• Disk block buffer size.
Governs the buffer size used when WaveLab Essential is reading data 
from the hard disk. If you experience problems in a read intensive sce-
nario (such as playing back an Audio CD Montage with a lot of simulta-
neous clips), you should try changing this value. 
If you change this setting, playback will stop when you leave the dialog.

• Use system cache.
When this is deactivated (default), WaveLab Essential reads files directly 
from the hard disk, bypassing Windows’ file cache.

The option is available since it may remedy problems on certain systems 
with slow disk drives. Note:

• If you activate this, avoid using large disk block buffer 
size values!

• After activating this option, you need to close and re-
open all open files, for the setting to take effect!

About latency

In the Playback section of the Audio device tab, you will 
find an indication of the current latency (at 16bit/44.1kHz 
stereo). Latency is the delay between when audio is “sent” 
from the program and when you actually hear it. The la-

! With ASIO drivers, you may find these settings in the 
ASIO Control Panel.

! We recommend that you leave this option deacti-
vated!
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tency in an audio system depends on the audio hardware, 
its drivers and their settings. It’s usually possible to reduce 
latency by lowering the number and size of the playback/
recording buffers. However, please note:

Temporary files
You also need to specify where WaveLab Essential 
should store its temporary files. Temporary files are used 
for certain operations, such as WaveLab Essential’s ex-
tensive Undo function (see “Undo and Redo” on page 
22).

If you have access to more than one drive, saving your 
temp files on a separate drive (not partition) can consider-
ably speed up performance. For example, if your source 
files are located on the C: drive, you could specify 
D:\temp as temporary folder. 

This will not only improve performance, but also reduce 
disk fragmentation.

1. In Windows, create a separate folder in which to store 
your “temp” files.

2. Select “Folders…” from the Options menu.
This opens the Folders dialog, where you can edit how various WaveLab 
Essential folders are handled . 

3. Click on the plus sign beside the “Temporary folders” 
item (this is located in the “Work folders” category).

4. Selecting the Temporary Folder item will show the cur-
rent location where the temp files will be created in the 
Folder field to the right.

5. Either type in the path to the directory or you can 
browse the drives to locate and select the folder via a 
standard Windows file dialog.
Click OK to select a folder and exit the file dialog.

Peak and view memories

A peak file is a small file with the extension “.gpk” automat-
ically created by WaveLab Essential each time a file is 
modified or opened in WaveLab Essential (if it hasn’t been 
previously). The peak file contains information about the 
waveform, and determines how it is drawn in the wave 
window.

View memory files (extension “.mem”) store view informa-
tion relating to a specific audio file such as window and 
scroll positions, etc. – see “Saving view settings” on page 
54.

By default, peak files and view memory files are stored in 
the same folder as the related audio file. Setting this to an-
other folder on a different drive will also improve perfor-
mance to a certain degree. Regardless of whether this 
folder is on a different drive or not you also get the advan-
tage of not having the audio file folder cluttered with non-
audio files if a separate folder is used.

This folder can be specified from the Folders dialog, either 
directly or via the Preferences–Wave edit tab:

• Select Preferences from the Options menu and select 
the Wave edit tab.

• If the “Save view settings in companion file” option is 
activated, view memory files will be saved in the same 
folder as the related audio file.

• If you select “Save in independent folder” you can click 
the “Edit” button, which will open the Folder dialog with 
the “Peak and view memories” work folder selected.
From here you can navigate to a new folder location to store the peak 
and view memory temp files.

! While a very low latency can be crucial in a real-time 
DAW application such as Steinberg Nuendo or Cu-
base, this is not strictly the case with WaveLab Es-
sential. Here the important issues are optimum and 
stable playback and editing precision. Therefore, you 
should not try to reach the lowest possible latency 
figures when working with WaveLab Essential. And 
again, should you get dropouts, crackles or glitches 
during playback, raise the Buffer Number setting on 
the Preferences–Audio device tab.

! The folder should be on your fastest hard disk and 
you should make sure you have plenty of room avail-
able on that hard disk (or partition). Putting the 
“temp” files on a separate drive (that is, not the same 
drive as your regular files) will speed up file opera-
tions considerably.
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Installing a CD/DVD recorder

Hardware installation/connection
For general instructions on installing internal or connect-
ing external recorders via USB or Firewire, please refer to 
the instructions that came with the computer, or the 
recorder itself.

For WaveLab Essential, please just check the following 
points:

• Make sure to have the latest firmware version installed in your 
recorder unit. For CD recorders, the firmware you have must 
support Disc-at-Once mode! In addition, running a unit with 
older firmware might for example prevent you from writing CD-
Text information into the tracks.

Checking the installation of the CD/DVD 
recorder
You might want to check that the recorder unit was actu-
ally found by the program. Proceed as follows:

1. Select “CD/DVD Information…” from the Tools menu.
The CD/DVD Info dialog appears.

2. Check that your recorder unit appears in the list to the 
left.
The list will also contain any regular DVD-ROM drives, etc. If your CD/
DVD recorder isn’t listed, there’s either something wrong with the instal-
lation or the unit is not supported by WaveLab Essential. 

Installation done! Where do I go 
next?
There are three things we suggest you do:

• Read through the rest of this book and try out the differ-
ent possibilities as you go along.

• Examine your WaveLab Essential directory and other 
disks included in this package for files that might be useful 
to you.

• If you run into problems, check the Troubleshooting 
chapter in the Operation Manual.

About the Tracer application
In the WaveLab Essential directory created on your hard 
disk during installation, you will find a folder called “Tools”. 
Among other things, this folder contains a small applica-
tion called Tracer. This is a diagnostic tool that tracks and 
logs various procedures that WaveLab Essential executes 
when it is launched, e.g. the loading of plug-ins.

Should you run into problems with WaveLab Essential 
and need to contact technical support, you can use the 
Tracer application and pass on the information it displays 
to the technical support staff. This could be of great assis-
tance since it might be possible to see exactly which op-
eration caused a problem.

• To use the Tracer, locate the file Tracer.exe in the Windows 
Explorer and double click on it – or use the Run command on 
the Start menu to browse for the file.

• After you have activated the Tracer application, launch Wave-
Lab Essential.

• All loading procedures are displayed as plain text, and you can 
copy this information and then paste it into, for example, an e-
mail.
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Overview

Get to know WaveLab Essential
Welcome to WaveLab Essential! 

This chapter is intended to get you acquainted with the 
program. We will here briefly describe its fundamental 
functions and main features, so as to point you in the right 
direction on your road to mastering all of the possibilities 
that WaveLab Essential offers.

The windows and what you can do 
with them
Working with WaveLab Essential, you will encounter a 
number of different windows that let you do different 
things. Editing audio files, compiling files for burning CDs 
or DVDs, applying effects and much, much more. This is 
an overview of the main windows in the program.

The Wave window

This is a Wave window, a graphical representation of an 
audio file. It consists of two parts – the lower is the Main 
view, and this is where you can perform various audio ed-
iting operations such as copying, cutting, pasting, moving, 
deleting, etc. 

The upper part is the Overview and serves to let you easily 
navigate through long files.

You can read more about the Wave window and the oper-
ations you can perform in it in the chapter “Editing in the 
Wave window” on page 32.

The Audio CD Montage window

This is an Audio CD Montage window. An Audio CD Mon-
tage lets you compile and edit multiple clips (references to 
audio files on disk) on one or two tracks.

As you can see, the window consists of two panes. The 
lower one is called the Track View, and this is where you 
assemble the clips. The appearance of the upper pane de-
pends on which of the six tabs at the very top of the win-
dow is selected. These tabs give you access to various 
functions.

After you have imported audio files as clips into an Audio 
CD Montage, you can arrange, edit and play back the 
clips. You can also apply effects, fades or crossfades, and 
much more, and last but not least, you can directly create 
CDs. All in all, the Audio CD Montage is an excellent tool 
for advanced music CD creation.

Read more about the Audio CD Montage and its features 
in the chapter “The Audio CD Montage” on page 103.
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The Data CD/DVD window

The Data CD/DVD window can be used for compiling and 
creating data CDs/DVDs (discs that exclusively contain 
computer data) and Mixed Mode CDs (discs that contain 
both data and audio).

The window is divided into two panes; the upper is called 
the source window, and the lower is the destination win-
dow. You drag files from the source window to the desti-
nation window, in which you can rename, remove and 
move files before burning a CD or DVD.

For a detailed description of the Data CD/DVD window and 
what you can do with it, see “Data CD/DVD Projects” on 
page 139.

The CD/DVD Label Editor

This window is the Label Editor. Here you can design and 
print custom labels for the CDs or DVDs you create. You 
can create labels for both the front and back of a jewel 
case, as well as for the discs.

Read more about this in the chapter “Creating labels” on 
page 147.

The Master Section

This is a very important part of WaveLab Essential, called 
the Master Section. It has a number of uses including:

• Adding real-time effect plug-in processors such as Chorus, 
Reverb, etc.

• Applying effects to files so that they are permanently made a 
part of the files (as opposed to using them in real-time).

• Monitoring and controlling the WaveLab Essential output 
level.

• Adding dithering.

For details, see “Master Section” on page 81.
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Find your way around in WaveLab 
Essential

Editing and processing

Where do I go if I want to…

• Edit an existing audio file?
When you open an audio file, it appears in a Wave window, in which you 
can edit it in various ways. See “Editing in the Wave window” on page 32.

• Compile and edit several audio files on two indepen-
dent tracks?
Create an Audio CD Montage. See “The Audio CD Montage” on page 
103.

• Apply processing to a wave file?
The Process menu contains a number of options for manipulating wave 
files, including fade-in/out, normalize, time stretch and much more – see 
“Off-line processing” on page 67. You can also use the Render function 
in the Master Section to apply effects to a file. 

• Convert an audio file into another audio format?
There are several ways: You can use either the “Save as” command or 
the “Save Special” command on the File menu (see “Saving in another 
format (Save as…)” on page 51), or the “Render” function in the Master 
Section (see “Rendering” on page 91). Finally, batch file encoding lets 
you convert multiple files to another format – see “Batch file encoding” 
on page 95.

Playback and recording

Where do I go if I want to…

• Play back with real-time effects?
Effects are added in the Master Section, see “Master Section” on page 81. 
In Audio CD Montages you can also add individual clip effects, see “Add-
ing effects to clips” on page 124.

• Record new audio files?
Use the Record button on the Transport bar. The new file will appear in a 
Wave window, see “Recording” on page 59.

• Record songs from an audio CD into WaveLab Essen-
tial?
You don’t – you import them directly from the disc. On the Tools menu 
there is an option called “Import Audio CD tracks” (see “Importing audio 
CD tracks into WaveLab Essential” on page 144).

CD/DVD creation

Where do I go if I want to…

• Create an audio CD that can be played back in a regu-
lar CD player?
You create an Audio CD Montage and insert audio files as clips into it, 
with each clip representing one track on the audio CD (see “The Audio 
CD Montage” on page 103).

• Create a data CD/DVD or a Mixed Mode CD/DVD con-
taining audio, data and video?
You do this in a Data CD/DVD window. See “Data CD/DVD Projects” on 
page 139. 

• Create labels for the CDs/DVDs I make?
This is done in the Label Editor. See “Creating labels” on page 147.

The above are just a few pointers to some of the funda-
mental functions in WaveLab Essential. While using them, 
you will discover a multitude of other features and func-
tions that let you make full use of the possibilities of this 
amazing program.

Have fun exploring WaveLab Essential!
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Why you should read this chapter
This chapter describes general methods that you will use 
when working with WaveLab Essential. Getting accus-
tomed with these procedures will allow you to work more 
effectively with the program.

Getting help
WaveLab Essential comes with a detailed help system, 
making it easy to look up procedures and descriptions 
from within the program. There are two ways to access 
the help system:

• By selecting “Operation Manual” from the Help menu.
This takes you to the help in Adobe Acrobat format (extension “.pdf”). 
This PDF file contains all chapters of the manual including additional 
sections describing plug-ins, key commands and troubleshooting proce-
dures.

• By pressing [F1].

Undo and Redo
WaveLab Essential has an extremely extensive Undo func-
tion, applicable when working in Wave windows, Audio 
CD Montages or the CD Label Editor. You can:

• Undo as many steps back as you like, by using the Undo 
item on the Edit menu.
The only limitation is the available hard disk space. You can also use the 
shortcuts [Ctrl]-[Z] or [F3] to undo. [F3] has the added advantage in that 
you can undo even if a modal dialog is currently open.

• Redo as many steps as you like, by using the Redo item 
on the Edit menu (or by pressing [Ctrl]-[Y] or [F4]).

Furthermore, each window has its own undo “history”, so 
you can click on any window and undo the last changes 
made there, even if you afterwards worked in another win-
dow.

About Undo and disk space
Many undo operations require no memory or disk space. 
However, operations that modify actual wave data (like 
time stretch, EQ, etc.) require that a file copy of the se-
lected part of the wave is stored, so that it can be brought 
back when you need to redo.

For this reason, WaveLab Essential will need to store files 
on your hard disk, in the folder you have specified for the 
temporary files (see “Temporary files” on page 15). These 
files are automatically deleted each time you close or save 
the related document.

Limiting the Undo function
If you run out of hard disk space or if you are applying pro-
cessing to extremely long sections of waves, you might 
want to put a limit on the Undo function (applicable to 
Wave windows only):

1. Select “Preferences” from the Options menu and click 
the Wave edit tab.

2. Uncheck the “Unlimited” option in the Undo/Redo 
section.

3. Change the Limit number to the desired value.

Clearing the undo
There might be situations where you have “collected” a 
large number of undo possibilities that you know you don’t 
need. You might then clear the whole undo “buffer” for 
one file at a time. This will free up some primary memory 
(RAM) but more importantly it will also delete all the “undo 
files” from your hard disk, to free up space.

1. Select “Clear undo” from the Edit menu.
A window appears informing you of how much RAM and hard disk space 
you will gain by this operation.

2. Click OK.
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Working with windows

Basic window handling
WaveLab Essential follows the basic guidelines for the 
Windows interface, which means standard “Windows 
procedures” apply.

Closing Wave windows

You can close a document window by clicking its close 
button, by selecting Close from the File menu or by press-
ing [Ctrl]-[W]. If document window(s) contain unsaved 
changes, you will be asked whether you want to save 
those changes before closing.

If you hold down [Ctrl]+[Shift] when clicking the close 
button, the window closes immediately. Any changes you 
have made will not be saved.

You can also close all windows in one go (either all 
Wave windows, or all windows regardless of type), by se-
lecting the corresponding option from the Windows 
menu.

Minimizing Wave windows

WaveLab Essential windows are minimized like any other, 
but there are also options for minimizing all Wave win-
dows or all windows (regardless of type, as with closing, 
see above), from the Window menu.

Quitting

When you quit the program, and have files with unsaved 
changes, the “Exiting with modified documents” dialog, 
see “Save All” on page 52, appears. Selecting all files in 
the list and clicking Save Selected, ensures that all 
changes made to any and all files, are saved.

Quick window switching
• To “cycle” between all open windows, press [Ctrl]-[Tab] 
or [Ctrl]-[F6]. 

• If you release the [Ctrl] key, and use any of these com-
mands again, you will switch to the previous window, 
rather than the next window in the stack.
This allows you to quickly move back and forth between two windows.

The document switch bar
A quick way to switch between the open document win-
dows is to use the document switch bar.

In this example, clicking on the tab will bring the “MoonProject”
window to front.

You can position the document switch bar at the top, 
bottom, left or right side of the screen by using the docu-
ment switch bar submenu on the View menu.
This submenu also lets you hide the document switch bar, if you like.

Panes
Several of WaveLab Essential’s windows are divided into 
panes. Panes are separated by dividers. For example, a 
Wave window can have two panes, the Overview and the 
Main view.

The panes and dividers in an Audio CD Montage window.

! Please note that this function works on one docu-
ment at a time. It is only the undo buffer for the file in 
the active window that will be cleared. Also note that 
it only applies to Wave windows.

DividersPanes
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Adjusting the size of a pane

1. Position the mouse over the divider between the two 
panes.
The pointer turns into a two-way arrow.

2. Drag the divider to adjust the pane size.

Hiding and revealing a pane

In some windows, a pane can be hidden altogether. 

To hide a pane, drag the border between the two panes all 
the way up or double click it. To reveal the pane again, 
drag the miniature divider symbol down or double click it.

You can also hide/show the Overview pane in the Wave 
window by pressing [O] on the computer keyboard.

“Folding” windows
If you find a window takes up too much screen space, but 
you still don’t want to close it, you can “fold it in” by click-
ing on the fold-in icon on the title bar. For dialogs, you can 
also double click on the title bar.

To return to normal size, just click again.

The Document icon

WaveLab Essential adds another symbol to some docu-
ment windows, the Document icon. This is used to drag 
the whole document to various other windows, such as 
Audio CD Montages or Data CD/DVD windows.

Unsaved changes indicator

When you have made changes to a document window, an 
asterisk will be displayed after the document name in the 
title bar until you save the document.

The miniature divider symbol

The fold-in icon

The normal Time Stretch dialog…
…and when “folded in”.

The Document icon
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Working with multiple windows
You can edit the same data in more than one Wave win-
dow. Among other things this allows you to work on differ-
ent sections of a wave file (for example the start and end), 
without scrolling back and forth.

The two windows are views of exactly the same data. 
Any change you make in one Wave window is immediately apparent in the 
other.

Creating a second window using menus

1. Make sure the desired window is the active one.
If it isn’t, click once in its title bar.

2. Select Duplicate View from the View menu.

Creating a second window by dragging

1. Make sure “Create windows using mouse” is activated 
on the Preferences–Wave edit tab.

2. Click and drag a rectangle in an empty area of the 
WaveLab Essential window.
This must be of a certain minimum size or bigger. If you don’t get a new 
window, try again with a bigger rectangle.

Windows sets, snapshots and Wave view 
settings
In addition to the above, there are other ways to manage 
windows:

• Snapshots store individual settings for one Wave window at a 
time, which allows you to quickly move between various views 
of a file. See “Snapshots” on page 39.

• Screen layouts store document window and dialog box posi-
tions and sizes. See “Working with window layouts” on page 
183.

• View settings can be automatically stored (Preference setting) 
when saving wave audio files. This will store all view settings 
for an individual Wave window; i.e. window size & placement, 
time ruler style, scroll positions, selection ranges and snap-
shots. See “Saving view settings” on page 54.

Dockable control bars
Various tools, shortcuts and commands are gathered on 
“control bars” (strips with symbols). These can be used ei-
ther as “palettes” (separate windows) or you can “dock” 
them to the window edges. 
The following control bars are available:

• The Standard Commands
• The Transport bar
• The Wave toolbox
• The Wave Snapshots control bar
• The Marker toolbar

Docking a control bar
There are two ways to dock a control bar:

• Drag the control bar window (by its title bar) to any of 
the sides of the application window and release the 
mouse button.
The outline shows you the shape of the control bar at the docked position.

• Double click the title bar of a control bar to return it to its 
last docked position.

Dragging a box like this will create a new window for this audio file.
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Please note that you can stack control bars and put them 
side by side, to create any type of layout you desire.

In this example, the Standard Commands, Toolbox and Transport con-
trol bars have all been docked to the upper part of the application win-
dow.

Turning a docked control bar into a separate 
window
To “un-dock” a control bar, drag it out from the docked 
position, or double click somewhere on its handle.

Control bar windows are moved by dragging the title 
bar, just as with any other window.
To drag a control bar on side of the application window, without docking 
it, hold down [Ctrl] when dragging.

Showing/hiding a control bar
There are different ways to show/hide a control bar:

• Pull down the View menu, select Control Bars, and from the 
submenu that appears, select the desired control bar, or…

• Hide a control bar by clicking its Close box.

Changing the appearance of a control bar
To change the shape of a control bar to either horizontal, 
square or vertical, drag the right or bottom edge as when 
resizing any other window. 

To change the size of the buttons in the control bar, open 
the Preferences–Environment tab and adjust the “Button 
size” setting.

Finding out what a button on a control bar 
does
1. Select Preferences from the Options menu and click 
on the Environment tab.

2. Make sure “Show Tips” is activated.

3. Close the Preferences dialog.

4. Move the pointer over an item on the control bar and 
wait a moment.
A text showing the name of the button appears.

An example of a “Tip” pop-up for the control bar.

The various control bars

The Standard Commands

The Standard Commands bar supplies shortcuts for the 
most commonly used menu items, as well as some unique 
functions.

The Toolbox

The tools are used to perform various operations on the 
data in the window, like selecting, playing, etc.

The Snapshots control bar

This is used to store and recall window “layouts”, see 
“Snapshots” on page 39.

The Transport bar

The Transport bar is used for various playback commands, 
see “Using the Transport bar” on page 57.



27

Basic methods

The Marker toolbar

This is used for various commands related to markers, see 
“Introduction” on page 98.

Speed menus
Most displays have speed menus associated with them.

To bring up a speed menu, right-click in the desired 
area.
In the Wave windows for example, there is one speed menu for the level 
ruler, one for each of the time rulers and one for each of the waveform 
displays.

The Wave window main view “speed menu”

The Speed menus contain the same items that can be 
found on the main menus, but some speed menus also 
contain unique items.

The status bar

This is normally displayed at the bottom of the screen, but 
it can be hidden on the Preferences–Environment tab. 

The status bar shows information related to the active win-
dow. Exactly what information appears depends on the 
window type – for Wave windows it shows various infor-
mation about the file. See “The status bar” on page 35.

• For some of the fields you can also click to perform operations 
related to that field.

• The status bar also indicates the progress of operations that 
take some time to finish.

! When searching for a function, don’t forget to check 
the speed menus in the window in which you are 
working!
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Units of time and level

For rulers
You can specify the time and level (amplitude) formats for 
each ruler in each window, by right-clicking on the ruler and 
selecting a format from the pop-up menu that appears.

Time formats

Level formats

To make a ruler format the default (to be used in new 
Wave windows), you need to save it as part of the default 
window style.
See “Styling WaveLab Essential – Wave windows” on page 180.

Setting values
In dialog boxes, you will find yourself adjusting values. The 
following techniques apply:

Typing values

As in most other Windows programs you can “tab to” or 
click directly on a value and type in a new one.

Using the spin controls/value fields

Values can be set using either the regular Windows spin 
controls, or any of the other methods described below.

• Clicking either arrow raises/lowers the value.
• Keeping the mouse button pressed over an arrow will “scroll” 

the value.
• Holding down [Ctrl] makes the value change in larger steps.
• Holding down [Ctrl]+[Shift] changes the value to its minimum/

maximum.
• The last adjusted control can be changed using the [↑] and [↓] 

keys, also in combination with [Ctrl] or [Ctrl]+[Shift] as de-
scribed above.

• You can also click and hold in the value field and move the 
pointer up or down to change values.

• Pointing in a value field will display the available parameter 
range.

• The down arrow to the right of the spin controls brings up a 
history pop-up where the last applied value change(s) in the 
current dialog are shown and can be selected.

Menu name Description

Time Positions are shown as hours, minutes, seconds and 
milliseconds. At large magnification factors, hundredths 
of milliseconds are shown.

Samples Positions are shown as number of samples. How many 
samples there are to a second depends on the sample 
rate of the wave. For 44.1 kHz for example, there are 
44100 samples for each second.

Time code Also called SMPTE. Positions are shown in the follow-
ing format:
hours:minutes:seconds:frames.
The number of frames per second is set on the Prefer-
ences–Wave Edit tab.

Meter Positions are shown as bars, beats and ticks, as speci-
fied on the Preferences–Wave Edit tab.

File size Positions are shown in file size units, MegaBytes, where 
the decimals represent kiloBytes.

Menu name Description

% Amplitude (level) is shown as a percentage of full level.

dB Amplitude is shown in decibels, a logarithmic scale 
used in audio engineering.

Decimal This is the actual value of the amplitude as stored in 
computer memory (always displayed as 16 bits). Please 
note that the range is from negative to positive with “0” 
representing “no signal”.

The spin controls

The history pop-up
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Using sliders and pop-ups

Many times, the most convenient way of changing a value is 
using WaveLab Essential’s proprietary sliders and pop-
ups:

1. Click with the right mouse button on the spin control 
(in some windows you can also double-click with the left 
mouse button).

2. If a pop-up menu appears, select one of the options 
on it.

3. If one or more sliders appear, drag the handle(s) or 
click the arrows to set the value.
The setting is shown in the value box “behind” the slider window.

4. When you have finished, click outside the slider win-
dow.
• If the value is “segmented” (for example divided into minutes 

and seconds, etc.), more than one slider will appear, each 
used for adjusting one of the “segments”.

• The slider window can be dragged to any position on the 
screen, using the “title bar” at the top.

• The last-used slider can also be adjusted using the computer 
keyboard:.

In effect processor panels

In the Master Section you will find either generic or cus-
tom effect panels for each effect processor. In custom 
panels, values are adjusted using special methods, see 
“The Effects pane” on page 85.

Using a wheel mouse
If you are using a mouse with a scroll wheel or similar, you 
can take advantage of the wheel for various operations in 
WaveLab Essential:

Scrolling

If you point at a waveform, the wheel scrolls the view hori-
zontally.

Zooming

If you hold down [Ctrl] and point at a waveform, the wheel 
zooms the view horizontally.

If you hold down [Ctrl] and [Shift] and point at a waveform, 
the wheel zooms the view vertically.

Changing values

If you point at an edit field in a dialog, the wheel can be 
used to adjust the value.

• If you hold down [Ctrl], the value changes in bigger incre-
ments.

• If you hold down [Ctrl]+[Shift] the value jumps to the minimum 
or maximum.

Master Section

• When working in the Master Section window, the wheel 
can be used to adjust the master volume. 
You have to point in the Master Section for this to work.

This functionality can be turned off in the Preferences–
Environment tab.

These keys Move the slider handle

[↑] and [↓] One step up/down.

[Page Up] and [Page Down] A few steps up/down.

[Home] and [End] To the top/bottom.

In this case, four faders appear, one 
for the integer and three for the deci-
mals.

The value gets updated when you 
move the sliders.



30

Basic methods

Presets
Many dialogs in WaveLab Essential have either a Presets 
tab or a Presets pop-up menu. If you think of the dialogs 
as forms, presets allow those forms to be filled out auto-
matically. WaveLab Essential comes with a selection of 
presets for most dialogs that use them, but the real power 
of presets becomes evident when you start creating your 
own!

For some WaveLab Essential effect panels there is a 
Preset button instead of a Presets tab or pop-up menu. 
Clicking the button opens the Presets dialog which has 
the same items as described below.

Depending on how presets are displayed in a certain dia-
log (tab or menu) they are handled slightly differently, but 
both cases are described below.

A number of presets in the Harmonization dialog

Loading presets
1. Open the dialog you wish to use and click on its Pre-
sets tab or pull down its Presets menu.

2. Select the preset you want to use. 

3. Where applicable, click the Load button.

A quick way to load a preset is to right-click on the 
Preset tab and select a preset from the menu that ap-
pears.

Creating a preset
1. Open the dialog you wish to use and set up the dialog 
as desired.

2. Click on the Presets tab or pull down the Preset menu.

3. Click on the name line and type in a name for the pre-
set or click the Save As… menu item and type in a name in 
the dialog that appears.

4. Where applicable, click the Add button.

Modifying a preset
1. Load the preset you want to modify, as described 
above.

2. Make the desired settings in the dialog.

3. Click the Update button or click the Save item.

Deleting a preset
1. In the Presets tab, click on the preset you want to de-
lete.

2. Click the Delete button.

Or…

1. From the Presets menu, select the option Explore pre-
sets.

2. In the Explorer window that appears, select the preset 
file you want to delete and press [Delete].

Store temporarily and Restore
Some dialogs also allow you to quickly save and load up 
to 5 presets with the Store temporarily and Restore menu 
items. This is useful if you want to quickly test and com-
pare different settings.

1. Select the option “Store temporarily” and from the sub-
menu select the number under which you want to save (#1 
– #5).

2. To quickly load the saved settings again, select the 
corresponding number from the Restore submenu.
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How presets are saved
The presets are automatically saved when you quit the 
program. The next time you load the program, the presets 
are ready and waiting, just as you left them. Furthermore 
the presets are “global” to all files. No matter which file 
you are working on, you still have access to all your pre-
sets.

About non-modal dialogs
Many of the dialog boxes in WaveLab Essential are “non-
modal”. This means that the window behind the dialog can 
be operated even though the dialog box is still up on the 
screen.

For example, when you have a Processing dialog up on 
screen, you can still work with the Wave window and the 
main menus. For example, this allows you to perform the 
following operations without closing the dialog.

• Play back the wave to hear the effect of any applied process-
ing.

• Adjust the selection before re-processing.
• Use the menu to undo the last processing.

Keyboard commands
Windows normally does not allow you to select from 
menus and use keyboard accelerators when a dialog box 
is the active window. However, we have provided a few 
special key shortcuts for the most crucial commands:

Using the computer keyboard
When you are working with WaveLab Essential, the com-
puter keyboard has several different uses:

Transport controls
The Transport functions (such as Play, Stop, Record and 
so on) can all be managed from the computer keyboard. 
The keyboard commands for these functions are located 
on the numeric keypad, to the right on the computer key-
board. See “Using the Transport bar” on page 57.

Keyboard shortcuts

Shortcuts for menus

Many of the items in WaveLab Essential’s menus have a 
computer keyboard equivalent – an “accelerator”, listed 
on the menu. Some abbreviations might need an explana-
tion:

Due to the large number of functions in WaveLab Essen-
tial, some key commands consist of double or triple key 
strokes (known as “key sequences”). These are displayed 
with the different keys separated by comma signs. 
For example, “Alt+F12, T” means “hold down [Alt] and 
press [F12], release, then press [T]”.

Customizable shortcuts

You can define your own key shortcuts for a number of 
functions in the program, see “Customizable key com-
mands” on page 184.

Additional shortcuts

In addition to the above, there are key commands that are 
not listed on the menus or in this manual. Check the Key 
Commands chapter in the online documentation for a full 
list.

Key Command

[F3] Undo

[F4] Redo

[F6] Play selection

[Shift]+[F6] Activate loop and play selection

[F7] Stop

[F8] Play

Abbreviation Description

KP The numeric keypad. “KP 2” for example means 
the “2” key on the numeric keypad.

BkSp The Backspace key.

F1 to F12 The Function keys.
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About this chapter
The Wave window is the heart of WaveLab Essential’s au-
dio editing capabilities. This is where you view, play back 
and edit individual audio files. This chapter describes how 
to open and save audio files, how to perform wave editing 
and how to handle the Wave window itself.

Creating new empty documents
If you want to start with an empty file, for assembling ma-
terial from other files for example, proceed as follows:

Using menus

1. Select New from the File menu, and Wave from the 
submenu that appears.
Or, right-click the New icon on the Standard Commands control bar.

2. Fill out the dialog that appears.
See “Supported file formats” on page 49 for details about the various 
options.

By dragging

This is only possible if the currently active window is a 
Wave window (or if no document windows are open).

1. Make sure “Create window using mouse” is activated 
in the Preferences–Wave edit tab.

2. Drag to make up a box in an empty free area of the 
WaveLab Essential application window.
This must be of a certain minimum size. If you don’t get a new window, try 
again with a bigger box. The new window “inherits” its attributes from the 
last active window. If no window is open, the dialog box settings for units 
are used instead.

About display options

There are a number of options that govern how a window 
will look when it is first created. These are all found on the 
Preferences–Wave edit tab.

Opening Waves

Using the Open dialog
1. Select Open Wave from the File menu, press [Ctrl]-[O] 
or click the Open icon on the Standard commands control 
bar and select “Wave…” from the pop-up menu that ap-
pears.

2. Use the standard controls to locate and select the de-
sired file.
The file format pop-up allows you to only view files in a certain format and 
the buttons in the upper left half provide various views of the files on the 
disk.

3. Click Open.
The Wave appears in a new window.

Below follow descriptions of the items/procedures which 
are not standard for all Windows Open dialog boxes:

The Recent Folders pop-up menu

At the top of the dialog, you will find a pop-up menu which 
lists the most recently accessed folders. Select one to 
open it.

The playback functions

Once you have selected a file in the list you can audition it 
by clicking Play. Click again to Stop.

You can also have files play back automatically as soon as 
they are selected. To do this, activate the Auto button.

Opening multiple files

As in many other Windows programs, you can select and 
open as many files as you wish. The [Shift] key is used for 
making continuous selections and [Ctrl] is used for select-
ing any combination of files.

When you click Open the selected files will be opened, 
each in an individual window.

The Open in Audio CD Montage window option

If you check this option at the bottom of the dialog, the 
file(s) you open will be placed in an automatically created 
new Audio CD Montage. 

! For a list of supported file formats, see “Supported 
file formats” on page 49.
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Inserting a file into the current document
You may have a file that you want to insert into an existing 
file. The two must have the same attributes (e.g. sample 
rate), or a warning will appear.

1. Locate the document into which you want to add ma-
terial, and make it active.

2. If you want to add the file at some arbitrary position in 
the document (rather than at the beginning or end), click 
to move the wave cursor to that position.

3. Pull down the Edit menu and select Insert Audio File 
and then one of the options from the submenu that ap-
pears.

4. Select a file and click Open.
The file is added. If you used the “at cursor position” option, a temporary 
marker is added at the insertion point.

Using drag and drop
To open files from the Windows desktop, use one of the 
following possibilities:

• Drag and drop the file(s) on the WaveLab Essential ap-
plication window.

• Drag and drop the file(s) on the WaveLab Essential pro-
gram icon or a shortcut for it.
If the program isn’t already running, it will be launched. This works even if 
the application is running but minimized.

To Nuendo

It is also possible to drag and drop files from WaveLab 
Essential to Steinberg’s Nuendo!
This should be done using the Document icon.

Opening files from the desktop
To open a file in WaveLab Essential by double-clicking on 
it, you must have created an association between the file 
format and the WaveLab Essential application.

• You can do this from within WaveLab Essential at any 
time by selecting “Associate all files of this type with 
WaveLab Essential” on the File menu–Special submenu.
This association is made according to the currently selected file’s format, 
and will ensure that all files of this format always opens with WaveLab 
Essential.

Using the Recent Files lists
On the bottom of the File menu you will find one or several 
hierarchical menu items that allow you to open recently 
used document files. There are different submenus for dif-
ferent file types, as indicated by the menu items (“Recent 
Audio Files”, “Recent Audio CD Montages”, etc.). Each 
section holds up to twenty files. Selecting an item on one 
of the submenus opens the corresponding file.

Using Favorites
Just above the “Recent…” items is the Favorites menu. 
This lets you create a “library” of files that you want to be 
able to open quickly.

• The “Add current document” option, adds the currently 
active document to the menu.
The list is sorted alphabetically.

• “Validate list” checks whether each document on the 
menu is still residing in the specified location on your hard 
disk(s).
If a document can’t be found, it is removed from the list.

• “Clear list” removes all files from the menu.

Opening Wave files from within other windows
You can also open files from Audio CD Montage win-
dows. See the respective chapter for details.

Importing tracks from an audio CD
This is described in the section “Importing audio CD 
tracks into WaveLab Essential” on page 144.
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Window overview and adjustments

About the window sections

Main view

The lower waveform area is where the main action is going 
on. It is here that you select, apply tools, drag and drop, 
etc. 

• There are both time and level rulers. These can be hidden and 
displayed (see the ruler and wave display speed menus). You 
can also set which units of time and level they show (see 
“Units of time and level” on page 28).

Overview

The overview is mainly used for navigating through long 
files. Since you can have different zoom factors in the two 
areas, the Overview can display the entire wave while the 
Main view only shows you a short portion.

The status bar

The status bar can be hidden. This is done on the Prefer-
ences–Environment tab. The status bar provides the fol-
lowing information:

• The Wave and Mouse cursor time positions are shown using 
the same unit of time as in the rulers and dialog boxes.

• Level positions are always shown in dB.

• The “Selection length” field shows the length of the entire 
wave if nothing is selected, and the length of the selection (in 
brackets) if there is one. If you click this value with the right 
mouse button the window zooms in on the selected range.

Sizing, moving and minimizing
WaveLab Essential uses standard Windows techniques 
for resizing, moving, maximizing and minimizing windows. 
See your Windows documentation for details.

Maximizing width

Selecting the Maximize Width item on the View menu 
makes the window as big as the screen (or any other fac-
tor) permits.

The divider
The divider between the Main view and the Overview can 
be dragged to change the view sizes. See “Panes” on 
page 23 for details.

Setting the zoom factor

About zooming

Horizontal zoom

• When you zoom out all the way the entire file fits the window.
• When you zoom in as far as possible, each sample will occupy 

several pixels on the screen. This allows for single sample-ac-
curate editing of waveforms.

Overview

Zoom controls
Main view

Left audio channel

Right audio channel

Mouse cursor position/Level 

Zoom factorWave cursor position/Selection length

File format details (see “Supported 
file formats” on page 49)

Zoom out all the 
way to see the 
entire wave.

Zoom in until 
you can see 
each individual 
sample point, 
for very detailed 
editing.
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Vertical zoom

• When you zoom out all the way, the complete height of the 
wave fits into the window. You can note this by checking the 
ruler on the left side.

• As you progressively zoom in, the display will only show you a 
smaller part of the total height. Exactly which section you see 
can be adjusted with the vertical scroll bars. Again, check the 
ruler to see which part of the waveform is currently shown in 
the display.

For example, to check the peaks of the waveform in great 
detail, zoom in and scroll all the way up and down.

Using the zoom controls
Both the Main view and the Overview have horizontal and 
vertical zoom controls. These behave just like scroll bars:

• You can drag the handle to any position.

• You can click anywhere on the scale to move the handle 
there.

• You can click on the arrows at either end to change the 
zoom factor in smaller steps.
Either way, the zoom factor on the status bar is updated continuously.

Using the Magnifying Glass tool
The Magnifying Glass tool is used to specify any section 
of the waveform and have it occupy the entire window.

The Magnifying Glass tool selected.

Selecting the tool

The Magnifying Glass tool can of course be selected from 
the tool box, but there are two other options:

• When you hold down [Ctrl] and move the pointer over 
the Main view, the Magnifying Glass is automatically se-
lected.
This is just a momentary selection. As soon as you release [Ctrl] you get 
the previous tool back.

• When you move the pointer over the overview, it turns 
into the Magnifying Glass automatically.

Using the tool in the Main view

1. Press the mouse button with the pointer somewhere in 
the waveform.

2. Drag left or right to make up a box, and then release 
the button.
The area encompassed in the box now fills up the entire window.

Detailed view of 
waveform peaks

Vertical and horizontal zoom 
controls

Making a box like this…

…zooms in so that the 
“boxed” area will span the 
entire display.
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Using the tool in the Overview

The Magnifying Glass can be used in the Overview, just as 
in the Main view. However, even though you use the tool in 
the Overview, it is the Main view that gets zoomed.

You can for example use this as follows: keep the Over-
view zoomed out all the way and use the Magnifying Glass 
tool to display any section in the Main view.

Mouse zooming
Using the mouse, you can continuously change the zoom 
factor by dragging:

1. Position the mouse pointer over the ruler in the Main 
view.

2. Press the mouse button and drag up or down.
The zoom factor changes continuously.

Dragging to change the zoom factor.

• To zoom with the cursor in a fixed center position, hold 
down [Shift].

• To make vertical zoom adjust automatically to the peaks 
in the waveform, hold down [Ctrl].

• To switch to scrolling, hold down [Alt].

This technique works very well in combination with the 
fact that you can move the song position by dragging hor-
izontally in the ruler. By dragging in both directions, you 
can quickly find a certain position in the file and display it 
at the desired magnification factor.

Using mouse zooming to its full effect requires some prac-
tice – but it is worth the effort!

Setting sensitivity for mouse zooming

On the Preferences–Environment tab, there’s a Sensitivity 
setting for mouse zooming. The higher the value, the less 
sensitive the function. You might want to raise this value 
when you first try out the function.

Using a wheel mouse
• If you hold down [Ctrl] and point at a waveform, the wheel 

zooms the view horizontally.
• If you hold down [Ctrl] and [Shift] and point at a waveform, the 

wheel zooms the view vertically.

Using the Zoom menu
The Zoom submenu can be invoked from two places:

• From the main view menu.
• By clicking on the Zoom factor on the status bar.

It provides the following options:

Using the keyboard
A quick way to zoom the active Wave window is to use the 
arrow keys on the computer keyboard: Press [arrow up] or 
[arrow down] to zoom in or out (respectively) horizontally. 
Hold down [Shift] and use the arrow keys to zoom in or 
out vertically.

There are also additional key commands for zooming – 
check the Key Commands chapter in the online documen-
tation for a full list.

Option Description

Restore last zoom Brings back the last zoom factor set using this 
menu or the Magnifying Glass tool.

Overview Zooms the view out as far as possible.

Zoom in 1:1 Zooms in so that one pixel (dot) on the screen rep-
resents one sample.

Microscope Zooms in as far as possible, so that one sample oc-
cupies several pixels.

Zoom selection Zooms the window so that the current selection 
(see “Selecting” on page 40) fills the entire display. 
You can also click the selection range (in brackets) 
with the right mouse button on the Status bar.

Custom… This brings up a dialog that allows you to enter any 
zoom factor.

Optimize vertical 
zoom

This changes the vertical zoom factor so that the 
peaks are clearly visible. This adjustment is done 
according to the section of the wave currently visi-
ble in the window, not the whole file.
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Using auto zoom for Overview
This setting, found on the Preferences–Wave edit tab, al-
lows you to have the zoom factor automatically adjusted, 
so that it always shows the entire wave. 

1. Activate “Auto zoom for overview” in the Preferences 
dialog.

2. Zoom out on the overview so that you see the entire 
wave.
Now, when you resize the window, the overview zoom factor is automat-
ically adjusted so that the entire wave is always shown.

Which part of the file do I see?
In the overview, a striped line called the “range indicator” 
tells you which section of the file is currently displayed in 
the Main view.

Furthermore, the range indicator moves while you drag the 
scroll bar handle. This means that by observing the over-
view you can easily find positions in the Main view when 
scrolling, even though the Main view might be zoomed in 
very closely.

The range indicator can be displayed at the top or bottom 
of the overview, see “Range Indicator at top/bottom” on 
page 181.

Navigating through the file
There are several ways to move the view to a certain posi-
tion in the file:

Scroll bars
This is the most evident option. These work exactly as in 
any other Windows program. Please note that the wave-
form scrolls while you drag the scroll bar handle.

Furthermore, WaveLab Essential uses proportional scroll 
bars, that is, the size of the handle shows you how much 
of the entire document you see. To get a feeling for how 
this works, drag the horizontal zoom control while observ-
ing the size of the scroll bar “handle”.

Centering the view vertically

If you have zoomed in vertically, you might want to center 
the waveform view. To do so, double click in the level ruler.

Clicking in the Overview
If you click once in the Overview, the Main view is scrolled 
so that the position where you clicked is shown on the left 
side of the window.

Using the Scroll to menu
To bring up the Scroll to menu, either select “Scroll to” 
from the Main view menu, or right-click in the Overview or 
the Main view. 
The difference between the methods is that the main 
menu always affects the Main view, whereas the speed 
menus affect either view depending on where you clicked.

The following options are available on the menu:

When you drag the scroll bar, the range indicator continuously 
shows you which part of the wave is shown in the Main view.

Option Scrolls the view to

Start/End The beginning or end of the wave.

Selection start/end The beginning or end of the current selection, if 
any.

Cursor The wave cursor.
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Clicking on the status bar
If you click on the cursor position on the status bar, the 
view is scrolled so that the wave cursor becomes visible.

If you right-click instead, a dialog appears to let you spec-
ify a certain time position to scroll the view to.

Using a wheel mouse
If you move the wheel down the scroll bar will move for-
ward and vice versa. You can also hold down the wheel 
and drag the view in either horizontal direction.

Snapshots
Snapshots store the Main view’s “layout” – essentially two 
things:

• How a window is scrolled (which part of the wave you see).
• The window’s zoom factor.

If you move back and forth between various positions in a 
file, or if you zoom in and out for detailed or overview edit-
ing, using snapshots will save you a lot of time. Snapshots 
are created and managed on the Wave Snapshots control 
bar, opened from the View menu.

To create a snapshot, you first set up the view as desired 
(by scrolling and/or zooming). Then click the camera icon 
on the Wave Snapshots control bar, followed by one of 
the numbers. The snapshot is now stored under that but-
ton. The fact that the snapshot is used is indicated by a 
red circle around the number.

You use the same procedure to “reprogram” existing 
snapshots.

To recall a stored snapshot, simply click on its number on 
the Wave Snapshots control bar.

Snapshots will be automatically saved with the individ-
ual file if “Save view settings in companion file” is acti-
vated in the Preferences–Wave edit tab, see “Saving view 
settings” on page 54. 

Setting the ruler start position
Normally, the ruler is set so that the beginning of the file 
represents position “0”. However, for editing purposes 
you may want to set the “0” position at some other point in 
the file. The picture sequence below shows you how to do 
this:

Working with a meter based display
If the material on which you are working is tempo based, 
and you know the tempo, you can make the ruler show po-
sitions in meter format (bars, beats and ticks), to make it 
easier to find musically related cutting points:

1. Select Meter for the ruler time format, see “Units of 
time and level” on page 28.

2. Open the Preferences–Wave edit tab.

3. Set the Time Signature and Tempo to match the file.

This snapshot is “programmed”.

1. Set the wave cursor where you want the “0” position.

2. Right-click 
the ruler to bring 
up this pop-up 
menu.

The ruler start 
position is 
moved.

3. Select “Set 
origin at cursor”.
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4. Set the “Ticks per quarter note” setting to a number 
you feel comfortable with.
This might for example be the same value as that used by your MIDI se-
quencer.

In this example, a meter ruler with 96 ticks per quarter note is used.

Setting the wave cursor position
Many operations, such as playback and selection depend 
on the current cursor position – for example, playback of-
ten starts at the cursor. The current cursor position is indi-
cated by a vertical flashing line, both in the Main view and 
in the Overview. There are various ways to move the wave 
cursor:

• By clicking once somewhere in the Main view or on the 
time ruler.
If you have a selection, click on the ruler, since clicking in the waveform 
deselects all.

• By clicking and dragging in the time ruler.

• By using the Transport controls (see “Setting the start 
point for playback” on page 58).

• By using the “Move cursor to” menu on the View menu.
The options on this are similar to the “Scroll to” menu, see above. There’s 
also a “Position” option which allows you to specify any position in the 
format selected for dialogs and a “Snap Cursor” option described in the 
section “Using “Snap Cursor”” on page 40.

• By using the Cursor keys:

• By using markers
Markers allow you to pre-define positions and move the cursor there, see 
“What are markers for?” on page 98.

Using magnetization
If you have “Magnetize bounds” on the Options menu ac-
tivated and drag the cursor on the time ruler, it will “snap” 
to the following positions:

• The start and end of the entire wave.
• The start and end of the selection.
• Markers (see “What are markers for?” on page 98).

Using “Snap Cursor”
This function – which can be reached from the “Move cur-
sor to” item on the View menu and from the main wave 
display speed menu – moves the cursor position automat-
ically for you. There are two options:

• Move to the closest zero crossing (see “Snapping to 
zero crossings” on page 42) to the left of the cursor posi-
tion.
To get this effect, make sure “Snap to time unit” is turned off on the Op-
tions menu.

• Move to the zero crossing closest to a major time unit.
For example, this can be to the zero crossing closest to a whole second 
on the time ruler. To get this effect, make sure “Snap to time unit” is acti-
vated on the Options menu.

In the last case, the “time unit” mentioned depends on 
which type of scale is selected for the ruler:

Selecting
Almost all types of editing and processing you perform in 
WaveLab Essential operate on the selection. There are 
numerous ways to make a selection:

By dragging or [Shift]-clicking
The standard way to select a range in a Wave window is 
to click and drag. If you drag all the way to the left or right 
side of the window, it scrolls automatically, allowing you to 
select larger sections than what can be shown in the win-
dow. The speed of the scrolling depends on how far from 
the window edge you are.

These keys Move the wave cursor

[←] and [→] One “pixel” (screen dot) in either di-
rection.

[Ctrl] + [←] and [→] Twenty “pixels” in either direction.

[Home] and [End] To the beginning and end of the 
wave.

Option Cursor moves to

Time Closest whole second

Samples Function not available

Time code Closest frame

Meter Closest whole beat
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You can also press [Shift] and click in the Wave window 
to make a selection between the position of the wave cur-
sor and the click position.

Selecting in stereo files
If you are working on stereo material you can select either 
channel or both so that you can apply an operation to one 
channel only or to the entire stereo material. Which chan-
nel will be selected when you drag or [Shift]-click de-
pends on where you position the mouse pointer, as 
indicated by the pointer shape:

To select a single channel by [Shift]-clicking, you need 
to set the wave cursor in only one channel (by clicking in 
the upper or lower part of the wave) and then [Shift]-click 
in the same channel.

Switching the selection between channels

If you have made a selection, you can move this to the 
other channel or extend it to both channels by selecting 
the corresponding items from the Select submenu (on the 
Edit menu). Or, you can press [Tab] to move the selection 
between channels (if there is no selection, [Tab] moves 
the cursor between channels).

Selection shortcuts
There are a number of ways to quickly make certain selec-
tions (for many options there is more than one method):

Selecting in the Overview
You can select in the Overview, just as in the Main view. 
To get the selection tool in the overview, hold down [Ctrl] 
and move the pointer into the overview.

Extending and shrinking the selection
Very often you will have made a selection only to find it isn’t 
completely perfect. In this case you can extend or shrink 
the selection. In fact you can very well use this as a 
method: make a coarse selection with a lower zoom factor, 
then zoom in and adjust the start and end in more detail.

By dragging

1. Move the mouse pointer to the beginning or end of the 
selection.
It turns into a double arrow.

Position Pointer 
Shape

Description

Upper half of left channel Only the left channel will be 
selected.

Middle area Both channels will be selected.

Lower half of right channel Only the right channel will be 
selected.

To select… You can…

The area between two consec-
utive markers

• Double click between them.
• Depending on the type of marker, use 
one of the last two options on the Select 
menu (on the Edit menu).

The area between any two 
markers

• Double click between two markers, 
keep the mouse button pressed and drag 
left or right.

The entire waveform • If there are no markers, double click.
• Triple click.
• Press [Ctrl]-[A].
• Select “All” from the Select menu on the 
Edit menu.

From the cursor to the follow-
ing or previous marker

• Select “From cursor to previous/next 
edge” from the Select menu (on the Edit 
menu).
• Hold down [Shift] and double click be-
tween the cursor and the marker.

From the cursor to the begin-
ning or end of the file

• Select “From cursor to start/end of file” 
from the Select submenu (on the Edit 
menu).
• Hold down [Shift] and double click to 
the left/right of the cursor position.
• Press [Shift]+[Home] or [Shift]+[End].

All data between two start/end 
loop or region markers

• Hold down [Shift] and double click on 
either marker head.
• Click between the start/end region 
markers and select the type (loop or ge-
neric region) from the Select menu on the 
Edit menu.

Half or double the current se-
lection length

• Select “Halve selection length” or “Dou-
ble selection length” from the Select menu 
on the Edit menu. These options are useful 
if you are working with measures.

What was previously selected • Select “Toggle” from the Select menu 
on the Edit menu.
• Press [Esc].

To select… You can…
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2. Press the mouse button and drag left/right.

Dragging the end of the selection.

Using [Shift]

• Hold down [Shift] and click outside (extend) or inside 
(shrink) the current selection.
If you click inside the first half of the selection, this will change the start 
point, if you click inside the latter half, this will change the end point.

Using the cursor keys

• If you hold down [Shift] and press the [←] or [→] keys, the 
start or end of the selection is moved one pixel (screen dot) to 
the left/right. If you also hold down [Ctrl] it is moved twenty 
pixels instead.

• If you hold down [Shift] and press [Page Up]/[Page Down], it 
will also move 20 pixels.

• If you hold down [Shift] and press the [Home]/[End] keys, the 
selection will extend from the current cursor position to the 
start/end of the file respectively.

Which end of the selection you change depends on which 
end of the selection the cursor is closest to.

Exactly how much one pixel represents depends on the 
zoom factor. If for example the zoom factor is “x1:64”, the 
cursor keys alone move 64 samples, and together with 
[Ctrl] they move 1280 samples.

Using the Select menu
The Select submenu (on the Edit menu) has a number of 
options for extending the selection to various points in the 
waveform.

Moving the selection
If the selection is the right length, but at the wrong posi-
tion, you can move it:

1. Hold down [Ctrl] and [Shift].

2. Point at the selection and drag left/right.

Snapping to zero crossings

About zero crossings

If you cut out a portion of a wave and paste it in some-
where else, chances are there will be a discontinuity 
where the two waves are joined. See the example below. 
This discontinuity will result in a transient in the wave 
when it is played back, which is perceived as a “click” or 
“bump” in the sound.

To avoid this you need to make the splice at a zero cross-
ing.

A zero crossing is – a point where the wave crosses the 
zero level axis, the point where the wave is considered to 
have “zero level”.

Furthermore we recommend that joins are made with the 
splice points of the two waves heading from opposite di-
rections to the zero crossing. That is, one should be on its 
way up (below the zero level axis), and the other should be 
on its way down (above the zero level axis).

WaveLab Essential can help!

If you wish, WaveLab Essential can automatically search 
for zero crossings, and extend the selection “outwards” 
(make it bigger at both ends) so that it begins and ends at 
a zero crossing. Normally this will not be noted in the edit-
ing precision (since there are usually hundreds or thou-
sands of zero crossings per second), but it will help avoid 
“clicks” and “pops” and “bumps”.

At this point, there 
will be a click in 
the sound, due to 
the discontinuity in 
the splice.
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But just making the selection start and end at zero cross-
ings is not enough. When you actually perform the editing 
operation (cut and paste or dragging, for example) you 
need to make sure the material is inserted at a zero cross-
ing. See “By dragging” on page 44.

Setting up zero crossing detection

1. Pull down the Options menu and activate “Snap to 
zero crossing”.

2. Select Preferences from the Options menu.

3. Click on the Wave edit tab.

4. Fill out the “Snap to Zero crossing” options.

Checking the effect of Snap to Zero crossing

1. Make sure that “Off at high zoom factor” is not activat-
ed and zoom in until the zoom factor is 1:1.

2. Make a selection and observe how it is extended left 
and right.

Snapping to time units
When “Snap to time units” is activated on the Options 
menu, selections will automatically be extended to the left 
and right so that they start and end at whole time units 
(and also at the closest zero crossing, if that option is ac-
tivated, see above). This allows you to easily make selec-
tions spanning a certain number of seconds for example.

The “time unit” mentioned depends on which type of scale 
is selected for the ruler:

Using Magnetization
If you have “Magnetize bounds” on the Options menu ac-
tivated and create or adjust a selection, it will “snap” to the 
following positions (or to the zero crossing closest to the 
position, see above):

• The wave cursor.
• The start and end of the entire wave.
• Markers (see “What are markers for?” on page 98).

Level selections
For some of WaveLab Essential’s level processing func-
tions, it is useful to make a selection not only in time, but in 
level.

By dragging

1. Make a regular “time” selection.

2. Hold down [Shift].

3. Move the mouse to the top or bottom of the selection 
box.
The pointer changes into a vertical double arrow.

! Note that this means that you must drag across a 
certain “time area” (for example more than half a sec-
ond) to get any selection at all.

If you make a selec-
tion like this…

…it is automatically 
extended at both 
ends, to the closest 
zero crossings.

Option Cursor moves to

Time Closest whole second

Samples Function not available

Time code Closest frame

Meter Closest whole beat

File size Function not available
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4. Press the mouse button and drag up/down.

If you then extend the selection time-wise, the level selec-
tion still remains the same.

Extend to peaks

To automatically set the level selection to the highest peak 
in the current selection, make a time selection as desired 
and select “Extend to peaks” from the Select submenu on 
the Edit menu.

Basic editing commands

Mono/stereo
WaveLab Essential is totally flexible in its handling of ste-
reo. All editing operations can be performed on either 
channel or both.

Copying audio
The following operations allow you to make copies of sec-
tions of audio within the same file or from one file to an-
other.

By dragging

1. Decide whether you want to use “Snap to Zero cross-
ing” (activated from the Options menu) for this operation.
When this is activated, both the selection start and end as well as the 
drop position will always occur at zero crossings. See “Snapping to zero 
crossings” on page 42 for details.

2. Make a selection.

3. Point at the selection, press the mouse button and 
hold it down.

4. Drag to a position outside the selection (in the same 
file) or to another Wave window.
When you have the cursor over a valid area, the pointer will turn into a 
single or double waveform (see below). The status bar will show the ex-
act position at which the selection will be inserted.

Make a regular selection, move 
the pointer to its top or bottom 
and hold down [Shift]…

…drag up/down, 
and release the 
mouse button.

! Please note that any existing markers (see “What are 
markers for?” on page 98) in the source audio sec-
tion also will be copied.

! Make sure you don’t drop on a selection in the desti-
nation window, or you will perform a crossfade, see 
“Crossfade” on page 73.
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5. Release the mouse button.
The selection is inserted at the indicated point. The audio that previously 
began at that point is moved forward so that it is now played after the in-
serted section.

Using “Magnetize Bounds”

If you have “Magnetize bounds” on the Options menu ac-
tivated when you drag, the cursor will “snap” to the follow-
ing positions:

• The wave cursor.
• The start and end of the entire wave.
• Markers (see “What are markers for?” on page 98).

Stereo/mono “conflicts”

Stereo/mono is handled as follows when you drag be-
tween files:

Sample rate conflicts

If you copy or move audio from one window to another, 
and the sample rates of the two files are not the same, the 
copied/moved sound will play back at the wrong pitch 
(speed). The program will warn you if this is about to hap-
pen.

While mixing sample rates can sometimes be used as an 
effect, it is most often not desired. There are two ways to 
get around this:

• Sample rate convert the source file to the same rate as the 
destination file before doing the editing.

You might go back later and undo this conversion if necessary.
• Sample rate convert the destination file to the same rate as the 

source file before adding the audio to it.
Please note that you are then partly “stuck” with this new sample rate, 
since rate converting back and forth too many times is not recom-
mended, see “Convert sample rate” on page 79.

By using Copy and Paste

1. Make a selection.

2. Select Copy from the Edit menu, press [Ctrl]-[C] or 
drag the selection onto the Copy icon on the Standard 
Commands control bar.

3. If you want to insert the audio, click once at some po-
sition in the same file or in another file.
The wave cursor appears at that point.

4. If you would rather replace a section of audio, select it.
In this case, the position of the cursor is of no relevance.

Make a selection, position the mouse pointer over it…

…drag and drop…

…the dragged section is inserted at the drop point.

Dragged 
section

“Drop” 
wave

Action

Stereo Stereo The dragged audio is always inserted into both 
channels.

Stereo Mono Only the left channel is inserted.

Mono Stereo What happens depends on the vertical position 
in the destination window at which the drop is 
made. This is indicated by the cursor shape (see 
“Selecting in stereo files” on page 41). The se-
lection can be inserted into only one of the chan-
nels, or the same material can be inserted into 
both channels.



46

Editing in the Wave window

5. Select Paste from the Edit menu or press [Ctrl]-[V].
The material you copied is either inserted at the indicated point (no se-
lection) or it replaces the current selection (if you have a selection).

Stereo/mono “conflicts”

Stereo/mono is handled as follows when you paste:

Moving audio
The following commands allow you to rearrange the “or-
der” of the audio in a file.

By dragging

This is just like drag copying (see above). The only differ-
ence is that you hold down [Alt] and [Ctrl] while dragging 
to move audio. The material you dragged is removed from 
its original position and inserted where you drop it.

By using Cut and Paste

This is just like using Copy and Paste (you can for example 
drag the selection to the Cut symbol on the Standard 
Commands control bar – see above). The only difference 
is that when you select Cut, the audio is removed from the 
window. The material after the cut section will be moved 
to fill out the gap.

By nudging

The Nudge left/right tools in the Toolbox (also known as 
“Kicker tools”) can be used to move the audio in small 
steps within a file.

1. Make a selection.

2. Click on the selection with one of the Nudge tools (de-
pending on the direction in which you want to move it).
The audio is moved one pixel (screen dot). Exactly how much this is de-
pends on how far you are zoomed in. If for example the status bar says 
x1:256, the selection will be moved 256 samples.

Copied 
section

Paste
wave

Action

Stereo Stereo If the wave cursor extends across both chan-
nels of the destination file, the material will be 
inserted into both channels.

Stereo Stereo If the wave cursor is only in one channel, the 
Paste will only happen in that channel. Material 
from the left channel will be pasted in the left 
channel and vice versa.

Make a selection, and select Copy…

…click for an insertion point…

…and select Paste. The copied section is inserted at the cursor po-
sition.

Stereo Mono Only the left channel is pasted.

Mono Stereo What happens depends on whether the wave 
cursor is in one channel or both. The Paste can 
either happen in one of the channels, or the 
same material can be inserted into both chan-
nels.

! Please note that to completely undo a move between 
two files you must first undo the paste in the destina-
tion window and then undo the cut in the source win-
dow.

Copied 
section

Paste
wave

Action

The Nudge tools
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The moved section “overwrites” the audio originally at 
that position. 
For example, when you nudge a selection to the right, silence will appear 
before the nudged section while audio to the right will be replaced by the 
nudged section. This is different from moving by dragging.

If you nudge many times in a row and then undo, all the 
moves are undone in one go.

Repeating an audio selection
To repeat a section of audio, proceed as follows:

1. Make a selection, select Cut or Copy and place a new 
insertion point, just as when performing a normal Cut or 
Copy (see above).

2. Select “Multiple copies…” from the Paste Special 
submenu on the Edit menu.

3. In the dialog that appears, enter the number of copies 
you desire (up to 1000), and click OK.

Other Paste operations
On the Paste Special menu you will find some additional 
options:

Overwrite

This will overwrite data in the destination file, rather than 
moving data to make room for the inserted audio. The ac-
tual amount that will be overwritten depends on the selec-
tion in the destination file:

• If there is no selection in the destination file, a section 
with the same length as the pasted data will be overwrit-
ten.
If there is a selection, the pasted data will replace that selection, just as 
when making a regular paste.

Append

This will add the pasted audio after the end of the file, just 
as if you had placed the wave cursor there and selected 
Paste.

Prepend

This will add the pasted audio before the beginning of the 
file.

Mix

This will blend the two files into each other, starting at the 
selection (if you have one) or at the cursor position (if 
there is no selection).

• When you select the Paste Special – Mix option, a dia-
log appears, allowing you to specify the desired gain for 
the audio on the clipboard and at the destination, respec-
tively.
A setting of 0 dB means the level will be unaffected.

• All the data on the clipboard is always mixed in, regard-
less of the length of the selection.
It doesn’t matter whether or not you have a selection in the destination 
file when you paste.

Deleting selections

Delete

You can use the following methods to delete a selection 
of audio:

• Select Delete from the Edit menu.
• Click the Delete icon on the Standard Commands control bar.
• Press [Backspace] or [Delete].
• Drag the selection to the Delete icon on the Standard Com-

mands control bar.

Trim

To remove all the audio except the current selection, se-
lect Trim from the Edit menu (or press [Ctrl]-[Backspace]).

Silence
The Silence function offers two different methods for in-
serting silence:

• You can “insert” silence into a section, i.e. to space two sec-
tions further apart.

• Or, you can select to “replace” a selection or time range with 
silence. 

Insert silence

If you intend to insert silence, proceed as follows:

1. Make a selection that encompasses the range where 
you wish to insert the silence.

2. Select Insert Silence from the Edit menu or press 
[Ctrl]+[Shift]-[Space].
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Replace selection

If you intend to replace a specific range with silence, pro-
ceed as follows:

1. Make a selection that encompasses the range you 
wish to replace with silence.

2. Select Silence from the Edit menu or press [Ctrl]-
[Space].

There are four ways to replace a section of audio with 
silence:

• Select it and select Silence from the Edit menu.
• Select it and click the Silence icon on the Standard Com-

mands control bar.
• Select it and press [Ctrl]-[Space].
• Select it and drag the selection to the Silence icon on the 

Standard Commands control bar.

Turning selections into new documents
If you want to turn a section of wave into a new document, 
proceed as follows.

1. Make a selection.

2. Drag the selection out of the window and onto an 
empty section of the WaveLab Essential application win-
dow.
The cursor turns into a “new document” icon.

3. Release the mouse button.
The selection appears in a new window. You can also use this function to 
create stereo waves out of mono waves, see below.

Converting from mono to stereo
You may convert a mono file into a stereo file that contains 
the same material in both channels, for example for further 
processing into “real” stereo.

1. Make a selection.

2. Drag the selection out to the WaveLab Essential 
“desktop”.

3. When the pointer is outside the window, hold down 
[Ctrl] and release the mouse button.

Converting from stereo to mono
You may mix the two channels in a stereo file into a mono 
document.

This can be done in two ways. Which method to use 
mainly depends on whether you want to convert the entire 
file or just a selection:

By dragging

1. Make a stereo selection.

2. Drag the selection out to the WaveLab Essential 
“desktop”.

3. When the pointer is outside the window, hold down 
[Ctrl] and release the mouse button.

By saving (converting an entire file)

1. Open the stereo file.

2. Select “Save as” from the File menu and click the 
Properties button at the bottom of the dialog to open the 
“Audio File Format” dialog.

3. Change the Channels setting to the “Mono (Mix)” op-
tion, but leave the other settings as they are.
You can of course change the other settings too, but this will have other 
effects, see “Saving in another format (Save as…)” on page 51.

The other two “Mono (Mix)” options will also convert a 
stereo file to mono, but the amplitude of the resulting file 
will be attenuated by 3 or 6 dB respectively.
Since the mixing of the two channels when converting a stereo file to 
mono might often result in the amplitude increasing to a point where clip-
ping occurs, these two options can be useful to remedy such a situation.

4. Click OK and save the file.

5. Open the file you just saved.

Swapping channels in a stereo file
You may move the material in the left channel to the right 
channel, and vice versa:

1. Make a selection across both channels.
Only the material in the selected section will be swapped.

2. Select “Swap channels” from the Edit menu.
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Waveform restoration with the Pencil tool 
The Pencil tool allows you to redraw the waveform directly 
in the Wave window. This can be used to quickly repair 
waveform errors.

This error in the right channel (red waveform) can be corrected quickly 
by using the Pencil tool.

• The Pencil tool can be used if the Zoom resolution is set 
to at least 1:8 (one pixel on the screen equals 8 samples) 
or a higher resolution.
Resolution values can be set in the Zoom pop-up menu. You can open it 
by clicking on the Zoom factor field in the Status bar, located at Wave-
Lab Essential’s bottom window rim.

• Select the Pencil tool from the Toolbox and redraw the 
waveform.
If you wish to redraw the waveform of both channels at once, press 
[Shift] on your computer keyboard during the drawing process.

File handling in Wave windows

Supported file formats
WaveLab Essential can open and save audio files in a 
number of file formats. The table below gives you some 
basic information about the various formats available (note 
that additional file formats may have been added after this 
document was written).

• The Format column also lists the typical file name extensions 
for each format.

• All sample rates are supported, for all file formats.
• All file types can handle mono and stereo.

Click here to open the 
Zoom pop-up menu.

! This section describes file handling in the Wave win-
dow (i.e. handling audio files). File handling of other 
document types (e.g. Audio CD Montages) is de-
scribed in the respective chapter.

Format Description

Wave (.wav) The most common file format on the PC platform. If 
you plan to load the files into any other PC program, 
Wave files are a safe bet. 8, 16, 20, 24 bit and 32 bit 
(float) resolutions are supported.

AIFF (.aif, .aiff, .snd) Audio Interchange File Format, a standard defined 
by Apple Computers Inc. 8, 16, 20, or 24 bit resolu-
tions are supported.

MPEG-1 Layer 3 
(.mp3)

The most common audio compression format. The 
major advantage of MPEG compression is that the 
file size is significantly reduced, while there is little 
degradation of sound quality. WaveLab Essential 
can both open and save files in this format.
- Note that when you open an MPEG compressed 
file in WaveLab Essential, the file is converted to a 
temporary wave file that is much larger than the orig-
inal compressed file. Therefore, make sure that you 
have enough free space on your hard disk when 
opening MPEG compressed files. 
- When you save, the temporary wave file will be 
converted back to MP3, so from a user perspective 
the file handling is transparent apart from the size 
difference mentioned above.

MPEG-1 Layer 2 
(.mp2/.mpa/.mpg/
.mus))

MP2 (sometimes referred to as “Musicam files”) is a 
common file format in the broadcast industry. With 
regard to file sizes the same applies as with MP3 
files.

Original Sound 
Quality (.osq)

This is WaveLab Essential’s proprietary lossless 
compressed audio format. By saving files in this for-
mat, you can save considerable disk space without 
compromising audio quality. See “About saving 
OSQ files” on page 51.

Sound 
Designer II (.sd2)

This audio file format is used by Digidesign applica-
tions (such as Pro Tools). 8, 16 or 24 bit resolutions 
supported.
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About 20-, 24- and 32-bit float files

You do not need a 20- or 24-bit audio card to take advan-
tage of the fact that WaveLab Essential can handle 20- 
and 24-bit audio files. Any processing or editing per-
formed on the files is always done at full resolution, even if 
your card doesn’t support the full resolution. For playback, 
WaveLab Essential automatically adapts to whatever card 
you have installed.

About temporary files
As you work in WaveLab Essential, temporary files (file 
name extension .$$$) used for Undo, etc. are created on 
your hard disk, see “Temporary files” on page 15.

You can decide whether these files should be in 16-, 24- 
or 32 bit format. This is done on the Preferences–File tab.

The higher this value, the better the quality of the tempo-
rary file. However, 32-bit files are also twice as big as 16-
bit files and take longer to process.

• If you ever plan to export your files in 24-bit or 32-bit format, 
use this format or a better one (higher number) for your tem-
porary files as well.

• Use 32-bit if you want to create files with levels exceeding 
0dB.

• Even if you only work with 16-bit files, selecting 24-bit for your 
temporary files can improve audio quality slightly.

• For less critical applications where speed and disk space are 
crucial factors, use 16-bit temporary files.

Opening files
The various methods for opening an audio file in a Wave 
window are described in the section “Opening Waves” on 
page 33. Importing CD tracks from an audio CD is de-
scribed in the section “Importing tracks from an audio CD” 
on page 34.

Save and Save as – General information

When you save a new document for the first time, it 
doesn’t matter whether you select Save or Save as. 
The “Save as” dialog will appear, since you need to specify a file format, 
folder, and file name.

Once a file has been saved, you can continue to edit it 
and then select Save from the File menu, or press [Ctrl]-
[S], to update the file and make the changes permanent.

If you want to specify a new name, location and/or file 
format, you should select Save As from the File menu.
See “Saving in another format (Save as…)” on page 51.

All save operations except “Save a Copy” clear the 
Undo buffers, which means that after saving you cannot 
undo or redo.

U-LAW
(.ulaw, .vox)

This is an audio encoding and compression tech-
nique supported by Windows and Web phones, us-
ing 8 bit resolution. The U.S. telephone system uses 
U-law encoding for digitization.

A-LAW 
(.alaw, .vox)

This is an audio encoding and compression tech-
nique for telephony, using 8 bit resolution. The EU 
telephone system uses A-law encoding for digitiza-
tion.

Sun/Java
(.snd, .au)

This is an audio file format used on Sun and NeXT 
computers. Files in this format can often be found on 
the Internet. 8, 16 or 24 bit resolutions are sup-
ported.

ADPCM – 
Microsoft/
Dialogic (.vox)

This is a format commonly used for games and tele-
phony applications that offers a lower bit rate than 
linear PCM and thus requires less storage space/
bandwidth.

Ogg Vorbis 
(.ogg)

Ogg Vorbis is a relatively new compressed file for-
mat that is open and patent-free and offers very 
small audio files maintaining comparatively high au-
dio quality. 

Text/Excel (.txt) This is a text representation of a waveform. By sav-
ing an audio file as a text file and then opening it in a 
spreadsheet application such as Excel, you can view 
it in textual, decimal form and edit the sample values. 
When you open a text file representing a waveform 
in WaveLab Essential, it will be decoded and 
opened as an audio file. Note that these files are not 
compressed in any way, so they can get very large! 
Therefore, avoid creating and opening extremely 
large .txt files. Also note that when using 32 bit float 
files, the .txt format is not 100% lossless – i.e. infor-
mation may be lost! This is because it is not possible 
to express a binary floating point value in textual 
decimal form without some precision loss.

Windows Media Au-
dio (.wma, .asf))

Microsoft’s own compressed format. WaveLab Es-
sential lets you import/export audio in this format, 
provided that you have Windows Media Player 9 (or 
later) installed on your system.

Ensoniq Paris (.paf) Used by the Ensoniq Paris™ system (16 bit resolu-
tion).

Format Description
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Automatic backups
For all save operations except a regular “Save”, backups 
are created automatically if a file with the same name al-
ready exists.

If for example you select Save As and specify a file name 
already used in that folder, the program will ask you if you 
want to back up the existing file first. If you click Yes, the 
first letter in the file’s extension will be changed to “~”. 
“AIF” for example, will become “~IF”.

Saving in another format (Save as…)
If you want to change the format (file format, sampling fre-
quency, bit resolution and stereo/mono status) when sav-
ing, proceed as follows:

1. Select Save as… on the File menu.

2. A regular file dialog appears where you can specify a 
file name, folder and a file format (see “Supported file for-
mats” on page 49).

3. If you wish to change other attributes of the file (e.g. 
mono/stereo status, bit resolution or sample rate), click 
the button at the bottom of the dialog.
This opens the Audio File Format dialog where you can specify the de-
sired properties of the converted file.

The Audio File Format dialog

4. After making the desired settings, close the Audio File 
Format dialog and click Save.
A new file is created. The original file is not affected by the operation.

If you change the sample rate, bit resolution and number 
of channels, the following operations are performed:

• If you only wish to change the bit resolution you can do 
this directly in the “Audio Properties” dialog (see “Editing 
audio properties” on page 55) instead and perform a stan-
dard save.

• For high quality mastering purposes, it is not recom-
mended to change the sample rate and number of chan-
nels this way, but instead use plug-ins and functions of the 
Master Section (see “The Effects pane” on page 85).

• For the available compressed file formats (MP3, MP2, 
WMA and Ogg Vorbis), you can select “Edit…” from both 
the Encoding and Attributes pop-up menus in the Audio 
File Format dialog.
This opens additional settings dialogs, where you can specify various op-
tions such as bit rate and compression method, and also enter text tags 
for the file.

It is also possible to convert several files to another 
format in one go (batch encoding). 
See “Batch file encoding” on page 95.

Note that you can also save as WMA files, MP3 files 
and MP2 files via the “Encode to…” options on the Save 
Special submenu.

About saving OSQ files

OSQ (Original Sound Quality) is a lossless audio com-
pression format, which can significantly reduce the audio 
file size without affecting the audio quality at all.

Property Action

Sample Rate If a new sample rate is specified, a sample rate conver-
sion will be performed (see “Convert sample rate” on 
page 79).

Bit Resolution If a different bit resolution is specified, the file is either 
“truncated” down (e.g. to 8 bits), or “padded” up (e.g. to 
24 bits).
If you are converting to a lower bit resolution, you should 
consider adding dithering – see “The Dithering pane” 
on page 88.

Mono/Stereo If the file is converted from mono to stereo, the same 
material will appear in both channels. If the conversion is 
from stereo to mono, you can either select to only save 
the left or right channel, or create a mix of the two chan-
nels.
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• You can save any audio file as an OSQ file by using the 
Save As function.
The audio will play back exactly the same as in the original, uncom-
pressed file.

• Similarly, if you open an OSQ file in WaveLab Essential 
and save it as an uncompressed audio file in its original 
format (e.g. WAV), the audio will play back exactly the 
same.

• You can also convert several files to OSQ format in a 
batch. See “Batch file encoding” on page 95.

Save selection as
This is a menu item on the Save Special submenu. It 
works exactly as Save As, except that only the current se-
lection is saved as a new file.

Save a Copy
This item, also on the Save Special submenu, allows you 
to save a copy of the file, in its current state, without af-
fecting the original. A regular file dialog is used as with 
Save As.

Save left/right channel as
These two menu items are also located on the Save Spe-
cial submenu. They allow you to save each channel indi-
vidually, into a separate file. A regular file dialog is used as 
with Save As.

This menu command is used when you have been editing 
“dual mono” files for example, and wish to save the chan-
nels into separate files.

Save All

The Save All dialog

This menu item brings up a dialog that allows you to save 
some or all of the open documents, in one go.

The list displays all open documents that currently contain 
unsaved changes. The “Show paths” check box allows 
you to display/hide the complete file paths.

1. Select /deselect files by clicking on them or by using 
the Select/Deselect button.
Only the selected files will be saved.

2. Click “Save selected”.

Revert to saved
This menu option, on the File menu, allows you to revert 
the file back to its last saved state (actually, the last saved 
version of the file is loaded from disk). This can be used as 
a kind of “super undo” which undoes all the changes 
made to the file since it was last saved.

1. Select “Revert to saved” from the File menu.

2. Click “Yes” in the warning dialog that appears.
The file is restored to its previously saved state.
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Renaming files and documents (Rename)
The Rename function is available from most WaveLab Es-
sential documents, not just Wave windows. The function 
is however of particular importance when renaming audio 
files. If you rename an audio file outside WaveLab Essen-
tial, and this file is referenced to an Audio CD Montage or 
Data CD/DVD project, the reference will be lost the next 
time you open the document that references this file.

But WaveLab Essential allows you to handle file renaming 
in an intelligent way so that all the documents that refer-
ence this renamed file are automatically updated! This 
works as follows:

All open documents that reference the file or docu-
ment to be renamed will be automatically updated to refer-
ence the new name.
E.g. if you rename an audio file named “India” to “Sitar”, all currently open 
documents that reference the file “India” will be updated to reference the 
file as “Sitar”!

For audio files, peak and marker files will also be renamed 
accordingly. 

• Documents that use audio file references are Audio CD 
Montages and Data CD/DVD projects. 

• WaveLab Essential documents can also refer to the 
names of other documents, e.g. a Data CD/DVD project 
will contain references to Audio CD Montages. 
This will work in the same way – if the document/project that references 
the document to be renamed is open, the references will be updated.

To rename a file or document proceed as follows:

1. Select the audio file/document to be renamed. 
Make sure all documents that reference this particular file are open. This 
is not mandatory, but if they aren’t, the file references will not be updated.

2. Select “Rename…” from the File menu, or press [F2].
The Rename dialog opens.

The dialog contains the following items:

Deleting files and documents
It is possible to delete whole files or documents from 
within WaveLab Essential. This function is available from 
the File menu and will delete the currently selected file or 
document from disk. Make sure the file or document you 
wish to delete is in focus.

1. Select “Delete…” from the File menu.
A dialog appears as a warning, allowing you to cancel or proceed with 
the operation.

2. Select whether to permanently delete the file or to 
move it to the Recycle bin by clicking the appropriate but-
ton in the Method section of the dialog.
Only select to permanently delete if you are absolutely certain – you 
won’t be able to retrieve the file!

• Any Data CD/DVD project that is open in WaveLab Es-
sential and has a reference to this file will be updated ac-
cordingly.
The file will get removed from the Data CD/DVD project(s).

Item Description

Name text field This is where you type in the new name.

Change folder It is also possible to change the folder location 
of the file when renaming. If Change folder is 
ticked, you can navigate to a new location. Note 
that this is only possible within the same drive 
partition.

Keep as default path If you check this option, the same path will be 
selected the next time you open the dialog. This 
is useful if you need to move several files suc-
cessively.

Extension pop-up The file extension can be changed, but only if 
corresponds to the original file format (certain 
file formats can have different possible file exten-
sions, e.g. “aif” or “snd”).
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• However, if a file is being referenced by a currently open 
Audio CD Montage, you will not be able to delete the file 
and a warning will appear. 

In addition, you will not be able to delete the file in the fol-
lowing circumstances:

• If it is currently copied to the clipboard.
• If a part of it is has been pasted into another file that is open. 
• If the file is open in another application.

• Deleting an audio file will also automatically delete its 
peak and marker file names.

Saving view settings
WaveLab Essential can automatically save all settings as-
sociated with a Wave file. This includes:

• Window size and position.
• Zooming.
• Scroll position.
• Snapshots.

The view setting information is stored in a companion file 
(extension “.mem”) either together with your audio files or 
in a separate folder.

• This feature is activated/deactivated (on by default) in 
the Preferences–Wave edit tab (“Save view settings in 
companion file”).

If the feature is activated and you save a file, the settings 
will be recreated exactly as you had them when later re-
loading the same file!

Compression encoded export formats
Apart from the formats available in the Save As dialog and 
the Save special encode MP3/MP2/WMA options, Wave-
Lab Essential allows you to export files in a number of 
compression encoded audio formats, suitable for multime-
dia, web publishing, etc. (see “Supported file formats” on 
page 49). The basic functionality for this is part of a soft-
ware technology called Microsoft ACM (Audio Compres-
sion Manager) which is included with Microsoft Media 
Tools.

The number of formats you can export, depends on which 
ACM drivers you have installed on your computer.

For more information, see www.microsoft.com/windows/
windowsmedia.

About “lossy” and “non-lossy” compression

There are two types of compression methods. When you 
use a “non-lossy” method (like saving as an OSQ file – 
see above), all information about the file is preserved, 
which means that when you decompress the file, you get it 
back exactly as it was.

However, most audio compression techniques are “lossy”. 
This means that once the file has been compressed, some 
information has been lost. This type of compression al-
ways results in some kind of audio degradation, albeit in 
many cases a very small one.

WaveLab Essential can also import any file supported by 
ACM, provided that the correct ACM drivers are installed.

Exporting to encoded formats

The menu item “Encode (ACM)” uses the Microsoft Media-
Tools technology to convert the file to one of a number of 
compressed formats.

1. Select “Encode (ACM)…” from the Save Special sub-
menu.
The dialog that appears is a MediaTools dialog, not a WaveLab Essential 
dialog.

2. Select one of the formats from the pop-up in the mid-
dle and chose a setting for it from the pop-up below.
The dialog also provides possibilities for creating “presets” of formats 
and settings, using the upper row of controls.

3. Click OK.
A regular file dialog appears.

4. Specify a name and location for the file, as with any 
Save operation.

! If you need audio file compression with uncompro-
mised audio quality, you should use the OSQ (Origi-
nal Sound Quality) lossless audio compression 
format instead (see “About saving OSQ files” on 
page 51).

! The options which are available depend on the origi-
nal format of the file, its sample rate, the number of 
channels, etc. However, we have noted problems 
with some ACM drivers. Even though a certain for-
mat can be selected, an error message appears 
when you try to save the file. If this happens, please 
use another encoding method.
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Note: When you export to compressed files using the “En-
code (ACM)” option, the file that is created will technically 
be a Wave file, regardless of the compression format (the 
files will have the extension “wav”). But instead of the reg-
ular “linear” audio data that usually makes up a wave file, a 
special audio data “chunk” is included that contains the 
compressed audio.

This is normally not a problem, but something to be aware 
of when planning for usage of files in other programs and 
on other computer platforms.

Editing audio properties and file 
attributes 

Editing audio properties
Each audio file has a certain set of properties, that is, in-
formation about the sample rate at which it was recorded, 
what the bit resolution is, etc. The “Audio Properties” dia-
log allows you to change that information.

There are two ways to bring up this dialog:

• Select “Audio Properties” from the Edit menu.

• Click on the properties information field, on the status 
bar.

The Audio Properties dialog

About changing the values

Changing the values in this dialog does not process the 
file in any way, unlike Convert File (see “Saving in another 
format (Save as…)” on page 51). However, the following 
rules apply:

• If you change the sample rate, the file will play back at the 
wrong pitch.

• If you change the bit resolution the file will be converted to the 
new resolution the next time you save it.

File attributes
If you select this option on the Edit menu, a dialog opens 
in which you can specify various information about the 
wave file.

The Wave Attributes dialog 

You can enter information on either the Standard tab or 
the Broadcast Audio Extension tab. The information you 
enter here is added to the header of the file, and thereby 
labels it as either a Standard wave file or a Broadcast 
wave file. A Broadcast wave file is essentially the same 
thing as a Standard wave file, the difference is what infor-
mation the file headers can contain.

• On the Standard tab in the dialog, you can enter infor-
mation that will be displayed for instance when viewing 
the file’s properties in the Windows explorer.

Note that you can instruct WaveLab Essential to auto-
matically fill out the text fields for “Originator software” 
(WaveLab Essential) and “Creation Date” (the current), by 
clicking the small buttons to the right of the fields.

• On the Broadcast Audio Extension tab you can also en-
ter information to be embedded in the file, such as title, 
author, etc. A Timecode position is included in the file as 
well. This makes it possible to insert audio at precise posi-
tions in other applications. By default, the Timecode posi-
tion is set to the start position of the audio.

! There is no Undo for this item. If you save with a 
lower bit resolution, the file is permanently converted.
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Playing back

Background information

About sample rates

If the wave file is recorded at a sample rate not supported 
by your audio card you will not be able to play it back. You 
might then opt to use sample rate conversion, see “Con-
vert sample rate” on page 79. Also see “Supported file 
formats” on page 49 for more on file formats.

About the playback cursor position and 
appearance
Great care has been taken to achieve synchronization be-
tween what you hear and what you see (the wave cursor 
position in the wave during playback). However, by nature, 
this precision depends to a large extent on the audio card 
and its driver. In case you run into problems you may want 
to adjust the settings on Preferences–Audio device tab.

About audio cards and playing in the background

When you activate playback or recording in WaveLab Es-
sential, it will “grab” the audio card so that other applica-
tions cannot access it. The opposite is also true: if another 
application has grabbed the card, WaveLab Essential will 
be unable to play.

If you want to run WaveLab Essential together with 
another audio program, and make sure whichever applica-
tion is active gets access to the audio card, activate the 
“Release audio hardware…” option in the Preferences–
Audio device tab. 
When you do, WaveLab Essential will “let go” of the audio card when 
another application is made active (provided that this doesn’t happen 
during playback or recording in WaveLab Essential).

Using the Transport bar

Displaying the Transport bar

If the Transport is hidden, select Transport from the Con-
trol bars submenu on the View menu.

The Transport controls

The Stop button

The result of clicking on the stop button depends on the 
current situation: 

• If the program is stopped and you click the Stop button, 
the wave cursor is moved to the beginning of the last start 
position. A second click will move the cursor to the start of 
current selection (if any and if this is located before the 
last start position).

• If there is no selection, or if the wave cursor is already to 
the left of the selection, it is moved to the beginning of the 
file instead.

• If there is no selection, and you activate playback from a 
point and then stop so the wave cursor is to the right of 
the original point, the cursor will move to the place you last 
started when you click Stop again.

• If you click on the Stop Point/Loop button and activate 
the “On stop, move cursor back to start” option on the 
menu, the cursor will be automatically moved back to the 
beginning of the selection when you click Stop (from play-
back).
If there is no selection, it will automatically move back to the place you 
started from.

Loop On/Off

Start 
Point

Skip

Stop Point/Loop

Goto beginning Rewind
Fast Forward

Goto End

Stop
Play

Record
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Transport control settings for separate windows

By default, open windows in WaveLab Essential (wave 
windows and montage windows) all use the same Trans-
port control settings (loop settings, playback speed, etc.). 
You can however choose to use separate settings for 
separate windows if you want: open the Preferences–Au-
dio device tab and make sure the option “Transport set-
tings are global to all windows” is not activated.

When this option is deactivated, the following transport 
controls can be set differently for each open wave or mon-
tage window:

• Start point (see “Setting the start point for playback” on page 
58).

• Skip (see “Skipping sections during playback” on page 58).
• Stop point/loop (see “Setting the Stop point/loop” on page 

58).
• Loop On/Off (see “Looping” on page 58).

Setting the start point for playback
The Start point button on the transport brings up a menu 
that allows you to specify where playback will start.

For example, if you select “Play from start of file”, as soon 
as you hit Play, the wave cursor will jump back to the be-
ginning of the file and playback starts from there.

Setting the Stop point/loop
The Stop point/loop button on the Transport bar allows 
you to select where playback should stop and whether it 
should loop indefinitely.

Automatic Stop

For example, if you select “Stop at next marker”, playback 
will stop as soon as the program reaches a marker or the 
end of the file, whichever comes first.

Looping

Let’s say you have chosen “Loop selection” mode. Now, if 
some piece of the wave is selected, this will be repeated 
indefinitely (as long as you don’t start playback from a po-
sition later than the selection).

If no selection is made, the entire wave is looped.

About loop updating and short loops

The loop points are updated continuously during play-
back, which means that if you change the loop start or end 
during playback, the loop changes. This is a great feature 
for auditioning selection points for rhythmic material!

Please note that it takes some time for positions to be up-
dated (0.3 to 1 second, depending on the file’s bit resolu-
tion and sample rate). If you don’t want to wait, activate 
“Restart on loop/selection change” on the Options menu. 
When this is activated, the loop starts over as soon as you 
adjust the selection or move a loop start marker.

Also please note that WaveLab Essential handles play-
back of extremely short loops without problems. However, 
the cursor position might not be updated correctly.

Skipping sections during playback
You can also have playback automatically jump past cer-
tain positions during playback. This way, you will be able 
to audition what the material would sound like with certain 
sections cut out, before the actual edits are made.

This selection is done from the menu invoked by clicking 
the Skip button on the Transport bar.

• If you have made a selection range, you can select “Skip 
selection” to skip the selected area.

Play tool – Playing one or both channels in 
stereo files

Selecting the Play tool momentarily

The Play tool can of course be selected by clicking in the 
Toolbox, but there are situations when you are working 
with another tool and just momentarily want to use the 
Play tool.

• To momentarily select the Play tool, hold down [Alt]. 
When you have finished playing, release [Alt].

Using the Play tool

The Play tool allows you to play back from any position:

1. Point at the position where you want playback to start.

2. If the wave is in stereo, move the pointer up or down to 
decide whether only one channel should be played back.
Watch the cursor shape, it indicates what will be played back (L, R or 
both).
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3. Press the mouse button.
Playback continues for as long as you keep the mouse button pressed, 
or until the wave ends. After playback has stopped, the cursor will be 
moved to the playback start position, making this a quick way to locate to 
certain positions in the audio.

Using the Playback Browser
The Playback Browser feature helps you find a certain po-
sition in an audio file, by restarting playback repeatedly 
when you click or drag to move the wave cursor.

1. Activate playback using the regular Play function, or 
select the Play tool.
Note that depending on your Preferences settings, Playback Browsing 
may only be available for the Play tool.

2. Click or drag in the ruler.
If you click, playback jumps immediately to the position at which you 
clicked. If you drag continuously, a short snippet of audio from each new 
position is played (looped).

Playback Browser preferences

On the Preferences–Wave edit tab you will find two pref-
erences for Playback Browsing:

• The Sensitivity setting is used to determine the size of the 
“snippets of audio” played back when you drag.

• When the “Restrict to Play tool” option is activated, Playback 
Browsing is not available when you activate Playback using 
the transport bar or computer keyboard.

On the Options menu you will also find an option called 
“Stop after playback browsing”, which determines what 
happens when you release the mouse button: playback 
continues (deactivated) or stops (activated). Note that 
when this option is activated, the cursor will automatically 
be moved back to the playback start position on stop, al-
lowing you to use this function for locate positions in the 
audio.

Playing the selection only
There are several ways to play the selected part of the 
wave only:

• Press the right mouse button in the Overview or the 
Main view and select Play Selection from the menu that 
appears.

• Hold down [Ctrl] and click on the Play button.

• Press [F6].
If you hold down [Shift] and press [F6], the selection will be played back 
repeatedly (looped).

• Drag and drop the selection on the Play button on the 
Transport.

Scrolling during playback
The “Scrolling during playback” submenu on the Options 
menu contains several options for how the view should be 
scrolled in Play mode:

Note: these options do not apply to playback using the 
Play tool, and the last two options require a fast computer 
and graphics card.
If you get dropouts during playback, please select another Scrolling 
mode.

Recording

About automatic gain controls
Some audio cards may have a feature which automatically 
sets the recording level for the microphone input. This fea-
ture is often called AGC (Automatic Gain Control). For 
“professional” results we recommend that you deactivate 
this feature using the software that came with the card.

Option Description

Immobile view This disables scrolling completely.

View follows cursor In this mode, the waveform view will automati-
cally change when the Wave cursor reaches the 
right side of the window during playback. 

Scroll wave (partial) In this mode, the waveform view is scrolled con-
tinuously, attempting to keep the Wave cursor in 
the middle of the view. However, if loop mode is 
activated and the loop range fits on the screen, 
no unnecessary scrolling takes place, allowing 
for a more stable view of the loop. The program 
will also “sense” the end of a file and stop scroll-
ing when it is “in view”, rather than when the end 
is reached.

Scroll wave (always) In this mode, the waveform view is scrolled con-
tinuously, attempting to keep the Wave cursor in 
the middle of the screen. 

! For details on connections, recording levels, etc. 
please refer to the documentation that came with 
your audio card.
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Please note that if you leave this feature activated, the Mi-
crophone input gain control in the Mixer (see later in this 
text) will have less effect on the recording level.

Preparations
To record a new file, proceed as follows:

1. Click the Record button, or press [*] on the numeric 
key pad.
The Record dialog appears.

The Record dialog

2. Decide whether you want to record to a “named” or a 
“temporary” file, by selecting from the pop-up at the top of 
the dialog.
Temporary files are practical to use, since you don’t need to name the file 
beforehand, you just “hit record and go”. On the other hand, you will 
need to save the file at a later stage. Temporary files are always wave 
files, while named files allow you to choose to record files in a number of 
different formats. Also note that if you plan to make a recording over sev-
eral minutes we recommend that you record a named file.

3. If you have selected one of the “Named File” options in 
the step above, type in the path to the desired destination 
for the file on the line below the pop-up or click the folder 
button and specify a file location.
If you activate the Auto number checkbox, a three-digit number will be 
added to the file name. Starting at the number you specify in the value 
field to the left of the checkbox, the Auto number will be increased in in-
crements with each new recording, to prevent existing files from being 
overwritten.

4. Click the file format button at the top of the Record di-
alog, and decide on a recording format. WaveLab Essen-
tial lets you record directly into a number of different 
formats (see “Supported file formats” on page 49 for de-
tails). 
In the Audio File Format dialog that appears, you can among other things 
choose the desired format, sample rate, number of channels to record 
and bit resolution.

The Audio File Format dialog

5. Click OK to close the Audio File Format dialog.

6. If needed, activate the desired recording options in the 
dialog.
There are also additional settings in a separate dialog, opened by click-
ing the Settings button.

At this point, you can start recording (see “Start record-
ing!” on page 61) if you like.

Setting up the mixer (MME/WDM drivers)
At this point you may want to click the Mixer button to ad-
just the relative volume of your card’s inputs.

For the mixer to appear, you must have specifically se-
lected the card on the Preferences–Audio device tab. 
If the Input and Output are set to “Microsoft Sound Mapper” a mixer can-
not be created.

Exactly what controls will appear in the mixer depends on 
the card, but here are some possibilities:

• Master Gain (output-fader)
• Synth In (input-fader plus on/off check box)

! If you choose a bit resolution not supported by your 
audio card, you will not be able to record.
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• CD (input-fader plus on/off check box)
• Line (input-fader plus on/off check box)
• Mic (input-fader plus on/off check box)

In addition to the above, the card might have custom con-
trols for monitoring, etc., which cannot be accessed from 
the WaveLab Essential mixer. Again, please use the appli-
cation(s) included with the card.

Using the meters
In the lower part of the Record dialog, you will find a meter 
display. This is useful for checking the input level, as well 
as the frequency spectrum of the input signal.

The meters in the Record dialog are “miniature” ver-
sions of the Level and Spectrum Meters in the Meter win-
dows.
For detailed descriptions of the functionality and features, see “Level 
meter” on page 64.

For the meters to register the signal, you need to activate 
the Monitor checkbox. This can be done automatically, if 
the option “Activate meters when opening record win-
dow” is activated in the Record Settings dialog. The pop-
up menu in the lower left corner allows you to select be-
tween Level or Spectrum metering.

• When the Level Meter is selected, horizontal bars show 
the peak level (outer bars) and average loudness (VU, in-
ner bars) of each channel.
Values are also shown numerically. If the Phase Scope option is acti-
vated on the pop-up menu next to the Reset button, a Phase Meter is 
displayed to the right of the Level Meter.

• When the Spectrum Meter is selected, a “bar diagram” 
will be shown, providing a continuous graphical represen-
tation of the frequency spectrum.
See “Spectrum meter (60 bands)” on page 65.

You can reset the meters by clicking the Reset button – 
this instantly resets all meters and numerical indicators, in-
cluding the Maximum Peak and RMS values to the right in 
the Level Meter.

You can also select one of five presets for the Level Meter 
on the pop-up menu next to the Reset button. These pre-
sets (containing settings for meter ranges, colors, etc.) 
can be edited by selecting “Settings…” from the pop-up 
menu. The options are described in the chapter “Making 
settings for the level meter” on page 65.

Checking disk capacity
The Disk Capacity indicator above the meters helps you 
make sure you have enough disk space for the recording. 
This indicator shows the amount of available disk space 
on the hard disk specified in the Named File path, or the 
hard disk you have selected for your temporary files (see 
“Temporary files” on page 15). Please note that this value 
is approximate.

Start recording!
When all the preparations are done, click Record to start 
the actual recording.

• If you have selected one of the Auto-start options, the 
recording will go into Pause mode (the Record button will 
blink), until the specified Auto-start criteria are met.
When recording starts, the Record button will be “lit” and the Recorded 
Time value will indicate how much you have recorded. 

• If you have selected the “Auto-stop after given duration” 
option, the “Remaining Time” value will indicate how much 
recording time you have left.

• If you like, you can pause the recording by clicking the 
Pause button at any time.
The Record button will blink to indicate Pause mode. To resume record-
ing, click the Pause or Record button again. A short section of audio just 
before you resume recording (according to the Pause memory value in 
the Record Settings dialog) will be captured.

! Not all audio cards have a mixer application and can 
therefore not access the WaveLab Essential mixer. 
This is especially true with digital I/O cards.

! Use the Level Meter to check the audio input level. 
Adjust this (with the mixer controls or the audio 
card’s applications), so that the Peak Level Meters 
go as high as possible without ever reaching 0dB!

! When there is less than ten seconds of available 
hard disk space, the disk capacity indication is dis-
played in red.
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• You can drop markers in the file during recording by 
clicking the Drop Marker buttons.
See below.

• If you want to abort the recording, click the Discard but-
ton.
This terminates recording and discards the recorded file. 

• When you have finished, click Stop. You can also have 
recording stop automatically by using one of the Auto-
stop options. Either way, the recording by default appears 
in a new window behind the dialog.

If you want to perform more recordings after the first, click 
the Record button and record again. If you have selected 
the Named File option, and the Auto number option is de-
activated, you have to specify another file name to avoid 
overwriting the previously recorded file.

When you have finished recording completely, click the 
Close button (in the lower right corner) to close the dialog.

If you have created temporary files, and want to save 
the file(s) permanently, click on each document you have 
created and use Save As on the File menu to save each 
one.
See “Saving in another format (Save as…)” on page 51 for details.

About dropping markers during recording

When you are recording, you can click the marker buttons 
at any time, to add a marker to the recorded file. The yel-
low button will generate a numbered, generic marker (see 
“The various marker types” on page 98), while the white 
buttons will generate numbered, generic region start and 
end markers.

If you want to name the markers you drop rather than us-
ing generic, numbered markers, you can do this in the fol-
lowing way:

• Type in the desired name in the box below the buttons. 
You can type in a new name for each marker before you drop. This works 
well if you know beforehand where you want to drop the markers and 
what their names should be. If you want to be able to drop markers not 
planned beforehand though, use the dialog that will appear each time 
you click a button to drop a marker. In this dialog, you can either type in a 

name for the marker, or you can confirm that you want to use an already 
entered name. The benefit of using this method is that the marker will be 
dropped at the time position when you clicked the marker button, regard-
less of how long you take to type in a name for the marker.

Furthermore, this dialog also allows you to specify a delay value for the 
marker. The marker will then be dropped at the position when you clicked 
the marker button, minus the delay value you specify. So if you clicked 
the marker button after 10 seconds of recording and specify a delay 
value of 2 seconds, the marker will be dropped 8 seconds into the re-
cording.

Note: if you insert two or more region start markers in 
a row (with no region end markers in between), only the 
last of these start markers will be kept (the first marker(s) 
will be removed).
In other words, the last region start marker doesn’t become “permanent” 
until you insert a region end marker.
The same goes for region end markers – if you insert several end markers 
in a row, only the last one will be kept.

This is a very useful function, because it allows you to 
“change your mind” when inserting markers during re-
cording. For example, let’s say you are recording a contin-
uous performance and want to mark all takes worth 
keeping. At the start of a take you insert a region start 
marker. However, this turns out to be a false start or a 
flawed take. When the next take starts you insert a new re-
gion start marker again and the previous, unwanted start 
marker is removed.
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Introduction
WaveLab Essential offers very detailed and versatile me-
tering, allowing you to monitor level and spectrum during 
playback, and also featuring an oscilloscope display. This 
chapter describes how to display, set up and use the var-
ious meters.

Monitor playback

The meters reflect the audio being played back. Note that 
metering occurs after the Master Section, which means 
the results of effects, dithering and Master faders are 
taken into account.

The meters can be used for monitoring all kinds of audio 
playback: Wave windows, Audio CD Montage, audio CD 
track lists, audition in file dialogs, etc.

The meters
There are three different meters in WaveLab Essential, 
each with its separate window. The meters are opened 
and closed from the Analysis menu.

As with any standard window, you can resize the meter 
windows by dragging the window borders, and fold the 
windows by clicking the fold icons (or by double clicking 
the title bars).

On the following pages, the available meters are de-
scribed.

Level meter
This meter window shows the peak level and average 
loudness, in the following way:

• The Peak Level meters display the peak levels of each 
channel, graphically and numerically.
By default, the meter segments and numerical peak values are displayed 
in green for low levels, yellow for levels between –6dB and –2dB, and 
red for levels above –2dB. You can change both the colors and the 
range boundaries if you wish, as described on “Making settings for the 
level meter” on page 65.

• The VU (Volume Unit) meters measure the average 
loudness (RMS) of each channel.
These meters have a built-in inertia, evening out loudness variations over 
a user-defined time span. 
If you are monitoring playback, you will also note two vertical lines follow-
ing each VU meter bar, seemingly “trying to reach” the current RMS 
value. These lines indicate the average of the most recent minimum RMS 
values (left line) and the average of the most recent maximum RMS val-
ues (right line). To the left, the difference between the minimum and max-
imum average values is displayed (the level value in brackets) – this gives 
you an overview of the dynamic range of the audio material.

• If you are monitoring audio playback, the maximum peak 
and loudness values are displayed numerically to the right 
of the meter bars.
Numbers in brackets to the right of the Maximum Peak values indicate 
the number of successive clips (0dB signal peaks). 1 or 2 clips can be 
acceptable, but if you get a larger number, you should lower the master 
level to avoid digital distortion.

Resetting the meters

You can reset the level meters by clicking the Reset icon, 
or by selecting Reset from the Options pop-up menu. This 
instantly resets all meters and numerical indicators, includ-
ing the Maximum Peak and RMS values and the number of 
signal clips.

The Reset icon

VU meters

Peak level 
meters

Meter presets (see “Selecting meter presets” on page 65)

Reset button

Recent minimum Recent maximumDifference value
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Making settings for the level meter

You can adjust the behavior, scale and color of the meters 
as desired. It is also possible to save five sets of meter 
settings as presets, for instant access. Proceed as fol-
lows:

1. Pull down the Options pop-up menu and select “Set-
tings” (or click the “tool” icon).
The Level Meter Settings dialog appears.

2. Adjust the settings as desired.
By using the Apply button, you can check the results of your changes 
without closing the dialog. The following settings are available:

3. If you want to store your settings for later use (or as-
sign them to a preset), select “Save as…” from the pop-
up menu at the bottom of the dialog, and specify a name 
for the preset in the file dialog that appears.

4. To make the settings instantly available for selection in 
the Meter window, use the “Assign to preset button” sub-
menu on the pop-up menu.

5. When you are finished, click OK to close the dialog.
Clicking Cancel closes the dialog and discards any changes you have 
made (even if you have used the Apply button to apply them to the 
meters).

Selecting meter presets

If you have assigned your settings to the Preset buttons in 
the Settings dialog, you can quickly switch between differ-
ent level scales and display modes, by clicking one of the 
Preset icons [1]-[5], or selecting the desired preset from 
the Options pop-up menu.

Spectrum meter (60 bands)

The Spectrum meter shows a continuous graphical repre-
sentation of the frequency spectrum, in the shape of a “bar 
diagram” with 60 frequency bands.

Setting Description

Global colors Click these buttons to select colors for the meter back-
ground, marks (scale units) and grid lines.

Global range This is where you specify the low and high end of the 
displayed level range. Typically, you may want to create 
a preset showing the full level range, and other presets 
for detailed view of a smaller range.

Peak meter – 
Ballistics

These settings determine how fast the peak level meter 
falls after a peak (Release rate) and for how long the 
numerical peak indication remains displayed after a 
peak (Peak hold time).

Peak meter –
Zones

The color buttons allow you to select colors for the 
peak level meters’ low, middle and top zones. You can 
also define what should be considered “middle” and 
“top” zones, by changing the “Middle zone from” and 
“Top zone from” values. 

VU meter –
Show

Allows you to activate or deactivate the VU meters.

VU meter – 
Ballistics

These settings determine how the VU meter responds:
Resolution is the sample width of the “average win-
dow” for the VU meter (the number of samples contin-
uously evaluated to calculate the average). The smaller 
this is, the more the VU meter behaves like the peak 
meter.
Range inertia determines the “average windows” for 
the recent minimum and maximum value lines, and will 
therefore affect how quickly these respond to changes 
in loudness.

VU meter –
Color

The color button allows you to select the color for the 
VU level meter. 

Setting Description
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Oscilloscope

The Oscilloscope is a “microscope” version of the level 
meter, showing the area around the cursor position at 
large magnification.

If you are analysing stereo audio, the Oscilloscope will 
normally show the separate levels of the two channels. 
However, if you activate the option “Show Mix and Sub-
traction” on the Options pop-up menu (or click the +/– 
icon) the upper half of the Oscilloscope will show the mix 
of the two channels and the lower half will show the sub-
traction.

Making settings

Selecting “Settings” from the Options pop-up menu (or 
clicking the “tool” icon) will open the Oscilloscope set-
tings dialog. Here you can adjust the display colors, and 
choose whether Auto-zoom should be active or not. 
When Auto-zoom is activated, the display will be opti-
mized so that the highest level reaches the top of the dis-
play at all times.
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Introduction
When we refer to off-line processing, we mean functions 
that “permanently” alter the file, to make it sound more or 
less different. This is in opposition to “real-time process-
ing”, which makes the file play back differently, without 
making any permanent changes to it. Real-time process-
ing is described in the next chapter.

Applying processing
Processing can be applied to a selection or to a whole file. 
For certain processing operations processing the entire 
file is necessary. This will be indicated in the respective 
section.

If “Process whole file if no selection exists” is activated 
in the Preferences–Wave edit tab, the whole file will auto-
matically be processed if no selection exists.

To apply processing to a selection, proceed as follows:

1. Make a selection.
Note that you will “Select All” to process the entire file. If the file is in ste-
reo, you can apply processing to either channel or both, by selecting one 
channel or both, see “Selecting in stereo files” on page 41.

2. Select the desired type of processing from the menus.

3. If a dialog appears, fill it out.
If the dialog uses presets, you can load one of them to fill out the settings 
automatically, see “Presets” on page 30.

4. When you have finished with the settings in the dialog, 
click the Apply/Paste/Process button.
The status bar shows the progress of the operation. If you need to inter-
rupt a long process, click the “Stop” button on the status bar or press 
[Esc].

Undo/Redo
No matter how long the selection is or how elaborate the 
processing may be, you have access to unlimited Undo/
Redo for all processing. The only limitation to this is the 
available hard disk space, as described in the section 
“Undo and Redo” on page 22.

Getting the most out of the non-modal dialogs
The processing dialogs are non-modal, which means they 
stay on screen even after the processing has been ap-
plied. This, together with the Undo allows you to try differ-
ent types of processing without ever leaving the dialog (or 
even stopping playback!):

• When the dialog is still the active window you can use 
the computer keyboard for the following operations:

• While the dialog is still open (but inactive) you can se-
lect from menus and use other dialogs and palettes (for 
example the Transport bar).

• You can “fold in” and “fold out” non-modal dialogs, as 
described in the section ““Folding” windows” on page 24.

Presets
As described in the section “Loading presets” on page 
30, you can use presets for most processing dialogs, to 
save and recall settings. In addition, the program comes 
with a number of useful presets for each processing op-
tion.

Level Normalizer

This allows you to change the amplitude (volume) of the 
selection. The value is always related to the maximum level 
that can be obtained.

Key Command

[F3] Undo

[F4] Redo

[F6] Play selection

[Shift]+[F6] Loop selection

[F7] Stop

[F8] Play
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Gain Change

This also allows you to change the amplitude (volume) of 
the selection, just like the Level Normalizer. The difference 
here is that the gain change is set in absolute numbers, 
plus/minus the current level (which is indicated as 0dB).

Clipping

This processor lets you do something that most other 
functions in WaveLab Essential never do: introduce clip-
ping.

Clipping is when the gain is raised to a point where distor-
tion is added. While this is normally not wanted, mild clip-
ping in for example the attack of a drum sound can add 
some “punch”.

Dynamics

This dialog allows you to tailor the dynamics of the audio, 
to create effects like compression, expansion, limiting and 
noise gating. Since dynamic processing of audio is a big 
subject, we will not be able to describe all the possibilities 
in this short text. Please study the included presets which 
implement examples of the above-mentioned functions 
and experiment with the controls to get a feeling for what 
they do.

The Time Response controls

The settings in this section apply regardless of whether 
you use the graphic editing possibilities or not. These con-
trols govern how a variation in sound level in the material 
affects the amount of processing.

The Attack parameter, for example, is related to the begin-
ning of new sounds in the material (for example each new 
“hit” in a drum recording). Raising the Attack time means 
that more of the beginning of each sound (the attack) will 
pass through unprocessed.

We recommend that you try the Auto feature first, and if 
that doesn’t give the desired result, use the individual con-
trols instead.

If you try to raise the 
level of a wave above 
0dB (100%)…

…it will get distorted 
(the peaks are 
“clipped”).
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The Normalize controls

These are used to normalize the sound before and/or after 
processing. Please note the following:

• The effect of all dynamic processing depends on the ampli-
tude (level) of the material to be processed. Therefore, if you 
process a number of files with slightly different levels (for ex-
ample using presets or batch processing) the effect of the 
processing will be different from file to file. To avoid this, acti-
vate “Normalize before”.

• On the other hand if you are experimenting with different set-
tings, this means that after activating “Normalize before” you 
may have to re-adjust the Threshold level. See “Level Normal-
izer” on page 68 for more information on normalizing.

• One reason for setting the “Normalize before” value to less 
than 0 dB (full level) is if you are expanding, which might intro-
duce clipping if the signal is too strong to start with.

The Dynamics controls

When the Graphic Editing switch is deactivated, the dy-
namics processor works very much like a simple compres-
sor. Use the Threshold and Ratio settings to set the 
amount of compression.

About graphic editing

When the Graphic Editing check box is activated, you can 
specify any input to output function. This allows you to 
“draw” limiters, noise gates, expanders, etc. and combina-
tions of all these. See the presets for examples.

• The curve shows input level along the horizontal axis and out-
put level along the vertical axis. With a straight line diagonally, 
each input level is represented by the same output level (the 
signal is not processed at all).

No processing

• If the curve starts at 45° and then tilts downwards from any 
point, signals above this point will have a lower output level 
than input level. In other words, a gain (compression) reduc-
tion is performed.

Compression

• If the curve is tilted upwards instead, the output level will be 
higher than the input level, which is referred to as expanding.

Expansion

• If the curve is horizontally flat from some point, the output level 
will be the same regardless of input level. This is referred to as 
limiting.

Limiting
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• If the curve starts out horizontally flat and then rises upwards, 
signals in the flat area will be eliminated completely. This is 
called (noise) gating.

Gating

Setting up the curve

• You can drag any breakpoint in the curve to any posi-
tion, using the left mouse button.

• When you move breakpoints closer to the left side or 
the bottom of the graph, you will note that the number of 
positions is more limited. This is due to the nature of digital 
audio, where, for lower levels, a smaller number of “bits” is 
used to represent the data.

• You can add a new breakpoint by clicking anywhere on 
the curve with the left mouse button.

• You can delete a breakpoint by clicking on it with the 
right mouse button.

• The Reset button restores the curve to a straight line 
with only one breakpoint.

• The “Add point at level selection” button adds a break-
point at the level indicated by the current level selection 
(see “Level selections” on page 43 and the example be-
low).

An example of using “Add point at level selection”

The “Add point at level selection” function can be used to 
create a noise gate with a threshold at a certain level. Let’s 
say you have a recording of narration, with noise between 
the phrases that you’d like to remove:

1. Make a regular selection in a section that only contains 
background noise.
The longer this selection, the more accurate the result will be.

2. Select “Extend to peaks” from the Select submenu on 
the Edit menu.
The selection height now represents the level of the background noise.

3. Open the Dynamics dialog and set it up for graphic 
editing.

4. Remove all breakpoints from the graph.

5. Click on the “Add point at level selection” button.

6. Add a second breakpoint, “manually”, to the left of the 
one that just appeared.

7. Drag this second breakpoint so that it appears directly 
below the other one, at the bottom of the graph.
See the noise gate example above.

8. Adjust the Attack, Hold and Release settings as de-
sired.

9. Go back to the Wave window and select the section 
to be gated.

10. Open the Dynamics window and click the Process 
button.

11. Listen to the result, and if necessary, Undo, adjust the 
settings and Process again.

Expert settings

The Dynamics dialog also has a special tab devoted to 
“expert” settings.

Level envelope

This dialog allows you to create a volume envelope which 
can be applied to a selected range or a whole file.
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The dialog consists of a waveform view in the middle, with 
an envelope curve (initially a straight line) running through 
it. A vertical ruler displays the level change in dB, and the 
horizontal ruler displays the time line. You can boost the 
level up to 6 dB and decrease it down to silence.

Basic operation procedure
By adding points to the envelope curve you can create an 
envelope curve that will change the volume of the material 
over time.

1. Double click on the envelope curve to add a point.
A point will be added where you click. 

2. If you click on the point it will be selected (red color) 
and by click-dragging you can move it in any direction.
The curve changes accordingly in the waveform display.

• When you point the mouse in the display (or move a 
point), the current position and level change is shown 
continuously in the field above the display.

3. You can keep adding as many points as you like to the 
curve.
You cannot move a point past a another point in the horizontal direction.

4. You can select several points using [Shift] and move 
them together.
By clicking on the envelope curve itself (not on a point) you can move the 
whole curve up or down.

Envelope functions in the dialog
The functions are selectable in three ways (the same op-
tions in all cases): 

• From the Functions menu. 
• By clicking the icons above the display.
• By right-clicking in the display.

The following options are available in the dialog:

Fade-in and fade-out
A fade-in is a gradual increase in level and a fade-out is of 
course the opposite. There are two ways of applying fades 
in WaveLab Essential: by using the Easy Fade function or 
by using the Fade dialog.

Easy Fades
The Easy Fade function allows you to very quickly apply a 
fade-in or fade-out to an audio file, without having to make 
any settings:

1. To create a fade-in, make a selection from the start of 
the audio file to where you want the fade-in to end.
Similarly, to create a fade-out, you should make a selection from the po-
sition where you want the fade to start, to the end of the audio file.

2. Select “Easy Fade” from the Process menu, or press 
[Ctrl]-[D].
A fade is applied to the selection. The shape of the fade is governed by 
the Default fade/crossfade setting in the Preferences–Wave edit tab.

Using the Fade dialog
The Fade dialog allows you to specify the desired shape 
of the fade, and to create fade-ins or fade-outs anywhere 
in a file:

1. Make a selection that spans from where you want the 
fade to start to where you want it to end.

2. Select fade-in/out from the Process menu to open the 
Fade dialog.

Option Description

Deselect all points This will deselect all selected points.

Delete selected points Deletes all selected points.

Reset selected points Resets all selected points to 0dB.

Reset whole envelope This removes all added points.

Flip Vertical This will flip the current envelope vertically (in the 
level axis).

Flip Horizontal This will flip the current envelope horizontally (in 
the time axis).

Smooth envelope This allows you to create spline curves, for 
smoother level changes.

Option Description
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3. Use the Type options to select a fade-in or a fade-out.

4. Set the Offset and Damping parameters.
A graph in the waveform indicates the resulting shape. The Damping 
value indicates how much the wave will be attenuated at the Offset point. 
A 6dB Damping with a 50% Offset normally gives the most natural re-
sults. See “Crossfade” below for more details.

Crossfade
A crossfade is a gradual fade between two sounds, where 
one is faded in and the other faded out. This function al-
lows you to do just that. It also lets you create plain mixes 
of two sounds.

Performing a regular crossfade

The material you want to crossfade can either be in two 
different sections of the same file, or it can be in two dif-
ferent files.

Since the crossfade is a type of paste operation, you must 
start by getting the section into which you want to fade 
(the later part of the fade) onto the clipboard.

1. Select the section into which you want to fade.

2. Select Copy, from the Edit menu.

Now it’s time to move over to the section from which you 
want to fade, which might very well be in another Wave 
window:

3. Select the section from which you want to fade-out.

The length of this selection will determine the length of the 
actual crossfade (check the length on the status bar). In a 
typical case, this selection will be at the end of the wave. 
See below for details.

4. Select Crossfade from the Process menu.
The dialog appears and crossfade slope indicators are shown in the cur-
rent selection.

5. Make sure that “Mix without fading” is not activated in 
either section.

6. Adjust the Offset and Damping parameters as desired.
The shape of the two curves is indicated in the selection. See below for 
details.

7. Click the Paste button.

How the fade is done

• As described above, the length of the fade is determined by 
the size of the selection in the file into which you paste.

• The pasted material has to be longer than the selection you 
paste “into” (or there won’t be enough material to finish the 
fade).

• Any “excess” material in the copied selection will appear after 
the fade (at “full level”). The wave is lengthened as needed.

• Any material that originally appeared after the selection in the 
file into which you paste, will be moved so that it now appears 
after the newly pasted material.

About the curves

The design of the fade and crossfade curves is based on 
psycho-acoustic research material, in order to give as 
pleasant and harmonic a result as possible.

! This selection cannot be longer than the selection 
you just copied, or the program will not be able to 
perform the crossfade!

! Please note that if both waves already have full level 
sections in the crossfade area (for example if you 
have normalized both waves), clipping (and hence 
distortion) might occur! If this happens, reduce the 
amplitude of both waves by 3 to 6 dB and try again.
Also note however, that if one of the “Inverse of Fade 
In/Out” boxes is checked, clipping can never occur.
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For each of the two sections – the fade-out and the fade-
in – you can select an Offset and a Damping value. When 
you adjust these values, the curves in the wave are ad-
justed accordingly so that you can see what kind of cross-
fade you will get.

The Offset factor determines where in the fade section the 
file will play at its “mid level” (normally half the level, see 
below).

The Damping parameters adjust the “steepness” of the 
fade. For example, a -6dB setting for the fade-in will result 
in a normal fade, where the level is half the original when it 
reaches the Offset point. Values closer to 0dB will em-
phasize the beginning of the fade-in wave. Values closer 
to -18dB will make the fade-in sound drop drastically at 
the beginning of the fade.

Here, the default -6dB Damping curves with 50% Offsets are selected. 
This gives you a normal crossfade with the focus on the middle of the 
fade.

In this example, the Offsets have been moved so that the focus of the 
fade is more to the left. This means the fade-out is faster than the fade-
in. However, both Damping factors are still set to the standard -6dB.

Mix without fading

If you activate “Mix without fading” for either section, it will 
play at full level throughout the entire fade.

An example

Let’s say you have two environmental sound effects you 
want to fade between, “city” and “restaurant”. You want to 
fade from “city” to “restaurant”. The two sounds are in dif-
ferent windows.

1. Select the entire “restaurant” wave and copy it.

2. Make a selection in the “city” wave, from a point close 
to the end.
The length of this selection is equal to the length of the fade.

3. Open the crossfade dialog, set both Offsets to 50%, 
both Damping settings to -6dB, deactivate both “Mix with-
out fading” options and click the Paste button.
The “city” wave is now lengthened, so that it starts as it originally did, 
then fades over to the beginning of the “restaurant” wave and ends like 
the “restaurant” wave.

Invert Phase
This turns the signal “upside down”, which is the same as 
inverting the phase by 180°. No settings are needed for 
the operation.

There is no audible change when you invert the phase of a 
mono signal. However, if one channel in a stereo pair is 
out of phase with the other, this will lead to artifacts such 
as a drop in the bass register and a “blurred” stereo im-
age.

The most common use for this function is therefore to fix a 
stereo recording where one of the channels has acciden-
tally been recorded out of phase with the other.

Reverse
This function reverses the selection, as if playing a tape 
backwards. No settings are needed.

Eliminate DC Offset
This function removes a problem that most often appears 
due to mismatches between various types of recording 
equipment.

! This function should be applied to whole files, since 
the problem is normally present throughout the entire 
recording.
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A DC offset is when there is too large a DC (direct cur-
rent) component in the signal. If the DC offset is really 
bad, it can be visible as the signal not being visually cen-
tered around the “zero level axis”. However, the DC offset 
can be significant without actually being seen.

A wave with a serious DC offset

A DC offset is problematic for two reasons:

• It affects where the zero crossings appear, which in turn af-
fects the smoothness of splices between audio files.

• Certain processing options do not give optimal results when 
performed on files with a DC offset.

Checking for and eliminating DC Offset

1. Select the wave you want to check and fix.

2. Select “Eliminate DC Offset” from the Process menu.
A dialog appears stating the amount of DC offset.

3. Click OK or Cancel.

Waveform Restorer
This lets you remove intermittent clicks and pops in an au-
dio file. First make a selection encompassing the artefact 
you want to remove, then apply one of the available meth-
ods. Usually, you will have to use a high zoom factor to be 
able to locate and select the undesired element.

The Waveform Restorer lets you select one of several 
available restoration methods. The selected method is de-
scribed in the dialog.

Time Stretch
Time stretch is an operation that allows you to change the 
length of a recording without affecting its pitch. Actually 
the standard term “time stretch” is a bit misleading since 
you can of course also make the material shorter.

This function is most often used to make a section of au-
dio fit in with some other material. Therefore this dialog is 
set up exactly for that. You select the material to be 
stretched and use the options in the dialog to find a 
stretch factor (the “Percentage”). This is done by specify-
ing the desired length, or the desired tempo, all according 
to what the situation requires.

Opening the dialog

When you open the dialog, the following information 
about the selection is displayed:

Specifying a percentage directly 

If you know by how many percent you want to change the 
length, you can enter this value in the “Percentage” field.

Calculating the percentage by specifying a new length

• If you know the desired length in samples, adjust the 
Samples value in the “Desired result” section.

• If you know the desired length in minutes, seconds and 
milliseconds, adjust the corresponding value in the “De-
sired result” section.
Regardless of which you choose, the other values and the Ratio are up-
dated accordingly.

The original length 
in seconds.

The original length 
in samples.

The calculated orig-
inal tempo accord-
ing to the set length 
and time signature.
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Calculating the ratio by specifying a time code range

If you want to fit the selection to a certain range, for exam-
ple in a video or film sequence, you can specify the start 
and end of this range as time code values:

The other values and the Percentage are updated accord-
ingly.

Calculating the Percentage by specifying a new tempo

If you know you want the selection to play back in a certain 
tempo, after the stretch, proceed as follows:

1. If you know the current tempo of the selection, type it 
in the Tempo field in the Source part of the dialog.

2. If you don’t know the exact current tempo, but the 
length of the selection and the time signature, you can 
specify these instead, in the Bars and signature fields, and 
the Source tempo will be calculated for you.

3. Type in the desired tempo in the Tempo field in the 
“Desired result” section.

Reset

The Reset button resets the Percentage to “100%”.

Additional settings

Limitations

Time stretch is a very complicated Digital Signal Process-
ing (DSP) operation. It requires complicated mathematical 
operations and always affects the sound quality to some 
extent:

• For speech, stretch factors within a ±30% limit will normally 
provide very good results.

• For composite music, try to limit the range to ±10%.
• For sensitive material, like solo piano, try not to exceed ±3%.

! Please note for these operations to work properly, 
the exact specified source tempo or length must be 
selected. Any deviation from the real values will be 
transferred to the stretched audio.

Enter the desired 
end position here.

Enter the start 
position here.

Setting Description

Quality There are three Quality settings, “Quick Process”, 
“Standard” and “High Quality”. The High Quality 
mode provides very high quality pitch correction, 
but the process will take longer. For most uses, the 
Standard mode is probably sufficient.

Preserve pitch When this option is activated, the pitch of the audio 
material will not be affected when you apply Time 
stretch. This is the normal mode of operation. If you 
turn this off, the pitch will change proportionally 
with the Time stretch ratio, much like when speed-
ing up or slowing down a tape recorder.

Audio quantize When this option is activated, the length of the re-
sulting file will be exactly the one displayed in the 
“Desired result” section of the dialog. When it is 
deactivated, the actual file length may differ by a 
few milliseconds.
If you don’t need this accuracy, you should leave 
the option deactivated, for a slightly better audio 
quality.

Rhythm accuracy This is only available if “Standard” or “High Quality” 
mode is selected. Set this parameter according to 
whether the rhythmic feel of the audio material has 
a high priority or not. If you set this to a high value, 
the timing and rhythmic feel will be preserved as far 
as possible, which is important for drum tracks, etc. 
If you set it to a low value, the audio quality can be 
slightly better, but sections of audio might be 
moved slightly (in the milliseconds region) in the 
process. 
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Pitch Correction
Pitch Correction is a function which allows you to detect, 
and to change, the pitch of a sound, with or without affect-
ing its length.

Amount of shift

This allows you to specify the amount of pitch change in 
semitones and/or cents.

Pitch detection

WaveLab Essential can analyze an audio selection and 
detect the pitch of the audio. Click the “Find current pitch 
of audio selection” button to perform the detection. The 
found pitch is displayed below the button.

You also have the option to automatically compute the re-
quired pitch shift, based on the currently detected pitch 
and the pitch specified in the value field below the “Ac-
cording to the current pitch, etc.” button. When the button 
is clicked the “Amount of Shift” parameters are automati-
cally adjusted to the computed pitch shift.

Length compensation

This allows you to set how the length of the selection 
should be affected by the operation.

• A setting of 100 means that the length will be the same after 
the operation.

• A setting of 0 means that the program will behave like a tape 
recorder does when the speed of its tape is varied. For exam-
ple, if you raise the pitch by one octave, the sound will become 
half as long.

• Intermediate values will give results in between these two ex-
tremes. 

• For large transposition values, the lower this setting is, the 
better the quality of the effect will be.

Additional settings

Setting Description

Quality There are three Quality settings, “Quick Pro-
cess”, “Standard” and “High Quality”. The High 
Quality mode provides very high quality pitch 
correction, but the process will take longer. For 
most uses, the Standard mode is probably suffi-
cient.

Audio Quantize When this option is activated, the processed file 
will have the exact same sample length as the 
original. When it is deactivated, the resulting file 
length may differ by a few milliseconds.
If you don’t need this length accuracy, you 
should leave the option deactivated, for a slightly 
better audio quality.

Preserve Formants When this option is activated, changing the 
pitch of vocal material will give a more realistic 
result. When you are processing non-vocal ma-
terial, you should leave this option deactivated, 
since it uses a slightly slower processing algo-
rithm.
Warning: this algorithm might increase the sig-
nal level. If your audio material has a high level, 
you may need to lower its level before pitch 
shifting.

Rhythm Accuracy This is only available if “Standard” or “High 
Quality” mode is selected. Set this parameter 
according to whether the rhythmic feel of the au-
dio material has a high priority or not. If you set 
this to a high value, the timing and rhythmic feel 
will be preserved as far as possible, which is im-
portant for drum tracks, etc. If you set it to a low 
value, the audio quality can be slightly better, but 
sections of audio might be moved slightly (in the 
milliseconds region) in the process.
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Harmonization

This is a variation of the Pitch Correction, which allows 
you to create not only one shifted voice, but up to sixteen! 

Setting up the voices

1. Set the scroll bar to the voice for which you want to 
make settings.
Which voice is currently shown is indicated just above the scroll bar.

2. Activate the voice by clicking the check box.

3. Set up the amount of pitch shift for this voice, by ad-
justing the Semitones and Cents values.
The maximum range is ±36 semitones (±3 octaves). The cents value ad-
justs the pitch within one semitone, that is, 50 means a quarter tone.

4. If you want one of the voices to play back the original 
wave (at the recorded pitch), activate one voice for this 
and set both its Semitones and Cents settings to 0.

5. If you are processing a stereo selection or if you have 
activated “Create stereo wave” (see below), you can ad-
just the stereo position of the voice by using the Pan con-
trol.
If you pull the slider all the way left or right, this voice will be played in that 
channel only.

6. Use the scroll bar to select the next voice and set this 
up like the first.
The text to the right of the Pan control tells you how many voices are ac-
tivated.

Additional controls

Please note that by specifying very small pitch shift 
amounts (a few cents only) and panning the detuned 
voices hard left and right, you can create stereo material 
out of mono recordings without a noticeable change in 
pitch. Please try to keep a balance in the detuning. If for 
example you set one voice to +5 cents, set another to -5 
cents.

Hi-fi Chorus

This chorus works slightly differently from many others. 
Often chorusing is achieved by delaying a copy of the sig-
nal, continuously varying the amount of delay and mixing 
the delayed signal back in with the original.

While this is adequate for many purposes, WaveLab Es-
sential takes a more natural approach to creating chorus. 
Since a chorus effect is about making a recording sound 
as if it was performed by many “identical musicians”, 
WaveLab Essential takes just that approach. It multiplies 
the recording up to 100 times and detunes and delays 
each “voice” slightly and – if so desired – pans the voices 
across the stereo image.

Control Description

Preserve level When this is activated, the resulting audio will have the 
same level as the original, even though a number of 
voices have been added.

Create stereo 
wave

If you are operating from a mono selection you can still 
create a stereo wave by activating this option. The pro-
cessed wave will then open in a new window. 
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EQ

This is a three-band equalizer with high and low shelving 
filters and a full parametric mid-frequency band. The fol-
lowing parameters are available on the Settings tab:

Presets tab

The Presets tab features a list of EQ presets, with self-ex-
planatory names.

• To load a preset, select it in the list and click the “Load” 
button.

• If you have modified a preset which you wish to save, 
use the “Update” button.

• You can also save your own presets by typing in a name 
and clicking the “Add” button.

Convert sample rate
This function allows you to change the sample rate of a re-
cording. This is very convenient if you have a file that you 
wish to use in a certain audio system and find that the file 
was recorded at a sample rate this system doesn’t sup-
port. Please note that Sample rate conversion can also be 
done as part of the Saving process (see “Saving in an-
other format (Save as…)” on page 51).

Please note the following:

• Sample rate conversion from a low frequency upwards does 
not improve sound quality. The high frequencies that were lost 
due to a low recording frequency cannot be restored by a 
conversion.

• When you sample rate convert down to a lower frequency, 
high frequency material will be lost (this is part of the mathe-
matics behind digital audio). Therefore, do not convert down 
and then up again, since this will lead to a degradation in 
sound quality (unless that’s exactly what you’re after). Instead, 
use the Undo and Redo functions.

Performing the sample rate conversion

1. Select Convert sample rate from the Process menu.
This opens the Sample Rate dialog.

Parameter Description

High Shelf Gain Determines the boost or cut (in dB) of the high 
shelving filter.

High Shelf
Frequency

Sets the frequency of the high shelving filter. Fre-
quencies above this value will gradually be in-
creased or reduced in level, according to the High 
Gain setting.

Mid Shelf Gain Determines the boost or cut (in dB) of the Mid 
range EQ.

Mid Shelf 
Frequency

Sets the center frequency of the Mid range EQ. 
Frequencies around this value will be affected by 
the Mid Gain.

Mid Q Use this parameter to set the width of the Mid 
range, i.e. how wide a frequency range around the 
Mid Frequency should be affected by the Mid range 
EQ. The higher this value, the “narrower” the Mid 
range.

Low Shelf Gain Determines the boost or cut (in dB) of the low 
shelving filter.

Low Shelf 
Frequency

Sets the frequency of the low shelving filter. Fre-
quencies below this value will gradually be in-
creased or reduced in level, according to the Low 
Gain setting.
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2. Select the desired sample rate from the pop-up menu 
and click OK.
If you want to change any other audio properties (e.g. the bit resolution or 
stereo/mono status), you can do this in one of two ways:
• Open the Audio Properties dialog from the Edit menu and 

make the desired settings (see “Editing audio properties” on 
page 55).

• Open the Audio File Format dialog by selecting “Save as” on 
the File menu and clicking the Properties button in the lower 
section of the dialog (see “Saving in another format (Save 
as…)” on page 51).

Support for reNOVAtor™
If this audio restoration plugin is installed on your system, 
you can select it from the Tools menu.

This menu option is enabled if a wave window is open and 
an audio selection is active (it can be both channels or a 
single channel). 

Selecting “reNOVAtor…” from the menu opens this plug-
in and the active audio range is edited. The plug-in win-
dow is non-modal, hence you can work in WaveLab Es-
sential without closing the plug-in.

Go to http://www.algorithmix.com/en/renovator.htm for 
more info.

! Sample rate conversion is always applied to the en-
tire file. Any selection you have made is not used in 
any way for this operation.
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Introduction
The Master Section is the heart of WaveLab Essential’s 
“Real-time Engine” and the final block in the signal path, 
before the audio is sent to the audio hardware (or to an 
audio file on disk). This is where you adjust master levels, 
add effect processors and dither. 

The settings and processors in the Master Section are 
taken into account in the following cases:

When playing back an audio file in a Wave window.

When playing back an Audio CD Montage.
Note that the Master Section effects are global for all clips and tracks in 
a Montage, as opposed to the individual clip effects.

When using the Render function with any of the above.
The Render function writes the output of the Master Section to a file on 
disk, allowing you to apply Master Section processing to a Wave or mix 
down a Montage to an audio file. See “Rendering” on page 91.

About the “Use Master Section” option
If you don’t need the Master Section at all, you can turn it 
off completely by deactivating the Use Master Section 
setting on the Options menu. This will save processor 
power, but makes the following sections of the program 
unavailable:

• The Master Section window, including processors and dither-
ing.

• The functions of the Monitor window.
• Audio CD Burning from the Audio CD Montage.

The Master Section window
To open the Master Section window, you can either select 
it from the Specialized Windows submenu on the View 
menu or press [Ctrl]-[F9].

When you open the Master Section, active effect pro-
cessor panels will also appear (if they haven’t been hidden).

To close the Master Section, select it from the menu again 
or press [Ctrl]-[F9].

There are four slots for inserting effect processors. Effects can be 
turned on or off with the On buttons, and reordered by dragging the 
slots.

The Master Level pane. This is 
where you adjust the final output 
level. See “The Master level pane” 
on page 83.

The Dithering pane lets you add dith-
ering when mixing down to a lower 
bit resolution. See “The Dithering 
pane” on page 88.

Indicates that the level faders are 
active (any setting other than 
0.00), or that the Mono button is 
activated.

The Effects pane allows you to 
add and manage effect pro-
cessors. See “The Effects 
pane” on page 85.

Options for the internal dithering 
algorithm.

Level faders.

Indicates that an effect is activated.

Here you can insert a post-master 
fader effect or other dithering plug-
ins, replacing the internal dithering.

Click here to render the output to a file.

Activate this for mono output.

Indicates that dithering is on.
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Showing and hiding panes

You can independently hide the three Master Section 
panes in any combination:

• Clicking on the Hide button for a pane will “fold” it, leav-
ing only the pane title bar visible.
This is useful for saving screen space, if you e.g. don’t need to see the 
Dithering settings. Note that the green indicator for the pane will still be 
visible when the pane is hidden, allowing you to see at a glance whether 
effects, master volume or dithering are used or not.

• To show a hidden pane, click its Hide button again.
• Right-clicking (or [Ctrl]-clicking) a Hide button will hide the 

other two panes and bring the clicked pane to view (if hidden).
• Double clicking a Hide button will hide or show that pane and 

the pane(s) below it.

About the signal path
The three panes in the Master Section window corre-
spond to the Master Section’s three “processing blocks”: 
Effects, Master Level and Dithering. The signal passes 
through these blocks from top to bottom, as shown in this 
figure:

The Master level pane

The Faders
The faders in the Master level pane govern the final output 
level. Use these in conjunction with the level meters (those 
next to the fader, or even better, the meters in the Level 
Meter window) and the clip indicators to optimize the level 
of the signal sent to the audio hardware.

To adjust the level, use the following methods:

1. To make coarse adjustments, click a fader handle and 
drag it.
You can also click directly anywhere along the fader scale to move the 
fader handle there immediately.

2. For fine adjustments, click on the upper or lower half 
of the fader handle.
This raises or lowers the level by a small amount.

• To reset a fader to 0.00 dB, press [Ctrl] and click any-
where on the fader.
When both faders are set to 0.00 (and the Mono button isn’t activated), 
the Master level section will not affect the signal at all. This is indicated 
by the green indicator for the Master pane going dark.

• You can control the faders using a wheel mouse.
This has to be activated in the Preferences–Environment tab.

The fader settings are shown numerically below each 
fader.

Audio from WaveLab

Slot 1

Slot 4

Master Level

Dithering 
(or post-master effect)

Audio Hardware 
(or file on disk)

Note that the signal passes 
through the effects in series 
(from top to bottom) – reorder-
ing the effect slots affects the 
signal path.

Master Section meters monitor 
the signal here.

Meters in the Meter windows 
monitor the signal here.

! It’s particularly important to avoid clipping (signal lev-
els exceeding the available headroom), especially 
when mastering. Clipping is indicated by the Master 
Section’s clip indicators (see below) and by the 
number of clip indicators in the Level Meter.
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About the Unlink mode

The Unlink button determines whether the faders should 
be individually adjustable (indicated by a lit Unlink button) 
or “ganged”. Normally, you will probably want Unlink de-
activated, so that moving one fader also moves the other 
by the same amount. Turning on Unlink allows you to cor-
rect improper stereo balancing by adjusting the channels’ 
levels individually. Note:

If you offset the faders (with Unlink turned on) and 
then deactivate Unlink again, you can adjust the overall 
level without changing the level offset between the chan-
nels.
In other words, moving one fader will move the other one by the same 
amount, relative to its current setting. Note that the faders use an expo-
nential scale – this means that when you move one fader, the other does 
not follow in a linear fashion on the screen. However, the audio result is 
what you expect.

Fader offsets are not preserved at the end of the range 
of movement.

The Meters
The Master Section meters show the signal level of the 
signal before dithering (or any other plug-in you have ap-
plied post-master fader – see “Adding other plug-ins to 
the Dithering pane” on page 89). Use these to get an 
overview of the signal levels.

• The numeric fields above the faders show the peak lev-
els (the highest signal levels reached) for each channel.
They will hold these values until you click on them to reset them.

• The red “LEDs” above the meters are clip indicators, 
which will light up whenever the signal clips (exceeds the 
maximum available headroom). 
If this happens, you should lower the faders, reset the clip indicators by 
clicking on one of them, and play back the section again until no clipping 
occurs.

The Mono button
If you activate the Mono button, the two channels will be 
summed to mono. Furthermore, the output level is auto-
matically reduced by -6dB, to avoid clipping. The Mono 
button is useful for checking mono compatibility of stereo 
mixes, etc.

If the Mono button is activated, the green indicator for 
the Master level pane will be lit, even if the master level 
isn’t adjusted.
This helps you avoid accidentally leaving the Mono button activated.

The Dropout indicator
This indicator lights up whenever WaveLab Essential fails 
to properly play back as little as a single sample of the cur-
rently selected wave. A dropout is most likely to occur 
when your computer does not have the processing power 
to adequately handle all effect processors you have in-
serted.

To avoid dropouts, try the following:

• Use fewer effects.
You might be running out of processing power.

• Consider “Rendering” the processing rather than run-
ning it in real time. Then master from the processed file 
without any processors plugged in. See “Rendering” on 
page 91.
Dropouts never occur when “Rendering” to a file.

• Do not process any files in the background while mas-
tering digitally to a DAT for example. See “Working with 
multiple files” on page 92.

• If neither of the above helps, please check the audio 
card preference settings, you might need to adjust the au-
dio buffer settings.

If a dropout occurs during a real-time mastering process 
(and if your master needs to be flawless) we recommend 
that you re-master. Stop playback, click on the dropout in-
dicator to reset it, and try again.

As mentioned above, this indicator lights up as soon 
as even a single sample is not played back correctly. This 
type of precision is not often required, but it’s there if you 
need it.

! For critical level metering, we recommend using the 
Level Meter (see “The meters” on page 64). Not only 
is this more detailed, it’s also applied after the whole 
Master Section (after dithering) and will thus show 
the actual signal level sent to the audio hardware.
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The Effects pane

WaveLab Essential allows you to insert up to four effect 
plug-ins in series (plus an additional, post-master fader 
plug-in, normally used for dithering, see “The Dithering 
pane” on page 88). Three plug-in formats are supported in 
the Master Section:

• WaveLab Essential-specific plug-ins, included with the 
program.

• VST plug-ins.
Steinberg’s VST plug-in format is supported by a lot of programs and 
plug-in manufacturers. You will find a number of VST plug-ins included 
with WaveLab Essential; other plug-ins can be purchased separately 
from Steinberg or other manufacturers or in some cases downloaded 
from the Internet. 
Note that if you have additional VST plug-ins installed on your computer, 
these can optionally be available in WaveLab Essential (provided that 
they are installed in the “Shared VST Plug-ins” folder). Whether the ef-
fects in the “Shared VST Plug-ins” folder should be available in Wave-
Lab Essential or not is set in the Preferences–VST tab. You can also 
specify an extra VST plug-ins folder in the Preferences if you wish, mean-
ing that you can have access to both the effects in the “Shared VST 
Plug-ins” folder and the effects in some other folder containing VST 
plug-ins.

• Plug-ins that adhere to the Microsoft DirectX standard.
These are known as DirectX or DX plug-ins and are also widely available.

Selecting effects and managing slots
To select an effect plug-in for a slot, click on the slot (or 
the numbered button to the right of the slot) and select an 
effect from the pop-up menu that appears. Note that ef-
fects can be organized in groups (see “Organizing plug-in 
processors” on page 186), in which case they will appear 
in hierarchical submenus.

Selecting an effect from the VST group.

When you have selected an effect, it is automatically acti-
vated (the On button lights up), and its control panel ap-
pears as a separate window (see “Making settings – The 
Effect control panels” on page 86 for more on effect con-
trol panels).

• You can turn off an effect (without removing it) by click-
ing its On button.
To activate the effect again, click the On button so that it lights up.

• To hide the control panel for an effect, right-click its On 
button (or right-click the effect slot and select Hide from 
the pop-up menu that appears).
A hidden control panel can be shown by right-clicking the On button 
again (or by selecting Show from the same pop-up). You can also have 
one effect panel shown and automatically hide all the other panels, by 
right-clicking the Solo button for the slot.

• Clicking the Solo button for an effect will bypass all 
other effect slots, allowing you to check the sound of that 
effect only.
You can also bypass effects manually in their control panels – see below.

! The number of effects available on the menu de-
pends on which plug-ins you have installed. It’s also 
possible to globally deactivate or exclude effects you 
don’t need, as described in the section “Activating 
and deactivating plug-ins and groups” on page 187.
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• You can change the order of the slots (and thus the or-
der in which the signal passes through the effects) by 
clicking a slot and dragging it to a new position.
When you drag, a dotted outline shows the position of the slot.

• To remove an effect from a slot, right-click the slot and 
select Remove from the pop-up menu that appears.
This is the same as selecting “None” from the effect selection pop-up 
menu.

Making settings – The Effect control panels
The control panel window is where you make settings for 
an effect. Plug-ins can either have specialized control 
panels (with any combination of knobs, sliders, buttons 
and displays) or use standard panels.

Bypass, Mute and Preset

As you can see in the figure above, the three buttons 
above the actual panel are common to both kinds of con-
trol panel windows. They have the following functionality:

• Clicking the Bypass button will temporarily bypass the 
effect.
Unlike turning off the On button for the slot, the bypass function does not 
free up any processing power. Note that you can bypass all effects ex-
cept one by using the Solo button for a slot. It’s also possible to bypass 
all effects by using the global bypass button in the Effects pane. Also 
note that bypassing effects is for playback only, and does not affect ren-
dering. To deactivate an effect when rendering, use the On/Off buttons 
in the Master Section effect pane.

• The Mute button turns off the signal output from the ef-
fect.
This means that you will no longer hear your signal because it won’t even 
reach the next stage (either another slot or the master faders).

• The Preset button allows you to select and edit presets 
for the effect.
This is described in the section “Working with effect processor presets” 
on page 87.

Standard panels

A standard panel shows parameter names and values in 
the display to the left. To make settings, use the slider be-
side the corresponding parameter.

Custom panels

An effect plug-in can actually have any control panel that 
the plug-in designer desires. There are several examples 
of custom panel plug-ins included with WaveLab Essen-
tial.

For information about the panels for additional plug-ins, 
see the documentation for each plug-in.
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Working with effect processor presets
With WaveLab Essential comes a number of “factory pre-
sets” for the included processors, which you can either 
select and use as is, or use as a starting point for your own 
settings. Additional plug-in processors may provide their 
own “factory presets”.

To access the presets for an effect, click the Preset 
button in its control panel window.
The result and available functions depend on the type of plug-in:

WaveLab Essential specific plug-ins

Applying and saving presets for WaveLab Essential spe-
cific processors works exactly as with any other preset, 
apart from the fact that there are no preset “tabs” or menu 
items as in dialogs. Instead, clicking the Preset button will 
open a separate Preset dialog. The options in this dialog 
are exactly the same as for dialogs with Preset tabs. See 
“Presets” on page 30 for more details.

VST-compatible plug-ins

VST plug-ins have their own preset handling. When you 
click the Preset button for this type of effect, a pop-up 
menu with the following options appears:

DirectX plug-ins

Here, the same functionality is provided as for WaveLab 
Essential plug-ins. In addition, you can import “native” pre-
sets created for the plug-in.

About the effect plug-ins supplied with 
WaveLab Essential
Included with WaveLab Essential is a large number of 
plug-ins for all kinds of purposes, audio compression, 
chorus, stereo enhancement, reverb, etc. The parameters 
for each plug-in are described in the “Plug-in Processor 
Reference” in the online documentation.

Installing additional effect plug-ins
If you have purchased or downloaded additional plug-ins 
(VST or DirectX), you need to install these to be able to 
use them in WaveLab Essential. Normally, plug-ins come 
with an installer application of some kind, along with a 
manual or installation notes – make sure to follow the in-
structions in these when installing the plug-in.

About installing DirectX plug-ins

Normally if the DirectX plug-in has been installed properly, 
it will automatically be “visible” in WaveLab Essential. If it 
isn’t, you need to “update the Windows registry” so that it 
is. Proceed as follows:

1. In Windows, locate the actual plug-in file on your hard 
disk.
These are “dll” (dynamic link library) files, which means they normally 
have the extension “.dll”. Sometimes other extensions are used as well.

2. Drag and drop the file icon, either onto the WaveLab 
Essential program icon, or somewhere in the WaveLab 
Essential application window.
A dialog box will ask you whether you want to register the plug-in or not.

Organizing plug-ins

You can specify which plug-ins should be available in the 
program and how these should be organized on the menus. 
See “Organizing plug-in processors” on page 186.

Item Description

Load/Save Bank… This allows you to load and save complete sets of 
presets. The file format is compatible with Cubase.

Load/Save Default 
Bank

This allows you to load the default set of presets 
(as will appear when first loading the plug-in) or 
save the current set of presets as the default bank.

Load/Save Effect Lets you load or save one preset at a time. Also 
compatible with Cubase.

Edit name of current 
program…

This allows you to define a name for the preset, 
which might be displayed in the panel (depending 
on the plug-in).

Preset List This allows you to select one of the currently 
loaded presets.
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The Dithering pane

The Dithering pane allows you to add dithering to the sig-
nal before it’s sent to the audio hardware or to a file on 
disk. You can choose between WaveLab Essential’s inter-
nal dithering algorithm or any external dithering plug-in of 
your choice. First, some theory:

What is dithering?
Dithering is a method for reducing quantization errors in 
digital recordings. In the case of WaveLab Essential, dith-
ering is applied when reducing the number of bits in a re-
cording, for example when moving from 24 to 16 bits, and 
when applying processing.

The theory behind this is that during low level passages, 
only a few bits are used to represent the signal, which 
leads to quantization errors and hence distortion. To the 
ear, this is perceived as “graininess” during low level pas-
sages in a recording.

When “truncating bits”, as a result of moving from for ex-
ample 24- to 16-bit resolution, such quantization noise is 
added to an otherwise immaculate recording.

By adding a special kind of noise at an extremely low level, 
the quantization errors are minimized. Indeed, the added 
noise can be perceived as a very low-level quiescent hiss 
added to the recording. However, this is hardly noticeable 
and much preferred to the distortion that otherwise oc-
curs.

The reason for the dithering block to be last in the 
Master Section is that the output level must not be 
changed after dithering a signal.

When should I apply dithering?
The basic rule-of-thumb is that you should dither when 
moving to a lower bit resolution. One obvious instance of 
this is when converting an audio file to a lower resolution 
(e.g. preparing a 24-bit file for mastering to CD, which 
uses 16-bit format).

However, even if you’re playing back or rendering a 16-bit 
file to the same resolution, you need to dither if you’re us-
ing any real-time processing whatsoever in WaveLab Es-
sential! The reason for this is that WaveLab Essential 
works with an internal resolution of 32-bit (floating point), 
for supreme audio quality. This means that as soon as you 
perform any kind of real-time processing, the audio data 
will be treated at this high resolution instead of the original 
16 bits, thus making dithering necessary.

Examples of real-time processing include level adjust-
ments, any effects, mixing of two or more clips in a Mon-
tage, etc. In fact, the only time when a 16-bit file will be 
played back at 16-bit resolution is if you play it without any 
fades or effects, and with the Master Faders set to 0.00 
(no level adjustment – Master level indicator turned off).

Selecting a dithering algorithm
To select and activate a dithering algorithm, click on the 
arrow button next to the plug-in slot in the Dithering pane, 
and select one of the options from the pop-up menu that 
appears. The default option is “Intern” (WaveLab Essen-
tial’s internal dithering algorithm). However, you can also 
add other plug-ins to this list, see “Adding other plug-ins 
to the Dithering pane” on page 89.

Once you have selected a dithering algorithm, dithering is 
active (as indicated by the green indicator for the Dither-
ing pane). It will apply to all playback (through the Master 
Section) or rendering.

To turn off dithering completely, right click in the slot 
and select “Remove” from the pop-up menu that appears.
This is the same as selecting “None” from the effect selection pop-up 
menu.
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Making settings
When dithering, there are no hard and fast rules for how to 
set up the parameters – this largely depends on the type 
of material. We recommend that you experiment and let 
your ears be the final judge.

Internal dithering

Adding other plug-ins to the Dithering pane
If you have purchased another dithering plug-in that you 
prefer, you can use this instead of the internal dithering. 
It’s also possible to insert some other type of plug-in in the 
Dithering pane – it will be applied after the Master level 
faders (possible useful plug-ins would be maximizers, lim-
iters, etc.).

To make a plug-in available on the plug-in slot pop-up 
menu in the Dithering pane, proceed as follows:

1. Pull down the Options menu and select “Organize 
Master Section plug-ins…”.
A dialog appears, listing all plug-ins installed in your system. See “Orga-
nizing plug-in processors” on page 186.

2. Locate the plug-in in the list.
Note that plug-ins can be placed in groups (folders) in the list – click the 
plus sign next to a folder to view the contents of a group if needed.

3. Activate the checkbox in the PM column for the plug-
in.
PM stands for “Post Master fader”.

4. Click OK to close the dialog.

Now, the plug-in will appear on the pop-up menu in the 
Dithering pane, and can be inserted after the Master Level 
faders (as with the regular dithering types). You make set-
tings for the plug-in like you would for effects in the Ef-
fects pane. Note also that the plug-in will still be available 
for selection as a regular, pre-master effect.

Master Section presets

You can turn all settings currently made in the Master 
Section into a preset. This includes which processors 
were used, what settings were made for each one of 
them, and dithering options.

Parameter Description

Noise Type Determines the dithering method used:
In “Off” mode, no dithering is applied – use this as a 
Bypass function. 
The “Type 1” mode is the most “all-round” type of 
method.
The “Type 2” mode emphasizes higher frequencies 
more than Type 1.

Noise Shaping This parameter alters the character of the noise added 
when dithering. Again, there are no hard and fast rules, 
but you may notice that the higher the number you se-
lect here, the more the noise is moved out of the ear’s 
most sensitive range, the mid-range.

Output Bit 
Resolution

This is where you specify the intended bit resolution for 
the final audio, after dithering, regardless of whether 
you will “Render” the settings or play back in real-time.
It is very important to set this to the correct resolution!
Dithering will change the sample resolution, but not the 
sample size. E.g. when dithering 24-bit to 16-bit, the 
file will be still be 32-bit in size, although only 16 bits of 
information will have significance. 
Hence, when rendering to a 16-bit file, specify the de-
sired file resolution to avoid wasting space!

! Please remember that the meters in the Master Sec-
tion monitor the signal before the Dithering pane! To 
avoid clipping, check the Level Meter and adjust the 
output level setting of the plug-in, if available.
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Creating presets
To create a new preset, proceed as follows:

1. Set up the Master Section as you want it.
This includes selecting Processors, making settings, and setting dither-
ing options.

2. Click the Presets button in the Effects pane.

3. Type in a name for the preset in the upper right corner.

4. If you want the dithering options and Master level set-
tings to be part of the preset, make sure “Save Dither/
Level settings” is activated.
This is the default.

5. Click Add.

The presets are saved automatically when you quit the 
program. The next time you load the program, the presets 
are ready and waiting, just as you left them.

Loading a preset
To load a preset, select it in the list to the left, and click on 
one of the Load buttons, depending on the desired load 
method:

• The Replace method replaces all settings in the Master 
Section with the setting in the preset.

• The Mask method replaces only those slots in the Mas-
ter Section that are actually used in the preset.

• The Append method fills the unused slots in the Master 
Section with the settings in the preset.
If there are not enough free slots available to load the entire preset, a 
warning message will appear.

Modifying a preset
1. Set up the Master Section as desired.
If you only want to adjust a few settings in an existing preset, you may 
want to load this first, as described above.

2. Go back to the “Master Section Presets” window.

3. Select the preset you want to overwrite with the new 
settings.

4. Click the Update button.

• To update settings for the last loaded preset you can 
[Ctrl]-click the Presets button.
This will save any changes without having to open the dialog.

Deleting a preset
To delete a preset, select it in the list to the left and click 
the Delete button.

Using key sequences for presets
If you want to invoke a preset via a key command se-
quence, you can do this by defining key sequences.

A key sequence contains between one and three keys that 
must be pressed in a certain order to recall the preset.

Defining key sequences

1. Select the preset for which you want to create a key 
sequence, and click the key sequence button.

2. If you want to clear the current key sequence, click 
Clear.

3. Make sure Catch mode is active.

4. Press the first combination of keys that you want to 
use.
You can include modifiers ([Shift], [Ctrl], [Alt], etc.) if you like. There is 
also a setting that makes the program distinguish between two modifiers 
with the same label, on each side of the space bar.

5. Proceed with the following key(s).

6. Disable Catch mode.
This is just a safety measure so that you don’t accidentally erase or add 
to your current key sequence, when pressing more keys.

7. Close the dialog.

8. Use the Default Key Action buttons to decide whether 
your key sequences will invoke the “Replace”, “Mask” or 
“Append” load method.
This setting is global to all Key sequences.

Using key sequences

Key sequences can only be invoked when the Master 
Section Presets dialog is closed. Press the keys in the or-
der they were entered in the dialog, and the preset is 
loaded.

Saving and loading preset groups
You can save one or more created presets as a preset 
group for easy access. If you have added presets to the 
Preset window and want to save them as a group, use the 
drop-down menu at the bottom of the dialog to enter a 
name for the group and save it.
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This function is useful if you are working on several 
projects, since it makes for a convenient way to keep spe-
cific Master Section presets for specific projects well or-
ganized and easily accessible.

Rendering
While the Master Section can perform all processing in 
real time during playback, it’s also possible to save the au-
dio output to a file on disk. This is done with the Render 
function.

There are several uses for Rendering:

• Mix down a complete Audio CD Montage to an audio 
file.
This can be a goal in itself, but can also be necessary if your Montage 
uses e.g. more effects than the system can handle in real time. By Ren-
dering it to a file first, and creating a CD from this file instead, you can 
avoid dropouts and CD burning failure.

• Mix down a file in a Wave window to a new audio file, 
complete with Master Section effects, dithering and other 
settings.
You can freely choose the format of the new audio file, allowing you to 
create an mp3 file and add effects at the same time, for example.

• “Apply” all settings in the Master Section to a file in a 
Wave window.
This is the same as the previous option, but the Master Section process-
ing will transparently and permanently be “applied” to the current file in-
stead.

What is rendered?
When you use Render, all Master Section settings (ef-
fects, master levels, dithering, etc.) are included in the re-
sulting audio file. In other words, what you hear is what 
you get.

One thing to note: the Bypass switch affects playback 
only, while the effect On switches affect both playback 
and Rendering.

Calling up the Render dialog and filling out the 
options
Click the Render button to call up the following dialog:

The Render dialog for Wave windows (for information on Rendering Au-
dio CD Montages, see “Mixing down – The Render function” on page 
131).

Here is what the options mean:

Range

This is where you specify what part of the wave to render.

Result

Here, you can choose whether the original wave file 
should be changed (“applying” the Master Section set-
tings) or whether a new audio file should be generated.

! Rendering Audio CD Montages is described in the 
Audio CD Montage chapter (see “Mixing down – The 
Render function” on page 131). This section de-
scribes Rendering waves.

Option Description

Selection Process only the portion that is currently selected 
in the Main view.

Whole file Process the entire file.

Option Description

Process in place Modifies the original file. If you wish to keep the 
changes, you need to save the file again. Note: if you 
use this for adding effects to a file, you may want to 
activate the “Activate Global Bypass” option on the 
Schedule tab (see below).

No tail If this is activated, the resulting file will end where the 
original did, even if the processing adds material (like 
for example echoes or reverb tails).

Copy markers If this is ticked, the resulting new file will contain all 
markers present in the original file.
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Create named file

If this is activated, the resulting new file will be saved (not 
temporary). The field below the checkbox allows you to 
specify a name and location for the file, and you can click 
the audio properties button to set the desired audio for-
mat. Clicking the “Rename as source” button will set the 
file name to the same as the file being processed (but re-
taining any path you have specified above).

If you click the audio properties button at the bottom 
of the dialog, you open the Audio File Format dialog in 
which you can choose the desired format of the file and 
make settings for the conversion and encoding.

Options on the Schedule tab

• The On Start options determine what WaveLab Essential 
should do before rendering:

• The On Completion options determine what should happen 
after rendering:

• The Priority setting lets you specify how fast the file should be 
processed.

Processing the file
Once everything is set up correctly, click OK to initiate the 
processing. Or, if you change your mind, click Cancel.

Tip: If you just need to process the current audio se-
lection in place, you can press [Ctrl] while clicking on the 
Render button. This will process the audio selection in 
place without opening the dialog. 
Other settings are kept from the last time you accessed the dialog.

Working with multiple files
Once you have applied settings to one wave, as de-
scribed below, you can continue with processing the next. 
The processing of the first wave will continue in the back-
ground. This way you can apply processing to as many 
waves as desired. Please also note that each wave can 
have its own priority setting, as described below.

Stop playback Stops playback to free up some processing 
power. This option is not available if playback is 
already stopped.

Open Monitor window Opens the Monitor window, see “The Monitor 
window” on page 93.

Minimize window The file window is minimized to free up screen 
space.

Beep WaveLab Essential will beep to signal that the opera-
tion is completed.

Show 
message box

WaveLab Essential will display a message to confirm 
the operation. Click OK to continue.

Restore 
audio window

Upon completion, WaveLab Essential will restore a 
minimized window (see above) to its original size.

Activate 
Global Bypass

WaveLab Essential will automatically activate the By-
pass switch in the Master Section’s Effects pane (see 
“Bypass, Mute and Preset” on page 86) upon comple-
tion. This allows you to play the processed file back af-
ter rendering, without hearing the effects “twice” 
(applied to the file and activated in the Master Section).

Relax 
Background

The file is processed in the background, but priority is 
given to audio playback and to your continued work on 
other files. This makes WaveLab Essential as responsive 
as possible, but slows down processing.

Background The file is processed in the background but with a lower 
priority given to your continued work on other files. This 
makes processing faster but the program less responsive. 
Try this mode when several files should be processed in 
the background.

Fast Processing is given a high priority. A fairly high-perfor-
mance computer may be required to avoid dropouts in 
playback.

! Any dropouts that occur as a result of too little pro-
cessing power left will only affect the played file. 
Files processed in the background will always be 
free of dropouts!

! If you are rendering to MP3 format, you should only 
render one file at a time.
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The Monitor window
This window allows you to monitor the ongoing processes 
and check how hard your computer’s CPU is working with 
various tasks.

To open this window, select “Monitor” from the Special-
ized Windows submenu on the View menu or press [Ctrl]-
[F10].

The window has two displays, selected by clicking the 
corresponding tab at the bottom of the window.

The Progress display

The Progress display shows a list with the following col-
umns:

Process menu

Even while a wave is being processed, you can change its 
settings. Position the pointer in the monitor window and 
press the right mouse button.

The following options are available:

The Performance display

The Performance display provides an overview of the pro-
cessing power currently being used.

Column Description

Name The name of each wave or montage being pro-
cessed.

Progress How much of the wave has been processed so far.

Remaining time This indicates how much time is required to finish 
the processing.

Priority Boost The priority assigned to this particular processing 
(see “The Priority setting lets you specify how fast 
the file should be processed.” on page 92 and be-
low).

Option Description

Suspend/Resume Suspends processing of the wave. The menu 
option changes to Resume so that you can acti-
vate processing again. When a process is sus-
pended, more CPU power will be available to 
the other processes.

Suspend/Resume All Halts/starts processing of all waves.

Relax Background, Back-
ground, Fast

Changes the priority status for the wave, see 
“Relax Background” on page 92.

Cancel Cancels the processing operation for the se-
lected wave, in which case the message in the 
Priority Boost column reads Cancelled until 
WaveLab Essential has performed all the nec-
essary clean up operations.
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• The yellow lines refer to the power used for providing input to 
the Master Section, i.e. reading waves from disk. Please note 
that the values are an approximation.

• The purple lines indicate the processing power that is re-
quired for all processors currently running in the Master Sec-
tion. The shorter the line, the less the load on the CPU. This is 
a very precise measurement.

• The blue lines reflect the processing power required by the 
output device.

• There is also a number indicating processor usage in percent.

Customizing the Performance display

You can customize the way the processing information is 
displayed. If you want to see more of what is going on, re-
size the window. 

Other options are available if you position the cursor any-
where in the black part of the window and press the right 
mouse button. 

The following options are available:

• You can activate/deactivate the Input, Process, and Output in-
formation (see above).

• To get an exact (but not as smooth) picture of the processor 
usage, deactivate Average.

• You can select a Zoom factor for the display (50%~400%).
• You can change the direction of the status information flow 

(horizontal or vertical).
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Basic procedure
WaveLab Essential can open and play both uncom-
pressed and compressed files in a number of different for-
mats, including WAV, AIFF, MP3, WMA (Windows Media 
Audio) and OSQ (Original Sound Quality), which is 
WaveLab Essential’s proprietary lossless audio format.

It’s also possible to convert WAV or AIFF files to another 
format. While this can be done by opening a file and se-
lecting “Save As” or “Save Special/Encode” on the File 
menu, you can also convert several files in one go (batch 
conversion).

Proceed as follows:

1. Select “Batch file encoding…” from the Tools menu.
The “Encode audio files” dialog opens.

2. Click on the green “plus” symbol.
A file selector opens, where you can select the desired audio files (WAV 
or AIFF). Files must have the same sample rate and number of channels 
(e.g. stereo/mono).

Click here to add files.

3. In the file type pop-up select one of the available for-
mats (WAV or AIFF) and then – in the file list – select the 
desired files. If necessary, use the [Ctrl] and/or [Shift] keys 
to select several files. Confirm your selection by clicking 
“Open”.
This brings you back to the “Encode audio files” dialog.

4. Select the destination folder for the converted files 
from the corresponding pop-up menu.

5. Select the desired destination format by clicking the 
audio properties button at the bottom of the dialog.
This opens the Audio File Format dialog in which you can select the de-
sired format and make settings for it.

6. For some compressed file formats, clicking on the ar-
row button to the right of the Encoding and Attributes 
menus calls up dialogs where you can set the encoding 
parameters and enter text strings.

! Note that it is possible to simultaneously batch en-
code audio files of different formats, given that all the 
files have the same sample rate and number of chan-
nels.
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Introduction

What are markers for?
Markers allow you to save and name certain positions in a 
file. You can use these positions later on in various ways:

• Set the wave cursor to a marker.
• Select all audio between two markers.
• Loop the section between two markers, etc.

There is no limit to the amount of markers you can have in 
a file.

The various marker types
The following marker types are available:

About marker pairs
Two of the marker types come in pairs: Loop and Region.

Since you can’t have a region that starts but never ends, a 
loop end point without a start, etc., special rules exist for 
creating, deleting and moving these types of markers.

• Loop and region markers only have a functionality when 
balanced.
You can enter just a start marker, but its purpose will be defeated by the 
lack of a corresponding end marker. Furthermore, if you delete a start 
marker, the corresponding end marker will also be deleted.

About importing and saving loop markers
There are a few points to be aware of when importing files 
with loops into WaveLab Essential. This is because the 
loops can be defined in two places: Wave and AIFF file 
formats have the ability to contain loop points, and Wave-
Lab Essential stores loop points as markers separately for 
each file, in “.MRK” files. So, there’s a potential risk for 
conflict:

• When you import a file that has never been used in WaveLab 
Essential before, and which contains loops, the loops are “im-
ported” and displayed as loop markers (in addition, the sample 
note and detune information described in the section “Editing 
sample attributes” on page 170 is imported, if present).

• When you then save the file in AIFF or Wave format, the loop 
points are stored, both as part of the actual file (so that other 
applications can read them) and in the “.MRK” file (for Wave-
Lab Essential).

• When you open a file that has been used in WaveLab Essen-
tial before, loop indications that were originally in the file, be-
fore you used it in WaveLab Essential, are ignored. Only the 
loop information in the “.MRK” file is used.

! This chapter describes how to use markers in Wave 
windows. 
Audio CD Montages have their own markers, see 
“Using markers in the Montage” on page 127.

Marker type Description

Generic This is mainly used for locating certain important 
positions and for editing (for example selecting all 
audio between two positions). Generic markers 
can be created directly during recording if needed 
(see “About dropping markers during recording” 
on page 62).

Loop start and 
end

These are used for defining loop points. This is 
useful for editing purposes as well as when creat-
ing loop sounds (e.g. for samplers).

Region start and
end

Use these to define start and end points for ge-
neric regions. This is useful for editing purposes 
and can be created directly during recording if 
needed (see “About dropping markers during re-
cording” on page 62).
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The Marker toolbar
This is a special control bar for markers. It can be brought 
up from the Control Bars submenu on the View menu.

Creating markers

Dropping markers on the fly
To add a marker on the fly, proceed as follows:

1. Play back the file.

2. When the cursor reaches the position where you want 
a marker, do one of the following:

• Press [Insert].

• Click the Drop marker button on the Marker toolbar.

• Select Drop Marker from the time ruler speed menu.
You can give the marker a proper name later.

The markers dropped this way are generic.

Creating a marker from “stop mode”
1. Set the wave cursor to where you want the marker to 
appear.

2. Do one of the following:

• Click on the New Marker button on the Marker toolbar.

• Click with the right mouse button on the time ruler and 
select New Marker from the menu that appears.

• Press [Ctrl]+[Insert] as a shortcut for the “New Marker” 
operation described above.

3. Select a marker type.

4. Fill out the other options in the dialog and click OK.

The new marker appears at the wave cursor position.

Dropping markers while recording
You can drop markers during a recording. For example, if 
you are auditioning some material while transferring it from 
DAT tape to WaveLab Essential, you can add markers at 
important positions, as they are coming up. The marker 
types you can add are: Generic, Region start and Region 
end. See “About dropping markers during recording” on 
page 62.

Creating marker pairs from the Marker toolbar
To create a loop or a generic region, you can use the 
Marker toolbar:

1. Make a selection that spans the area you want to en-
close by a marker pair.

2. Click on the corresponding marker pair symbol on the 
Marker toolbar.
Markers are added at the start and end of the selection.

About the marker list
There is a marker list window that displays all markers in a 
wave. This can be used for various purposes, for editing, 
deleting and locating to markers, as described in the fol-
lowing sections.

Add new 
marker

Drop Generic marker
Add region markers

Open marker list

Go to previous 
marker Go to next 

marker

Add loop markers
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Opening the list
To open the marker list, either select “Specialized Win-
dows”/”Wave Marker List” from the View menu, or click 
the corresponding button on the Marker toolbar.

The marker list

• To sort the list alphabetically, click on the “Name” head-
ing.

• To sort the list according to position, click the “Position” 
heading.
This is the default when you first open the window.

Marker appearance and visibility
Hiding marker heads

To hide/display the marker triangles from the ruler, click 
with the right mouse button in the ruler and select Hide/
Show Marker Heads.

Changing the appearance of marker lines

To hide the marker lines in the waveform, click with the 
right mouse button in the waveform and select Elements. 
From the menu that appears, set things up so that neither 
Solid markers, nor Dotted markers are activated.

Hiding all markers of a certain type

There’s a special dialog for hiding markers of certain 
types. To open it:

• Click with the right mouse button on the time ruler and 
select Visibility, or…

• Open the marker list, click with the right mouse button 
on a marker and select Visibility.

In this dialog you can show/hide markers of any type.

Editing, converting and naming 
markers
The Edit Marker window can be used to change existing 
marker’s properties. There are several ways to open this 
window with settings for a certain marker:

• Right click on the marker in the time ruler and choose “Edit 
Marker” from the menu that appears. 

• Hold down [Alt] and double click on the marker.
• Open the marker list, select a marker and click with the right 

mouse button on a marker and select Edit or press [Return].

To transform a marker into any other type, select that type 
in the list to the left.
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To rename a marker, uncheck “Automatic naming” and 
type in a name of your own choice. The name of the 
marker will then be visible beside it. The name of the 
marker will also be shown as a “tip” if you move the mouse 
pointer over the marker head and wait for a moment.

The name of the marker is shown as a “tip”.

• If the marker is a loop end marker you can change the 
number of loop repetitions by unchecking Infinite and 
specifying your own number of loops.

Moving and duplicating markers
To move a marker, press the mouse button over the trian-
gle “Head” and drag to the new position.

If “Magnetize bounds” is activated (see “Dropping on 
markers (Magnetize bounds)” on page 102) the marker 
“snaps” to the edges of the selection, the cursor’s posi-
tion and the beginning and end of the wave.

If you hold down [Shift] while dragging a marker in the 
ruler, you will be duplicating it instead of moving it.

Deleting markers

Deleting one marker from the Wave window
1. To delete a marker in the Wave window, click with the 
right mouse button on the head of marker you want to de-
lete.

2. Select Delete.
Alternatively you can drag the marker out of the window.

Deleting in the marker list
1. Hold down [Ctrl] and double click in the ruler.
The wave markers window appears.

2. Click with the right mouse button on the marker you 
want to delete.

3. Select Delete.

Deleting all markers of a certain type
1. Click with the right mouse button on the time ruler.

2. Select “Delete Multiple Markers…”.

3. Check the marker types that you want to delete.

4. Click OK.

Operations involving markers

Setting the wave cursor to a marker position
To move the wave cursor to a certain marker, do one of 
the following:

• Double click on the marker triangle.
This is probably the most convenient option if the marker is currently vis-
ible in the window. This even works during playback!

• Open the marker list and select one of the markers on it.
This is probably the most convenient option if the marker is outside the 
current view.

• Activate “Magnetize bounds” on the Options menu. 
Click on the ruler close to the marker, or drag the cursor to 
a position close to the marker.

Browsing markers
You can move the wave cursor from marker to marker by 
clicking the arrow buttons on the Marker toolbar, or by us-
ing the keys [4] and [5] on the numeric key pad.

Starting playback from a marker
There are several ways to make playback start from a cer-
tain marker:

• Locate to a marker, as described above, and activate 
playback from there.

• Double click on a marker in the marker list.

• Select one of the marker related options on the Trans-
port bar (see “Setting the start point for playback” on 
page 58 for details).

! When you delete one marker in a marker pair, the 
other marker will also be deleted.
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Selecting between markers
To select all audio between two adjacent markers, double 
click between them.

You can extend the selection to consecutive markers, by 
continuing to drag to the left/right.

To select all audio between any two markers, double click 
just to the right of the leftmost one, hold down [Shift] and 
double click just to the left of the rightmost one. 

Dropping on markers (Magnetize bounds)
For any operation involving drag and drop of audio mate-
rial you can use a marker position as start point for the 
section you drop. This is useful when it is very important 
that the dropped material is inserted at a very specific po-
sition.

1. Make sure Magnetize bounds (on the Options menu) is 
activated.

2. Drag the selection, and position the mouse pointer 
close to a marker line.
The “drag line” snaps to the marker line.

3. Make sure the marker line and the drag line appear on 
top of each other, then release the mouse button.

Looping
Loop markers are primarily intended for creating loop 
sounds (e.g. for samplers) as described in the section 
“Sampling and creating loops” on page 169, but you can 
use loop markers in various additional ways:

• Set up a loop and repeat it indefinitely during playback, 
while editing material inside the loop.
For more information on playback and loops, see “Looping” on page 58.

• Set up a loop with a specified number of repetitions, to 
check out how a repetition effect will sound.

• Note that you can nest loops, that is you can have loops 
inside loops.

Double clicking here…

…selects the audio between the markers.

Make this selection by dou-
ble clicking as above…

…then press [Shift] and double 
click to the left of the rightmost 
marker…

…to select all audio between the leftmost and rightmost markers.

If you point at a marker 
when using drag and drop, 
the audio will be inserted 
there.
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Introduction
The Audio CD Montage is an environment that lets you 
non-destructively edit, play back and arrange audio clips 
as tracks on an audio CD. Features include clip-based ef-
fects, volume automation, wide-ranging fade and cross-
fade functions and direct audio CD recording.

The Audio CD Montage is a great tool for mastering and 
music CD creation, but also for general multimedia work, 
radio spot production, etc.

Basic terminology

The Audio CD Montage can contain two stereo or mono 
audio tracks. These provide a way for the user to structure 
the work graphically, but should not be viewed as “virtual 
tape tracks”.

On an audio track, you can place any number of clips. 
These are “containers” for the audio, and include a num-
ber of settings and functions such as volume curves, 
fades, etc.

A clip contains a reference to a source audio file on your 
hard disk, as well as start and end positions in the file (al-
lowing clips to play back smaller sections of their source 
audio files). Any number of clips can reference the same 
source file.

In addition to audio tracks you can create a video track 
(see “Using video tracks” on page 130) in the Audio CD 
Montage.

The Audio CD Montage window

About the two panes and the views
The Audio CD Montage window is divided into two 
“panes”. The lower pane always shows the tracks and the 
clips, while the upper pane shows one of six views, as 
listed below.

• You can resize the upper and lower panes by dragging 
the divider between the panes up or down.

• You can choose to view the upper pane or the Track 
View only, by selecting “Show tabs only” or “Show Tracks 
only” from the main View menu.
To revert to the standard view (showing both panes), pull down the View 
menu again and deselect the selected option.

• You select views for the upper pane by clicking the tabs 
at the top of the Montage window (see below). 
Apart from the actual displays, the different views may have different 
menus and icon bars.

The following views are available:

View Description

Edit This is where you configure various options for edit-
ing, fading, selecting, etc.

Markers This view allows you to add and manage markers in 
the Montage. See “Using markers in the Montage” 
on page 127.

Video Displays the contents of the video track in the upper 
pane of the Audio CD Montage. See “Using video 
tracks” on page 130.

The CD view selected in the upper pane

The Track ViewClipsTracks
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• If the Montage window is too narrow to show all tabs, 
two arrow buttons are displayed in the upper right corner 
of the window.
Use these to “move” the row of tabs so that you can see and click the 
one you want.

About naming

Most of the views contain one or several menus. To make 
it clear which menu is meant in each case, we use the fol-
lowing syntax:

• X view : Y menu

For example, “Edit view : Options menu” means the Op-
tions menu in the Edit view.

The ruler
At the top of the Track View in the Audio CD Montage 
window, there is a ruler, similar to that in the Wave win-
dow. To change the ruler format, right-click in the ruler and 
make a selection from the pop-up menu that appears.

Selecting Meter format on the ruler pop-up menu

• Depending on the selected format, you can make de-
tailed display settings by selecting “Time format…” from 
this pop-up menu.

• It is also possible to offset the ruler, so that “zero” is 
somewhere other than at the actual start of the Montage 
(this is done by selecting “Time offset…”).

The time grid

If you like, a “grid” can be displayed in the Track View, 
consisting of vertical lines at every labeled position in the 
ruler. To show or hide the grid, right-click in the ruler and 
activate or deactivate the “Show Grid” option on the pop-
up menu.

Time grid activated

CD This is where you prepare for writing a CD directly 
from the Audio CD Montage (see “Preparing the Au-
dio CD Montage for CD burning” on page 132).

Files Contains various tools for audio file management, in-
cluding direct import of audio files into the Montage. 
See “The Files view” on page 117.

Notes A standard notepad.

View Description
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Assembling the Montage

Creating a new Montage
1. Pull down the File menu and open the New submenu.

2. Select the “Audio CD Montage…” item.
The Sample rate dialog appears.

3. Specify the preferred sample rate.
The audio files that you want to use in the Montage must have this sam-
ple rate. 

4. Click OK.
A new Audio CD Montage window appears, containing one stereo track.

Alternative ways to create a Montage

There are other ways to generate a new Montage “auto-
matically”:

• By importing Audio CD tracks directly to a Montage.
When using the Import Audio CD tracks function on the Tools menu, you 
can automatically create an Audio CD Montage playing the imported 
tracks. See “Convert to Montage” on page 145.

• By opening a Wave file and selecting “Create Audio CD 
Montage from Wave” on the Edit menu.
This option is also available in the Open – Wave dialog (File menu).

Handling tracks
Creating and managing tracks is done in the area to the 
left of the tracks in the Track View (from now on called the 
Track Control area). In the middle of this area is a button 
with the number of the track. Clicking this button brings 
up the track pop-up menu, which contains most of the 
track functions.

Adding tracks

There are two different track types available in the Mon-
tage: audio and video (see “Using video tracks” on page 
130).

1. Click on the track number button for a track next to 
where you want to add a new track.
The track pop-up menu appears.

2. Select one of the Add items at the top of the menu.
You can choose what type of track to insert and, if an audio track is to be 
inserted, whether the new audio track should be mono or stereo. By de-
fault, the new track is added below the focused track. If you wish to place 
it above the focused track rather than below, press [Ctrl] when adding 
the new track.

Moving tracks

To move a track up or down in the Track View, proceed as 
follows:

1. Click on the track number button for the track that you 
want to move.
The track pop-up menu appears.

2. Select “Move track up” or “Move track down”.

! If you plan to burn a CD from the Audio CD Montage, 
you have to select the 44.1 kHz sample rate.

! If you have saved a template (see “Saving a Montage 
template” on page 129), the Sample rate dialog will 
not automatically be displayed (since the new Mon-
tage will use the sample rate saved in the template).
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Deleting tracks

To remove unwanted tracks, proceed as follows:

1. Click on the track number button for the track that you 
want to delete.
The track pop-up menu appears.

2. Select Delete track.
If there are clips on the selected track, you will be asked whether you re-
ally want to delete the track. Click OK to proceed.

Folding tracks

To save screen space, you can fold tracks that you don’t 
need to have visible. This is done by clicking the arrow 
button at the top left corner of the Track Control area.

Click on the arrow…

…to fold the track.

To unfold a folded track, just click on the button again, or 
double click anywhere in the folded track.

Adding audio clips to the Montage
You can create clips by copying audio selections from 
Wave windows into the Audio CD Montage. There are 
several ways to do this:

By using drag and drop from Wave windows

Select the audio section that you want the clip to refer to, 
and drag the selection into the Montage window and drop 
it on a track.

A clip is created, named after the original audio file. You 
can change the name of clips in the Audio CD Montage, 
as described in the section “Renaming files and clips” on 
page 117.

• If you want to drag the whole audio file from the Wave 
window to the Audio CD Montage, you don’t need to 
make a selection first.
Instead you can click on the Document icon at the upper right corner of 
the Wave window and drag it to the Montage.

• You can also drag files into the CD view’s track list.

By inserting from open Wave windows

If one or several Wave windows are open, you can right-
click an empty area on a Montage track and select any 
open Wave from the pop-up menu that appears.

If several Wave windows are open you can also select “In-
sert all open waves” from the pop-up to insert them all.

By using Copy and Paste

1. In the Wave window, select the audio section that you 
want the clip to refer to.

2. Select Copy from the Edit menu, or press [Ctrl]-[C].

3. Make the Audio CD Montage window active. In the 
Track Control area, select the track on which you want to 
put the clip, then click at the desired position in the track.
This selects the track (as indicated by the highlighted Track Control area 
to the left) and sets the Montage cursor position (as indicated by the ver-
tical line). 

4. Select Paste from the Edit menu, or press [Ctrl]-[V].

! Deleting a track with clips will also delete the clips! 
However, the audio files to which the clips refer will 
not be affected. Also remember that you can recover 
accidentally deleted clips by using the Undo func-
tion.

! You cannot add a mono clip to a stereo track or vice 
versa. Also, the clip’s audio file has to have the same 
sample rate as the Audio CD Montage.

! Once you have added the desired clips from an au-
dio file, you don’t need to have the original Wave 
window open. Should you need to edit the original 
(source) audio file, you can access it from the clip 
speed menu, as described in the section “Editing 
source files” on page 117 (any editing done to the 
source audio file is immediately reflected in all clips 
referring to the file).
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By dragging from the Files view

This way, you can add clips without having Wave win-
dows open:

1. Select the Files view by clicking the Files tab.
The view now shows a file navigation environment, similar to the Win-
dows Explorer.

2. Use the left pane to locate and open the folder con-
taining the audio files you want to import.
The contents of the folder is shown in the right pane.

3. Locate the desired audio file(s) and drag them to a 
Montage track.

By importing files

1. In the Track Control area, select the track on which you 
want to put the clip, then click at the desired position in the 
track.
This selects the track (as indicated by the highlighted Track Control area 
to the left) and sets the Montage cursor position (as indicated by the ver-
tical line). 

2. Right-click in an empty area on the track and select 
“Insert audio file(s)…” from the pop-up menu that ap-
pears.
A regular file dialog appears.

3. Locate and select the file(s) you want to import, and 
click Open.
The new clips are then added.

By copying clips from another Montage

If you have more than one Montage open, you can copy 
clips from one Montage to another. This can be done ei-
ther by using drag and drop (from the Track View) or by 
using Copy and Paste. You can also use this method to 
copy clips within the same Montage.

By dragging clips from the CD view

You can add clips (that are already used in the Montage) 
by using drag and drop from the CD view’s track list.

About the auto-grouping options

The Track and Global auto-grouping icons.

There are two auto-grouping options that can be used 
when inserting clips. If any of these auto-grouping options 
are activated in the Edit view, clips to the right of the inser-
tion point will be moved to the right to “make room” for the 
inserted clips.

If you are adding several clips at the same time, these op-
tions affect the result in the following way:

• If “Track auto-grouping” is activated, clips on the same track, 
to the right of the insertion point, will be moved to the right to 
“make room” for the added clips.

• If “Global auto-grouping” is activated, clips on all tracks, to the 
right of the insertion point, will be moved in the same way.

! When dragging or selecting clips in the Track View, 
you need to click at the appropriate mouse zone, as 
explained in the section “About the mouse zones 
(audio tracks only)” on page 113.



109

The Audio CD Montage

Zooming and navigating

Horizontal and vertical zoom controls

The zoom “levers” in the upper and lower right corners of 
the Montage window work just like in the Wave windows. 

Note that changing the vertical zoom does not affect the 
height of the tracks. Rather, it affects the vertical magnifi-
cation of the waveforms within each (audio) clip.

Zooming in the ruler
As in the Wave windows, you can adjust the horizontal 
zoom by clicking in the ruler and dragging the pointer up 
or down with the mouse button pressed. Drag up to zoom 
out and drag down to zoom in.

If you hold down [Shift] while zooming this way, the 
Montage cursor position isn’t affected.

Changing the height of tracks
The height of the tracks (and thereby the number of tracks 
displayed in the Montage window) is governed by the 
track magnification controls in the lower right corner of the 
Montage window.

• Click on the large Magnifying Glass icon to “zoom in” – 
increase the height of the tracks.
This is the same as displaying one track less. When only one track is dis-
played, this icon will be greyed out.

• Click on the small Magnifying Glass icon to “zoom out” 
– decrease the height of the tracks.
This is the same as displaying one track more. When all tracks are visible, 
this icon will be greyed out. Consequentially, if the Montage only con-
tains one track, both Magnifying Glass icons will be greyed out.

• You can zoom in on a single track, making it fill the win-
dow.
This is done by clicking the numbered button to the left of the track to 
bring up the track pop-up menu, and selecting “Zoom”.

Zooming with the Rubber Band tool
1. Click the magnifying glass icon in the top left corner of 
the Track View.
The pointer takes on the shape of a “four-way arrow” with a magnifying 
glass.

2. Click and drag a rectangle in the Track View, to indi-
cate the section you want to zoom in on.
When you release the mouse button, the Track View is magnified, so that 
the section in the rectangle fills out the display. Note that the magnified 
view will include any tracks fully or partially enclosed by the rectangle.

Drag a rectangle and release the mouse button…

… and the selection is magnified to fill out the Track View display.

3. Deactivate the Rubber Band tool by clicking the icon 
again, or by right-clicking anywhere in the Track View.

• It is also possible to temporarily select the Rubber Band 
tool, by holding down [Ctrl] and aiming in an empty area of 
the Track View.
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Zooming in on a single audio clip
If you want to study an audio clip in detail, you can zoom in 
on it so that it fills up the track display:

1. Point at the audio clip.
Make sure you don’t aim at an envelope curve.

2. Click with the right mouse button.
The clip speed menu appears, containing various clip-based functions 
and settings.

3. Select “Zoom”, and from the submenu that appears, 
“Whole Clip”.
The Track View zooms in on the clip.

Zooming and navigating in the Edit Overview
When the Edit view is selected (by clicking the Edit tab), 
the upper pane shows an Overview of the Montage, with 
clips displayed as boxes. You can use this Overview to 
zoom in or out, and for navigating to other sections of the 
Montage. This is done by moving and resizing the Track 
View rectangle in the Overview:

• The Track View rectangle indicates the section of the 
Montage currently displayed in the Track View.

• You can zoom in or out, vertically or horizontally, by re-
sizing the Track View rectangle.

You can also resize the rectangle horizontally by holding down [Shift] and 
clicking. This will instantly move the closest edge of the rectangle to the 
clicked position.

• You can drag the Track View rectangle to view other 
sections of the Audio CD Montage.

• Clicking on one of the clip boxes outside the Track View 
rectangle will make the Track View zoom in horizontally on 
that clip.
The number of tracks shown will not change.

• Double clicking on one of the clip boxes in the Overview 
will make the Track View zoom in horizontally and vertically 
on that clip.

• Right-clicking anywhere in the Overview will make the 
Track View zoom out, so that the whole Audio CD Mon-
tage is visible.
The Key Command for this is [J].

• To identify a clip in the Overview, position the pointer 
over its box.
The name of the clip is displayed.

Moving the Montage cursor
To move the Montage cursor, you can either click at the 
desired position, use the Transport bar or use the com-
puter keyboard.

• You can click in the ruler, in an empty section of the 
Montage or within a clip (anywhere except in the mouse 
zone used for copying clips by dragging, and on the vol-
ume envelope line).
The mouse zone concept is described in the section “About the mouse 
zones (audio tracks only)” on page 113.

• The buttons on the Transport bar work as in the Wave 
windows.
The Fast Forward and Rewind buttons scroll the playback position for-
wards or backwards, while the start and end buttons move the playback 
position to the start or end of the Montage.

• The left and right arrow buttons on the computer key-
board can be used to move the Montage cursor in finer 
steps.
If you hold down [Ctrl] and press the left or right arrow button, the Mon-
tage cursor will jump to the nearest clip edge (start or end position of a 
clip). It is also possible to move the Cursor by using the Page Up, Page 
Down, Home and End keys.

The Track View rectangle
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Undoing view and position changes
There is a separate “Undo history” for zoom, view and po-
sition changes in the Audio CD Montage. This allows you 
to undo one or several changes, in the following way:

• To undo the latest change to the view, click the green 
left arrow to the left of the Track View ruler (or press [7] on 
the numeric keypad).
You can repeat this as long as there is any change to undo (as long as 
the green left arrow is lit). This Undo history includes changes to zoom, 
view and cursor position.

• To redo an undone view change, click the yellow right 
arrow to the left of the Track View ruler (or press [8] on the 
numeric keypad).

Maximizing the width of the Audio CD 
Montage
If you click the double arrow icon at the top left corner of 
the Track View, the Montage window is enlarged horizon-
tally to fill the screen.

Playing back
Playback in the Audio CD Montage works in much the 
same way as in the Wave windows.

Audio tracks are routed through the Master Section.
This allows you to add global effects to the Audio CD Montage or use 
the Render function to create a mixdown audio file (see “Mixing down – 
The Render function” on page 131).

Mute and solo
You can mute or solo tracks in the Montage by using the 
corresponding buttons in the Track Control area:

• Note that a track is muted when the green button is 
dark.

• Note that a track is soloed when the Solo button is blue 
(lit).

• The Solo buttons are exclusive, that is, solo can only be 
activated for one track at a time.

The track activity indicator

The track activity indicator is located on the right side of 
the Track Control area. This shows the volume level for 
audio tracks. It is not intended to give exact level readings 
but rather to provide an overview of which tracks are cur-
rently playing back audio, and at what approximate level.

Solo Mute

The track activity indicator
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About the track gain faders

The track gain faders are located to the left of the track ac-
tivity indicator in the Track Control area. They provide a 
simple way of adjusting the level for all clips on an audio 
track. 

• The track gain is independent from both the volume en-
velope and the clip gain. 

• The track gain can be lowered down to -48 dB, and in-
creased up to 6 dB.
If you change the level by dragging the faders, the fader handles change 
from grey to red/blue to indicate that the level is offset from the default 0 
dB setting. If you point at the faders, the current gain setting is shown.

• In the audio chain, the track gain affects the level post 
any clip effects and before the Master Section.

• The track activity meter does not reflect the track gain 
setting, nor is track gain reflected in the waveform.

• Press [Shift] and drag a fader handle to change the level 
for the left or right side of a stereo track separately. 
Press [Ctrl] and click on the fader to reset the level to 0 dB.

Playing back individual clips and selections
When editing and rearranging the Audio CD Montage, it 
can be useful to audition the individual clips and selec-
tions. This is done using the clip speed menu:

1. Right-click on the clip you want to play back (make 
sure you don’t click on the envelope curve, as this will open 
another speed menu).
The clip speed menu appears.

2. Select one of the “Play” items.
“Play clip” plays back the clip you clicked on. 
“Play (with Pre-roll)” plays back the clip you clicked on, starting slightly 
before the clip.

The clip speed menu

Playing back from the ruler
You can use the ruler to quickly locate to a position and 
start playback from there:

• Double clicking in the ruler starts playback from that po-
sition.
Playback continues until you press Stop (or until the end of the Mon-
tage).

• If you double click in the ruler and keep the mouse but-
ton pressed, playback will start from that position and stop 
when you release the mouse button.
After stopping, the Montage cursor will return to the position where you 
clicked. This is a handy way to quickly locate and audition positions in the 
Montage.

• If you single click in the ruler during playback, playback 
will immediately jump to that position.
This even allows you to “jump” between different document windows.
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Rearranging clips

About the mouse zones (audio tracks only)
Basic rearranging of clips in the Audio CD Montage is 
done by clicking and dragging with the mouse. However, 
the results of dragging with the mouse depend on where 
in the clip you click. The different areas in a clip are called 
mouse zones.

The mouse zones have the following basic functionalities: 

Magnetic bounds
When you move and edit clips, it is often useful to have 
them snap to other clips as well as to significant positions 
in the Montage. To facilitate this, certain items can be 
“magnetic”:

Activating Snap

In order to activate the Magnetic bounds option, you acti-
vate the Snap function by clicking the “Enable snapping” 
icon in the Edit view (or by pressing [N] on the computer 
keyboard).

Now, when you move or resize a clip and its edges (or its 
cue point) get close to one of the Magnetic positions, two 
things happen:

• The clip snaps to the magnetic position.
• A label is displayed, indicating what the clip snaps to.

To deactivate Snap, click the icon again or press [N].

Selecting clips
To select a clip (for copying, deletion, etc.), click in the 
bottom clip area.

Selected clips are normally displayed in a different color. You can edit 
this color, as described in the section “Defining custom colors” on page 
182.

• You can select multiple clips by [Ctrl]-clicking.
This works in the same way as selecting multiple objects in other Win-
dows programs.

Mouse zone Description

Top clip area Copy clip by dragging (see “Duplicating clips” 
on page 115).

Upper, lower and 
bottom clip area

Select clips and move clips by dragging (see 
“Selecting clips” on page 113 and “Moving 
clips” on page 114).

Upper and lower 
clip edges

Resize clips by dragging the edges (see “Resiz-
ing clips” on page 115).

Item Description

Start of 
Audio CD Montage

The start of the Audio CD Montage.

Clip’s cue-point A position within a clip that you set using the 
clip speed menu (see “Using cue points” on 
page 116).

Clip’s head The start of a clip.

Clip’s tail The end of a clip.

Audio CD Montage 
markers

Markers in the Audio CD Montage window 
(see “Using markers in the Montage” on 
page 127).

Cursor The Montage cursor position.

Top clip area Upper clip area

Lower clip area

Lower clip edge

Upper clip edge Upper clip 
edge

Lower clip 
edge

Bottom clip area
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• Holding down [Shift] and clicking allows you to select a 
range of consecutive clips (on the same track).
Again, this is similar to how you select ranges of objects in other Win-
dows programs.

Using the Select menu

The Edit view : Select menu holds several items for select-
ing clips:

About selected and focused clips

The program makes a distinction between selected and 
focused clips:

• A selected clip is a clip you have selected using the any 
of the procedures described above.
Several clips can be selected at the same time.

• The focused clip is the clip you selected (or clicked, or 
edited) last.
Only one clip can be focused at a time. By default, the focused clip is 
distinguished by a highlighted name label:

Clicking on the selected clip to the right makes it the focused clip.

Moving clips
To move a clip, proceed as follows:

1. If you want to move more than one clip, you need to se-
lect these clips first.

2. Position the pointer over the clip, in the lower clip area.
The pointer takes on the shape of a “four-way arrow”.

3. Click and drag the clip(s) in any direction.

• The clip(s) will snap to any activated magnetic bounds, 
see “Magnetic bounds” on page 113.

• If you move clips sideways, the auto-grouping settings 
are taken into account, as described below.
If you move the clip over another track, auto-grouping is temporarily dis-
abled until you release the mouse button.

• If you click on a clip, keep the mouse button pressed 
and then press [Shift], movement is restricted to vertical.
This is useful if you want to move a clip to another track without acciden-
tally changing its horizontal position.

• You cannot move mono clips to stereo tracks or vice 
versa.

Moving with auto-grouping

There are two options on the Edit view : Options menu 
that affect the result when you move clips horizontally: 
Track auto-grouping and Global auto-grouping. There are 
also separate icons for these options on the toolbar in Edit 
view mode:

• If Track auto-grouping is activated when you move a clip side-
ways, all clips to the right of it on the destination track will be 
moved by the same amount.

• If Global auto-grouping is activated when you move a clip 
sideways, all clips to the right of it in the whole Audio CD 
Montage will be moved accordingly.

Option Description

Select all clips Selects all clips in the Montage.

Select all clips at left of cursor 
(selected track)

Selects all clips with the endpoint to the 
left of the Montage cursor, on the selected 
track.

Select all clips at right of 
cursor (selected track)

Selects all clips that start to the right of the 
Montage cursor, on the selected track.

Deselect clips Deselects the currently selected clips.

Track auto-grouping Global auto-grouping
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About overlapping clips

You can move clips so that they overlap each other on the 
same track. Please note:

• The tracks in the Audio CD Montage are polyphonic, 
which means that each track can play back several over-
lapping clips at the same time. 
Overlapping clips will be transparent, allowing you to see the underlying 
clips and their waveforms.

• To select an overlapped (underlying) clip, double click 
in the bottom clip area.

• There is an automatic crossfading option that automati-
cally adjusts the volume envelope curves when you over-
lap clips.
This is described in the section “Using crossfades” on page 122.

Duplicating clips
To make a copy of a clip, proceed as follows:

1. If you want to copy more than one clip, you need to se-
lect these clips first.

2. Position the pointer over the clip, in the top clip area.

3. Click and drag the clip(s) in any direction.
While you are dragging the clip(s), a dotted line indicates where the first 
of the copied clips will end up.

4. Release the mouse button.

• The clip(s) will snap to any activated magnetic bounds, 
see “Magnetic bounds” on page 113.

• You cannot copy mono clips to stereo tracks or vice 
versa.

Duplicating with auto-grouping

If you are copying more than one clip at the same time, the 
auto-grouping settings in the Edit view affect the result 
(see “Moving with auto-grouping” on page 114):

• If Track auto-grouping is activated when you duplicate 
clips, all clips on the destination track, to the right of the 
new copy, will be moved to the right, to “make room” for 
the new clips.

• If Global auto-grouping is activated when you duplicate 
clips, all clips to the right of the new copy in the whole Au-
dio CD Montage will be moved to the right in the same 
way.

Resizing clips
In this context, “resizing” means moving the start and end 
points of a clip, so that more or less of the original audio 
file is “revealed” with the audio source being “static”.

As with other clip operations, the mouse zones determine 
when this function is used, and the pointer changes shape 
accordingly.

The “Resize clips” pointer.

Resize clips

You move the clip’s start or end point to the left or to the 
right:

1. Point at the left or right edge of the clip.
It doesn’t matter whether you click in the upper or lower half of the edge.

2. Click and drag to the right or left.

• You cannot drag the edge of a clip past the start or end 
point of the audio file it refers to.

• The clip edges will snap to any activated magnetic 
bounds, as described in the section “Magnetic bounds” 
on page 113.

• When you drag the right edge of a clip this way, the 
auto-grouping settings on the Edit view : Options menu 
are taken into account.
As when copying clips, this means that if Track auto-grouping is acti-
vated, all the following clips on the track will be moved when you resize 
the clip (so that the distance between the clip’s right edge and the next 
clip on the track remains the same).
If Global auto-grouping is activated, the same is true, but for clips on all 
tracks in the Audio CD Montage.

Resizing all selected clips

• If you press [Alt] when resizing, all selected clips will be 
resized by the same amount.
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Splitting a clip
You can split a clip in two, using the following method:

1. Set the Montage cursor to the position at which you 
want to split the clip.

2. Position the pointer over the cursor, in the top clip 
area.
The cursor takes on the shape of a pair of scissors.

3. Double click.
The clip is split in two. The two clips will have the same name and set-
tings. Envelopes and fades (see “The volume envelope” on page 117) 
are converted, so that the two clips play back as before.

• If the options “Create default fades in new clips” is acti-
vated on the Edit view : Fade menu, a crossfade is auto-
matically created between the resulting left and right clip.

• You can also split a clip by setting the Montage cursor 
and selecting “Split at Cursor” from the clip speed menu, 
or by pressing [S] on the computer keyboard.

Analyse and split at silences

You can use this function from the clip speed menu to 
split a clip into two or more separate clips. The clip will be 
analysed and split at its silent passages automatically. Af-
ter this a dialog will come up, allowing to adjust the pause 
times between the separate clips.

Deleting clips
There are two principal ways to delete a clip:

• Right-click on the clip to bring up the clip speed menu, 
and select “Delete clip”.

• Select it, and press [Backspace].
Instead of using [Backspace], you can press the [Delete] key or select 
“Delete” from the main Edit menu.

Using cue points
A cue point is a defined position marker that belongs to a 
clip. It may be positioned within or outside the clip. Cue 
points are displayed as dotted vertical lines.

A cue point

When you move a clip, its cue point will be magnetic to 
any edges, markers or other Magnetic bounds positions 
(see “Magnetic bounds” on page 113). There are several 
uses for this:

• Set the cue point at a “relevant” position in the audio and use 
it to align the clip with other clips, etc.

• Set the cue point before the start of a clip, allowing you to po-
sition clips in a row with pre-defined spaces (by magnetizing 
the cue point to the end of the previous clip).

• Set the cue point at the fade-in or fade-out point of a clip, 
making it easy to maintain defined fade lengths when cross-
fading (see “Using crossfades” on page 122).

To set the cue point for a clip, proceed as follows:

1. If you want to set the cue point at an arbitrary position, 
move the Montage cursor to that position.
This may be within the clip or outside it.

2. Right-click on the clip to bring up the clip speed menu.

3. Open the Cue point submenu.

4. Select one of the functions on the submenu:

Option Description

Set at cursor Sets the cue point at the current Montage cursor po-
sition.

Follows fade-in 
end point

Sets the cue point at the clip’s fade-in junction point 
(the left purple handle in the volume envelope). The 
cue point will follow the handle if you move it. See 
“Editing fades” on page 121.

Follows fade-out 
start point

As the previous option, but for the fade-out start 
point.

! Each clip can only have one cue point. This means 
that if you repeat the procedure above and select an-
other option on the submenu, the cue point will be 
moved to a new position.
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Managing clips and source files
There are some functions to help you check and manage 
the relationship between the clips and their source audio 
files:

The Files view

The Files view shows the files and folders on your hard 
disk, and can be used for importing audio files via drag 
and drop into the Audio CD Montage (see “By dragging 
from the Files view” on page 108).

Editing source files
Editing the Montage may require that you process or edit 
the actual audio files referenced by the clips. This is done 
in the following way:

1. Double click in the Top Clip area (the mouse zone used 
for dragging/copying clips), or drag the clip from there 
onto the WaveLab Essential desktop.
A Wave window opens, showing the referenced source audio file with a 
selection corresponding to the clip.

2. Edit the file as desired, save it and return to the Audio 
CD Montage.

Please note the following:

Any editing you perform this way will affect all clips 
that use the audio file (including clips in other Audio CD 
Montages).

You can undo/redo all changes in Wave windows, and 
these changes will be reflected immediately in all open 
Montages.

If you reduce the length of the source audio file, so 
that it ends before the clip end point, the end of the corre-
sponding clip(s) will be displayed in another color (inverse 
video), to alert you.

If you use “Save as” to save the source audio file un-
der another name, the Montage will now refer to that new 
file instead.
This is true for all open Montages that refer to the file.

Renaming files and clips
You can rename source files and have all open Montages 
that reference the audio files automatically be updated. 
Just use the Rename dialog (see “Renaming files and doc-
uments (Rename)” on page 53).

You can also freely rename clips within a Montage simply 
by double clicking the clip’s name label (this will in fact 
take you to the CD view automatically, where you can re-
name the clip in the track list).

The volume envelope
It is possible to create independent volume envelope 
curves for the clips in the Audio CD Montage. These en-
velope curves are used to automate volume, to create 
fades and crossfades, and for muting sections of clips.

How the envelope is displayed 
All clips display a volume envelope curve. Actually, you 
should view the volume envelope as three separate enve-
lopes: the fade-in part, the “sustain part” and the fade-out 
part. The purple points to the left and right on the curve 
are the fade-in and fade-out junction points that separate 
the fade parts from the sustain part.

The default volume envelope, with zero fade-in and fade-out times. 

The fade-in and fade-out parts of the envelope are de-
scribed in the section “Using fades and crossfades in the 
Montage” on page 121. The following pages describe the 
“sustain part” of the envelope, that is, the section between 
the two fade junction points.
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Graphic display of envelope curves

The envelope curve indicates at a glance if points, fade-
ins or fade-outs have been defined. In addition to the 
curve, changes in the volume envelope are also reflected 
in the waveform itself.

A defined volume envelope curve with the waveform reflecting the en-
velope changes.

The volume envelope mouse zone

The default envelope curve contains no volume envelope 
points. In this condition you can still use the curve to 
change the overall volume for a clip. Proceed as follows:

1. Place the mouse pointer on the curve.
The mouse pointer takes on the shape of a circle with two arrows point-
ing up and down, indicating the envelope mouse zone. A label also ap-
pears displaying the current clip volume in dB. 

The volume envelope mouse zone

2. Click and drag the curve up or down to change the 
clip volume and release the mouse button.
A label appears displaying the new clip volume in dB.

Editing envelopes

About using key commands

On the envelope speed menu, you will find that most func-
tions have key commands. These will affect the envelope 
curve with the focus.

The focused envelope curve is displayed with yellow 
handles for the envelope points.

To set the focus to an envelope curve, click on it.

Adding volume envelope points

The volume envelope points allow you to “draw” volume 
curves in the clip. To add a point, double click on the en-
velope curve (or select “New point” from the envelope 
speed menu). You may add as many points as you like.

Selecting envelope points

Clicking on an envelope point selects it (it becomes red). 
You can also select several envelope points. The following 
rules apply:

• [Shift]-click (on a point) to select all points between a 
previously selected point and the current point.

• [Ctrl]-click (on a point) to select non-contiguous points 
in the envelope curve.

• [Alt]-click (anywhere in the clip) and draw a selection 
rectangle.
All points inside the rectangle become selected.

Deselecting points

You can deselect all selected points by clicking on a se-
lected point or by selecting “Deselect all points” from the 
envelope speed menu. To deselect a single point 
(amongst other selected points), [Ctrl]-click the point you 
want to deselect.

! The envelope mouse zone is always linked to an en-
velope curve.

! The following sections apply to both volume and 
fade envelope points. In other words, you can select, 
deselect and move both sustain and fade envelope 
points.

The focused 
envelope curve.
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Dragging volume envelope points

• To move a point, click on it and drag it in any direction.
The junction points (the points separating the Fade parts and the sustain 
part) will only move horizontally this way. To move a junction part verti-
cally, press [Ctrl] and drag.

• To move several selected points, click any selected 
point and drag in any direction.
All selected points will be moved.

• Clicking on a curve segment (i.e. the part of an envelope 
curve between two selected points) allows all currently 
selected points to be moved vertically. 
You are constrained to vertical movement using this method.

• Clicking on a curve segment (i.e. the part of an envelope 
curve between two selected points) and then pressing 
[Shift] allows all selected points to be moved horizontally. 
You are constrained to horizontal movement using this method.

• [Ctrl]-clicking on the envelope curve and dragging it up 
or down will select (and move) the two nearest points to 
the right and left respectively.
You are constrained to vertical movement using this method. This 
method is useful as a shortcut for quickly adjusting the level of a curve 
segment.

• [Shift]-clicking on the envelope curve and dragging it 
left or right will select (and move) the two nearest points to 
the right and left respectively.
You are constrained to horizontal movement using this method. This 
method is useful when working with “Duck according to other track” (see 
“Duck according to other track” on page 119) since it allows you to 
quickly adjust the position of duck regions.

• Clicking and dragging the envelope curve up or down 
selects (and moves) all points.
You are constrained to vertical movement using this method. Note that 
points set to the minimum value are not affected.

• Holding down [Alt] and dragging the envelope curve up 
or down adjusts the corresponding envelopes in all se-
lected clips.
This is a quick way to adjust the level or pan of several clips at the same 
time.

Deleting volume envelope points

There are three ways you can delete points:

• By double-clicking on a point.

• By right-clicking on the point and selecting “Delete point” 
from the envelope speed menu.

• By selecting points and selecting “Delete selected point(s)” 
from the envelope speed menu.

Resetting points and envelopes

There are various ways to reset the envelope:

• To reset a point to 0dB, right-click on the point and se-
lect “Reset point” from the envelope speed menu.

• To reset the whole envelope curve to default, right-click 
the envelope curve and select “Reset all” from the speed 
menu.

• To reset the sustain part of the volume envelope only, 
select “Reset sustain to 0dB” on the envelope speed 
menu.
All volume envelope points will be removed, but any defined fades will be 
left untouched.

Duck according to other track

This feature allows you to create ducking effects between 
clips on two adjacent tracks. Normally, ducking is when 
the signal level on one track or channel is automatically 
lowered by the presence of another signal on another 
track or channel. With “Duck according to other track” it is 
not the presence of another signal that causes ducking to 
take place, but the presence of another clip on an adja-
cent track.

The most obvious application of this feature is when mix-
ing background music with a voice-over. When the voice-
over starts, the level of the music is automatically lowered 
and when the voice-over stops, the level of the music is 
restored to the original level. This is done by automatically 
creating volume envelope curves. In the following example 
we have chosen to use “music” on the track to which 
ducking will be applied and a “voice-over” on an adjacent 
track that will cause ducking to take place.

! The junction points between the sustain and fade 
parts of the envelope cannot be deleted.

! The clips that cause ducking must be located com-
pletely inside the time range of the clip to which 
ducking is applied.
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Proceed as follows:

1. Place the clips containing the music and the voice-
over on separate adjacent tracks.
Make sure the voice-over clips are located inside the time range of the 
music clip.

The three voice-over clips on the upper track are placed inside the time 
range of the music bed on the track below.

2. Open the envelope speed menu for the clip containing 
the music, and select “Duck according to other track…”.
The Ducking options dialog opens.

The Ducking options dialog

3. Click the appropriate “Previous track” or “Next track” 
radio button in the “Clips to follow” section (according to 
whether the voice-over track is above or below the music 
track in the Montage).
For now, we will use the default settings for the other dialog options.

4. Click “OK”.
The level of the music is automatically lowered by the voice-over clips, as 
shown in the illustration below.

After applying “Duck according to other track”

The following parameters can be set in the Ducking op-
tions dialog:

! If the clip(s) that cause ducking contain silent pas-
sages, ducking will not work properly. These clips 
have to be edited so that each phrase is a separate 
clip without any silence. This is because it is not the 
signal level that activates the ducking, but the clip it-
self.

! When “Duck according to other track” is performed 
it is applied to one clip at a time. If the music (in our 
example) consists of several clips that have been 
spliced together, only one of the clips will be ducked 
by the voice-over. One solution is to repeat the func-
tion for each clip, another is to use the “Render” 
function (see “Mixing down – The Render function” 
on page 131) in the Master Section to create a spe-
cific (single) file from the separate clips, and re-im-
port this as a new clip in the Montage.

Parameter Description

Fall Duration The time it takes for the level to fall when ducking 
starts.

Rise Duration The time it takes for the level to rise to the original 
level after ducking ends.

Gap before Clip
(Fall)

The time between the end of the Fall region and 
the start of the voice clip.

Gap before Clip
(Rise)

The time between the end of the voice clip and the 
start of the Rise region.

Balance clip 
fade-in

If this is ticked, any Duration or Gap settings in the 
Fall region will be ignored. Instead the ducking en-
velope will lower the volume according to the time 
of the voice clip’s fade-in curve.

Balance clip 
fade-out

If this is ticked, any Duration or Gap settings in the 
Rise region will be ignored. Instead the ducking 
envelope will raise the volume according to the 
time of the voice clip’s fade-out curve.

Damp factor This sets the amount of ducking, i.e. the level of at-
tenuation applied to the affected clip.

Clips to follow This determines whether the track that will cause 
ducking to take place is positioned before or after 
the track that will be ducked. If “Only selected 
clips” is ticked only the selected clips on the spec-
ified track will cause ducking.
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Using fades and crossfades in the 
Montage
There are a number of different options to choose from 
when creating and editing fades and crossfades in the 
Montage. These are described in the following sections.

Creating fades
As mentioned earlier, by default all clips display a fade-in 
and a fade-out junction point. These can be dragged hori-
zontally to create a fade-in or fade-out for a clip. You can 
add envelope points to a fade just as with volume enve-
lopes. To create a fade, proceed as follows:

1. Click on the fade-in point at the beginning of a clip and 
drag it to the right.
The resulting linear (by default) fade-in curve is displayed in the clip, and 
the fade is also reflected in the waveform. If you position the mouse over 
the fade-in point, a label appears, showing the fade-in time in seconds 
and milliseconds, and the volume in dB.

A linear fade-in

2. To create a fade-out, use the same basic procedure 
but instead click and drag the fade-out point at the end of 
the clip to the left.

• By default you can only move the fade junction points 
horizontally. To move them up or down, you need to hold 
down [Ctrl] and drag.

Editing fades

The operating procedure when creating and editing fades 
is identical to volume envelopes. Please refer to the vol-
ume envelope section for details.

• To make editing of fades easier, there are special Zoom 
options on the clip speed menu, for zooming in on the 
fade-in or fade-out area.

Fade Options

Editing the fades of all selected clips

If you press [Alt] and change a fade-in or fade-out point, 
this will affect all selected clips simultaneously.

Create default fades in new clips

If this option is ticked on the Edit view : Fade menu, all 
new clips that are imported or recorded in the Montage 
will get the default fade-in and fade-out shape and length. 
This is also true for clips that are created by splitting a clip.

Using the fade- in/out ROM presets

If you select “Fade-in/out ROM Presets” on the envelope 
speed menu, a submenu opens where you can select var-
ious preset curves.

The following curve types can be selected (in these exam-
ples fade-in curves are used – the corresponding fade-
out curves would of course display the mirror image):

! Note that the fade junction points (the points sepa-
rating the fade parts from the sustain part) have a 
special property: If you move a junction point, all 
other points in the corresponding fade are moved 
proportionally, to maintain the shape of the fade!

! The fade-in/out ROM presets are only selectable on 
the envelope speed menu if the respective fade-in/
out length in the clip is defined, i.e. not set to zero.

Fade-in curve type Description

Linear This is the factory default fade curve. 
A straight line between two points.

Sinus This produces a fade-in curve that 
starts out moderately fast but planes 
out towards the end. This curve type 
will provide a constant power cross-
fade.
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Using crossfades
A crossfade is a gradual fade between two clips, where 
one is faded in and the other faded out. Crossfades in the 
Montage are created automatically when clip edges over-
lap. To create an automatic crossfade, proceed as fol-
lows:

1. Click on the Edit tab and open the Edit view : Fade 
menu.

2. Select the menu item “Automatic crossfading – free 
overlaps”.
This can also be selected by clicking the automatic crossfade icon.

The automatic crossfade icon

3. Move a clip so that it overlaps the edge of another clip.
The crossfade is automatically created in the overlap; by default two 
equal length linear fade curves, one fading out and the other fading in. 
This will also happen if you paste a clip so that it overlaps another clip.

Crossfade option

The automatic crossfade option on the Edit view : Fade 
menu determines if automatic crossfades will be created 
in the Montage: 

• Automatic crossfading – free overlaps.
If this is activated, automatic crossfades are created when a clip overlaps 
the edge of another clip on the same track, and the length of the overlap 
determines the length of the crossfade.

Editing crossfades

The factory default automatic crossfade is linear, using the 
same shape and fade lengths for both the fade-in and 
fade-out. Most of the time, an unaltered linear or sinus 
crossfade will produce the desired result. You can, how-
ever, create crossfades with totally independent shapes 
and lengths for the fade-in and fade-out curves. The fol-
lowing rules apply:

• You can edit the fade-in and fade-out curves in cross-
fades in exactly the same way as fades.

• To change the crossfade time (the width of the cross-
fade zone) “symmetrically”, press [Shift] and move left and 
right.

• Press [Ctrl] and move left and right to “slide” the cross-
fade region while keeping its length.

Changing the crossfade time (left), and sliding the crossfade region 
(right).

Square-root This creates a curve that fades in 
quickly then planes out. This curve 
type will provide a constant power 
crossfade.

Sinusoid This creates an s-shaped fade, with 
a medium slow start and end fade.

Logarithmic This creates a curve that fades in 
fast in the beginning, reaching full 
level early in the fade.

Exponential This creates a curve that fades in 
slowly in the beginning.

Exponential + This creates an even more pro-
nounced exponential curve.

Fade-in curve type Description
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Please note that for these two functions to work, the 
mouse pointer must not be positioned on an envelope 
curve point inside the crossfade region.
If the mouse pointer is positioned on an envelope point, this point was 
the priority and you cannot change the crossfade time nor slide the 
crossfade region.

• When you move a clip so that it overlaps another clip to 
create a crossfade, and neither clip has a defined fade in 
the overlap, a default crossfade is created.

• When moving a clip with a defined fade curve so that it 
overlaps another clip’s adjacent edge (without a defined 
fade), the unmoved clip automatically gets the same fade 
shape as the moved clip (but as a corresponding opposite 
fade), with amplitude compensation.

Dragging the right clip so that it overlaps the left clip…

…will use the right clip’s fade shape (as a corresponding fade-out), to 
create a crossfade.

• If both clips have different defined fade curves at their 
adjacent edges when creating a crossfade, this will create 
an asymmetrical crossfade, based on the defined fade 
curves.

! Note that the above only applies if the unmoved 
clip’s fade-out length is set to zero.

Dragging the right clip so that it overlaps the left clip…

…creates a crossfade based on the already defined fades.
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Adding effects to clips
The Montage supports VST effect plug-ins for individual 
clips. The standard WaveLab Essential and DirectX plug-
ins cannot be used as clip or track effects in the Montage, 
but VST versions of several standard WaveLab Essential 
effects are provided, as well as several of the standard 
Cubase VST effects. Each clip in the Montage can be in-
dependently processed by one VST effect plug-in. Effects 
are configured either as Inserts, when all sound is pro-
cessed by the effect, or as Send effects (“Split mode”) 
where the balance between the unprocessed sound and 
the effect send level can be adjusted.

Adding a clip effect slot 
To add an effect to a clip, proceed as follows:

1. Open the clip speed menu by right-clicking the clip.

2. Select “Effect (unused)” from the menu.
A slot is created and a dialog box opens where various settings relating 
to that slot can be made. Leave the dialog open for now.

Selecting an effect for a slot
1. Click on the button marked “Effects”.
A pop-up menu opens containing all installed VST plug-ins.

2. Select one of the effects from the menu.
The chosen effect’s parameters appear to the left in the dialog. 

3. Change the parameter settings as desired.

4. When you are done, click “Close” to close the dialog 
or leave it open if you want to make more adjustments 
later.
You can continue working with the Effect dialog open. It is also possible 
to have several Effect dialogs open.

If a clip effect has been added, the number [1] is displayed 
before the clip name. This is to indicate that an active ef-
fect slot is used for that clip.

Removing an effect from a slot
1. To remove a clip effect from a slot, open the clip speed 
menu and select the effect you want to remove from a slot.
The effect window opens.

2. Click on the “Effects” button, and select “Remove” 
from the pop-up menu that appears.
The effect is removed from the slot. You can now either select a new ef-
fect for the slot or leave the slot unused.

Effect type: Insert or Split Mode?
Clip effects can be configured either as Insert or Send ef-
fects. This is done using the “Split mode” setting in the Ef-
fect dialog (see “The Effect dialog” on page 125). 

• When Split mode is deactivated for an effect, it is 
treated as an insert effect.
This means the whole clip signal is routed through the effect. Typical in-
sert effects would be compressors, auto panners or distortion units, etc. 

• When Split mode is activated for an effect, it is treated 
more as a send effect.
In this mode, you can adjust the send level to the effect. Note that Split 
mode is different to conventional send effects in that the effect signal is 
mixed directly into the audio path and not to an effect return section. Typ-
ical Split mode effects would be reverb, chorus or delay, etc.

! Only clip effects for clips that are active at the cur-
rent playback position will consume any CPU power.

! DirectX plug-ins from Waves Ltd. can be used as 
Montage effects by using the Waves VST shell.

! The first time you play a Montage after opening or 
cloning it, the program has to load all effects into 
memory. If you have a lot of effects, this may result in 
a short silence before playback starts.

! You can add effects during playback. However, if 
you add an effect with a latency larger than zero (dis-
played to the right in the Effect dialog, see “Latency” 
on page 125), you should stop and restart playback 
to avoid timing discrepancies.
Also, a small number of VST plug-ins may change la-
tency depending on parameter settings. If that is the 
case, make sure to stop and restart playback after 
the latency is changed.

! Unused slots do not consume any CPU power.

! Some effects are always in Insert mode or always in 
Split mode. For these effects, the Split mode setting 
is greyed out and cannot be changed.
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The Effect dialog

The Effect dialog

When an effect is selected, the left part of the Effect dia-
log contains the parameters for the effect. The right part of 
the dialog contains a number of options and functions that 
are common (although some settings may be disabled de-
pending on the effect type, as explained above). 

The dialog contains the following common elements:

Copying effect settings to another clip

You can copy both the effect type and its settings and 
paste them into another clip. Proceed as follows:

1. Select the effect you want to copy the settings from.

2. Select “Copy” from the Functions menu in the Effect 
dialog.

3. Right-click the clip which you want to paste the ef-
fect’s settings, and either select “Effect (unused)” or an 
existing effect slot (if you want to replace the existing ef-
fect).

4. Select “Paste” from the Functions menu.
The copied effect type is added to a new slot along with the effect set-
tings you copied.

Undoing effect changes

It is possible to undo changes to the effect settings. How-
ever, WaveLab Essential will only “register” the changes 
(thus making them undoable), when the Effect dialog 
loses focus. Therefore, if you have made an effect setting 
change that you want to undo:

1. Click on another window, so that the Effect dialog los-
es focus.
The new effect setting is registered by WaveLab Essential.

2. Select Undo as usual.

3. Go back to the Effect dialog to continue working (if 
you wish).

Dialog item Description

Send level 
slider

This controls the send level for the chosen effect. Only 
available when Split mode is selected. 

Latency Certain effect plug-ins that have to analyze the sound be-
fore passing it on, will introduce a latency (delay) in the au-
dio path. WaveLab Essential automatically compensates 
for this delay with regard to other tracks. However, real-
time changes (like turning an effect knob) will be delayed 
according to the maximum latency found among all clips 
(the largest sum of latencies for a single clip). Plug-ins 
with latency cannot be used as Split mode effects (see 
below).

Tail Effects like reverb and delay produce audio “tails”, i.e. the 
effect sound continues after the clip sound ends. If for ex-
ample you add echo to a clip without specifying a tail 
value, the echo effect is muted as soon as the clip ends, 
which is in most cases undesirable. Set the tail length so 
that the effect is allowed to decay naturally. The maximum 
tail setting is 30 seconds.

Split mode If Split mode is activated for an effect, the send level for 
the effect can be adjusted, as described in the section “Ef-
fect type: Insert or Split Mode?” on page 124. For some 
effects, this setting cannot be changed.

Bypass If this is activated, the effect is bypassed.

Effects 
button

This button opens the Effects menu where you can select 
to remove the slot’s current effect, or select a new one 
from the menu for the same slot. Changing the effect using 
this menu will erase any unsaved changes to the previ-
ously selected effect.

Preset 
button

This button opens the preset menu where you can load or 
save effect banks or effects. There are also two items 
named Load and Save Default Bank. Saving as default 
bank will store the effect settings in the same folder as the 
plug-in’s .dll file, and each time you load the plug-in this 
bank will automatically be loaded. This is the way to cus-
tomize the default presets of a plug-in. 

Functions 
button

This button opens the Functions menu which allows you to 
copy and paste effect settings between clips. See “Copy-
ing effect settings to another clip” below.

! Stereo plug-in settings can’t be pasted onto mono 
clips (the same applies for mono plug-in settings and 
stereo clips).

Dialog item Description
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The Meta Normalizer
The Meta Normalizer, found on the Edit view : Special 
menu, is a special tool for setting clip gain levels. The pro-
cessing is non destructive, i.e. it will not affect the source 
audio files. 

The Meta Normalizer operates in two or three passes. It 
first analyses the peak or RMS levels on all clips in the 
Montage. Then it processes the clips according to the 
highest possible level found amongst the clips, so that 
they will all play back at equal peak or RMS levels. This is 
achieved by automatically adjusting the clips “Gain” set-
ting in the CD view’s track list. Note that the gain level of a 
clip can either be amplified or reduced. The two purposes 
of the Meta Normalizer are to equalize the loudness be-
tween all clips (useful e.g. when producing a CD) and to 
ensure that the full mixdown of the Montage will never clip. 
Depending on how much the levels differ between clips, 
there are a number of options available to ensure that the 
applied processing optimizes the levels without clipping.

The Meta Normalizer dialog

The Meta Normalizer settings dialog

Selecting the Meta Normalizer from the Edit view : Special 
menu opens a dialog where you can set up various op-
tions before applying the processing. The dialog is divided 
into two pages; “Settings” and “Schedule”, which you can 
switch between by clicking on the appropriate tab at the 
top of the dialog. In the Settings dialog you specify how 
the clips will be processed, and in the Schedule dialog 
you set up options related to the performance of the pro-
cessing (which always happens in the background).

The options on the Settings tab in the Meta Normalizer di-
alog are listed on the next page.

• When you have set up the Meta Normalizer dialog, click 
the “Process” button to activate processing.
Processing happens in the background. You can go on working in 
WaveLab Essential during the processing, although not in the Montage 
being processed.

! The audio path in WaveLab Essential uses 32 Bit 
floating point processing. You can therefore “over-
load” it, i.e. use levels above 0 dB, without running 
the risk of causing clipping in the signal path. The 
only section of the audio path that can introduce 
clipping is the output of the Master Section, and this 
can also be taken care of by the Meta Normalizer.
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The following options are available in the Meta Normalizer 
dialog:

Using markers in the Montage
Separate markers are provided for use in the Montage. 
Markers are used in the Montage in much the same way 
as in the source Wave windows. See “Markers” on page 
97 for details regarding marker types and the basic func-
tionality of markers.

Creating markers
The quickest way to create a marker is to right-click in the 
area above the ruler and select a marker type from the 
pop-up menu that appears. Right-clicking this way auto-
matically moves the cursor to the click position (provided 
that you don’t click on an existing marker) and inserts the 
marker at the cursor position – i.e. the position at which 
you click. 

Creating markers by right-clicking can be done regardless 
of what view is currently selected.

 
The Markers view

When the Markers view is selected, you can create mark-
ers at the Montage cursor position by using one of the fol-
lowing methods:

• By selecting a marker type from the Markers view : Insert 
menu.

• By clicking on one of the marker icons.
• By pressing the [Insert] key (this creates a Generic marker).

Moving markers in the Track View
To move a marker in the Track View, you click and drag it. 
The "Enable snapping" setting on the Edit view : Options 
menu applies.

Option Description

Equalize Clip Volume Selecting this will process all clips in the 
Montage according to the highest possible 
level or loudness found amongst the clips, so 
that they will all play back at equal levels.

Equalize peak level Select this option if you want to use peak lev-
els as a basis for determining what is consid-
ered “equal level” when executing Equalize 
Clip Volume.

Equalize loudness 
(RMS)

Select this option if you want to use RMS 
(Root Mean Square) levels as a basis for de-
termining what is considered “equal level” 
when executing Equalize Clip Volume. RMS 
normally produces more natural results than 
using Peak levels, since this method is better 
at detecting the perceived “loudness” of a 
sound.

Global When this is activated, the RMS value is cal-
culated over the whole clip. That is, the over-
all loudness of entire clips will be used as a 
basis for calculating the loudness.

Resolution 
(0 – 10 seconds)

This option is only relevant if “Equalize Loud-
ness (RMS)” has been selected and “Global” 
is deactivated. It is used to set the size of the 
audio sections that are analysed when calcu-
lating the loudness. The loudest section 
found will be used. The smaller this value, the 
more sensitive the method will be to peaks in 
the material.

Normalize Mix 
(Master Section Input) 
(-24 to 0 dB)

If this is selected, the entire Montage mix will 
be normalized to a preset level at the Master 
Section input. The maximum level that can be 
used is 0 dB. Since there is no risk of clip-
ping in the 32 bit internal audio path, you can 
usually turn off this feature.

Normalize Master Section 
Output 
(-24 to 0 dB)

If this is selected, the entire mix will be nor-
malized to a preset level at the Master Sec-
tion output. The maximum level that can be 
used is 0 dB. This function is useful before 
you mix down or create a CD. 
Note that this function affects the output of 
the Master Section, which is “outside” the 
actual Montage. Therefore, the effect of this 
function is not saved when you save the 
Montage.

Exclude effects If this is selected, effects will not be taken 
into account when processing with the Meta 
Normalizer.

Only selected clips If this is selected, only selected clips will be 
processed with the Meta Normalizer.

! You can also use any of the above methods to create 
markers at the current cursor position while playing 
back.



128

The Audio CD Montage

Deleting markers
There are three ways to delete markers in the Montage:

• By right-clicking the marker head and selecting “Delete 
marker” on the menu.

• By selecting the markers and then selecting “Delete se-
lected markers” on the Markers view : Functions menu.

• By dragging the marker up and dropping it outside the 
ruler.

Editing in the markers list view
Clicking on the Marker tab opens the Markers view in the 
upper pane of the Montage. By default, this list contains all 
markers currently in the Montage. Below the Montage 
tabs there is a row of marker icons, and to the left of them 
are the Markers view : Insert and Functions menus. The 
markers list columns are used for editing and/or displaying 
the following marker data:

About locking marker positions to clips

As described in the table above, you can lock markers to 
clips by selecting one of the Functions menu items “Make 
current marker relative to start of focused clip”, “Make cur-
rent marker relative to end of focused clip” or “Make cur-
rent marker relative to audio of focused clip”. If selected, 
the marker will remain in the same position relative to the 
clip start, end or audio position even if the clip is moved in 
the Montage or is resized. 

Selecting the Functions menu item “Detach current marker 
from its relative clip” removes the marker’s clip reference 
and the marker position is no longer locked to the clip.

About attaching markers to clips

On the Functions menu there are two items that control if 
and how markers you insert should be automatically at-
tached to existent clips. If a marker is attached to a clip, 
the marker will move with and maintain its relative position 
to the clip if the clip is moved or resized.

Activating the option “Attach automatically new markers to 
the most suitable clip” results in the following:

• If a marker is created within the boundaries of a focused clip 
or a clip on a focused track, the marker is attached to the au-
dio of that clip (as per the option “Make marker relative to au-
dio of focused clip” described above).

• If a marker is created outside of any clips on the focused track 
(or if there is no clip on the focused track) but within the 
boundaries of a clip on any other track, the marker will be at-
tached to the audio of that clip.

Note that the marker must be inserted within 2 sec-
onds from a clip edge in order to get attached. 

Activating the option “Full clip attachment” will cause at-
tached markers to not only remain in position relatively to 
clips when you move them, but also to be attached during 
clip operations. That means; if you copy a clip, the at-
tached markers will also be copied. If you delete a clip, the 
attached markers will also be deleted.

Option Description

Type This column displays the corresponding marker type 
icon. Clicking the icon opens a pop-up menu where 
you can select a new marker type for the current 
marker position.

Name Displays the marker name. Double click the name field 
to type in a new name. This can also be done by dou-
ble clicking to the right of the marker head in the area 
above the ruler (the pointer changes shape when you 
move it into the “Marker name zone”).

Position This column displays the markers’ time positions. 
Double click to edit.

Lock If this is ticked, the marker cannot be moved by drag-
ging the marker head.

Clip reference By selecting one of the Functions menu items “Make 
current marker relative to start of focused clip”, “Make 
current marker relative to end of focused clip” or 
“Make current marker relative to audio of focused clip” 
you can lock a marker position to the left or right edge 
of a clip, or to its audio position. This column displays 
the name of the clip to which a marker is locked.

Offset Depending on which of the three Functions menu 
items described above is chosen, this column displays 
the time offset between the clip and the marker posi-
tion.
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File handling in the Audio CD 
Montage

Saving the Montage
You save the Montage using the Save or Save As com-
mands on the File menu. Audio CD Montage files have the 
extension “.mon”. 
A couple of things to note:

The Montage files do not contain any audio data in 
themselves.
Rather, they contain references to audio files. This means that you must 
make sure not to delete, move or rename any audio files referenced by 
Montages.

You can use the Rename dialog to rename (and/or 
move) audio files and automatically update all clip refer-
ences.
See “Renaming files and documents (Rename)” on page 53.

If the Audio CD Montage contains clips that refer to 
untitled audio files, you will be asked to save these audio 
files before you can save the Montage.

Saving a Montage template
Once you have set up the Audio CD Montage window the 
way you want it, you can save it as a template. The tem-
plate file contains all settings and options in the Montage, 
but no clips. Next time you create a new Audio CD Mon-
tage (by selecting New Audio CD Montage on the File 
menu), the Templates dialog will come up and you can se-
lect to open a template, which is used as a basis for the 
new Montage. This allows you to create custom track lay-
outs and other settings, stored in different templates.

To save a template, pull down the File menu and select 
“Save as template…”.

When a new Montage is created based on the tem-
plate, the new Montage will automatically get the sample 
rate saved in the template.

Opening Montage files
To open a saved Audio CD Montage (.mon) file, pull down 
the File menu and select “Audio CD Montage…” from the 
Open submenu.

If any of the audio files referenced in the Montage cannot 
be found, you will be asked to locate them manually. In the 
file dialog that appears, it’s also possible to replace the 
missing file with another – useful if you have renamed the 
original audio file.

Closing the Montage
Closing the Montage is done as with any document win-
dow, by clicking the window’s close button or by selecting 
Close from the File menu. If you have unsaved changes, 
you will be asked whether you want to save the Montage 
before closing it.

Cloning Montages
It is possible to make a “clone” of an Audio CD Montage 
by using “Quick cloning”. The new clips in the new Mon-
tage will reference to the original audio files.

Quick cloning

This is useful if you want to create several versions of the 
Montage, for example experimenting with variations. Note 
however that any processing or editing you apply to the 
actual audio files will be reflected in both Montages, since 
they share all file references.

1. Select the Edit view by clicking the Edit tab.

2. Pull down the Edit view : Special menu and select 
“Quick cloning (reuse audio files)”.
A clone of the Audio CD Montage is created and appears in a new unti-
tled window.

You can also create a “quick clone” by clicking the Docu-
ment icon of the Montage window and dragging to an 
empty area in the WaveLab Essential window.
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Using video tracks

You can edit audio in sync with video placed on a video 
track in the Montage. Video tracks are created from the 
track pop-up menu, just like audio tracks.

Adding video clips to the video track
There are several ways you can add video clips:

• By right-clicking somewhere on the empty video track 
and selecting “Insert file(s)”.
A file dialog opens where you can locate the video clip you wish to insert. 
The clip will be inserted at the cursor position.

• By dragging from the Files view (see “By dragging from 
the Files view” on page 108).

• By copying video clips from another Montage (see “By 
copying clips from another Montage” on page 108).

Playing back a video clip 
Video clips are displayed as clips on the video track, with 
thumbnails representing the frames in the film. If you start 
playback, the video is played back in the Track view for the 
video track.

Viewing video clips in the Video view

You can also view the film in the upper Montage pane if 
you select the Video view. To view the video in full screen 
mode, press [Shift]+[A]. Use this same command to reset 
the view.

The Video view Options menu

There are two items on the Video view : Options menu:

• Play video in track (at cursor).
If this is ticked, the video frames will play back in the Track view at the 
cursor position. If this is off, the frames will be displayed as non-animated 
thumbnail images.

• No video playback in track when this tab is open.
If both options are ticked, the frames will be displayed as non-animated 
thumbnail images when the Video view is selected, but otherwise play 
back.

Editing video clips in the Montage

You can perform basic functions like moving the video clip 
by dragging it in the time line, lock the clip position, use 
Split at cursor, copy and paste, etc. All available functions 
are displayed on the clip speed menu for a video clip.

! To be able to use video tracks, DirectX 9 must be in-
stalled.
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Mixing down – The Render function
The Render function in the Master Section allows you to 
“mix down” the whole Montage (or sections of it) to a sin-
gle audio file. 

The Render function can be used in many ways:

• It’s useful if you want to burn a CD from a CPU-intensive Mon-
tage, as it allows you to first render all clip effect processing 
and then burn the CD in a second pass (see “About the two 
CD write methods” on page 133).

• The Render function is useful for “printing” the effect process-
ing for CPU-intensive Montages prior to the “final” rendering, 
allowing you to add more effects, etc.

1. If you want to render the whole Montage from start to 
end, proceed to step 3.

2. If you want to render some of the clips only, select 
these.

3. If necessary, mute or unmute tracks.

4. Click the Render button in the Master Section window.
The Rendering preferences dialog appears.

5. Use the radio buttons in the Source section to specify 
what you want to include in the created file.
The Selected Clips option will only be available if you have selected clips 
(in step 2 above). 

6. Activate the options as desired:

7. Select whether you want to create a named file or not.
If you activate “Create named file”, you must specify a name and location 
for the file. If you don’t activate the option, a temporary file is created, 
with the bit resolution specified in the Preferences dialog–File tab. 

8. If “Create named file” is selected you can click the 
item at the bottom of the dialog to open the Audio File 
Format dialog.
Here you can specify the various audio properties for the file(s) to be ren-
dered. For certain compressed file formats (mp3/mp2/WMA/Ogg Vor-
bis), you can make encoding settings from the Encode pop-up menu.

9. Close the Audio File Format dialog when you are done.

10. Click the Schedule tab to make settings for Priority, 
Start and Completion actions (see “Options on the 
Schedule tab” on page 92).

11. Click OK to create the file.

! Only unmuted audio will be included in the rendered 
file(s)!

Option Description

No Tail When this is activated, any audio appended by the 
Master Section effects (such as echoes and reverb 
tails) will be cut off. Note that this doesn’t affect the 
Tail setting for clip effects (see “Tail” on page 125).

Create CD image and 
cue-sheet

This option (available when “Whole Montage” and 
“Create named file” are selected) lets you export an 
Audio CD Montage as a CD image with an accom-
panying cue sheet (a text file identifying the CD 
tracks in the image file). The cue sheet and the im-
age file it describes can then be imported into any 
CD recording application that supports this func-
tion, and written onto CD.
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Preparing the Audio CD Montage for 
CD burning
The descriptions in this section cover preparations for CD 
burning. A CD can be burned directly from within the 
Montage:

1. Make sure the Audio CD Montage contains exactly the 
material you want on the CD.

Note that CD tracks must be at least 4 seconds long. 

2. Click the CD tab to select the corresponding CD view.
This contains a CD track list with each clip in the Montage representing 
one track on the audio CD.

3. Select “Adjust pauses between clips…” from the 
Functions menu or click the horizontal "double-arrow" 
icon.
A dialog appears, which contains a number of settings that help you ad-
justing the pauses between the clips or CD tracks, respectively. 

4. Set the options as desired:

5. Click Apply.
The dialog closes. Now, pauses between CD tracks are adjusted ac-
cording to your settings. You can check the result in the CD view’s list of 
CD tracks.

6. If needed, you can adjust the CD track pauses manu-
ally in the CD view’s list of CD tracks, or by dragging the 
clips in the Track view.

7. Select “Check...” from the CD view : Functions menu 
or click the “glasses” icon.
WaveLab Essential will check the CD list and inform you whether it’s OK 
or not (this check is also performed automatically before actually burning 
a CD from the Montage). 

8. If the Check gave a warning message, make manual 
adjustments and repeat the Check procedure until the list 
is OK.

You may get warning messages for several reasons, in-
cluding:

• You have CD tracks that are shorter than 4 seconds.
• The pause before the first CD track is shorter than 2 seconds.
• The CD is too long (the total length of the CD is displayed in 

the control bar at the top of the tab).

Editing the CD view list 
Once you have prepared a CD track list as described pre-
viously, you can go ahead and write the CD.

However, there are some additional settings you can ad-
just in the CD view track list:

• You can hide or show CD track list columns by using 
the column pop-up menu (accessed by clicking the arrow 
button to the left of the column headings).
You can also drag and resize columns as usual.

• You can adjust all settings in the list by clicking or dou-
ble clicking the desired item (except for the "Start", "End" 
and “Length” values, which can be set by moving or resiz-
ing the according clip).

• You can change the order of CD tracks by dragging 
tracks in the CD view list.

Edit CD-Text
This CD view : Functions menu item opens the CD Text 
editor, where you can input the track’s title, artist and 
other information. It will be burnt onto the CD as CD Text. 
Some CD Players support CD Text and display this infor-
mation during track playback.

Set specific pause time Set the amount of pause time you want to have 
between the CD tracks.

Do not create a pause
between two contiguous
clips

This is only availale if the above option is set, 
which then will not create pauses if clips are 
connected by crossfades or snapping to each 
another.

Round existing pauses
to closest second

This will adjust existing pauses so that they 
match exact full seconds.
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About the two CD write methods
The final phase of CD creation can be done in two ways:

• By burning directly from the CD view in the Montage.
This is an easy process, but puts some demand on your computer. Keep 
in mind that even if your Audio CD Montage plays back without prob-
lems, the CPU load will be four times as high if you burn in 4x speed 
(since the audio file has to be rendered four times as fast)! 

• There is, however, an option in the CD Write dialog to 
“Render a temporary file before burning” that alleviates 
this problem – see “About the “Render to temporary file 
before burning” option” on page 135.
This method is recommended if your Audio CD Montage contains a lot of 
clip effects (or is otherwise CPU intensive), since it separates the audio 
file rendering from the CD burning process. It is also recommended if 
you want to create multiple copies of the CD.

In both cases, all clip effects are used and the Montage is 
processed through the Master Section, including any acti-
vated effects and the dithering/noise shaping stage.

Now you can proceed with burning the CD as described 
in the next chapter.

Rendering a CD image and cue sheet

This is an option that enables you to export an image file of 
the Audio CD Montage (including clip effects, Master 
Section settings etc.), which can then be used in other 
CD recording applications.

1. Open the Master Section and click the Render button.
The Rendering Preferences dialog appears.

2. Select the “Whole Montage” option in the Range sec-
tion and activate the “Create named file” option.

3. Specify a name and location for the file, and make sure 
the Wav 16 bit format is selected.

4. Select the “Create CD image and cue-sheet” option in 
the Options section.

5. Click OK.
Now, the whole Montage is rendered to a CD image file, with an accom-
panying cue sheet (a text file identifying the CD tracks in the image file). 
The cue sheet and the image file it describes can then be imported into 
any CD recording application that supports this function, and written 
onto CD.



14
Burning an audio CD



135

Burning an audio CD

Introduction
This chapter describes the basic CD burning process, as 
well as some general reference information about the CD 
format. 
It does not, however, describe the necessary preparations 
for creating a CD from an Audio CD Montage. In other 
words, this chapter assumes that the respective prepara-
tions have been completed, and that you are ready to exe-
cute the actual CD burning.

Please refer to the chapter “The Audio CD Montage” for a 
description of the respective preparations before follow-
ing the instructions in this chapter.

Selecting a CD-R unit
Before you start writing, you must specify which CD-R 
unit WaveLab Essential should use (for example, you can 
have more than one unit connected at a time, and switch 
between them from within WaveLab Essential).

1. Click the CD tab in the Audio CD Montage and select 
“Write CD” from the Functions pop-up menu.

2. Use the Device pop-up menu to select your recorder.

3. Click the “i” (info) button next to the Device name.
This will show you details about, and settings for, your specific CD-R 
unit.

Testing an audio CD before burning
There are two ways to check a CD before burning:

Check
The “Check” command on the Audio CD Montage Func-
tions menu (CD tab selected) scans through the audio 
CD and checks that the settings conform to the CD stan-
dard. This command does not access the CD-R recorder 
in any way, it only checks the setting in the list against a 
set of rules.

This check is automatically performed when you try to ac-
tually burn a CD.

“Test writing of first track” and “Test writing of 
the whole CD”
These two options in the Write CD dialog actually simu-
late writing of one or all tracks to the CD. This takes all 
settings into account, including the writing speed (1x, 2x, 
etc.), or whether a disk image should be rendered first 
(see below), etc.

• If the test fails, try writing at a lower speed.
• If the testing of all tracks is successful, you can be sure there 

will be no problems with writing the actual CD.

About the “Render to temporary file before 
burning” option
This is an additional option in the Write CD dialog that can 
be used in case you have a slow computer and/or a lot of 
CPU-load intensive effects, etc. in the Montage. If this 
item is ticked, a disk image is created before burning, 
which eliminates the risk of buffer underruns.

• This option is included in the test writing if it is ticked 
beforehand.
Therefore if it was on when testing, it should be on when writing.

• If this option was off, and the whole CD was test written 
successfully, there is no need to activate it when burning.
It will only make the write time longer, without providing any “extra” 
safety.
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Writing a CD
Once you have set up the CD Montage, we suggest the 
following work order for burning the CD. These steps are 
not mandatory though, just a recommendation.

1. Listen through the CD once more from the Montage, to 
check that all starts, ends and transitions are OK.

2. Select Check from the CD tab – Functions menu, to 
check that all settings conform to the Red Book standard.
This is done automatically before burning, but you might want to do this 
anyway at this point.

3. Insert a fresh CD-R disc into your drive.

4. Select Write CD.

5. Select the speed at which you expect to be able to 
burn from the small pop-up menu.

6. Use the test options in the dialog to check that you will 
actually be able to write the CD at that speed.

7. If you want to create a CD in the CD-Extra format, ac-
tivate the CD-Extra Support option in the dialog.
See below.

8. Once the Montage has passed the test, switch to 
“WRITE” and press OK in the dialog.
If you run into problems, check the Troubleshooting chapter in the online 
documentation.

• In the progress dialog that appears while the CD is re-
corded, you will find an option called “Eject CD on suc-
cess”. If you activate this option, the CD recorder will 
automatically eject the CD once it’s finished.

CD-Extra support
When writing an audio CD as described above, it is pos-
sible to prepare it for CD-Extra support. CD-Extra is com-
parable to Mixed Mode CDs in that both of these formats 
allow for the writing of both audio and data on a single 
CD. However, unlike Mixed Mode CDs, the audio on CD-
Extra CDs is placed on the first track(s) of the CD and the 
data follows subsequently. This means that the audio will 
start to play immediately when the CD is used in a regular 
audio CD player, without having to skip to track 2. Also, 
when creating a CD-Extra CD, you can make use of all the 
functions available in the Montage.

If you are writing an audio CD and want to prepare it for 
CD-Extra, do the following:

1. Put a checkmark in the “CD-Extra compatible” box in 
the Write CD dialog.
This will prepare the CD for further writing of data later. Much like a multi-
session CD.

2. Write the audio CD as described above.

3. The next step is to create a Data CD/DVD containing 
the data you want to incorporate on the CD.
How to create a Data CD/DVD is described in the section “Creating a 
new Data CD/DVD Project” on page 140.

4. In the Write dialog for the Data CD/DVD (described in 
the section “The Write dialog for the Data CD/DVD” on 
page 142), select the options “Track At Once” for Write 
Method and “Close CD” for Closing Method.

5. Click on “Write”.
The data will now be added to the CD after the audio you added previ-
ously, and the CD-Extra is created and finalized (no further writing is pos-
sible).

! Please observe the precautions indicated in the 
Troubleshooting chapter in the online documentation 
before writing your first CD!

! Please be aware that some computer CD drives may 
not recognize CDs in the CD-Extra format. Plextor 
drives are recommended.
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The audio CD format – Background 
information
This text aims to provide you with some background infor-
mation on the CD format, to help you better understand 
how to create your own CDs. This is a big subject, and we 
will only be able to touch upon it here. For more informa-
tion, try a text-book on the subject, or search the Internet 
for more information.

The basic CD formats

There are a number of different formats for the contents of 
a CD disc. You are probably familiar with audio CDs, CD-
ROMS, and CD-I. These are all slightly different, although 
they use the same media – CD discs. The audio CD spec-
ification is called Red Book. It is this standard to which 
WaveLab Essential conforms.

Red Book CD is not a real file format

Those of you who are computer literate might know about 
file formats. Please note that Red Book CD is not a real 
file format. All the audio on the CD is stored in one big 
chunk, one file if you will. This is different from hard disks, 
for example, where each file is stored separately. Under-
standing the fact that all the audio is in fact one long 
stream of digital data is something that will probably help 
you better understand the limitations of the format.

The different types of “events” on an audio CD

There are three types of events that can be used to spec-
ify various sections of audio on the CD. These are:

About frames, positions, small frames and bits 

The data on an audio CD is divided into frames. A frame 
consists of 588 stereo samples. 75 frames make up one 
second of audio. Why? Well, 75 x 588 = 44100, and 
since the sampling frequency of the CD format is 
44100kHz (samples per second), this equals one second 
of audio. When you specify positions on the CD, in Wave-
Lab Essential, you do it in the format mm:ss:ff, where mm 
is minutes, ss is seconds and ff is frames. The frame val-
ues go from 0 to 74, since there are 75 frames to a sec-
ond.

Technically, there is no way to specify something smaller 
than a frame on a CD. One effect of this is that if the 
length of a track on the CD does not equal a perfect num-
ber of frames, some blank audio must be added at the 
end. Another effect of this is that when you play the CD, 
you can never locate (position) to anything closer than a 
frame. If you need some data in the middle of a frame, you 
still have to read the whole frame. Again, this is unlike a 
hard disk, where you can retrieve any byte on the disk, 
without reading the surrounding data.

But frames aren’t the smallest block of data on a CD. 
There is also something called “small frames”. A small 
frame is a container of 588 bits. 98 small frames together 
make up one regular frame. In each small frame there is 
actually only room for six stereo samples, which means 
that a lot of space is left for data other than the actual au-
dio. There is information for encoding, laser synchroniza-
tion, error correction and the PQ data (so called because 
it is stored in the “P” and “Q” bits). This PQ data is of ma-
jor importance to anyone who wants to create their own 
CD, so please let us explain it in further detail.

PQ codes and WaveLab Essential's solution to handling 
them

The PQ codes convey information about track start, sub-
indexes and pauses, as described above. They also con-
tain the timing information (minutes, seconds, frames). To 
fit all this information in, a block of PQ information is 
spread out over 98 small frames.

Event Description

Track Start There can be up to 99 tracks on one CD. Each is 
identified by its start point only.

Track Sub-Indexes On advanced CD players, you might have noted that 
a track can be divided into sub-indexes (sometimes 
called only indexes). These are used to identify “im-
portant” positions within a track. There can be 98 
sub-indexes in each track. However, since it is diffi-
cult and time-consuming to search for and locate to 
a sub-index, many CD players ignore this informa-
tion.

Pause A pause appears before each track. Pauses can be 
of variable lengths. Some CD players indicate the 
pauses between tracks on their displays.
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Specifying PQ codes is not complex. However, when cre-
ating a CD there are a number of rules you must take into 
account. For example, there should be some silent frames 
before each track, sub-indexes should be slightly early, 
there should be pauses at the beginning and end of the 
entire CD, etc.

When creating CDs from an Audio CD Montage, these 
rules and settings are handled by WaveLab Essential to 
ensure your CD will work properly.

ISRC codes

In addition to the basic PQ codes, there is something 
called “International Standard Recording Code”, identifi-
cation that is only used on CDs intended for commercial 
distribution. WaveLab Essential allows you to specify an 
ISRC code for each audio track.

The ISRC code is structured as follows:

• Country Code (2 ASCII characters).
• Owner Code (3 ASCII characters or digits).
• Recording Year (2 digits or ASCII characters).
• Serial Number (5 digits or ASCII characters). 

UPC/EAN codes

UPC stands for “Universal Product Code”. Some CD/
DVD-R units allow you to specify this code, which is a thir-
teen-digit catalog number for the disc. Also known as 
EAN.

Pre-emphasis 

Pre-emphasis works by boosting (or pre-emphasizing) 
high frequencies before burning the CD, and cutting (de-
emphasizing) them when playing back. The theoretical re-
sult of this is that the desired audio is returned to normal 
sound, but any other high frequency content (noise) in the 
recording is reduced.

Disc-At-Once – Writing CD-Rs for duplication into “real” 
CDs

WaveLab Essential only writes audio CDs in Disc-at-
Once mode. There are three good reasons for this:

• If you want to create a CD-R to use as a master for a 
real CD production, you must write the CD-R in Disc-At-
Once mode. In this mode, the entire disc is written in one 
pass, without ever turning off the recording laser. There 
are other ways of writing a CD, namely Track-At-Once 

and MultiSession. If you use these writing formats, the 
“link blocks” created to link the various recording passes 
together will be recognized as “uncorrectable errors” 
when you try to master from the CD-R. These links can 
also result in clicks when playing back the CD.

• Disc-At-Once mode provides more flexibility when 
specifying pause lengths between tracks.

• Disc-At-Once is the only mode that supports sub-in-
dexes.

Writing on the fly vs. CD images

WaveLab Essential always writes a CD on the fly, that is, it 
does not create a CD image before burning. This method 
makes writing CDs faster and requires much less disk 
space. However, if for some reason you need to, Wave-
Lab Essential lets you join all audio tracks into one large 
file that can be used as an “image” of the entire CD.
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Introduction
A Data CD/DVD project is an environment that can be 
used to compile and write a data only CD-ROM/DVD-
ROM or Mixed Mode CDs.

• Data discs exclusively contain computer data. This can be files 
of any type. However, the files are stored on the CD/DVD in 
such a way that an audio CD player cannot recognize them.

• The difference between a Mixed Mode CD and a normal audio 
CD is that the Mixed Mode CDs contain both computer data 
and audio data that can be played back by a CD player.

• On a Mixed Mode CD, the computer data occupies track 1, 
and the music occupies the subsequent tracks.

Creating a new Data CD/DVD 
Project

Creating a new Data CD/DVD project for data discs or 
Mixed Mode CDs

To create a new Data CD/DVD project, select “Data CD/
DVD” from the New submenu on the File menu. A new 
Data CD/DVD window appears.

The principle is simple: The Data CD/DVD window has 
two main window panes; the source window on top and 
the destination window below.

The source window shows the contents of your hard disks 
(or other storage media) in a way much like the Windows 
Explorer: with a folder hierarchy “tree” to the left and the 
contents of the selected folder shown to the right. The 
destination window shows the contents of the CD/DVD to 
be recorded, again with two panes in the same manner.

• To compile a data only CD-ROM/DVD-ROM or a Mixed 
Mode CD, drag files and/or folders from the upper into the 
lower window pane.
You can record the CD/DVD as soon as you have placed all files in the 
lower pane.

• In the destination window, you can rename, remove or 
open files.

• You can save and open Data CD/DVD files from the File 
menu, as with other document types.
Data CD/DVD files have the extension “.cdp”.

Source window settings
You can decide how files and folders are displayed in the 
source window (as icons, as a list, etc.) by selecting one 
of the items on the Source menu (or by clicking the corre-
sponding icon) on the source window toolbar.

To help navigating, you can use the functions “Up one 
level” and “Recent paths”. The latter (only available as an 
icon on the toolbar) displays a menu listing all recently 
used paths, allowing you to quickly go back to any of the 
listed folders.

The Source window Source menu contains the following 
view options:

! An alternative to a Mixed Mode CD is the “CD-Extra” 
format, which also allows audio and data to be com-
bined on the same CD. To create a CD-Extra, you 
first create and write an Audio CD Montage and then 
add the data. See “CD-Extra support” on page 136.

! For DVD, creating a new Data CD/DVD project as 
described below will enable you to create a data only 
DVD-ROM disc.

Source window

Destination window

Function Icon Description

Refresh Click on this icon to update the con-
tents of the window. This is useful if, for 
instance, storage media has been 
added or removed.

Show Audio and
Video Files

If this function is active, the right part of 
the window pane only shows audio and 
video files, if available.

Show All Files If this function is active, the right part of 
the window pane shows all file types.
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Destination window settings

View settings
Use the Destination menu to adjust how files and folders 
are displayed in the destination window, just like in the 
source window.

Getting size information
At the bottom of the Data CD/DVD window, a ruler shows 
you the current and the maximum size of the project. On 
the CD/DVD menu you can set the ruler to display either a 
CD scale or a DVD scale, as well as define the actual 
available space of the destination media you intend to use 
(see “Define media size…” on page 141). Holding the 
mouse pointer over the ruler brings up a pop-up tip, show-
ing you the exact size of the project, and a dotted, vertical 
red line in the ruler shows you the maximum available 
space on the destination media. This allows you to quickly 
assess the used and remaining space for the project.

You can also select “Properties” from the Destination win-
dow Edit menu, to get information about the number of 
files on the CD/DVD and their total size.

Editing the CD/DVD contents
You can move items between folders on the CD/DVD by 
using drag and drop, just like you drag them from the 
source window to add them. There are also various op-
tions on the Edit menu for adjusting the contents of the 
CD/DVD to be created:

• To add a new folder (within the selected folder), select 
“New Folder”.
See “Creating a Mixed Mode CD” on page 142 for a description of the 
“Add Audio Track Folder” function.

• To rename the selected folder, select “Rename” from 
the menu and type in a new name.

• To remove the selected file or folder from the Data CD/
DVD, select “Remove”.
If a folder was selected, this and all its contents will be removed. Note 
that this only removes files from the Data CD/DVD, not from the hard 
disk.

• To open the selected file or folder, select “Open”.
There is also an “Open in WaveLab Essential” item, for opening audio 
files and other documents in WaveLab Essential.

The CD/DVD menu
The CD/DVD menu contains items for preparing and writ-
ing the disc:

Function Description

Disk Label… Opens a dialog where you can name the CD/DVD 
to be recorded.

CD/DVD Info… Displays the total number of files as well as the total 
file size on the CD/DVD to be recorded.

Add photo viewer
to CD/DVD…

This opens a dialog where you can select to add a 
simple photo viewing application to CDs/DVDs that 
contain photo images. The viewer application is 
called ImageViewer.exe and is added to the root of 
the CD/DVD. It can only be used to visualize the 
photos on the CD/DVD. Note that the CD/DVD 
does not need to exclusively contain photos.

Write CD/DVD… Opens a dialog from where you can start recording 
the data or Mixed Mode CD (see below).

Save as ISO Image… An ISO image is a file that holds the entire contents 
of a data CD or DVD (files and folders).

Create Label set… This allows you to create labels for your CDs. See 
“Selecting a template” on page 148 for more infor-
mation.

Edit text variables… Opens a dialog where you can edit and create text 
variables as used for CD labels (see “Defining user 
variables” on page 152).

Export text variables in 
ASCII…

This saves the current text variables as an ASCII 
text document in a tabulated format, suitable for ed-
iting in a spreadsheet application such as Microsoft 
Excel.

CD Scale/DVD Scale These items allow you to select whether the ruler at 
the bottom of the Data CD/DVD window should 
display a CD scale or a DVD scale, showing the 
available amount of storage space. Since a DVD 
can hold considerably more data than a CD, you 
should for proper reference select the appropriate 
option depending on which kind of media the mate-
rial you are compiling is intended to end up.

Define media size… Opens a dialog in which you can specify the avail-
able storage space of the destination media. If you 
for instance are using a DVD disc that can hold 
more data than the “standard” 4 700 MB, you can 
specify how much it can hold, to get a correct visual 
reference of the available space when preparing 
the DVD.
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Creating a Mixed Mode CD
To create a Mixed Mode CD (i.e. a CD with both audio 
and data), proceed as follows:

1. Select the “root” of the CD in the left destination win-
dow pane.

2. Select “Add Audio Track Folder” from the Destination 
window Edit menu.
An Audio Track Folder item appears in the destination window. This can-
not be moved or removed.

3. Drag any audio files you want included as audio tracks 
from the source window to the audio track folder.

The Write dialog for the Data CD/
DVD
When you select “Write CD/DVD…” on the Destination 
window’s CD/DVD menu, you will first be asked for a 
name for the CD or DVD to be created. After entering a 
name and clicking OK, the “Write virtual Disc” dialog ap-
pears. Here you can make all the necessary settings for 
the CD or DVD to be recorded. 

Item Description

Write The CD/DVD writing process is started.

Close The dialog is closed.

Settings This opens a dialog where you can make settings 
for your CD/DVD recorder. The content of this dia-
log depends on the recorder used.

Disc Info If a writable disc is in the CD/DVD recorder, you 
can use this option to get information about its size 
and available space. 

Write speed Here you can select a write speed supported by 
your recorder.

Write method Here you can select a Write method supported by 
your CD recorder. If you are adding the data por-
tion to a CD-Extra CD, you must select “Track At 
Once” (see “CD-Extra support” on page 136). For 
DVD, there are no write method options.

Closing method Here you can select a closing method. If you are 
adding the data portion to a CD-Extra CD, you 
must select “Close CD” (see “CD-Extra support” 
on page 136).

Simulation Here you define if and how a simulation should be 
performed before the actual writing process. Simu-
lating the writing process lets you find out whether 
the writing process will be successful, or if prob-
lems might occur. 

Write to hard
disk first

If this function is active (ticked), the writing pro-
gram first writes an image file onto your hard disk 
(which must have enough free space to hold the 
file). An image file has the advantage that the data 
to be recorded doesn’t have to be converted into 
CD format during burning, as this is done when the 
image file is created. The actual burning (record-
ing) procedure will therefore be faster and per-
formed with greater reliability and less risk of 
malfunction.

Default Click on this button to save the current dialog set-
tings as default. The next time you open the dialog, 
they will automatically be set.

Advanced If you click the “Advanced” button, the dialog is ex-
tended downwards and you get access to five 
tabs. These let you make a number of additional 
settings for the writing process. 

! Note that at the end of the DVD burning process it 
can take up to 15 minutes to close the DVD. Please 
be patient.

Item Description
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Importing audio CD tracks into 
WaveLab Essential
WaveLab Essential provides the ability to read audio 
tracks from regular CDs. This makes a digital copy of the 
audio from the CD directly into an audio file on your hard 
disk.

Although WaveLab Essential supports a large number of 
CD drives, there are some restrictions you should be 
aware of:

There are a number of different, not very well stan-
dardized protocols for retrieving audio from a CD-ROM/
CD-R drive.
WaveLab Essential tries to support as many of these methods as possi-
ble, but there are no guarantees it will work with any particular drive. 
Some brands that reportedly use the same method still have slightly dif-
ferent implementations which might cause problems.

Please observe and respect any copyright notices on 
the CDs from which you are reading tracks!

To import CD tracks, proceed as follows:

1. Insert the CD into the CD-ROM/CD-R unit.

2. Pull down the Tools menu and select “Import Audio 
CD tracks”.

3. Select the drive from which you want to read from the 
pop-up menu at the top of the dialog.

4. Select a read speed from the pop-up menu just be-
side this.

5. If necessary, click Refresh so that the list of tracks is 
updated.
The window now lists the tracks on the CD, plus some information about 
each track. Please note that the Copy Protection and Pre-emphasis col-
umns are for information only, you cannot change these settings.

• By default, the tracks will be named “Track XX”, where 
XX is a number starting at 01. You can adjust the auto 
numbering scheme by right-clicking in the list and select-
ing an option from the pop-up menu that appears.
This pop-up menu also contains some additional functions for saving in-
dividual tracks directly as files, appending a track to the current Montage, 
etc.

The “Import Audio CD Tracks” dialog

6. Click on the Folder button at the bottom of the dialog 
to select a destination folder for the file(s).
The files will be saved with the name that is shown in the track list. To re-
name a file, double click on it in the track list and type the desired name.

7. If you want to import to a format other than Wave, click 
on the file format button at the bottom of the dialog and 
select the desired format from the Audio File Format dia-
log that appears.
See “Supported file formats” on page 49 for information about the avail-
able file formats.

! The tracks must have unique names if you want to 
import them all. If two or more files have the same 
name, a warning dialog will appear when the second 
one is imported, allowing you to either cancel the op-
eration or to replace the first file saved with that 
name.
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8. If required, you can select one file and click Play.
This will play the beginning of the track so that you can check it out.

If you notice that playback starts too late into the track 
– i.e. a small part of the beginning of the track is “cut out”, 
you can specify a pre-roll value to ensure that the entire 
beginning of the track is read.
This is done by selecting the option “Define reading of audio before and 
after CD track…” on the Options menu, and entering the desired pre-roll 
value in the dialog that appears. You can also specify a post-roll value to 
ensure that the entire end of the track is read. The technical reason be-
hind this is that it’s not possible to locate, or position, to anything closer 
than a frame – a block of data on a CD. Thus, if there is data in the middle 
of a frame, you might have to specify a pre-roll or post-roll so that the 
whole frame is read. See “About frames, positions, small frames and bits” 
on page 137 for more information.

9. Select as many tracks as you wish from the list.
You can use [Ctrl] and [Shift] to make multiple selections, or use the Se-
lect All button.

• You can also “drag and drop” one or more CD tracks 
onto WaveLab Essential’s desktop or into an Audio CD 
Montage to save them.
In the latter case, you can drop them in the CD view track list or directly 
into the track pane. For this to work, the item “Enable Drag and Drop to 
Audio CD Montages” must be activated on the Options pop-up menu.

10. If you have only selected one file, you can import just a 
part of the track by adjusting the start and end/length val-
ues.
The bar graph shows the part of the track that will be imported.

11. Click the Save button.
The track(s) are retrieved. Optionally, each is opened in its own window. 
This is specified in the progress indication menu that appears during im-
porting.

About the Freedb function

You need to be connected to the Internet to use the 
Freedb function.

Clicking the Freedb button opens a pop-up menu where 
you can use some functions provided by Freedb to get in-
formation about your CDs. Freedb maintains a worldwide 
database of CD information.

• When an audio CD is inserted, you can query the database to 
get the track names of this CD, and more.

• If the CD is not yet recorded in the database, you have the op-
tion to become a participant by describing the CD and submit-
ting your description to the database. Find more information on 
this at www.freedb.org.

File format – Converting CD track(s) to other formats

The extracted audio files are saved in WAV (Wave) format 
by default. You can, however, directly save files in other 
audio formats by clicking the button at the bottom of the 
dialog to open the Audio File Format dialog, and select the 
desired file format from the Type menu.

Among the formats available are the following com-
pressed audio formats: MP3, MP2, WMA and Ogg Vor-
bis.

When any of these formats is selected, you can click the 
Encoding field and select “Edit…” from the pop-up to 
open the corresponding Encoding dialog, where you can 
specify the bit rate and other attributes of the file to be 
created.

CD reading method

In rare cases, the default method of extracting audio sam-
ples from a drive does not work. In such cases you can 
change the extraction method used by selecting the “CD 
reading method” item on the Options pop-up menu. This 
opens a dialog with several optional audio extraction 
methods.

Do not change the settings if you are not having prob-
lems!

About Ultra-Safe mode

Sometimes a small bit of a CD track is not properly re-
trieved (this depends on the quality of your CD drive). This 
can result in unpleasant clicks and pops. To solve this is-
sue, you can activate the ultra-safe mode on the Options 
pop-up menu. When activated, each CD track is read sev-
eral times until the exact same result is found (check sums 
are used).

Convert to Montage

The “Convert to Montage” function can convert a CD to 
an Audio CD Montage. Once you have converted to a 
montage, you can reorder tracks, remove some tracks or 
add new tracks. You can use this function to create mixed 
compilations of CDs.
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Notes

• Note that importing audio CD tracks is technically more com-
plicated than reading files from a CD-ROM or hard disk, be-
cause audio sectors can be hard to detect. Some CDs which 
do not conform completely to the CD standard may cause 
problems.

• There are several other functions on the Options pop-up 
menu.

• If you import a CD track with Emphasis, and later want to use 
this on a CD of your own, remember to activate Emphasis for 
that track in the CD view of the Audio CD Montage.
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Introduction
The Label Editor allows you to design and print custom la-
bels for your CD and DVD projects. You can design sepa-
rate layouts for front, inside, back and disk labels. Both 
text information and a wide range of image file formats can 
be imported and edited in various ways.

About variables and templates
Every Data CD/DVD Project, Audio CD Montage or Im-
port Audio CD Tracks session has a default set of “vari-
ables”, text that consists of a short code string plus a 
value. Variables provide information about a project, such 
as track titles, personal data, etc. There are two types of 
variables: factory and user editable.

Factory variables automatically provide information based 
on the contents of a project, and user editable variables 
can be customized to suit the current project.

Templates are ready-made layouts that will use the infor-
mation provided by the variables.

You can freely customize the properties of a template lay-
out by using the Label Editor. Add new images or other 
objects, delete or edit existing objects, etc.

Selecting a template
The first thing you do before the Label Editor is opened is 
to select a template. As mentioned previously, templates 
provide some information based on the current project, 
and have ready-made layouts:

1. Open the project you wish to create labels for.
This can be a Data CD/DVD Project, an Audio CD Montage or an Import 
Audio CD Tracks session.

2. Select the “Create Label set…” menu item.
Where this menu item is located depends on the type of project; for Au-
dio CD Montages it is on the Functions menu, for Data CD/DVD it is on 
the CD/DVD menu, and for Import Audio CD Tracks it is on the Options 
menu.

3. A dialog appears, allowing you to select a template for 
your project.

To the right in the dialog there is a list of available templates, divided into 
three groups “Audio”, “Data” and “Audio + Data”. By clicking on the cor-
responding tab the available templates for the selected project type are 
shown in the list. To the left in the dialog, preview images of the front, 
back and the disk labels are shown.

4. Select a template, and click OK.
The Label Editor window opens, displaying the CD case front label.

• If you do not wish to use a template at all you can select 
“Void” in this dialog.
This will open the Label Editor with totally empty labels, allowing you to 
build your own labels from scratch by adding objects, specifying back-
grounds, etc.

• You can also save user templates.
See “Saving a label set as a user template” on page 152.

Using the Label Editor

Overview
The Label Editor always displays one of the three available 
views or pages: the front, back or disk case label. You 
switch between these pages by selecting the correspond-
ing tabs below the toolbar. The layout is completely inde-
pendent for each page.

Please note that the front label can be either single- or 
double-sided. 
This option is set in the Page Layout dialog on the Printing menu.
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The Label Editor window displays a frame with the cur-
rently selected label (front, back or disk) layout. Layouts 
are made up of editable objects – images, text boxes, lines 
or circles. You can also select either an image or color as 
background for the layout as a whole.

Basic object handling in the Label Editor

The Label Editor tools

Tools can be selected in three ways:

• From the Tools menu
• By clicking the corresponding icon on the toolbar
• By right-clicking in the background area (not an object), and 

selecting from the speed menu that appears

The following tools are available:

Selecting objects

Click an object with the Selection tool to select it. 

• Selected objects are indicated by a dotted outline, and square 
“handles”, which can be used to scale the size of the object. 

• To select several objects, hold down [Shift] or [Ctrl] and click. 
Selected objects can be de-selected by [Shift]-clicking.

• When several objects are selected, one of the objects will al-
ways have “focus”. The focus is indicated by red handles on 
this particular object. You can move the focus to any of the se-
lected objects by [Ctrl]-clicking.

Two objects selected, with the upper having the focus.

Front/back/disk layout buttonsHorizontal and vertical rulers

Text box objectCircle object

Toolbar

Selection tool
Zoom object

Insert track list

Insert box 
with text

Insert circle Insert line

Insert image

Print label
Zoom in/out

Tool Description

Selection tool Used to select, resize or move objects.

Zoom Object & 
Zoom In/Out

This is used to zoom in on a selected ob-
ject, keeping it in view. The Zoom In/Out 
zooms the layout as a whole in or out. You 
can go back to normal magnification (1:1) 
by selecting “Zoom 100%” from the Op-
tions menu.

Insert track list This will produce an automatically gener-
ated track list, based on the tracks belong-
ing to the current project.

Insert box with text Creates a text box object.

Insert Circle This will insert a circle or ellipse object.

Insert Line This will insert line objects.

Insert Image This will insert an image.

Set background color…
(menu only)

Allows you to define a color for the back-
ground of the layout.

Set background image… 
(menu only)

Allows you to define an image for the back-
ground of the layout.
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Resizing objects

If you click on a handle of a selected object, the pointer 
changes to a double arrow, indicating that you can resize 
the object by dragging. Images or circle objects will be 
scaled, whereas dragging the handles of text box objects 
will resize the size of the box, not the text itself.

You can also right-click an object and select “Edit Po-
sition and Size…” from the speed menu.
A dialog appears, allowing you to edit size (width and height) numerically, 
in cm/mm.

Inserting new objects

Inserting new objects is done by selecting the corre-
sponding tool, and clicking and dragging in the layout. 
When you release the mouse button, a dialog appears, al-
lowing you to define basic properties for the inserted ob-
ject. Note that this does not apply to image objects, where 
instead a standard file dialog appears.

The Edit Properties dialog is also selectable from the 
Objects menu and by right-clicking objects and selecting 
from the speed menu.
See “About the Edit Properties dialog” on page 151 for a description of 
the items available in the Edit Properties dialogs.

Inserting a text box object

Deleting objects

To delete objects, select them and use the [Delete] key.

Copy/move object

If you manually move an object with the right mouse but-
ton pressed, a small pop-up menu appears when you re-
lease the button allowing you to either select to copy the 
object to the new position or to move it there.

Positioning objects
There are several methods you can use to position ob-
jects:

• Manually – by dragging objects using the Selection tool. 
• Automatically in relation to the layout frame. You can have an 

object centered (horizontally or vertically) by right-clicking it 
and selecting the corresponding item from the speed menu.

• Automatically in relation to other selected objects (see “The 
Objects menu” on page 151).

• By selecting “Edit Position and Size…” from the Objects (or 
context) menu and adjusting the position numerically in the di-
alog that appears. Note that this adjusts the position of the 
object with focus.

You specify the position from the left side and the top of the layout 
frame, in cm/mm. Click “Apply” to apply the position change without 
closing the dialog.

About the grid, rulers and magnetize options

On the Options menu, you will find two items, “Show 
Grid” and “Show Rulers”. If these are ticked, the back-
ground of the layout will show a dotted grid, and also ver-
tical and horizontal rulers that show the current position of 
the mouse pointer. Both these items help you to position 
objects with fine precision in the layout. The grid spacing 
can be specified in the Preferences dialog on the Options 
menu.

You can also use magnetize so that objects will snap ei-
ther to grid positions, to other objects or to the frames lim-
its (or all three), by selecting the corresponding Options 
menu item.
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About the Edit Properties dialog
The Edit Properties dialog can be opened in three ways:

• By selecting an object and selecting “Edit Properties” from 
the Objects menu

• By right-clicking an object and selecting the same item from 
the speed menu 

• By double-clicking an object 

The contents of the dialog varies depending on the object 
type.

The Objects menu
The Objects menu can be selected from the toolbar, or 
opened by right-clicking an object (speed menu). The 
items on the Objects menu are greyed out if no object is 
selected. 

If one object is selected, the following Object menu items 
are available:

If several objects are selected when opening the Objects 
menu, the following additional items are available:

About label sets
You can save as many label sets as you like for a project. 
However, whenever you open the Label Editor by select-
ing the “Create Label” menu item, a new label set opens 
which is untitled and only contains the auto-generated 
data.

Whenever you have edited layouts in the Label Editor, you 
will be asked to save it as a label set if you close the Label 
Editor or exit the program without first having saved your 
changes. If you don’t save, any changes are lost.

It is important to note that any work performed in the 
Label Editor is not saved with the project – it has to be 
saved separately as a label set.

Item Description

Edit properties… See “About the Edit Properties dialog” on 
page 151.

Edit position and size… See “Positioning objects” on page 150.

Edit display condition This allows you to decide whether an object 
will be displayed or not, depending on 
whether a given variable is empty or not.

Bring to front This brings any object that is partially ob-
scured by another overlapping object to the 
front.

Send to back This sends any object that partially or com-
pletely overlaps another object to the back.

Center horizontally Centers a selected object horizontally in the 
layout.

Center vertically Centers a selected object vertically in the lay-
out.

Lock movement This locks the position of the selected object.

Select all Selects all objects.

Select all with the 
same size

Selects all objects with identical dimensions 
to the selected object.

Item Description

Apply same properties 
as focused object

This item allows you to apply properties 
from the focused object to all of the se-
lected objects of the same type.

Space evenly horizontally This distributes the selected objects hori-
zontally, using the top center handle as a 
guide. This means that the top center han-
dles in each selected object will be exactly 
the same distance from each other horizon-
tally. 

Space evenly vertically This distributes the selected objects verti-
cally, using the side center handle as a 
guide. This means that the side center han-
dles in each selected object will be exactly 
the same distance from each other verti-
cally. 

Place under each other This will place all selected objects directly 
under each other.

Align with focused object (sev-
eral items)

These menu items will align selected ob-
jects to the position of the focused object. 
You can select to align to any side (left/
right/top/bottom), or to the horizontal or 
vertical center of the object with the focus.

Resize as focused object (sev-
eral items)

These menu items will resize all selected 
objects to either the same size as the fo-
cused object or to the same width or height 
as the focused object.

Group/Ungroup This will group all selected objects so that 
they will act as one object when selected 
or moved (keeping the relative positions to 
each other). Ungroup deselects the group-
ing.
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Saved label sets (with the extension *.lab) contain all 
the layout work performed in the Label Editor.
It is, however, not dynamic. This means that if you have added to or 
changed the Data CD/DVD Project, Audio CD Montage, etc. in any way 
after saving a label set, these changes will not be reflected in the saved 
label set, unless you save it as a user template (see below).

Saving a label set

To save a label set, select “Save” or “Save As…” from the 
File menu with the Label Editor open and as the active 
window (on top).

Opening a label set

To open a saved label set, select “Open” from the File 
menu and “Label Set…” from the submenu that appears.

Saving a label set as a user template

If you have saved a label set, you can make this appear on 
the list of available templates in the “Select a Label Tem-
plate” dialog. Label templates are label sets that reside in 
designated subfolders inside the WaveLab Essential pro-
gram folder. The path to the Label template folders (start-
ing from the main WaveLab Essential program folder) is 
“Presets\Label\Templates\”. Here you will find four fold-
ers: “Audio/AudioData/Data/Images”. Place (or save di-
rectly) a label set in the appropriate folder. It will now 
appear as a new template next time you open the “Select 
a Label Template” dialog.

Defining user variables
Apart from the auto-generated data such as media infor-
mation, date and time, etc., you can define a number of 
user editable variables that are local to the project you are 
working on. Once you have defined a set of user variables, 
this is automatically saved with the current project. To de-
fine user variables, proceed as follows:

1. Open the project you wish to set user variables for.
This can be a Data CD/DVD Project, an Audio CD Montage or an Import 
Audio CD Tracks session.

2. Select the “Edit text variables…” menu item.
Where this menu item is located depends on the type of project; for Au-
dio CD Montages it is on the Functions menu and for Data CD/DVD 
Projects it is on the CD/DVD menu. Selecting this item opens a dialog 
containing a list of folders similar to the structure in the Windows Ex-
plorer.

• Only the variables in open folders (and “Editable” writ-
ten in the Type column) can be edited.
The editable variables vary according to the type of project.

3. To define a value for a default variable, for example 
copyright or personal information, double-click in the Cur-
rent Value column for the relevant description.
A text box opens where you can type in the relevant information.

4. Click OK when done.

Creating new variables
You can create new variables and define values for them. 
The new variable will automatically be put in the currently 
selected folder (or in the folder with a currently selected 
variable). Proceed as follows:

1. Either create a new folder by clicking the “New Folder” 
button, or select a folder that you want to add a new vari-
able to.
If you chose the former option, select the new folder.

2. Click the “New Variable” button.
A new editable variable appears in the selected folder.
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3. Double-click in the Description column beside the 
new variable to open a text box where an appropriate de-
scription can be typed in.
For example “Producer”.

4. Double-click in the Current Value column to enter the 
relevant information for the new variable, i.e. the name of 
the producer.

5. To create a code that can be used to refer to the vari-
able in the Label Editor, type in an appropriate name be-
ginning and ending with “%” in the Code column.
To use the earlier example, this would be written “%Producer%”.

6. Click OK when done.

Once you have entered your personal data you can save 
the text variables file as a preset, see below.

On the Options menu there is a default set of text vari-
ables that is always available. Use this as a clean slate for 
creating new variables.

Saving variable sets as presets
Clicking the name field pop-up at the bottom of the win-
dow opens a menu which allows you to save sets of vari-
ables as presets. After having saved one or more variable 
sets as presets, you can switch between different presets 
of already “filled in” variables by selecting one from the 
name field pop-up. A preset could typically represent the 
information belonging to a client you work with regularly, 
for example. Naturally, the auto-generated variables will 
still adapt to the current project as usual.

Exporting text variables in ASCII
This option opens the current text variables as an ASCII 
text document in a tabulated format, suitable for editing in 
a spreadsheet application such as Excel.

Where this menu item is located depends on the type of 
project; for Audio CD Montages it is on the Functions 
menu, and for Data CD/DVD Projects it is on the CD/DVD 
menu.

Printing labels
You print your labels directly from the Label Editor, either 
on standard paper or on special media label paper (usu-
ally available in computer peripheral stores, etc.).

Calibrating the printer
If you are printing on special label paper, it is very impor-
tant that the printer is “calibrated”, that is, the measure-
ments in the program (for margins, positioning, etc.) must 
be exactly the same as the actual results you get when 
printing. This is not as important when you print on stan-
dard paper (since the printouts then don’t have to fit ex-
actly in specific positions on paper).

To calibrate the printer, select “Calibrate printer” from the 
Printing menu in the Label Editor and follow the steps in 
the dialog that appears.

Setting up page layouts
The Page Layout dialog contains various settings relating 
to how the page layout will be printed. It’s important to 
note that you make page layout settings individually for 
each one of the three label types (case front, case back 
and disc label). These are also printed individually.

To set up the page layout, select the desired label type (by 
clicking the corresponding tab) and select “Page lay-
out…” from the Printing menu in the Label Editor. Note 
that there are different settings for the three different label 
types.

! You only need to do this once (unless you switch to 
another printer).

! If you are using special label paper, these will typi-
cally come with a measurement sheet, showing the 
exact size and positioning of the labels.
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Printing
Printing is done independently for the three label types. 
However, there are two settings that are global for all 
three label types:

1. Pull down the Options pop-up menu and select “Pref-
erences”.
The “Label editor preferences” dialog appears.

2. Use the “Printing” checkboxes to determine whether 
the frames around the labels should be printed, and 
whether cut markers should be printed (making it easier to 
cut out the labels from the printed paper).

Now, you are ready to print:

3. Select one of the label types by clicking its tab.

4. Select “Print” from the Printing menu in the Label Edi-
tor window.
The “Print label” dialog appears, allowing you to make printer settings, 
preview the result and specify a number of copies.

5. Click Print.

6. Select the next label type by clicking on its tab, and 
proceed from step 3 above.
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Global analysis

Introduction

What does the “Global analysis” dialog do?

This dialog allows you to perform advanced analysis on 
your audio to find certain areas with specified properties. 
It can be used to find problem areas (glitches, distortion), 
etc., or to check general information such as the pitch of a 
sound.

How does it work?

When you analyse a section of an audio file, the program 
scans it and extracts overall information which it displays 
in the dialog.

However, during analysis, it also “pin-points” sections in 
the file that meet specific characteristics, for example, 
sections being very loud or very silent. You can then 
browse between these points, set markers at these places 
or zoom in on them.

About the tabs

• The Peaks tab is used for finding individual samples with very 
high values.

• The Loudness tab is for finding sections with high amplitude.
• The Pitch tab is for finding out the exact pitch of a sound or 

section.
• The Extra tab tells you about DC offsets and the significant bit 

resolution.
• The Errors tab helps you find glitches and sections where the 

audio has been clipped (recorded or processed at too high a 
level).

General operations

Opening the “Global analysis” dialog

1. Make a selection in the wave file that you want to pro-
cess.
This selection can be of any length and in one or both channels. If you 
want to analyse the entire file, hit [Ctrl]-[A]. If “Process whole file if no se-
lection exists” is activated in the Preferences - Wave edit tab, the whole 
file will be processed automatically if no selection has been made. 

2. Select “Global analysis…” from the Analysis menu.

Deciding what types of analysis to perform

As described above, there are several types of analysis 
that can be performed. Each of them takes some time, so 
you may want to make sure that only the types you are ac-
tually interested in are included in the analysis.

It doesn’t hurt to have more options activated than you 
need, but it will slow down the process. The pitch analysis 
in particular uses up a lot of processing time, because by 
its very nature it is complicated.

If the section you are analyzing is very short, it doesn’t 
matter much whether all options are activated.

• Click on the Peaks tab and decide whether you want peak 
analysis by activating the “Peaks” option.

• Click on the Loudness tab and decide whether you want 
“RMS Power” analysis performed.

• Click on the Pitch tab for the program to find the “Average 
Pitch”.

• On the Errors tab, decide whether you want the program to 
search for “Glitches” and/or “Clipping”.
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Setting parameters and performing the analysis

1. Set up the parameters.

On most of the tabs, you will find settings determining ex-
actly how the analysis should be performed. For example, 
on the Peaks tab there are two parameters:

• “Maximum number…” allows you to set an upper limit for the 
number of peaks reported. For example, if you set this to “10”, 
the program will only report the ten highest peaks in the file.

• “Minimum time…” allows you to specify the minimum interval 
between two peaks found. For example, if this is set to “5 s”, 
there will always be at least five seconds between the re-
ported peaks.

These two settings allow you to make sure that the re-
ported peaks are not all in the same area.

2. If desired, move the wave cursor to a new position.
The Peak and Loudness tabs report values specifically for the position of 
the wave cursor, so if this is of interest, you should make sure the wave 
cursor is at the position for which you want a readout.

3. Click Analyse.

Checking and browsing the results

Checking the results on the Pitch and Extra tabs is simple, 
since there is only one value returned for the whole sec-
tion of analysed audio. Just click on the tab and read off 
the values in the dialog (for details about the values, see 
later in this chapter).

For the other tabs, slightly more advanced options are 
available. This is since all these analysis methods provide 
their results as a number of positions in the file, positions 
that indicate peaks, glitches, etc. We call these “hot 
points”.

You can browse (jump) between these points in a very 
practical way. Proceed as follows:

1. Click on the tab that represents the values you are in-
terested in.
For example, let’s say you click the Loudness tab.

2. Check the display for maximum/minimum values in the 
entire section analysed.
For the Loudness tab, these values represent the maximum and minimum 
amplitudes in the left and right channels respectively (for a stereo file).

3. Decide which of these values you want to browse.
For example, say you want to browse the minimum amplitudes in the right 
channel.

4. Click on the button that currently displays this value.
The value displayed is for the “hot point” with the highest/lowest value. In 
our example, you would click the button in the lower right corner.

5. Check the “Number of hot points” value at the bottom 
of the dialog. It displays how many positions in the file the 
analysis found.
In our example it shows how many positions with low amplitude in the 
right channel meet the criteria specified by the parameters in the dialog.

6. Use the scroll bar below the “Number of hot points” 
value to browse between the positions found.
The wave cursor jumps between the points found by the analysis, and 
the display scrolls if needed.

7. When you want to browse another property, click on 
the corresponding tab (if required) and then on the value 
button that represents it.
For example, to check the amplitude of the left channel instead, click that 
button. To check peak values, click on the Peaks tab and then on one of 
the value buttons on that tab.

The result of the analysis is saved until you close the dia-
log or click Analyse again.

Creating markers

If you like you can add markers at the “hot points”:

1. Select a property and channel for which you want to 
add markers.
You will add markers for the same property as you are currently brows-
ing, so this selection is done with the value buttons, as described above.

2. Click the “Create markers…” button.
Temporary markers are added at all “hot points”.

! Since you are always browsing one channel at a time 
in a stereo file, markers can be added for only one 
channel at a time.

Click here to 
browse the mini-
mum levels for 
the right channel.

Here you can 
see the number 
of “hot points” 
found.
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The markers are named using the following principle: “Hot 
point number” (“Channel”). For example, a marker at the 
third “hot point” in the left channel would be labelled “3 
(L)”.

Focusing

You can also focus the display on a certain “hot point”:

1. Use the “Number of hot points” scroll bar to move the 
position indicator to the position you are interested in.

2. Click the Focus button.
Now two things happen:

• The wave display zooms in on the selected point.

• The “Global analysis” dialog is “folded in” so that only 
its title bar is visible.

The Peaks tab

This is used to find peak values in the audio, that is, single 
samples with very high values.

Parameters

There are two report parameters:

• “Maximum number…” allows you to put restrictions on how 
many points will be reported. For example, setting this to “1” 
will make the program report only the highest peak (or one of 
the peaks with the highest value – if there are several with the 
same value).

• “Minimum time…” lets you set things up so that the points 
don’t occur too close. Settings this to “1 s” will ensure there is 
always at least a second between reported points.

Result

The Result fields show you the following values:

The Loudness tab

This finds loud and weak sections in a more “intelligent” 
manner than the Peaks tab. The theory behind this is that 
there might be a single sample with a high or low value 
somewhere, but this may not necessarily mean that this 
section is perceived as loud/weak.

To find sections that the ear perceives as significant in vol-
ume, you must look at a longer section of audio. To do this 
you measure a consecutive section of samples and then 
average their value. WaveLab Essential does just this, us-
ing a mathematical method called RMS (Root Mean 
Square) which is well known for its accuracy.

Parameters

The parameters on the Loudness tab are slightly more 
complicated than those for Peak analysis:

• “Resolution” is the length of audio measured and averaged. If 
this value is lowered, very short passages of loud/low audio 
will be detected. When it is raised, the sound will have to be 
loud/low for a longer period to result in a hot point.

• “Threshold…” is used for recordings where there are pauses, 
to make sure the average value is calculated correctly. A 
pause could “fool” the algorithm. Therefore you can set up a 
value, and all audio below that value will be considered silence 
and will not be taken into account for the average value.

Option Description

Maximum The highest peak in the analysed section.

At Cursor The level of the sample at the wave cursor position, at the 
time of the analysis.
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• “Maximum number…” and “Minimum time…” are the same as 
on the Peaks tab, see above.

Result

The Result fields show you the following values:

The Pitch tab

The Pitch tab shows the values from WaveLab Essential’s 
extremely accurate pitch detection algorithm. This can be 
used for pitch shifting, for example, to get one sound in 
tune with another.

There are no parameters to set. The display shows the 
pitch for each channel, both in Hertz (Hz) and as semi-
tones and cents (hundredths of a semitone).

Since the display shows an overall value for the entire 
analysed section, the “hot point” controls in the lower sec-
tion of the dialog are not used on this tab.

Usage guidelines

• The result is an average value for the whole selection.
• The method only works on monophonic material (not on 

chords or harmonies).
• The algorithm assumes the analysed section has a reasonably 

stable pitch.
• The material must be relatively well isolated from other 

sounds.
• It is preferable to analyse the sustain portion of a sound, rather 

than the attack. The pitch is usually not “stable” during the at-
tack.

• Some synthetic sounds may have a weak fundamental (first 
harmonic) which can fool the algorithm.

The Extra tab

This tab shows you two things:

• The average DC Offset in the analysed section.
See “Eliminate DC Offset” on page 74 for details.

• The Apparent Bit Resolution.
This attempts to detect the actual resolution in the audio, i.e. how many 
bits are really used. This is useful e.g. if you want to check whether a 16 
bit file really uses 16 bits (or if it was actually recorded with only 8 bit res-
olution and then expanded up to 16 bits).

Option Description

Maximum and Mini-
mum

The level of the highest and lowest points in the analy-
sed section.

Average The overall loudness of the whole analysed section.

Around Cursor The loudness at the wave cursor position at the time of 
the analysis.
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The Errors tab

This tab actually reports two totally separate things:

• Glitches
These are disruptions in the audio. Glitches may occur after problematic 
digital transfers, after careless editing, etc. They manifest themselves as 
“clicks” or “pops” in the audio.

• Clipping
A digital system has a finite number of levels that it can represent prop-
erly. When a sound has been recorded at too high a level or when digital 
processing has raised the level past what the system can handle, hard 
clipping occurs. This will be heard as a very harsh type of distortion.

A sine waveform before clipping…

…and after.

Report parameters

“Maximum number…” and “Minimum time…” are the same 
as for the Peaks tab, see above.

Glitch parameters

• “Threshold” is a value for setting how drastic a change in level 
has to be reported as a glitch. The higher this value, the less 
sensitive the detection.

• “Sensitivity” is a length value. It represents the length of time 
that the waveform must exceed the threshold to be reported 
as a glitch. The higher this value, the less sensitive the detec-
tion.

Clipping parameters

The program checks for a number of consecutive samples 
at full value, to determine whether clipping has occurred. 
“Threshold” is a setting to determine the exact number of 
these consecutive samples which must occur for the pro-
gram to report clipping.

Results

This reports the number of glitches and clipping instances 
that have been found.

Working with presets
As with effect processors you can create presets for all 
the settings in the dialog for quick recall. See “Presets” on 
page 30 for details.

! It is not 100% certain that the points found by the al-
gorithm are real glitches. Please zoom in and play 
back to check whether the found points really indi-
cate a problem.
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3D Frequency Analysis
This function allows you to view a wave file in the fre-
quency domain rather than in the time domain. Although a 
wave display (time domain) tells you a lot about where one 
sound starts or ends in a file, for example, it doesn’t say 
anything about the timbral contents of the file. A frequency 
graph (frequency domain) does.

The graph used in WaveLab Essential is actually some-
thing often referred to as an FFT (Fast Fourier Transform) 
plot.

Creating the graph
1. Select the part of the file you want to analyse.
If you select a stereo recording, a mix of the two channels will be analy-
sed.

2. Select “3D Frequency analysis options” from the Anal-
ysis menu and click on the Frequency tab. Adjust the set-
tings if needed.
These are the only settings that cannot be redone when the graph is al-
ready open.

3. If you only want to see a plot for a part of the frequency 
range, adjust the “From” and “To” values.
The range must always span at least three octaves.

4. Decide if you want the frequency axis in the graph to 
be linear or logarithmic.
Logarithmic is often the most natural choice since each octave (doubling 
of the frequency) is then represented by an equal distance on the fre-
quency axis.

5. Click OK to close the dialog.

6. Select 3D Frequency analysis from the Analysis menu.
The wave is analysed and the graph opens in a new window.

The frequency graph shows you how the different fre-
quency components vary over time. A high “mountain” 
means that this frequency is very prominent at that partic-
ular time.

Adjusting the view
There are a number of settings you can make that affect 
the way the graph is displayed.

1. Either select “3D Frequency analysis options…” from 
the Analysis menu, or double click directly on the graph. 
Click on the Style tab.

2. Decide whether you want the graph to be in color, 
grey scale or black and white.

3. Decide whether you want to use a change in color to 
represent the amplitude (the height of each mountain de-
termines its color) or if you want it to represent frequency 
(the frequency spectrum is drawn in colors ranging from 
red to purple).

4. Decide on a background color (black or white).

5. To view the effect of your changes, click Redraw.

! The length of the selection affects the accuracy of 
the analysis. For short selections the result will be 
very detailed. For longer selections (over a minute or 
so) it will not give equally detailed results, since the 
harmonic content might vary “between the measure 
points”, which is then not shown in the display. You 
might for example make a separate analysis of the at-
tack (beginning) of a sound, since the most drastic varia-
tions usually occur there.
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6. Click the Perspective tab.

7. Decide from which point of view you want to examine 
the graph (use the “freq/time” figure as a directional 
guide).

8. Decide whether you want a linear or exponential am-
plitude display.
The Wave window’s level rulers use a linear display, so this is a natural 
choice to start with.

9. Again, if you so desire, click Redraw.

Working with multiple views
If you wish you can view the same graph in several win-
dows, but with different style and perspective settings. 
This allows you to get a better view of an otherwise 
crowded graph.

• To open a second view of the graph, drag-create a window, 
see “Working with multiple windows” on page 25.

• To make settings for one of the windows, select it, open the 
“3D Frequency analysis…” options dialog from the Analysis 
menu and proceed as described above.

Examples of how the graph can be used
The graph can be used for example for the following pur-
poses:

• To see how the frequency spectrum is distributed in a mix.
• As a basis for EQ-ing, so that you know which frequencies to 

reduce or boost.
• To see which parts of the audio spectrum a certain background 

noise occupies (for removing by filtering).
• For educational purposes – these graphs tell you a lot about 

how different sounds are “built”.
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Introduction
Podcasting is a method of distributing multimedia files 
over the Internet, e.g. for playback on mobile devices and 
personal computers. A Podcast can be downloaded auto-
matically, using software capable of reading "RSS feeds". 
RSS stands for "Really Simple Syndication" and is a stan-
dard for distributing news and other information via the In-
ternet.

An RSS news feed sends short messages on a certain 
topic (e.g. sports, music, etc.), made available from a web 
site. In order to read the messages, the user employs a 
program (e.g. a special feed reader or an Internet 
browser) that has the ability to monitor multiple feeds and 
automatically download new messages on a regular basis.

Technically speaking, a Podcast is an RSS feed including 
data content, such as audio or video files. Like a kind of 
"show" with new episodes released regularly, for an audi-
ence that wants to listen when, where and how they want. 
As such, this is a great way to make information available 
to anyone.

As you know, WaveLab Essential is capable of editing and 
producing audio material, but it also has the ability to cre-
ate and publish Podcast episodes at will. And all this with-
out ever quitting the program!

All you need, except for WaveLab Essential itself, is some 
webspace with an FTP account for it in order to upload 
the Podcast data.

Creating a new Podcast
In order to create a new Podcast from scratch, pull down 
the File menu, and select "Podcast..." from the New sub-
menu. 

This will bring up a new Podcast window where you can 
enter all information required for the Podcast (usually this 
will be paths to mp3 audio files along with some textual in-
formation).

Alternative ways to create a Podcast

There are other ways to create a Podcast, which can be 
shortcuts, depending on what kind of documents you al-
ready have opened in WaveLab Essential.

Given that a Wave window is the currently active docu-
ment:

• Pull down the Edit menu and select "Create Podcast 
from Wave...".
This will create a new Podcast window, with the audio file already being 
selected for episode 1.

• Pull down the File menu and select "Add to Podcast..." 
from the Special submenu.
A dialog appears from which you can either select a Podcast currently 
open in WaveLab (if any), or browse and open an existing Podcast from 
your harddisk. In both cases, a new episode will be added to the Pod-
cast, with the audio file selected for this episode. Alternatively, you can 
also choose to create a new Podcast from this dialog, with the audio file 
already being selected for episode 1.

Given that an existing Podcast window is currently open:

• Select "Clone this Podcast..." from the Podcast win-
dow’s Options menu.
An untitled copy of the existing Podcast is created, containing all infor-
mation of the original Podcast. Alternatively, you can drag the Podcast 
window’s Document icon onto the WaveLab Essential desktop to 
achieve the same.

Podcast templates

WaveLab Essential allows to store Podcast templates 
from open Podacst windows:

• Pull down the File menu and select "Save as template..."
This will store the currently active Podcast window’s information in a 
template. Next time when you create a new podcast by using any of the 
methods described above, you can choose this template, so that the in-
formation is already filled in the new Podcast window.
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The Podcast window

A Podcast window including four episodes.

The Podcast window is divided into two panes. The lower 
pane shows an item list of the basic feed and all episodes 
included in the Podcast. 

The upper pane shows the information for the feed or an 
episode, depending on the item selected in the list below. 
This is where you will be adding files, Internet links or tex-
tual information to the Podcast feed and its episodes.

Adding, moving and deleting episodes
There are two ways to add an episode to a Podcast:

• Select "New" from the Podcast window’s Episodes 
menu.
This will add a new untitled episode without any information being 
present.

• Select an existing episode in the Podcast window’s 
item list, then select "Duplicate" from the Episodes menu.
This will add a new episode, copying all information from the existing ep-
isode to the new one.

Episodes can be moved by using the "Move up/down" 
functions in the Podcast window’s Episodes menu. Alter-
natively, you can also re-order episodes by using drag-
and-drop in the item list.

In order to delete an episode, select it in the item list and 
use the "Delete" function in the Episodes menu.

There must be at least one episode present in the 
Podcast.

Adding information to the Podcast
The upper pane of the Podcast window shows various 
fields and settings that are related to the basic feed or an 
episode, depending on what you have selected in the 
lower pane’s item list (the fields are slightly different for 
the feed and episodes).

Field labels in bold letters point at a field that is man-
datory to fill. For quick publishing of your Podcast it is suf-
ficient to fill these fields only.

Following settings are available for the feed:

Setting Description

Title Sets the title of the feed (e.g. the topic of your pod-
cast). This is a mandatory field.

Description Further description of the feed content (HTML tags 
are also allowed). This is a mandatory field.

Import 
HTML file

Allows to browse for an HTML document, replacing 
the description above. Clicking the "Pen" button 
launches your HTML editor (see “Global Podcast 
options” on page 166), which allows for more com-
plex designs.

Internet link
(URL)

Your feed’s main link presented to the user. Use this 
to direct people to a certain website that is related to 
your feed. This is a mandatory field.
Clicking the "Link" button will open the specified 
URL in your system’s default Internet browser, to 
make sure that the link is correct.

Picture You may add a picture to your feed. This picture can-
not be larger than 144 x 400 pixels according to the 
RSS standard, but it is possible to automatically re-
size the picture, if required (see “Global Podcast op-
tions” on page 166).
Clicking the "Glasses" button will open the specified 
picture in your system’s default image viewer.

Publication 
date and 
time

Allows to set the feed’s publication date and time. If 
"As most recent episode" is checked, this will auto-
matically be set accordingly. Clicking the "Now" but-
ton will set your system’s current date and time.
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These settings are available for episodes:

Please note the following:

• When using HTML files and publishing the Podcast, any 
picture files that may be referenced by the HTML file will 
automatically be uploaded without any intervention (for 
this to work, HTML files should be in unicode "utf-8" or 
"Windows Latin code 1252" format).

• All fields support WaveLab Essential's "Default text vari-
ables" from the Options menu (see “Defining user vari-
ables” on page 152).

• It is possible to add an open Podcast to a Data CD/
DVD project, using "Add to Data CD/DVD" from the Spe-
cial submenu of the File menu. This way you can easily 
backup the complete Podcast including all accompanying 
media files to a CD for example.

Optional information

Clicking the "Extra..." button in the Podcast window’s up-
per pane allows to specify optional information for the 
feed and the individual episodes. The information here is 
not mandatory and rarely used. Feed receiving programs 

may or may not take advantage of these settings, and this 
is why they are gathered in an extra dialog (your Podcast 
will play perfectly without specifying anything here, but 
you may go ahead, if you so desire).

If any optional information is set in this dialog, the small 
"light" within the "Extra..." button will turn from orange to 
green.

iTunes extension

If your Podcast should be received using Apple’s iTunes 
application, you may want to activate the "iTunes exten-
sion" checkbox in the feed settings. This enables the 
"iTunes..." button to specify additional feed and episode 
information.

Again, the information here is not mandatory, and your 
Podcast will play fine in iTunes, even without the iTunes 
extension activated. But making proper settings here (e.g. 
in the Categories and Keywords sections) may help your 
Podcast getting distributed more easily among iTunes us-
ers.

Global Podcast options
There are some additional options you can set, which are 
valid for all Podcast windows. Selecting "Global op-
tions..." from the Podcast window’s Options menu brings 
up this dialog:

The Global Podcast options dialog.

Setting Description

Title Sets the episode’s title. This is a mandatory field.

Description Further description of the episode content (HTML 
tags are also allowed). This is a mandatory field.

Import 
HTML file

Allows to browse for an HTML document, replacing 
the description above. Clicking the "Pen" button 
launches your HTML editor (see “Global Podcast 
options” on page 166), which allows for more com-
plex designs.

Internet link
(URL)

An additional link related to the episode. 
Clicking the "Link" button will open the specified 
URL in your system’s default Internet browser, to 
make sure that the link is correct.

Audio file Sets the path to the audio file you want to add to the 
episode. This could be any file type that is supported 
by WaveLab Essential, but should be an mp3 file for 
best possible compatibility.
Clicking the "Arrow" button allows to directly add any 
file that is currently open. Alternatively, it is also pos-
sible to drag an opened audio file’s Document icon 
onto the Podcast window’s upper pane.
Clicking the "Play" button will open the specified file 
in your system’s default media player.

Publication 
date and 
time

Allows to set the episode’s publication date and 
time. Clicking the "Now" button will set your system’s 
current date and time.
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The following options are available:

Publishing the Podcast
When you are finished with adding files and information to 
your feed and episodes, you can directly publish the Pod-
cast to the Internet from within WaveLab Essential, using 
the built-in FTP client.

The requirement for this to work of course is, that you 
must have some webspace with an FTP account for it in 
order to upload data, so that you can make your Podcast 
available at a publicly accessible Internet address.

FTP site manager
WaveLab Essential’s FTP site manager stores all informa-
tion required for the Podcast upload process. Selecting 
"FTP site..." from the Podcast window’s Publish menu 
brings up the FTP site dialog:

FTP site dialog.

Following settings are available and must be specified:

Here’s an example:

• Your FTP host address is "ftp.MyPage.com", your public 
web site address is "www.MyPage.com".

• The Feed file name setting is "podcasts/fantastic-
cast.xml", the Associated web site setting is 
"www.MyPage.com/podcasts".

• The Podcast’s media files will then be uploaded onto 
the FTP at "ftp.MyPage.com/podcasts".

• The Podcast file itself (and as such the Internet address 
to be distributed) will be found at 
"www.MyPage.com/podcasts/fantastic-cast.xml".

Each Podcast stores its own complete FTP site informa-
tion. It’s also possible to save and recall FTP site presets 
using the Preset functions at the bottom left of the dialog.

Uploading the Podcast
Once you have specified the FTP site settings, uploading 
the Podcast is rather simple by using the functions in the 
Podcast window’s Publish menu.

Option Description

Automatic
picture 
resizing

Defines what to do, if specified pictures exceed the 
maximum size allowed by the RSS standard. If pic-
tures need resizing, the original images on your hard-
disk will not be modified.

Time offset
with GMT

The displayed dates and times are "local". If your sys-
tem is properly set, WaveLab Essential will automat-
ically adjust the time offset in relation to GMT 
correctly. However, if you want to have time and date 
relative to a different time zone, adjust the value here.

HTML 
Editor

Sets the path to the external HTML editor, which will 
be launched when clicking the "Pen" button in the 
feed or episode "Import HTML file" setting.

Setting Description

Host Your own FTP address.

User name Your login user name to your own FTP address.

Password The password to your user name.

Use Passive 
Mode

This should be left activated and only changed if you 
experience problems with the FTP connection.

Feed file 
name (with 
path)

The Podcast file name, as you want it to end up on 
your FTP site (extension .xml), including the relative 
path to it.
Both, file name and path, are part of the Podcast’s fi-
nal public Internet address, so you may want to avoid 
long names.

Associated 
web site 
(URL)

Your own web site address, including the path to the 
feed (see above).
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Following upload functions are available:

Please note that when we say "all items", we in fact 
mean all items which have their "Enabled" checkbox acti-
vated in the item list. If not enabled, these episodes are 
simply omitted from the Podcast.

Uploading happens in a separate background pro-
cess, so that you can continue working in WaveLab Es-
sential, in case uploading takes time.

Checking the Podcast

Selecting "View XML source document..." from the Pod-
cast window’s Publish menu launches your system’s de-
fault XML editor, in order to visualize the contents of the 
feed XML file produced by WaveLab Essential.

And as a final check, select "View published Podcast..." 
from the Podcast window’s Publish menu, to open your 
system’s default Internet browser and receive the Podcast 
you have just published from the Internet.

Function Description

Update all 
items on 
FTP

Uploads/updates the XML Podcast file on the FTP; 
also uploads all items’ media files, but only if they are 
not already present on the FTP.
This is the most common function to upload and up-
date your Podcast.

Upload/Re-
place all 
items on FTP

Same as above, but always uploads/replaces all 
items’ media files; useful if you have changed the au-
dio data, for example.

Update se-
lected item on 
FTP

Uploads/updates the XML Podcast file on the FTP; 
also uploads the media file of the currently selected 
item in the list, but only if it is not already present on 
the FTP.

Upload/Re-
place se-
lected item on 
FTP

Same as above, but always uploads/replaces the 
media file of the currently selected item in the list; 
useful if you have changed the audio data, for exam-
ple.



20
Sampling and creating loops



170

Sampling and creating loops

Introduction
This chapter describes various operations related to cre-
ating loop sounds (e.g. for samplers).

Looping is a common technique used in samplers to sim-
ulate the infinite (or at least very long) sustain of many in-
strumental sounds. WaveLab Essential has tools for 
creating smooth loops, even for the most complex types of 
sounds.

What we normally refer to as audio files in WaveLab Es-
sential are probably called “samples” in your sampler. In 
this chapter we will adhere to this terminology and call au-
dio recordings “samples”.

Using WaveLab Essential with 
Steinberg HALion
If you are the lucky owner of Steinberg’s HALion software 
sampler, you can use WaveLab Essential as your sample 
editor. You can add samples by dragging audio file selec-
tions from WaveLab Essential onto the HALion Key Zone 
Editor or by using copy and paste. It is also possible to 
transfer multiple samples from WaveLab Essential to 
HALion in one go, using the following procedure:

1. Open and set up the audio files in WaveLab Essential.
You may for example need to adjust the root key settings in the “Sample 
attributes” dialog (see “Editing sample attributes” on page 170), so that 
they correspond to the proper pitches of the files.

2. If you have edited the files in any way, make sure they 
are saved.
This is very important, since HALion will load the actual file from disk.

If you haven’t edited the actual audio, but only the loop 
markers or sample attributes (e.g. root key settings), you 
should save the file(s) with the “Save as” command. 
This is because those settings are stored in the file headers, which are 
only rebuilt when the audio is re-saved. If the audio portion of a file hasn’t 
been changed, WaveLab Essential will not re-save the audio on a regular 
“Save” – hence you should use “Save as”.

3. Make a selection range in one of the files, covering the 
section you want to use as a sample.

4. Press [Ctrl]-[Shift]-[C].
With this function, no audio is copied, only the audio file reference and 
the position of the selected region.

5. Make a new selection in another file and press [Ctrl]-
[Shift]-[C] again.
The file and region information for the new selection is added to the clip-
board, without removing any previous information there.

6. Copy the regions of as many audio files as you like in 
the same way.

7. When you have copied the desired regions, go to the 
Keyzone Page view in HALion and press [Ctrl]-[V].
The copied regions appear as separate samples in HALion, assigned to 
keys corresponding to their original root key settings.

If you are using HALion with Cubase SX/SL, and have 
selected WaveLab Essential as your external Wave Editor, 
you can open HALion samples for editing in WaveLab Es-
sential directly from the sampler, by selecting “Edit in Cu-
base SX/SL”.

Editing sample attributes

The “Sample attributes” dialog.

This menu item on the Sampling menu allows you to make 
settings for a sample. They do not process the sample in 
any way, they just give it properties that your sampler may 
or may not take advantage of. 
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Basic looping
Instrumental sounds in samplers rely heavily on looping. 
Looping a sound allows you to repeat a section of the 
sample indefinitely, to create a sustain of unlimited length. 
An example of this would be an organ sound. Without 
looping you will only be able to play notes as long as the 
original recording. With looping, notes can be of any length.

Finding a good loop point takes a bit of practice. Here is 
some advice:

• There are only two types of loops: very long and very short. 
Loops of intermediate lengths usually don’t work very well.

• A long loop will sound the most natural, and should be used 
whenever possible. However, if the sound does not have a 
stable section in the middle (an even sustain part), it might be 
hard to find a good long loop. For example, a piano note – 
which decays continuously – will be hard to loop since the 
start point of the loop will be louder than the end. A flute will 
be much simpler, because the sound in the sustain section is 
very stable.

• Very short loops (covering only a few cycles or periods) can 
almost always be found, but may sound “static” and unnatural.

• A loop should normally start a short time after the “attack” por-
tion, that is, when the sound has “stabilized” to a sustaining 
note.

• If you try to set up a long loop, it should end as late as possi-
ble, but before the sound starts decaying to silence (if it does).

• If you go for a short loop, it is harder to say exactly where in 
the sound to put it, but it should definitely be towards the end.

More information about looping in general, and the exact 
capabilities of your sampler in particular, can be found in 
the sampler’s manual. Below follows a description of 
WaveLab Essential’s set of tools for setting up loops.

Setting Description

Name The name the sample will have in the sampler. If the 
sample is an already named file, the name is dis-
played here, but you can change it if you wish. Note 
that not all samplers support all characters. Further-
more, if the name is too long, it will be truncated.

Parse name into 
key

If a sample is named so as to denote its root key 
(e.g. “Bass C0” – a sample of a bass in the key C0), 
clicking this button will automatically fill in the key 
field (see below) with the root key information taken 
from the file name. Note that you can also use this 
method for samples that are named so as to denote 
their MIDI note numbers (see below).

Parse last 
group of digits

This is available when you select MIDI note number 
notation (see below), and can be useful when you 
want to use the Parse name into key option (de-
scribed above). In cases where samples are named 
with multiple groups of numbers – e.g. 
“Piano_01_112” – you need to activate this option 
to let WaveLab Essential know that the last group of 
digits is the one denoting the MIDI note number.

Key This specifies which key will play back the sound at 
its original pitch.

Detune This specifies whether the sample should be played 
back at a slightly different pitch. The range is ±50% 
of a semitone, which translates into a quarter tone in 
each direction.

Detect from 
audio selection

If you click this button, WaveLab Essential will anal-
yse the sample and determine its pitch and amount 
of detune. For this to work properly, the sample must 
be of such a nature that it is possible to clearly de-
tect a pitch (it won’t work properly with chords and 
drum loops for example). 

Musical notation/MIDI 
note number

These radio buttons let you choose whether to dis-
play the different key values in the dialog with the 
key’s pitch or the key’s MIDI note number. In musical 
notation, keys are denoted according to their pitch 
(e.g. C3 – meaning the note C in the third octave). 
Each key corresponds to a MIDI note number, from 
0 – 127. The key C3 for example, corresponds to 
the MIDI note number 48. MIDI note numbers make 
it possible for samplers to automatically map sam-
ples to the correct keys.

Key range If a sample is part of a multi-sample key map, you 
can specify the key range for the sample, i.e. which 
keys should be able to play it.

Velocity range If a sample is part of a multi-sample key map with 
velocity switchable samples, you can here specify 
the velocity range for the sample – the minimum and 
maximum velocity values that should trigger the 
sample.
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Adding, moving and playing loop markers
Loop markers are added, moved and otherwise edited just 
as any other type of marker. This is described in the sec-
tion “Introduction” on page 98 and onwards.

Here is a brief description on how to create a basic loop:

1. Make a selection that corresponds to the area you 
want looped.
If you like, you can play back with “Loop selection” activated on the 
Transport bar and adjust the selection during playback.

2. Bring up the Marker toolbar.

3. Click on the loop marker icons (the green ones).
The selection is now enclosed by loop markers.

4. Make sure that “Loop as marked” is activated on the 
Transport bar.
Click the Playback end position/Loop mode button to open the corre-
sponding pop-up.

5. Play back and adjust the position of the markers to 
change the loop.

A basic loop setup using markers.

Getting a good loop by just dragging the markers around 
might be hard. Most often you will hear a click or an abrupt 
change in timbre at the turning point, which is hard to get 
rid of by dragging the markers.

We suggest you only use this method for setting up the 
basic length of the loop (leaving clicks, etc. as they are) 
and then use the Crossfade Looper and Loop Tone Equal-
izer (described below) to perfect it.

Using the Crossfade Looper

What is the Crossfade Looper?
The Crossfade Looper is a special tool for creating “seam-
less” loops. It allows you to “nudge” the loop points while 
at the same time providing visual feedback of the “join” 
between the start and end point.

The Crossfade Looper can also automatically find loop 
points for you, by scanning the area of the waveform that 
is in the current loop points’ vicinity. You can specify pa-
rameters for how “finicky” the program should be when 
suggesting loop points.

Finally, if you can’t find a good enough loop point using 
the methods described above, the Crossfade Looper al-
lows you to process the waveform to allow for smoother 
loops. It does this by crossfading areas of the waveform 
close to the loop start and end points.

Opening the Crossfade Looper
Before you open the Crossfade Looper we suggest you 
set up a basic loop as described on the previous pages. 
Then proceed as follows:

1. If you have several loops, place the wave cursor some-
where inside the one you want to work on.
This can be done by clicking somewhere between the loop markers.

2. Select Crossfade Looper… from the Sampling menu.

3. Click on the “Loop points” tab.
This tab should be your starting point, since this is where you adjust the 
loop points.

The following sections describe the common proce-
dures for using the Crossfade Looper.

About the Crossfade Looper dialogs

The Crossfade Looper dialogs are non-modal. While they 
are open, you can still access other windows (e.g. the 
Transport bar). However, all editing of the Wave window 
on which you are working is blocked out (except moving 
the current pair of loop markers, of course).

! Please note the points about marker pairs (see 
“About marker pairs” on page 98).

! Note that it takes a while for changes in the loop to 
take effect on playback. Exactly how long depends 
on your buffer settings, see “About loop updating 
and short loops” on page 58.
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Furthermore, each time you click Apply, the process starts 
out from the wave data as it was when you opened the 
Crossfade Looper (since you want to be able to try out 
various types of crossfading without re-processing the 
wave each time). This affects the undo function: there is 
only one step of undo and no redo in the Crossfade 
Looper.

Moving the loop points “manually”
Let’s assume you have set up a basic loop that you are 
happy with, except for glitches or “bumps” at the turning 
point. You can then use the Crossfade Looper to move 
the points manually, in small steps, to eliminate the glitch.

This is actually technically no different from moving the 
loop points in the wave display, but the features of this di-
alog makes it much easier to find good loop points, since 
the display gives you visual feedback as you go along. We 
also recommend that you have playback going on in “Loop 
as marked” mode since you will then also hear what you 
are doing!

The two ways of moving loop points

There are two ways of moving the loop points: dragging in 
the actual waveform (position the mouse pointer in the 
display and drag sideways) and using the “nudge” but-
tons.

• Dragging in the waveform allows you to perform larger moves 
more quickly.

• The nudge buttons are more useful for fine-tuning since they 
move the points by one screen pixel. This means that in 1:1 
zoom mode, each press on a nudge button moves the loop 
point a single sample.

The various moving options

• By moving the left part of the display, you are moving the end 
point to a later (left) or earlier (right) position.

• By moving the right part of the display, you are moving the 
start point to a later (left) or earlier (right) position.

• If you activate Linking, both the start and end points will move 
simultaneously. That is, the loop length will be exactly the 
same, but the entire loop will move.

• You can switch to the Wave window and adjust the markers 
there, if needed.

Using the auto-find feature
If desired, you can have the program search for good 
loop points automatically. This is technically no different 
from adjusting the loop points yourself, only that the pro-
gram uses pattern matching algorithms to suggest loop 
points for you.

Let’s say that you want to let the program find a better 
start point for the loop. You first set up a start and end 
loop marker, to get a basic loop, as described above. You 
then invoke the automatic searching, and the program 
searches the waveform from the current start point, trying 
to find a section that is as similar as possible to the area 
just after the current end point. When it finds a match it 
stops.

You decide how similar the section must be to be consid-
ered a match.

Setting up the parameters

The auto-find parameters.

There are two parameters for the auto-find feature, de-
sired correspondence and search accuracy.

• Search accuracy is a parameter for determining how many 
samples should be included in the analysis. Higher values re-
sult in greater accuracy, but also longer processing times.

You can drag either side of the waveform directly…

…or use the nudge buttons.
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• Desired correspondence is a value for how well the found 
section must resemble the section to which it is compared, to 
be considered a match. WaveLab Essential uses two meth-
ods for comparison, “phase match” and “join match” (which 
provide much better matching than the simple zero crossing 
detection used by most other programs. Phase matching also 
ensures that no harmonic cancellation will occur when you 
crossfade, see later in this chapter). First phase matching is 
performed and then, to “fine tune”, a join match is employed. A 
value of 1000 will most likely fail completely, since it requires a 
100% perfect match.

Searching

1. Set up the search parameters.

2. Click on one of the buttons in between the “nudge” 
buttons.
Each time you click, the program scans from the current point (forwards 
or backwards, depending on which button you clicked) until it finds a 
point that matches. It then stops. If you wish you can stop at any time by 
clicking the right mouse button, by using the Stop button on the status 
bar or by hitting [Esc]. The program will then jump back to the best match 
found so far.

3. Check the loop by playing back.

4. If you think there might be a better point, at some later 
or earlier position, just click the button again, and scan-
ning continues from this point onwards.

Remember that you can always go back to the main Wave 
window and adjust the markers manually.

Working with candidates
Often you will want to try various alternatives before com-
mitting to a loop. To be able to compare several alterna-
tives, WaveLab Essential offers looping candidates. These 
allow you to store sets of loop points in memory locations 
for later recall.

When you have set up the loop points as desired, you 
store them by selecting “Save candidate” from the options 
pop-up menu in the dialog, and then selecting one of the 
five memory locations.

To recall a stored candidate, select “Restore candidate” 
from the pop-up menu, and then select the desired mem-
ory location from the submenu. The points are now re-
called and the loop points in the wave are moved to the 
positions stored in the memory location.

To compare several candidates, you can for example 
have playback going, select them one after the other, and 
listen to the difference.
Once you have found your candidate, you can select OK to exit this win-
dow or proceed to crossfading.

Things to note about candidates

• There is only one set of candidates per Wave window, not one 
per set of loop points. This means that if you have several sets 
of loops in your file, you must be careful so that you don’t re-
call the wrong set.

• Crossfading is not part of the candidate, only loop positions 
are. You should decide on a candidate to use before you ap-
ply crossfading.
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Creating a crossfade

What is a crossfade and when do I need it?

Sometimes it is impossible to find a loop that doesn’t 
cause any glitches. This is especially true for stereo mate-
rial, where you might be able to find a perfect candidate 
for either channel, but not for both at the same time.

One solution to this problem is to use crossfading. This 
technique “smears” the material around the end loop point 
so that it loops perfectly. It does this by mixing material be-
fore the loop start with material just before the loop end.

The only problem with this technique is that it alters the 
waveform and hence changes the sound. However, nor-
mally you can find settings that minimize this problem.

Setting up

1. While still at the “Loop points” tab (in the Crossfade 
Looper dialog), try to create as good a loop as you can.

2. Click on the Crossfade tab.

3. Make sure the Crossfade check box is activated.
There is a corresponding check box on the Post-Crossfade tab. This lets 
you choose if regular crossfading and/or post-crossfading will be per-
formed when you click Apply later.

The Crossfade tab with crossfading activated.

4. Decide on a length for the crossfade either by drag-
ging the length handle or by adjusting the Length value 
below the graph.
The length is used to adjust the amount of the audio file that will be pro-
cessed. This area is always located just before the end of the loop, but 
the Length value adjusts how far towards the start of the loop it 
stretches. As you can see, an equally large area before the loop start is 
used as basis for the processing. However, this area is not processed, 
just analysed.

Generally you will want the crossfade to be as short as it 
can be, with an acceptable result:

• Using a long crossfade will be a better guarantee that the loop 
will be smooth. However, more of the waveform will be pro-
cessed and hence changed in character.

• Using a short crossfade will ensure the sound is affected as 
little as possible. However, the loop might then not be as 
smooth as otherwise.

5. Decide on a crossfade shape, by dragging the shape 
handle or by adjusting the shape value.
The considerations for this are the same as when creating other cross-
fades, see “Crossfade” on page 73. 0% means that the sound level will 
be equal in the middle of the crossfade, whereas 100% means that the 
energy will be equal in the middle of the crossfade. Use low values for 
“simple” sounds and high values for “complex” sounds.

Applying and checking the crossfade

When you click Apply, the sound is processed. If you have 
playback going, repeating the loop you will hear the 
change take effect after a short while.

You can check the crossfade visually by opening the 
“Loop points” tab and activating “Display processed sig-
nal” on the options pop-up menu.
When this is activated, the display will show the waveform as it looks 
when crossfaded. When the option is deactivated, the display will show 
the waveform as it originally was. Switching back and forth allows you to 
compare the two.

You can undo the crossfade by selecting Undo from 
the Edit menu.

If you click OK, the dialog closes and crossfading is 
made permanent.
If you click Cancel instead, the dialog closes and the waveform is re-
verted back to the way it was before crossfading.

! Do not move the loop points after performing a 
crossfade! The waveform has been processed spe-
cifically for the current loop settings!
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Creating a post-crossfade
The post-crossfade is accessed from its own tab.

This is identical to the regular crossfade, but it is applied 
to the area after the loop. This means that it is used to fade 
the material so that there will be no glitch when playback 
continues out of the loop.

The post-crossfade looks at the part of the waveform that 
occurs just after the loop start and processes a certain 
area beginning at the end of the loop. The Length param-
eter adjusts the size of this area.

Everything else is identical to regular crossfading, see 
above.

Working with presets
As with effect processors, you can create presets for set-
tings in the dialog for quick recall. See “Presets” on page 
30 for details. This comes in extremely handy for example 
when processing a number of similar files, for example for 
creating a multisample (several instrumental samples 
mapped across the keyboard).

Using the Loop Tone Equalizer

The Loop Tone Equalizer is a function for looping those 
un-loopable sounds, for example sounds that constantly 
decay in level or continuously change in timbre. The Loop 
Tone Equalizer applies drastic processing to the sound 
that evens out changes in level and timbral characteristics, 
before and during the loop.

It does this by using one of the following two methods:

• Slice mixing
A number of slices is specified for the looped section. If for example you 
specify eight slices, the loop is cut up into eight sections of equal length. 
These sections are then mixed together as one sound which is repeated 
eight times. This new piece of audio replaces all audio inside the loop in 
a smart way so that no harmonic cancellation (due to phase offsets) oc-
curs.

• Chorus smoothing
This has nothing to do with a conventional chorus effect, but uses a 
method known as “Phase Vocoding” to filter the harmonics. This method 
is recommended for looping ensemble and choir sounds.

You can use both slice mixing and chorus smoothing in 
conjunction, but it is highly unlikely that you will ever need 
to. Note also that the original length of the loop will not be 
changed by the processing.

In addition to the above, the Loop Tone Equalizer includes 
a crossfade facility so that the original sound fades into 
the processed sections as playback approaches the loop 
start.

! If you intend to use the sound in your sampler in such 
a way that the area after the loop is never played, you 
don’t need to worry about this feature at all! Some 
samplers don’t even allow you to play the area after 
the loop. However, if you do intend to use the area 
after the loop it is very important to have post-cross-
fade activated!



177

Sampling and creating loops

To use the Loop Tone Equalizer, proceed as follows:

1. Set up a basic loop of the length you desire.
This will probably not be a very good loop. If it was you wouldn’t need to 
use the Loop Tone Equalizer.

2. Select Loop Tone Equalizer from the Sampling menu 
and click on the Loop Tone Equalizer tab.

3. Make sure that either slice mixing or chorus smoothing 
is activated and make the desired settings.
For slice mixing, you need to determine the number of slices. Only exper-
imentation can tell how many slices are needed, but generally, the more 
slices, the more natural the sound (to a certain extent). However, the pro-
gram puts a restriction on the number of slices, so that each one is never 
shorter than 20 milliseconds.

For chorus smoothing, you can make the following set-
tings:

4. Switch to the Pre-Crossfade tab and set up a cross-
fade.
You will need to use this feature since the Loop Tone Equalizer itself 
changes the timbre inside the loop and only there. This will mean that the 
transition into the loop will not be as smooth as expected, unless you ap-
ply crossfading. Generally, this is the same as the crossfade in the 
Crossfade Looper window. However, the difference is that this cross-
fade is made before and up to the loop start. The processed material cre-
ated by the Loop Tone Equalizer is added to the original material before 
the loop.

5. Click Apply, and the sound gets processed.
If you have playback going, repeating the loop, you will hear the change 
take effect after a short while.

You can undo the crossfade by selecting Undo from 
the Edit menu.

If you click OK, the dialog closes and processing is 
made permanent.
If you click Cancel instead, the dialog closes and the waveform is re-
verted back to the way it was before processing.

About the end of the loop – Post-crossfading

After using the Loop Tone Equalizer, the transition from 
the end of the loop to the end of the file in many cases 
won’t be very natural. This can be fixed as follows:

1. Close the Loop Tone Equalizer and open the Cross-
fade Looper.

2. Click on the Crossfade tab and deactivate the Cross-
fade option (the check box).

3. Click on the Post-Crossfade tab and make sure 
Crossfade is activated.

4. Set up the post-crossfade parameters and click Apply.

Working with presets
As with the Crossfade Looper, you can create presets for 
settings in the dialog for quick recall. See “Presets” on 
page 30 for details.

Option Description

Timbre This governs the amount by which the timbral char-
acteristics of the sample should be evened out. The 
higher the value, the more pronounced the effect.

Chorusing The delay time of the chorus effect varies with the 
modulation, which causes a sweeping effect. What 
this parameter does is determine the width and 
speed of the chorus sweep.

Enhance Warmth Creates a smoother, warmer sounding effect.

Stereo Expansion This increases the width of the sample in the stereo 
sound image.

! Do not move the loop points after performing the 
processing! The waveform has been processed spe-
cifically for the current loop settings!
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What is customizing?
When we talk about customizing, we mean making set-
tings so that the program behaves and looks the way you 
want it to!

Preferences

In the Preferences dialog on the Options menu you will 
find a number of settings, collected on tabs, for tailoring 
the look and behavior of the program.

Saving the preferences
To make sure the preference settings “stick”, select the 
General tab and make sure “Save preferences on exit” is 
activated. When this is activated, all your preferences set-
tings (as well as all menu options, etc.) are automatically 
saved when you Quit the program.

Creating startup preferences

To make sure the program starts with the same preference 
settings each time you launch it, proceed as follows:

1. Set up all preferences as desired and make sure “Save 
preferences on exit” is activated.

2. Quit the program.

3. Launch the program again, and deactivate “Save pref-
erences on exit”.
Now you can change the preferences for this session, but the settings 
you had when you last quit will be the ones you get next time you launch 
the program.

Folder editing

Navigating to the right folder via file dialogs can some-
times be time consuming, but WaveLab Essential gives 
you the option to optimize these operations.

If you select “Folders” from the Options menu, a dialog 
opens where you set for the saving and opening of prefer-
ences for WaveLab Essential’s various folders. 

To the left in the dialog is a tree list with two root folders; 
“Work folders” and “Document folders”. Work folders are 
the folders associated with temporary files, and Document 
folders are all folders associated with WaveLab Essential 
specific files and documents (Wave, Audio CD Montage, 
etc.). 

Work folders
The Work folders are usually set up after installing Wave-
Lab Essential, as the folders specified for temporary files 
have an important bearing on WaveLab Essential’s overall 
performance. See “Temporary files” on page 15 for a de-
scription of how to set up these folders.
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Document folders
For each WaveLab Essential document type, you can 
specify paths to open and save folders (given that the 
document can be saved). This is done in the following 
way:

1. Click on the plus sign for a document type in the tree 
list.
All document types will have Open and Save sub-items.

2. Select either Open or Save.
Now you can specify a path to a folder which will be automatically se-
lected when opening or saving a document of this type.

For each folder, you can specify the following:

Saving the window layout
If “Open last window layout on startup”, on the Prefer-
ences–General tab is activated, the program will open in 
exactly the same state as it was when you last quit (with 
the option activated). The snapshots, and even the docu-
ment windows you had open (and their “layout”) will auto-
matically be reopened.

You can use this to create a startup “layout” that will al-
ways appear when you launch WaveLab Essential:

1. Set up all windows as desired.

2. Make sure “Open last window layout on startup” is ac-
tivated and quit the program.

3. Launch the program again, and deactivate “Open last 
window layout on startup”.
The next time you launch the program, it will open with the windows set 
up as in step 1 above, regardless of whether you have changed the win-
dow layout since.

If you hold down [Ctrl] when quitting the program, the 
effect of the “Open last window layout on startup” setting 
is reversed. If it was activated, it will be deactivated and 
vice versa.

If you hold down [Ctrl] when launching the program, 
no window layout is loaded.

Styling WaveLab Essential – Wave 
windows
It’s possible to “style” the Wave windows to your liking, by 
adjusting colors (of waveforms, background, cursor lines, 
etc.) and changing the look of the ruler and other window 
details.

By saving the current window style as default, you can 
change the style that is normally used when you open or 
record an audio file in a Wave window.

On the following pages, we will first describe the general 
procedure for how to change the default style, then de-
scribe the elements you can change.

Changing the default style
1. Set up a Wave window to look the way you want it.
Note that this also includes the ruler formats – see “Units of time and 
level” on page 28.

2. Select “Save current window style as default” from the 
View menu.
Now, all Wave windows (which have not been opened before) will be 
shown in the style you specified.

The elements of a style

When you change any of these style settings and want 
to make the changes available to other Wave windows, 
you need to save them as the default style. 
If you don't do so, newly opened Wave windows will automatically be re-
set to the default style!

Item Description

Current folder Here you can specify a path to a folder to use for 
Saving or Opening documents of the selected 
type.

Keep last used The last folder used for saving or opening docu-
ments of the selected type will be selected the 
next time you open or save from the file dialog.

Change when save/
open folder changes

Use this if you want the folder to be redefined if 
the opposite operation is performed (open vs 
save). If you set this option both for the Open and 
Save folders, then these folders will always be the 
same.

When opening 
WaveLab Essential 
set this folder

If you want to reset the folder to a specific folder 
each time you open WaveLab Essential you can 
specify a path here.
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Waveform elements

To change the waveform elements, right-click on a wave-
form (in the overview or in the main display), select Ele-
ments and then select the desired item from the submenu 
that appears.

Colors

To set the color of a certain element in the display, right-
click in the Wave window, select Colors and then select 
an element from the submenu that appears. In the stan-
dard Windows color dialog that appears, select or define 
a color and click OK.

For the display background colors, there are separate 
“top” and “bottom” settings – the resulting display back-
ground will be a gradient “fade” from the top color to the 
bottom color.

If you prefer a single background color (or if you need to 
speed up display redraws, typically with slower graphic 
cards), you can turn this feature off by activating “Do not 
use gradient backgrounds” in the Preferences–Environ-
ment tab. The background color will then be a 50/50 mix 
of the top and bottom color.

Ruler style

To change the look of the rulers (done separately for the 
Overview and Main view), right-click on the ruler, select 
style and then select one of the options from the submenu 
that appears:

Styling WaveLab Essential – Audio 
CD Montage windows

Using custom colors
You can create and assign different color schemes to dif-
ferent clips or tracks to make it easier to find your way 
through the Montage:

• To assign a color scheme to a track, open the Track 
menu and select a color scheme from the Color submenu.
The selected color scheme is used for all current clips on the track, as 
well as for clips you add later on. However, note that this color selection 
is overridden by the clip colors.

• To assign a color scheme to an individual clip, right click 
on the clip to bring up the clip speed menu, and select a 
color scheme from the Color submenu.
Clip color selections (if other than default) override track colors.

• The Mute color overrides all color settings above.

! Note that you make separate settings for the main 
waveform display, the overview and for the two chan-
nels in a stereo file! Which section you make settings 
for depends on where you click.

Item Description

Time Ruler Specifies whether or not the display should have 
a time ruler.

Level Ruler This only applies to the Main view display. It is 
used to set whether or not there should be a ruler 
showing levels.

Solid/Dotted
Markers

These two (mutually exclusive) items are used to 
set the style of the marker lines extending across 
the waveform. If neither is activated, the marker 
lines are hidden.

Range Indicator 
at top/bottom

The range indicator is a small “barber shop 
striped” bar that indicates which part of the 
waveform is shown in the main display. These 
two items are used to set whether it should ap-
pear at the top or bottom of the overview.

Thin/Medium/
Fat Cursor

These three items are used to set the thickness 
of the cursor line.

Solid/Dotted 
zero level axis

These two (mutually exclusive) items are used to 
set the style of the line crossing the waveform at 
zero level (in the middle). If neither is activated, 
the zero level axis is hidden.

Solid/Dotted 
half level axis

As above, but for the two lines crossing the 
waveform at ±50% level.

End of file indicator Allows you to show/hide the line that indicates 
the end of the file.

! Again, when changing colors for the waveform im-
ages, you make separate settings for the main wave-
form display, the overview and for the two channels 
in a stereo file, depending on where you click.

Option Description

3D/Mingled These two (mutually exclusive) items allow you 
to select whether the ruler should have its own 
looks (3D) or whether it should “inherit” the color 
of the waveform background.

Font Opens up a dialog box that allows you to set a 
font for the text/numbers on the ruler. Select a 
font, style, size, effect and color and click OK.

Tick Color This allows you to set the color for the tick marks 
on the ruler. A standard Windows color dialog is 
used.
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Defining custom colors
You can redefine all colors on the Color pop-up menus, as 
well as the colors for various other elements in the Audio 
CD Montage. This is done in the Audio CD Montage Col-
ors dialog, using the following procedure:

1. Pull down the View menu and select “Audio CD Mon-
tage colors…”.
The Audio CD Montage Colors dialog appears. For the menu item to 
be available, the active window must be a Montage window.

2. In the Items list, select the element for which you want 
to edit the colors.
By clicking the plus sign next to a heading, you display the sub elements 
for that item. The available elements are described in the section “The 
color elements” on page 183.

3. Use the three sliders (red, green and blue) to adjust 
the color of the selected element.
The current color is displayed in the field to the right. You can also see 
the changes in the Audio CD Montage window while you are editing.

• If you are editing a clip color element, you can make 
separate color settings for the left and right sides of stereo 
clips.
If you want the same color for the left and right sides, you must make 
sure that the checkbox Edit Left/Right is activated (it is by default).

When this is activated, settings for the left side of a clip are automati-
cally “mirrored” on the right side, and vice versa.

• If you activate the Link sliders checkbox, you can adjust 
all three sliders at once, by moving one of them.
This is useful if you want to adjust the brightness of the color, without af-
fecting the hue.

• Some elements can be hidden totally by activating the 
Hide option.
When this is activated, it is not possible to make any color adjustments 
(since the element won’t be visible in the Audio CD Montage anyway).

• It is also possible to select colors from a standard Win-
dows color dialog, opened by clicking the Select button.

4. If you make a mistake, you can undo your latest adjust-
ment by clicking the Undo button.
To undo all changes you made since you opened the dialog, click Undo 
All.

5. If you want to apply the same color to several ele-
ments, you can use the Copy and Paste buttons.
Set up the color, click Copy, select the next element and click Paste to 
apply the same color settings.

• You can also copy an entire color scheme (for example, 
copy all settings for one of the custom schemes to the de-
fault scheme) by dragging and dropping in the Items list.

6. If you are editing one of the color definitions (the items 
that appear on the track and clip color menus), you can re-
name the color by clicking on the name in the Item list and 
typing a new name.
In the Items list, the color definitions that can be renamed are displayed 
in blue.

7. When you’re finished, click Close to close the win-
dow.

! There are many items of different color displayed in a 
Montage. If you redefine colors, be careful not to 
choose colors which cause some elements to “dis-
appear” (e.g. black marker lines on a black back-
ground).
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The color elements

Clip colors

Under the heading Clip Colors you can select colors for 
various elements in the following clip types:

For each item, you can select colors for a number of differ-
ent clip elements. You can make separate adjustments for 
the left and right sides of a stereo clip, though by default, 
editing a color for the left side will automatically change 
the same setting for the right side and vice versa (see 
“Defining custom colors” on page 182). For mono clips, 
the “Left (mono)” setting is used.

The following color elements are available:

Miscellaneous colors

This section of the Items list in the dialog contains color 
settings for other elements in the Track View:

Working with window layouts
Window layouts are used for creating various “work dis-
plays” for different situations. The following items are 
stored in window layouts:

• The size, position and minimize/maximize properties of docu-
ment windows. This does not include the contents of the win-
dow, just the properties of the window “frame” itself. For 
example, if some Wave window was included in the window 
layout, the Wave you currently have open when you load the 
preset will be sized and moved accordingly.

• Positions of non-modal dialog boxes, such as the off-line pro-
cessors. This includes opening any such windows.

• Positions of plug-in processor panels.

Window layouts are managed in the Window Layouts dia-
log on the View menu. The procedures are the same as 
when handling regular presets (for detailed descriptions, 
see “Presets” on page 30):

• To create a new window layout, set up the display as 
you want it (see the list above) and use the Window Lay-
out dialog to name and add the new layout.

Option Description

Crossfade Region Allows you to set the background color for overlap-
ping clip sections.

Default The default colors, used for clips for which you ha-
ven’t selected any specific color.

Muted The colors used for all muted clips.

Custom These options correspond to the items on the Color 
submenus (on the Track menu and clip speed 
menu). These can be renamed, as described above. 

Option Description

Background top/bottom 
(normal/selected)

The background colors of the clip (unselected 
and selected, respectively). The resulting display 
backgrounds will be gradient “fades” from the 
top colors to the bottom colors (this can be 
turned off in the Preferences–Environment tab, 
as described in the section “Colors” on page 
181.

Waveform
(normal/selected)

The waveform color for unselected and selected 
clips, respectively.

Waveform outline
(normal/selected)

The color of the waveform outline (unselected 
and selected clips, respectively).

Edge The left and right edge of the clip.

Edge (selected) The left and right edge, if the clip is selected.

Axis (level zero) The color of the horizontal dotted line in the mid-
dle of a clip, indicating zero level.

Axis (half level) The color of the horizontal dotted lines halfway 
up and down from the middle of a clip, indicating 
50% level.

Channel separator 
(stereo clip)

The line dividing the two sides in a stereo clip.

Clip name The name label of the clip.

Focused Clip name The name label of the focused clip (see “About 
selected and focused clips” on page 114).

Focused Clip name 
background

The name label background of the focused clip.

! For the Crossfade Region item, you can only select 
colors for “Background”.

Option Description

Background 
top/bottom

The background colors of the Track View.

Cursor The color of the Montage cursor. Note that be-
cause of the blinking Cursor, the selected colors 
will appear in inverse video in the Montage.

Cue-Point The color of the vertical dotted cue point lines.

! Windows that are already open will never be closed as a 
result of recalling a window layout.

Option Description
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• To modify an existing window layout, set up the display 
as you want it, select the window layout in the dialog and 
click the Update button.

• To load an existing window layout, select it in the dialog 
and click Load.

Using key sequences

You can use key sequences for recalling window layouts, 
just as with many other items (see “Customizable key 
commands” on page 184). This can be used for quick and 
easy window control. For example, open a single docu-
ment window, maximize it, save a window layout and as-
sign it to a key sequence. Later, this key sequence can be 
used to maximize the active window only.

Setting default size and position for 
windows
As mentioned above, while window layouts can be used 
for storing the size and position of windows, it also stores 
settings for various dialog boxes. If you only wish to deter-
mine a default size and position for different types of win-
dows (Waves, Audio CD Montages, etc.), you can instead 
use the option “Remember active window’s layout as 
opening setting” on the View menu. This is a quick and 
effective way of organizing your working environment the 
way you want it.

To set a default size and position for a certain type of win-
dow, proceed as follows:

1. Open or create the desired type of window.

2. Size and position it the way you like.

3. Pull down the View menu and select “Remember ac-
tive window’s layout as opening setting”.
A dialog appears asking you to confirm the option.

4. Click “Yes” to continue.

All windows of that type will now open in this same size 
and position.

Loading a window layout as described above will 
override this setting.

Creating a Favorites menu
The Favorites item on the File menu allows you to assem-
ble a list of files that you want to be able to open quickly – 
a library if you will.

• To add a file to the list, make sure its window is active 
and select “Add current document” from the Favorites-
Functions submenu.

• To open a file from the list, select it.

• To clear the whole list, select Clear List from the Favor-
ites–Functions submenu.

• To update the list so that it only lists files that actually 
still exist in the specified locations on your hard disk(s), 
select Validate List from the Favorites–Functions sub-
menu.
Files that can’t be found are removed.

Customizable key commands
In addition to the fixed key commands for selecting from 
menus, etc., there are a number of operations for which 
you can set up your own commands.

You can do this by specifying a key sequence – a se-
quence of between one to three keys that must be 
pressed in a certain order to invoke the operation.

Key sequences are listed and managed in the “Keyboard 
Commands” dialog, opened from the Options menu.
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About the list of operations
The main part of this dialog is occupied by the list of avail-
able operations that can be called up via key sequences. 
You can choose to view this list in one of two ways, with 
the “Sort” buttons in the upper right corner of the dialog:

• “Sort by Command” organizes the operations in folders, in 
groupings that relate to various sections in the program.

• “Sort by Key” lists all commands in a “flat” fashion (no folders), 
and sorts the list alphabetically via the defined key commands, 
which allows you to easily find a command assigned to a cer-
tain key.

Regardless of which mode you select, the actual available 
operations are the same, it’s just the view that changes.

The “dynamic” items in the list

Please note that the number of items in the list varies with 
other settings in the program. For example, if you have as-
signed key shortcuts to plug-ins, in the Plug-in manager, 
they will appear in this list too. Otherwise they will not.

The columns

• The Description column lists the operations available.
• The next column allows you to choose between two modes 

that determine when a key sequence is available and when it 
is not, see “Setting enable options” on page 185.

• The Key column shows the Key sequence defined for the op-
eration.

Defining key sequences
1. Select the operation for which you want to create a key 
sequence.

2. Click the “Key Sequence…” button.

3. If you want to clear the current key sequence, click 
Clear.

4. Make sure “Catch mode” is active.

5. Press the first combination of keys that you want to 
use.
You can include modifiers ([Shift], [Ctrl], [Alt], etc.) if you like. There is 
also a setting that makes the program distinguish between two modifiers 
with the same label, on each side of the space bar.

6. Proceed with the following key(s).

7. Disable “Catch mode”.
This is just an optional safety measure so that you don’t accidentally 
erase or add to your current key sequence, when pressing more keys.

8. Close the dialog.

Setting enable options
Once the key sequence has been defined, you may want 
to set the Enable Options for the operation. This is done 
by selecting from the pop-up in the middle column:

Excluding windows (Key commands)
This is mainly for plug-in windows. Since some plug-ins, 
especially from third-party manufacturers, have their own 
set of key commands, you may want to disable WaveLab 
Essential key commands for these windows. 

Let’s say you assign a key command to “apply” in the Mas-
ter Section, and a certain plug-in already uses the same 
key combination for an internal operation. Then, pressing 
this key command might lead to the wrong operation be-
ing invoked when this plug-in has the focus.

! It is possible to define the same key sequence for 
two operations. If you do, one of them will be in-
voked. To see which, select “Sort by key” and locate 
the items in the list. The top one is the one that will 
be used.

Option Description

Enabled all time This key sequence is always active.

Enabled if active 
window…

This key sequence can be used for all windows, 
except the ones added to the “Exclude Win-
dows” lists, described below.
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“Exclude windows” allows you to prevent this situation:

1. Click the “Exclude windows” button.

2. Type in the name of the window in the Window exclu-
sion list.
You can include DOS “wildcard” characters. For example to exclude all 
products from the manufacturer Waves, you can type “Waves*”.

3. Close the window.

Using key sequences
To use a key sequence, press the keys/buttons specified 
in the dialog, and the corresponding operation is per-
formed.

About some special key commands
There are some key commands that might require an ex-
planation:

Organizing plug-in processors

Introduction
You may find that you need to organize your processors 
into sensible groups. Why? Well, a host of plug-ins are in-
cluded with the program, and additional ones can be 
added. Also, sometimes when you install a package of Di-
rectX plug-ins you get effects that are of no relevance to 
WaveLab Essential (or even to audio) and therefore just 
clutter menus.

To organize how your plug-ins appear on menus in the 
program, open the “Organize Master Section plug-ins” di-
alog on the Options menu.

About the plug-in list

The “Organize Master Section plug-ins” dialog

These are plug-ins that can be used in the program. They 
are processors, or effects, that can be added to the Mas-
ter Section slots (see “The Effects pane” on page 85).

! Key sequences can only be executed after you have 
closed the Key Commands dialog.

Command Description

Set focus on this 
key command group

This allows you to re-use key commands 
for certain groups.
For example, let’s say you set up things so 
that [Ctrl]+[F10] is the key command for 
setting the focus to the Master Section. 
You then assign simple key commands to 
the Master Section items, for example [A] 
for “Apply” and [R] for “Remove all plug-
ins”, even though these keys may be used 
for other sections of the program.
You can then Press [Ctrl]-[F10] followed 
by any of the single commands to control 
most aspects of the Master Section.

Bypass all defined 
key commands/
Enable all key commands

This can be used when an installed plug-
in, from a third party manufacturer, has its 
own set of key commands. You can then 
temporarily disable all WaveLab Essential 
key commands to be able to use the plug-
in’s own.

Bypass all defined 
key commands except those
set to “Enabled all time”

Same as above but disables all key com-
mands except those where you have set 
the Enable Option to “Enabled all time”.

Plug-in Slot commands To assign a certain processor to a certain 
slot, in the Master Section, you need two 
key sequences. Selecting a slot is done 
by a key sequence in the “Slot selection” 
section, and selecting a plug-in is done in 
the “Slot Commands” section.

! This organizes plug-ins accessed from the Master 
Section, not the VST plug-ins in the Montage. Note 
however, that you can exclude some VST plug-ins 
completely, see “Handling VST plug-ins” on page 
188.
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Groups

In the Master Section folder in the list, you will find sub-
folders, representing groups of plug-ins.

By organizing your plug-ins into folders, you arrange the 
way they appear on menus in the program. How you orga-
nize your effects is of course up to you, but initially, they 
are categorized according to their technical “type”, regular 
WaveLab Essential plug-ins in one folder, VST plug-ins in 
another, DirectX plug-ins in yet another, etc. (see “The Ef-
fects pane” on page 85 for more details on these types of 
plug-ins).

The columns

• The Plug-in column displays the names of all the available 
plug-ins.

• The FX column determines whether a plug-in is active or not, 
see below.

• If the checkbox in the PM (Post Master) column is activated 
for a plug-in, it will be available for selection in the Dithering 
pane in the Master Section (after the master faders in the sig-
nal path). This allows you to use separately purchased dither-
ing plug-ins and similar. See “Adding other plug-ins to the 
Dithering pane” on page 89 for more information.

• The Key column displays the key sequence defined for a plug-
in.

• The Module column tells you the name of the plug-in (dll) file.

Activating and deactivating plug-ins and 
groups
By clicking in the FX column, you can activate/deactivate 
individual plug-ins or an entire group of plug-ins (see be-
low for more information on groups). If you have plug-ins 
installed on your computer that you don’t want to use in 
WaveLab Essential, this lets you disable them completely, 
thus reducing “menu clutter”. The disabled plug-ins will 
still be applicable in other programs that can use them.

An example of this would be DirectX plug-ins. Many of 
these do not apply to audio at all and are of no relevance 
to WaveLab Essential whatsoever. By disabling these, you 
will make it easier to find the plug-ins that you really want 
to use in WaveLab Essential.

Working with groups
The Master Section plug-ins can be organized into 
groups. This is done by adding subfolders to the Master 
Section folder and then dragging Plug-in icons into these 
folders.

When you then select from plug-in menus or display lists 
of plug-ins, the organization you have created will be re-
flected in the menu/list.

• To create a group, click the New Group button, enter a 
name and press [Return].
The group will initially appear at the end of the list, but when you start us-
ing it, the list will be resorted so that the groups are displayed in alpha-
betical order.

• To delete a group, select it and click Delete Group.
If the group contains any plug-ins, they will not be deleted. Instead, they 
will appear in the Master Section section, outside all other groups.

• Moving plug-ins between groups is done by dragging 
and dropping, just as when dragging files in the Windows 
Explorer.

• If you lose track of your changes and wish to return to 
the state that the list was in when you first opened the di-
alog, click Undo Changes.

! VST and DirectX plug-ins need to be in a group, 
whereas WaveLab Essential plug-ins can be outside 
all groups.

! VST plug-ins can also be excluded, see “Handling 
VST plug-ins” on page 188.

Here, a “Dynamics” 
group has been 
created, which 
then appears in 
the Master Sec-
tion.
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• If you want to restore everything to the default “factory 
settings”, click “Set default”.

Handling VST plug-ins
If you have VST plug-ins installed on your computer that 
you don’t need in WaveLab Essential, you can tell the pro-
gram to ignore these on launch. This is done in the Prefer-
ences–VST dialog. It is possible to exclude single VST 
plug-ins, entire folders and subfolders containing VST 
plug-ins, and the “Shared VST Plug-ins” folder (if present 
on your system). The methods for doing this are all de-
scribed below.

Proceed as follows to set up which VST plug-ins to use in 
WaveLab Essential:

• Open the Preferences dialog from the Options menu, 
and select the VST tab.

This contains the following items:

Note the following:

• If VST plug-ins you want to exclude reside in one or several 
subfolders inside a main folder, you don’t have to list all the 
subfolders. Excluding the main folder will also automatically 
exclude its subfolders.

• It’s not necessary to type in the entire path to a folder you 
want to exclude (e.g. C:\plug-ins\reverb). Typing just reverb 
will suffice, since WaveLab Essential will look through the 
folders and subfolders on your C disk or partition upon star-
tup, searching for the folder named reverb, and exclude it.

• On the other hand, if you have a main folder containing two or 
more subfolders and you only want to exclude the plug-ins in 
one of the folders and you also have another folder or sub-
folder with the same name as the one you want to exclude, you 
will need to type the path to the subfolder you want to exclude 
(e.g. C:\plug-ins\delay).

In this case, the subfolder “Delay” in the folder “Old effects” will be ex-
cluded, but the subfolder “Delay” in the folder “New effects” will be in-
cluded.

! These settings are stored in the files “WaveLab Es-
sential/Presets/Plug-ins/PlugInPrefAE.set” and 
“WaveLab Essential/System/plugins_es.set”. If you 
ever encounter problems with “lost” plug-ins, delete 
these files and the program will re-scan and build a 
new list of plug-ins the next time you launch it. This 
can also be achieved by clicking the “Force plugin 
dectection at next launch” button in the Prefer-
ences–VST dialog (see below).

! Note that unlike deactivating a plug-in in the Plug-in 
Manager (as described in the section “Activating and 
deactivating plug-ins and groups” on page 187) 
which will only remove it from the plug-in menu in the 
Master Section, “ignoring” a VST plug-in as de-
scribed below will remove it from the whole program, 
including the Montage.

Item Description

Use VST plugin 
shared folder

If you have additional VST plug-ins installed on 
your computer, these can also be available in 
WaveLab Essential, provided that they are in-
stalled in the “Shared VST Plug-ins” folder and 
this checkbox is activated. Next time WaveLab 
Essential is launched the plug-ins in this folder 
will be available.

Optional extra VST 
plugin folder 
(WaveLab Essential spe-
cific)

Here you can set a path to an “extra” VST plugin 
folder. As some plug-ins may not be usable in 
WaveLab Essential, you can set up a specific 
folder containing all the VST plug-ins you wish 
to use in WaveLab Essential.

Ignore plugins located 
in the following 
sub-folders

In this text field, you can type in the name of a 
folder or subfolder containing VST plug-ins that 
you want to exclude.
If you want to exclude several folders, type in all 
their names, but separate each name with a 
semicolon.

Do not load the 
following plugins

In this list you can exclude individual plug-ins 
from being loaded by adding them to the list. 
Common VST instrument plug-ins (which can-
not be used in WaveLab Essential) are already 
added to the list.

Faster graphics refresh-
ing (consumes more 
computer power)

This can be useful for plug-ins that display e.g. 
meters. If changed, this option takes effect after 
closing and reopening the VST plug-in win-
dow(s).

Force plugin detection at 
next launch

Clicking this button lets WaveLab Essential re-
scan and build a new list of all plug-ins next time 
it is launched.

Item Description



189

Customizing

• Quit WaveLab Essential and then launch the program 
again.
If you check the effect menus, you will find that the plug-ins in the speci-
fied folders are removed.

• If you change your mind and want to use the ignored 
plug-ins again, repeat the steps above but remove the 
folder names from the text field.

Excluding all plug-ins
If you wish, you can temporarily exclude all plug-ins so that 
none will be available in WaveLab Essential:

• Press and hold [Ctrl]+[Shift] when launching WaveLab 
Essential.
This will disable the Master Section and prevent all plug-ins from being 
loaded. This can be useful for troubleshooting purposes – i.e. to deter-
mine whether the loading of one or more plug-ins is causing problems.

• If you wish to have access to the plug-ins again, activate 
the Master Section.
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About WaveLab Essential plug-ins
These plug-ins use WaveLab Essential’s own plug-in for-
mat, and cannot be used with other applications. Note:

As a rule, WaveLab Essential specific plug-ins can 
only be used in the Master Section (not as clip effects in 
the Audio CD Montage).
However, some WaveLab Essential effects are also included as VST 
plug-ins, available as clip effects in Audio CD Montages. This is indi-
cated for each effect below.

You can specify which plug-ins should be available in 
the Master Section by using the Organize Master Section 
Plug-ins function on the Options menu.
This also allows you to specify which plug-ins should be available in the 
Dithering Pane (post-master fader).

Presets for WaveLab Essential plug-ins are handled 
like other presets in WaveLab Essential (processing func-
tions, etc.).

Auto Panner
The Auto Panner (only available in the Master Section) 
pans the signals continuously between the left and right 
channel in the stereo image. It has the following parame-
ters:

Chorus
The Chorus plug-in (only available in the Master Section) 
is a classic stereo chorus based on a sweeping delay, 
with the following parameters:

Parameter Description

LFO Freq 
(0.1Hz~50Hz)

This parameter sets the speed of the panning. The 
higher the value, the faster the signal moves around 
in the stereo image. 

Width (0~100%) Use this parameter to specify the “width” of the pan 
movements. The value 100% causes the signal to 
move from the extreme left to the extreme right, 
while 0% disables the panning effect.

Waveform
(Sine, Pulse)

Allows you to specify the way in which the signal 
moves from left to right. Select Sine if you prefer 
fluid movements, or Pulse to create abrupt panning 
“jumps”.

Out Left, Out Right 
(-96dB~6dB)

These two parameters allow you to adjust the level 
of the left or right channel, useful e.g. for correcting 
the stereo image or adjusting the overall gain. The 
setting 0dB means no change of level, while -96dB 
means turning the channel off completely.

Parameter Description

Delay (0.1~60ms) Use this parameter to specify the basic time delay 
for the chorused signal with respect to the “dry” 
signal. The higher the value, the more prominent the 
effect. Low settings (up to 7ms) create flanger-like 
effects. Settings up to 25ms are for classic chorus 
while settings above this value are mainly for spe-
cial effects.

Width (0~100%) Use this parameter to specify how much the delay 
time is allowed to vary with the modulation. It is this 
variation in delay time that causes the sweeping ef-
fect. Note that the value 0% should probably be 
avoided since it might create the impression that 
you are experiencing phase problems.

Frequency 
(0.01~25Hz)

The Frequency parameter sets the speed of the 
sweep (the modulation). The higher the value, the 
faster the modulation. You will probably not use val-
ues above 7Hz except for special effects.

Feedback 
(0~100%)

This parameter specifies how much of the output 
from the effect is fed back to the input (the feed-
back signal is also phase inverted). The higher the 
value, the more prominent the effect. At short delay 
times, this creates a flanger-like effect. At larger 
settings it creates more of a slapback repetition 
type of sound.

Fb Balance (0~100%)Use this parameter to set the volume of the Feed-
back signal (see above) in the mix. If this is set to 
100%, and combined with a Feedback setting be-
tween 65% and 100%, the effect goes into self-os-
cillation.

Glimmer 1, 
Glimmer 2 (0~100%)

The two Glimmer parameters allow you to specify 
to what extent the Chorus signal should move 
around in the stereo image. They work in more or 
less the same way as the Auto Panner but only ap-
ply to the Chorus signals. Glimmer 1 processes the 
right channel signal, while Glimmer 2 processes a 
combination of the left and right channels (the ac-
tual left channel always remains at 0).

Stereo Spread 
(0~100%)

This parameter specifies the width the Chorus ef-
fect will occupy in the stereo sound image. The 
value 0% creates a mono impression, and since left 
and right channel signals are then mixed together, 
the Chorus becomes louder.

Mix (0~100%) Use this parameter to specify the balance in level 
between the dry and the delayed signal. The value 
0% means that only the dry signal will be heard, 
while 100% actually means a 50/50 mix between 
dry and effect signal.

Output Lev
(-48dB~0dB)

This is an attenuator that allows you to reduce the 
output level of the Chorus effect, avoiding clipping 
and hence distortion. If the Clip indicator lights up 
continuously, lower this value.



192

Plug-in processor reference

Crystal Resampler
The Crystal Resampler plug-in (only available in the Mas-
ter Section) is a professional sample rate converter pro-
viding exceptional transparency and preservation of the 
frequency content:

Echo
The Echo plug-in (only available in the Master Section) is 
a stereo echo effect with two separate delay lines. It has 
the following parameters:

EQ-1
EQ-1 is available both as a VST and a WaveLab Essential 
plug-in. It can be used as a clip effect in the Audio CD 
Montage, or as a global effect in the Master Section. 

This is a three-band equalizer with high and low shelving 
filters and a full parametric mid-frequency band. You can 
turn off each band separately by clicking the correspond-
ing button, making it easy to compare the signal with and 
without EQ. The following parameters are available:

Leveler
This plug-in is available both as a VST and a WaveLab Es-
sential plug-in. It can be used as a clip effect in the Audio 
CD Montage, or as a global effect in the Master Section. 

This “effect” simply reduces or boosts the signal level. 
This is useful for matching levels between effects. You 
may want to patch in the Leveler after an equalizer plug-in, 
for example. The parameters consist of volume settings for 
the left and right channels, and a Stereo Link setting 
(when activated, the Volume Left parameters control the 
level of both channels). Finally, a Mix to mono setting al-
lows you to mix an incoming stereo signal to mono (much 
like the Mono button in the Master Section).

Noise Gate
This plug-in is available both as a VST and a WaveLab Es-
sential plug-in. It can be used as a clip effect in the Audio 
CD Montage, or as a global effect in the Master Section.

Parameter Description

Sample Rate 
(6 - 96 kHz)

This defines the output sample rate while the input 
sample rate is determined by the sample rate of the 
active audio file or Audio CD Montage.

Quality (Preview (fast), 
Standard)

This defines the quality of the algorithm which is 
used. In Preview mode the CPU load is much lower 
than in Standard mode, but as a trade off the sonic 
quality of the resulting audio is also lower.

Parameter Description

Delay 1 
(0.5~1000ms)

This sets the delay time of Delay 1, with respect to 
the incoming signal. Please note that the minimum 
value (0.5ms) creates an out-of-phase impression.

Feedback 1 
(0~100%)

This sets the amount of delayed signal fed back 
into the Delay 1 block, to create repetitions. The 
value 100% means that the echo signal is repeated 
indefinitely, while 0% means there is only one repe-
tition.

Link 1-2 
(Off, Linked)

Select Off if you wish to use Delay 1 and Delay 2 as 
two independent blocks. Select Linked if the output 
of Delay 1 is to be connected to the Input of Delay 
2.

Delay 2, Feedback 2 See Delay 1 (0.5~1000ms) and Feedback 1 
(0~100%) above. These parameters are identical 
to these but apply to the second Delay block.

Del. Balance 
(0~100%)

This sets the stereo width of Delay 1 and Delay 2. 
When set to 100%, Delay 1 is assigned to the left 
channel, while Delay 2 is assigned to the right 
channel. The value 0% means that both Delay 
blocks are spread across the stereo field.

Vol Left, Vol Right 
(-96dB~0dB)

Use these parameters to correct volume imbal-
ances brought about by the Delay effects. These 
parameters only apply to the Echo effect, the dry 
signal is not affected by these settings.

Parameter Description

High Gain Determines the boost or cut (in dB) of the high 
shelving filter.

High Frequency Sets the frequency of the high shelving filter. Fre-
quencies above this value will gradually be in-
creased or reduced in level, according to the High 
Gain setting.

Mid Gain Determines the boost or cut (in dB) of the mid band 
EQ.

Mid Frequency Sets the center frequency of the mid band eq. Fre-
quencies around this value will be affected by the 
Mid Gain.

Mid Q Use this parameter to set the width of the Mid 
band, e.g. how wide a frequency range around the 
Mid Frequency should be affected by the mid band 
EQ. The higher this value, the “narrower” the mid 
band.

Low Gain Determines the boost or cut (in dB) of the low 
shelving filter.

Low Frequency Sets the frequency of the low shelving filter. Fre-
quencies below this value will gradually be in-
creased or reduced in level, according to the Low 
Gain setting.
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The Noise Gate plug-in mutes any signal that falls below a 
specified threshold level. This can be useful for removing 
unwanted residual noise from audio material without hav-
ing to manually clean up or mute soundfiles. Other appli-
cations include gating reverb “tails” and tightening 
percussion tracks.

Peak Master
This plug-in is available both as a VST and a WaveLab Es-
sential plug-in. It can be used as a clip effect in the Audio 
CD Montage, or as a global effect in the Master Section. 
This plug-in provides a safe and transparent way of boost-
ing the perceived loudness of audio material. By limiting 
transients and simultaneously raising the general level by 
compression, the Peak Master will increase the subjective 
loudness of the signal without risk of distortion inducing 
peaks.

Puncher
This plug-in is available both as a VST and a WaveLab Es-
sential plug-in. It can be used as a clip effect in the Audio 
CD Montage, or as a global effect in the Master Section.

The Puncher plug-in generates additional harmonics 
which are added to the audio material. The result is a more 
dynamic, and “punchier” sound, particularly when applied 
to drums and percussive material. Compared to the Peak 
Master the Puncher plug-in could be described as operat-
ing in almost the opposite way. Puncher leaves quieter 
parts untouched but will add power to the louder portions 
without causing clipping. The plug-in is optimized for peak 
signal levels between -10 and 0dB, the closer to 0dB, the 
better.

Silence
The Silence plug-in (only available in the Master Section) 
lets you add silent portions at the start and/or end of a file. 
This can be useful for example in conjunction with effects 
such as reverb and delay which produce audio “tails” – i.e. 
the sound of the effect lingers after the end of the file – 
since the sound of the effect would otherwise be muted at 
the end of the file. To remedy this, just place the Silence 
plug-in before the other plug-in in the Master Section and 
specify the length of the silent portion as necessary, so 
that the sound of the effect is allowed to decay naturally.

The Silence plug-in only has two parameters which let you 
define the length of the silent portions at the start and end 
of the file.

StereoExpander
The StereoExpander plug-in (only available in the Master 
Section) narrows or enlarges the stereo width of an exist-
ing stereo signal. This is set by the single “Width” param-
eter. 

A value of 0% produces two equal output channels (the 
original stereo image is lost). Values between 1 and 49% 
correspond to a narrower stereo image. A value of 50% 
corresponds to the original signal. Values between 51 and 
100% enlarge the stereo image.

Parameter Description

Threshold
(-144~-12dB)

This setting determines at what level the Noise 
Gate is activated. Any signal or portion of a signal 
that falls below the chosen threshold will be muted.

Rel Time (1~5000ms) Determines how long the gate stays open after a 
signal below the Threshold level has been de-
tected.

Rel Sens (1~100) This setting is used to prevent the gate from being 
triggered on/off inadvertently when the signal is 
close to the threshold level.

Attack Sens (1~100) Determines the time it takes for the gate to open. A 
low setting provides a fast transient response but a 
high setting will soften or mute the early portion of 
the sound which is triggering the gate.

Parameter Description

Input Gain
(-12~+24dB)

This allows you to adjust the input level to Peak 
Master. Use this to (typically) raise the loudness of 
the signal. Use extreme boost settings with caution 
as they can induce distortion.

Out Ceiling
(-18~0dB)

This setting determines the maximum level at the 
Peak Master outputs.

Softness (-5~5) This parameter affects the way the Peak Master op-
erates. A high setting will maximize the perceived 
loudness effect but can in some cases result in a 
slight harshness of the sound. Adjust this parame-
ter to optimize the balance between sound quality 
and the desired effect.

Parameter Description

Density (Soft, Medium, 
Hard)

The difference between these 3 settings lies in the 
number of added harmonics. The setting you use 
depends on the audio material.

Effect (0~100%) This adjusts the balance between the processed 
and the dry signal.

Input Gain
(-12~24dB)

This sets the input level. Boosting the signal may 
cause clipping, so use this with caution. With no 
boost, Puncher will never cause clipping.
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VST Plug-ins

About VST Plug-ins
These plug-ins use Steinberg’s widely adapted VST plug-
in format. As a rule, VST plug-ins can be used by any VST-
compatible application, although some plug-ins may still 
be limited to use with certain programs. Note:

VST Plug-ins can be used in the Master Section or as 
clip effects in the Audio CD Montage.

As with WaveLab Essential plug-ins, you can specify 
which VST plug-ins should be available in the Master Sec-
tion by using the Organize Master Section Plug-ins func-
tion on the Options menu.
This also allows you to specify which plug-ins should be available in the 
Dithering Pane (post-master fader).

It’s also possible to exclude VST plug-ins completely 
from WaveLab Essential, thereby removing them from the 
clip and track effects lists as well.

VST plug-ins have their own preset handling. 
When you click the Preset button for this type of effect, a pop-up menu 
appears, allowing you to save or load effect programs (presets) or com-
plete banks containing several programs.

Autopan
The AutoPan plug-in pans the signals continuously be-
tween the left and right channel in the stereo image. It has 
the following parameters:

Choirus2
Choirus2 is a chorus effect, used for making the sound 
“warmer”, etc. It has the following parameters:

Parameter Description

LFO Freq 
(0.1Hz~10Hz)

This parameter sets the speed of the pan move-
ments. The higher the value, the faster the pro-
cessed signal moves around in the stereo image. 

Width (0~100%) Use this parameter to specify the “width” of the pan 
movements. Setting this to its maximum value 
causes the signal to move from the extreme left to 
the extreme right, while lowering it completely dis-
ables the panning effect.

Waveform Determines the shape of the panning curve. Avail-
able curve shapes are Sine, Triangle, Sawtooth, 
and Pulse.

Out Levl The stereo output level of the effect.

Parameter Description

Time Use this parameter to specify the basic time delay 
for the chorused signal with respect to the “dry” 
signal. The higher the value, the more prominent the 
effect. Low settings create flanger-like effects, me-
dium settings provides classic chorus while higher 
settings are mainly for special effects.

Width Use this parameter to specify how much the delay 
time is allowed to vary with the modulation. It is this 
variation in delay time that causes the sweeping ef-
fect. Note that the value 0% should probably be 
avoided since it might create the impression that 
you are experiencing phase problems.

Lfo Freq The Frequency parameter sets the speed of the 
sweep (the modulation). The higher the value, the 
faster the modulation. You will probably not use 
higher values (above 7Hz) except for special ef-
fects.

Feedback This parameter specifies how much of the output 
from the effect is fed back to the input (the feed-
back signal is also phase inverted). The higher the 
value, the more prominent the effect. At short delay 
times, this creates a flanger-like effect. At larger 
settings it creates more of a slapback repetition 
type of sound.

Feed Bal Use this parameter to set the volume of the Feed-
back signal (see above) in the mix. If this is set to 
100%, and combined with a Feedback setting be-
tween 65% and 100%, the effect goes into self-os-
cillation.

Glimmer 1, 
Glimmer 2 

The two Glimmer parameters allow you to specify 
to what extent the Chorus signal should move 
around in the stereo image. They work in more or 
less the same way as the Auto Panner but only ap-
ply to the Chorus signals. Glimmer 1 processes the 
right channel signal, while Glimmer 2 processes a 
combination of the left and right channels (the ac-
tual left channel always remains at 0).

Out Levl The stereo output level of the effect.
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CleanComp
CleanComp is a simple compressor that allows you to 
limit loud sounds, while at the same time boosting the 
overall loudness of the audio material.

DeClicker
The DeClicker plug-in is specifically designed to eliminate 
single “clicks” or “pops” in a recording. One typical appli-
cation is to clean up recordings made from vinyl records, 
but you may also find it useful for removing pops from mi-
crophone switches, oxidized connector noises, clicks from 
sync problems when transferring material digitally, etc.

Note that the DeClicker module is not optimized for 
crackles (a series of short clicks).
However, as it is often hard to distinguish between clicks and crackles, 
you might also be able to use it to improve your recording in this respect.

If the recording also contains background noise (hiss), 
you may want to combine DeClicker with the DeNoiser 
plug-in.

How DeClicker works

The Declicker process is divided into two steps:

• Analysis – when the audio signal passes through De-
Clicker, the selected analysis algorithm finds the clicks in 
the recording. You provide input to the analysis parame-
ters by selecting a Mode and the Threshold and DePlop 
parameters.

• Removal – a de-click algorithm is applied to the audio, 
removing the clicks.
In many cases, the original audio material “hidden” underneath a click 
cannot be restored. This means there will be a gap once the click has 
been removed. DeClicker has the ability to automatically “redraw” the 
hence missing parts of the waveform. This feature can also be used to 
remove tape dropouts with a length of up to 60 samples (just above one 
millisecond at 44.1kHz).

The whole Declicking process can be visually monitored in 
the Input and Output displays of the DeClicker window 
(showing the incoming audio and the processed - De-
Clicked - audio, respectively). This helps you to adjust the 
parameters. Furthermore, if you activate the Audition but-
ton, only the removed material will be heard (and shown in 
the Output display).

Parameters

Parameter Description

Ceiling (0dB~-24) This setting determines the maximum level at the 
CleanComp outputs.

Softness (-5~5) This parameter affects the way CleanComp oper-
ates. A high setting will maximize the perceived 
loudness effect but can in some cases result in a 
slight harshness of the sound. Adjust this parame-
ter to optimize the balance between sound quality 
and the desired effect.

Out Gain (0~+24dB) This allows you to adjust the output level from 
CleanComp. Use this to (typically) raise the loud-
ness of the signal. Use extreme boost settings with 
caution as they can induce distortion.

! Make sure that no low-pass filter has been applied to 
your audio material before you edit it with DeClicker. 
This may affect the detection of clicks.

Parameter Description

Audition button When this is activated, only the removed material 
will be heard. The Output display will also show the 
waveform image of the removed material in this 
mode.

Classic When this is activated, the DeClicker attempts to 
remove both audible clicks and crackle noise. 
When it’s deactivated, only single clicks will be re-
moved while crackles (rapidly repeated clicks) are 
ignored. Which mode to choose depends on the 
source material. Note also that Classic mode re-
quires less CPU power.

Threshold This setting determines the amplitude (level) re-
quired for a click to be detected. In many cases, 
DeClicker’s sensitive algorithms identify a lot more 
clicks than you can actually hear. To avoid wasting 
processing power to remove inaudible clicks, raise 
this parameter to a high value, and then lower it un-
til all the artefacts that you actually want removed 
are detected. The lower the setting, the more clicks 
will be detected but also the higher the risk of audi-
ble artefacts. If in doubt, activate Audition mode 
and check that the removed material doesn’t con-
tain any actual musical or rhythmical information, 
etc.
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Tips and Tricks

• By combining Vintage Mode and extreme Threshold and De-
Plop settings, you can create an interesting effect which “soft-
ens” material with particularly sharp attacks, e.g. percussion or 
brass.

• If you have material with digital distortion (clipping), try apply-
ing DeClicker. While it can’t do miracles, it can at least make 
some improvement to the overall “hardness” introduced by the 
distortion.

DeNoiser
The DeNoiser plug-in lets you suppress noise without af-
fecting the general sound quality. Or, in tech talk, the De-
Noiser removes broad band noise from arbitrary audio 
material without leaving any “spectral finger print”. The al-
gorithm that this plug-in is based on has the ability to track 
and adjust itself to variations in background noise. This 

means the noise can be diminished without side effects, 
preserving the spatial impression, and without letting the 
result become “colorless”. Many years of research were 
invested in developing the methods used.

Typical applications for the DeNoiser include cleaning or 
remastering recordings from old tape or vinyl, or noisy live 
recordings.

How DeNoiser works

DeNoiser is based on spectral subtraction. Each section 
of the frequency spectrum that has an amplitude below 
the estimated noise floor, is reduced in intensity by use of 
a spectral expander. The result is a noise reduction that 
does not affect the phase of the signal. 

The figure below shows the signal flow:

The solid line represents the actual audio signal, while the dotted lines 
represent control signals

The signal is continuously analyzed by the first module in 
the chain, to estimate the noise floor at any given time. 
This is sufficient when the noise level is constant or mod-
ulates slowly. When the noise level varies rapidly, the Am-
bience and Transient analyses help adjust the response of 
the noise reduction unit, allowing transient-rich material to 
maintain its liveliness and natural ambience.

When you process audio in DeNoiser, the plug-in will 
need a short time (less than a second) to analyze the ma-
terial and set its internal parameters.
Since you would not want to include this short “startup sequence” in the 
final result, you should make it a habit to first play back a short section of 
the audio, thereby letting DeNoiser “learn” the noisefloor, and then stop 
and start over again from the beginning. The plug-in then remembers the 
settings internally.

DePlop This setting controls a special highpass filter which 
works on signals below 150 Hz. It cuts away the 
“plop noise” which sometimes appears after elimi-
nating a click. The slider adjusts the filter frequency 
(off - 150 Hz).
Note: This function is best applied to older record-
ings, which often use a narrow frequency range. Be 
careful when applying this function to modern re-
cordings, as you may risk removing parts of the 
useful signal! 

Quality This determines the quality of the click removal and 
audio restoration, with “4” being the best quality 
setting. Please note that selecting higher quality 
settings also means that more processing power is 
consumed.
Also, note that in some situations it might be more 
productive to use a lower Quality value. One exam-
ple of this is when two clicks follow each other in 
quick succession or when you tackle a click in a 
low level part that is followed by a loud part.

Mode Which Mode to select depends on the source ma-
terial. Standard mode is suitable for a wide variety 
of source material - try this option first. Vintage 
mode is suitable for restoring “antique” recordings 
(with limited high frequency content), while Modern 
mode is best suited for contemporary recordings 
with a wide frequency range (putting greater em-
phasis on distinguishing clicks from other strong 
impulses in the audio material).

Bypass This will bypass the effect, allowing you to compare 
the DeClicked and unprocessed material.

Parameter Description

Noise 
Reduction

Noise Floor Ambient 
Analysis

Transient 
Analysis

Input Output

Level

Noise Reduction

Ambience
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The Noisefloor Display

The display to the left in the DeNoiser window is crucial 
when making settings. It contains the following three ele-
ments:

• The dark green spectral graph.
This shows the spectrum of the audio currently being played back. The 
horizontal axis shows the frequency (linear scale). The low frequencies 
are visible on the left side, the high ones on the right side. The vertical 
axis shows the signal amplitudes, thus the level (displayed as a logarith-
mic dB scale).

• The yellow line.
This is a spectral estimation of the noise floor. The average of this value is 
shown numerically below the display.
• The light green line.
This is simply a graphic representation of the Offset parameter.

The light green Offset line should be adjusted so that it 
appears as close above the yellow noise floor graph as 
possible. The dark green spectrum plot is there to help 
you fine-tune the Offset setting, so that only the noise is 
removed, not parts of the signal (ideally, the light green 
line should be between the yellow line and the spectrum 
plot).

Parameters

Using the A/B setups

With the A/B buttons you can make instantaneous 
switches between two different DeNoiser setups, allowing 
you to quickly try out and compare different configura-
tions. You can also use this feature for separate settings 
for two different sections of an audio recording. Proceed 
as follows:

1. Make the settings you want for setup A.

2. Click on [Store] and then on the [A] button.

3. Make the settings you want for setup B.

4. Click on [Store] and then on the [B] button.
Now the two setups are stored, and you can switch between them sim-
ply by clicking [A] or [B].

NaturalVerb
NaturalVerb is a high-quality reverb that adds ambience, 
or room-quality, to the sound. In addition to the standard 
size and decay parameters, NaturalVerb also features low- 
and high-pass filters, plus a gate for gated reverb effects.

To change the parameters, either drag the sliders up and 
down, or click in a slider area to set the slider. If you hold 
down [Shift], you can change the parameters with a higher 
degree of precision. If you hold down [Ctrl] and click in a 
slider area, the slider is reset to its default value.

Parameter Description

Freeze If you activate this button, you “freeze” the noise 
floor detection process. The yellow noise floor 
graph in the display will hold its current value (as 
will the numeric noise floor value display below) un-
til you deactivate Freeze. This allows you to take a 
closer look at the readings.

Reduction Governs the amount of noise reduction. The display 
below this fader shows the amount of dB by which 
the noise level is being reduced. The final result 
also depends on the Ambience parameter, and on 
the automatic Ambience and Transient analysis of 
the original material, as described above.

Ambience This parameter is used to specify a balance 
between the noise suppression and the amount of 
natural ambience, which is essential for a natural 
result. With a low Ambience setting, the sound can 
become somewhat lifeless and sterile. A high set-
ting, on the other hand, preserves more of the am-
bient character of the sound, but the noise 
suppression is less effective.

Offset This parameter serves as a threshold, governing the 
overall level at which the noise reduction is per-
formed. For optimal noise reduction with a minimum 
of sound coloration, this parameter should be set to 
a value slightly above the noise floor level. To help 
you do this, the offset value is shown as a light 
green line in the noisefloor display, while the noise 
floor is shown as a yellow line.

A/B/Store These are described below this table. 

Classic When this is activated, a less CPU-intensive ver-
sion of the DeNoiser algorithm is used. Use Classic 
mode if you are short on processing power. How-
ever, for optimum noise suppression, we recom-
mend that you deactivate Classic mode.

Bypass When this is activated, the signal passes through 
the plug-in but you don’t hear the results of the pro-
cessing. Use this to compare the sound with and 
without processing. Note: the analysis is always 
performed, regardless of the Bypass switch. This 
allows you to monitor the noise floor, spectrum and 
level in the spectrum display.

Parameter Description
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If you click on the logo a diagram of the signal-chain is 
shown. The following parameters are available:

Spectralizer
The Spectralizer is a type of audio “enhancer” or “exciter”. 
It can be put to many uses:

• To restore lost harmonics in a recording.
• To improve the clarity and transparency of a recording.
• To make a recording sound “warmer”.

How Spectralizer works

Most audio equipment introduces a slight low-pass filter-
ing to the audio signal. This means you lose “high end” or 
“clarity”. The lost high frequency components often have a 
level close to the noise floor. This means that simply using 
EQ to boost the high frequencies does not create the de-
sired effect – the noise is amplified as much as the signal.

Spectralizer can actually re-synthesize lost harmonics 
based on existing lower frequencies in the material. This 
can create an acoustically more pleasing result than EQ-
ing.

Spectralizer basically works by generating 2nd and 3rd 
harmonics or overtones. 

Parameter Description

Pre-Delay This governs the start time of the first “early reflec-
tion”, i.e. how the sound is “bounced” off the walls 
in the simulated room environment. The value range 
is 0-100 milliseconds. The lower the value, the 
sooner the early reflection is heard. 

HPF This is a high-pass filter that only affects the reverb 
signal into the NaturalVerb, not the original audio 
signal. A high-pass filter lets high-frequency signals 
through while cutting off low-frequency signals. 
The slider allows you to set the frequency for the fil-
ter, and only sounds above the set frequency will 
be heard.

LPF This is a low-pass filter that only affects the reverb 
signal into the NaturalVerb, not the original audio 
signal. A low-pass filter lets low-frequency signals 
through while cutting off high-frequency signals. 
The slider allows you to set the frequency for the fil-
ter, and only sounds below the set frequency will 
be heard.

Room Size This regulates the size of the simulated room, and 
thereby the spaciousness of the reverb. The value 
range is 1-30, and the higher the value you specify, 
the bigger the room. 

Decay This lets you specify the length of the reverberation. 
The value range goes from 26 milliseconds to 
11.63 seconds.

Damping Damping can be used for attenuating the high fre-
quencies of the reverb, thereby creating a softer, 
warmer sound. The higher the value, the more the 
high frequencies will be attenuated.

Stereo Mix This parameter is used for balancing the reverb sig-
nal between the left and right channel inputs to the 
NaturalVerb. The value range is 0-100%. A setting 
of 0 means that the reverb signals for both chan-
nels are completely independent of each other (de-
fault), while a setting of 100 means that the reverb 
signals for both channels are equally mixed with 
each other (50/50). In between these, settings from 
1-99% mean that each channel signal will contain 
that percentage of the other channel’s signal. 

Wet/Dry This regulates the balance between the effect 
sound (wet) and the original, unprocessed audio 
signal (dry). If the slider is in the middle position 
(default), the output will be balanced equally. With 
higher values, the original signal will be more pro-
nounced, and with lower values, the effect sound 
will be more dominant.

Gate button Clicking this button turns the Gate section on and 
off. Gating cuts off signals below a certain set 
threshold level. That is, the Gate only opens to let 
signals above the set threshold through. Note that 
the three sliders directly above this button (Sensi-
tivity, Threshold and Fade-Out) control the Gate ef-
fect, and therefore have no functionality when this 
button is in the Off position. Also note that the Gate 
only affects the reverb, not the original audio signal.

Sensitivity This parameter determines how fast the Gate will 
open to let a trigger signal pass. The value range is 
1-100 milliseconds. In order for this to have any ef-
fect, the Gate button must be in the On position.

Threshold This is used for setting the reference signal level (in 
dB) for the Gate. Signal levels above the set 
threshold open the Gate and pass through, but sig-
nal levels below the set threshold close the Gate 
and are cut off. In order for this to have any effect, 
the Gate button must be in the On position.

Fade-Out This parameter determines how long it should take 
for the Gate to close again after being triggered to 
let a signal through. The value range is 0-200 milli-
seconds. With higher values, more signal “residue” 
will be allowed to pass through the Gate before it 
closes, thereby producing a smoother cut-off. In or-
der for this to have any effect, the Gate button must 
be in the On position.

Parameter Description
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• The second harmonic is a signal at twice the frequency (one 
octave) above the basic frequency (the fundamental). 

• The 3rd harmonic is three times the fundamental (one octave 
and a fifth above it).

The reasons for limiting the processor to these two fre-
quencies are; firstly, higher harmonics are most often per-
ceived as “too high”, and secondly, their amplitude 
normally doesn’t follow that of the fundamental in a natural 
way.

Please note the relation between the Frequency pa-
rameter and the harmonics generated. 
If the Frequency parameter for example is set to 4000, the 2nd harmonic 
generator will only create frequencies from 8000Hz upwards and the 3rd 
harmonic generator will add frequencies starting at 12000Hz.

Another part of this process is giving the added harmonics 
appropriate amplitude curves. The amplitude of the har-
monics is based on the amplitude of the existing material, 
but you can control it to some extent using the Density 
and Kick parameters, see “Parameters” below.

The amplitude of the added harmonics is usually very low. 
The difference Spectralizer makes is sometimes only ap-
parent on a psycho-acoustical level. To hear what is actu-
ally added to the signal, use the Solo button.

Parameters

The parameters are as follows:

Stereo Echo
The Stereo Echo is a delay with separate settings for the 
left and right channel. It can also be used as a single mono 
delay, in which case the maximum delay time will be dou-
bled.

The Stereo Echo has the following parameters:

Parameter Description

Solo When this is activated, the output will only contain 
the added Harmonics. The original unprocessed 
signal will not be heard on the output.
This mode is used as a diagnostic tool to monitor 
what the current settings actually add to the signal.

Kick When this is activated, even more Harmonics will 
be added when a transient (attack) occurs in the 
signal.

Frequency This adjusts the frequency of the high-pass filter 
that appears just after the input. Signals with a fre-
quency lower than this setting will not be affected 
by the processing. In other words, there will be no 
harmonics added to the frequencies that are too 
low to pass through the filter.

Density This controls the amplitude “envelope” of the 
added harmonics. The higher the value, the more 
prominent the effect.

Input This adjusts the overall input to the processor. Use 
this to both maximize the signal level and to make 
sure that internal clipping does not occur. Use the 
Meter and “Int. Clip” indicator to check the levels.

Gain This adjusts the level of the signal just before it 
reaches the harmonic generators.
As you increase this, you will most probably have to 
lower the Input setting to avoid clipping.

2nd This sets the level of the 2nd harmonics in the mix.

3rd This sets the level of the 3rd harmonics in the mix. 

Mix The Mix parameter adjusts the balance between the 
unprocessed signal and the added harmonics.

Int. clip When this lights up, the signal has exceeded the 
maximum level that Spectralizer can handle. This 
will lead to unpleasant distortion and should defi-
nitely be avoided. If this happens, please lower the 
Input level and/or Gain.

Meter This allows you to check your adjustments of the In-
put and Gain controls, so that the signal does not 
change drastically in level when passing through 
the Spectralizer.

Parameter Description

Delay 1 The delay time for the left channel. The maximum 
delay time is 1486 ms, unless you link both chan-
nels for mono operation, in which case the maxi-
mum delay time is 2972 ms - see below (1000ms 
= 1 second).

Feedback 1 This sets the amount of delayed signal fed back 
into the Delay 1 block, to create repetitions. Higher 
values result in a higher number of echo repeats.

Link 1-2
(Off, Linked)

Select Off if you wish to use Delay 1 and Delay 2 as 
two independent blocks. Select Linked if the output 
of Delay 1 is to be connected to the Input of Delay 
2.

Delay 2,
Feedback 2

These parameters are identical to these but apply 
to the second Delay block.

Del2 Bal This parameter determines how much of the left 
channel output is sent to the right channel input. 
When set to 0.0 (fully left), then none of the left 
channel output is added to the right channel input; 
when it is set to 1.0 (fully right), the right input re-
ceives both its normal source and the complete 
output of the left channel.

Volume L The output level of the left channel delay.

Volume R The output level of the right channel delay.

Parameter Description
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StereoExpander
The StereoExpander plug-in narrows or enlarges the ste-
reo width of an existing stereo signal. There is only one 
parameter, the horizontal stereo effect slider. Setting this 
to a value of -100% produces two equal output channels 
(the original stereo image is lost). Values between -99 and 
-1 correspond to a narrower stereo image. A value of 0 
corresponds to the original signal, while values between 1 
and 100 enlarge the stereo image.

Tools One
Tools One is an extremely useful “effect” for various appli-
cations. 

The level faders allow you to adjust the level of the left and 
right channel respectively. You can [Shift]-drag to make 
detailed settings. [Ctrl]-clicking a fader resets it to 0 dB 
(no level adjustment). Normally, adjusting one fader auto-
matically moves the other as well, but you can make sepa-
rate adjustments for the channels by pressing [Alt] and 
dragging.

The two Phase switches let you invert the phase of the left 
or right channel (or both).

The Algorithm buttons let you adjust the stereo sound im-
age. When none of the buttons are activated, the stereo 
image will be preserved as is. MS process mode can be 
used in one of two ways:

• To transform an incoming “regular” stereo signal so that it re-
sembles a signal recorded according to the M-S (middle/side) 
principle. This technique is often used in broadcasting to 
record the direct signal source (usually a voice) using one mi-
crophone, and the ambience using a second microphone po-
sitioned at a 90° angle. 

• To transform an incoming MS signal into a “regular” stereo 
signal (to simulate an “XY” recording technique, where neither 
microphone is placed directly in front of the signal source).

Channel Swap, finally, means that the left channel is as-
signed to the right side and the right channel to the left 
side.

Voice Attenuator
This plug-in can be used to remove lead vocals from a re-
cording, to produce a “karaoke” effect. The principle con-
cept is based on the fact that vocals are usually mixed to 
center position in the stereo field, and that the human 
voice occupies a limited area of the frequency spectrum. 

Note, however, that it is nearly impossible to remove a vo-
cal completely, without using very complex processing be-
yond the scope of this plug-in. 

• If the Remove Mono button is activated, the plug-in will sum 
the right and the left channels (with one of the channels out of 
phase), in the frequency range set by the Low and High Fre-
quency parameters. This method will only work with stereo 
material.

• If the Notch Filter button is activated, the plug-in will filter out 
the signals within the frequency range set with the Low and 
High Frequency parameters, by applying a notch (band reject) 
filter. This method can be used with both stereo and mono 
material.

• The Gain parameter allows you to adjust the output level of 
the plug-in.

VSTDynamics

General Information
The VST Dynamics plug-in combines five separate pro-
cessors; AutoGate, Compress, AutoLevel, Limit and Soft-
Clip, covering a variety of Dynamic Processing functions. 
The VST Dynamics window is divided into five sections, 
containing controls and meters for each processor. You 
activate the VST Dynamics panel by clicking the “On” but-
ton in the lower right corner. Once VST Dynamics is acti-
vated, you can turn the individual processors on and off by 
clicking on their labels. Activated processors have high-
lighted labels.

You can activate as many processors as you want, but re-
member that not all processors are designed to work to-
gether. For example, “Limit” and “SoftClip” are both 
designed to ensure that the output never exceeds 0dB, 
but achieve this in different ways. To have both of them 
activated would be unnecessary. The internal signal flow 
is printed in the lower right part of the Dynamics panel.
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The following processors are available on the VST Dy-
namics panel (click an item in the list for more information 
about the corresponding processor):

• “AutoGate” on page 201
• “AutoLevel” on page 202
• “Compress” on page 202
• “SoftClip” on page 202
• “Limit” on page 202

AutoGate
Gating, or noise gating, is a method of dynamic process-
ing that silences audio signals below a certain set thresh-
old level. As soon as the signal level exceeds the set 
threshold, the gate opens to let the signal through. Auto-
Gate offers all the features of a standard noise gate, plus 
some very useful additional features, such as auto calibra-
tion of the threshold setting, a look-ahead predict func-
tion, and frequency selective triggering. Available 
parameters are as follows:

Trigger Frequency Range 

AutoGate has a feature that allows the gate to be trig-
gered only by signals within a specified frequency range. 
This is a most useful feature because it lets you filter out 
parts of the signal that might otherwise trigger the gate in 
places you don’t want it to, thus allowing more control 
over the gate function. The Trigger Frequency Range 

function is controlled using the control in the upper part of 
the AutoGate panel, and the slider located below it. The 
basic operation of the Trigger Frequency Range function 
is as follows:

1. While playing back audio, drag the slider to the “Lis-
ten” position.
You will now monitor the audio signal, and the gate will be bypassed.

2. While listening, drag the two handles in the Trigger 
Frequency window to set the frequency range you wish to 
use to trigger the gate.
You will hear the audio being filtered as you move the handles.

• Dragging the left handle to the right will progressively 
cut frequencies starting from the low end of the frequency 
spectrum.

• Dragging the right handle to the left will progressively 
cut frequencies starting from the high end of the fre-
quency spectrum.

3. After setting the frequency range, drag the slider to 
the “On” position.
AutoGate will now use the selected frequency range as the trigger input.

4. To disable the Trigger Frequency Range function, 
drag the slider to “Off”.
AutoGate will now use the unfiltered audio signal as the trigger input.

Calibrate Function

This function, activated by using the Calibrate button lo-
cated below the Threshold knob, is used to automatically 
set the threshold level. It is especially useful for material 
with consistent inherent background noise in the audio 
material, like tape hiss for example. This may be masked 
by the audio content for most of the time, but becomes 
noticeable during silent passages. Use as follows:

1. Find a part of the audio material, preferably not too 
short, where only the background noise is heard. 
If you can find only a short section with background noise, try looping it.

2. Play it back, and click on the Calibrate button.
The button will blink for a few seconds, and then automatically set the 
threshold so that the noise will be silenced (gated) during passages 
where there is no other signal present.

Parameter Explanation

Threshold This setting determines the level where AutoGate is 
activated. Signal levels above the set threshold trig-
ger the gate to open, but signal levels below the set 
threshold will close the gate.

Attack This parameter sets the time it takes for the gate to 
open after being triggered. If the Predict button is 
activated, it will ensure that the gate will already be 
open when a signal above the threshold level is 
played back. AutoGate manages this by “looking 
ahead” in the audio material, checking for signals 
loud enough to pass the gate.

Hold This determines how long the gate stays open after 
the signal drops below the threshold level.

Release This parameter sets the amount of time it takes for 
the gate to close (after the set hold time). If the 
“Auto” button is activated, AutoGate will find an op-
timum release setting, depending on the audio pro-
gram material.
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AutoLevel
AutoLevel reduces signal level differences in audio mate-
rial. It can be used to process recordings where the level 
unintentionally varies. It will boost low levels and attenuate 
high level audio signals. Only levels above the set thresh-
old will be processed, so low level noise or rumble will not 
be boosted. If the input level is greater than 0dB, Au-
toLevel will react very fast, because it looks ahead in the 
audio material for strong signal levels and can attenuate 
levels before they occur, thus reducing the risk of signal 
clipping.

Compress
Compress reduces the dynamic range of the audio, so 
that softer sounds get louder or louder sounds get softer, 
or both. Compress functions like a standard compressor 
with separate controls for threshold, ratio, attack, release 
and make-up gain parameters. 

There is also a separate display that graphically illustrates 
the compressor curve shaped according to the Threshold, 
Ratio and MakeUp Gain parameter settings. Compress 
also features a Gain Reduction meter that shows the 
amount of gain reduction in dB, and a program dependent 
Auto feature for the Release parameter.

SoftClip
SoftClip is designed to ensure that the output level never 
exceeds 0dB, like a limiter. SoftClip, however, acts differ-
ently compared to a conventional limiter. When the signal 
level exceeds -6dB, SoftClip starts limiting (or clipping) 
the signal “softly”, at the same time generating harmonics 
which add a warm, tubelike characteristic to the audio ma-
terial. SoftClip is simplicity itself to use as it has no control 
parameters. The meter indicates the input signal level, and 
thus the amount of “softclipping”. Levels in the green area 
(weaker than -6dB) are unaffected, while levels in the yel-
low-orange-red area indicate the degree of “softclipping”. 
The deep red meter area to the right indicates input levels 
higher than 0dB. 

Avoid feeding SoftClip with excessively high signal 
levels as audible distortion may occur, although the output 
level will never exceed 0dB.

Limit
Limit is designed to ensure that the output level never ex-
ceeds a certain set output level, to avoid clipping in fol-
lowing devices. Conventional limiters usually require very 
accurate setting up of the attack and release parameters, 
to totally avoid the possibility of the output level going be-
yond the set threshold level. Limit adjusts and optimizes 
these parameters automatically, according to the audio 
material. However, should you want to, you can adjust the 
Release parameter manually.

Parameter Description

Threshold Only levels stronger than the set threshold will be 
processed.

Reaction Time Switch This parameter sets the amount of time it takes for 
AutoLevel to adjust the gain. Set this according to 
whether the program level changes suddenly or 
over a length of time.

Parameter Description

Threshold This setting determines the level where Compress 
“kicks in”. Signal levels above the set threshold are 
affected, but signal levels below are not processed.

Ratio Ratio determines the amount of gain reduction ap-
plied to signals over the set threshold. A ratio of 3:1 
means that for every three dB the input level in-
creases, the output level will increase by only one 
dB.

Attack This determines how fast Compress will respond to 
signals above the set threshold. If the attack time is 
long, more of the early part of the signal (attack) will 
pass through unprocessed.

Release Sets the amount of time it takes for the gain to re-
turn to its original level when the signal drops below 
the Threshold level. If the “Auto” button is activated, 
Compress will automatically find an optimum re-
lease setting, that varies depending on the audio 
program material.

MakeUp Gain This parameter is used to compensate for output 
gain loss, caused by compression.

Parameter Description

Threshold This setting determines the maximum output level. 
Signal levels above the set threshold are affected, 
but signal levels below are left unaffected

Release This parameter sets the amount of time it takes for 
the gain to return to its original level when the sig-
nal drops below the threshold level. If the “Auto” 
button is activated, Limit will automatically find an 
optimum release setting that varies depending on 
the audio program material.

Parameter Description
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General problems
Can't create a temporary file

• Please check which drive is specified for your temporary files 
(in the Edit Folders dialog). You cannot use a CD-ROM disk 
or a write protected drive for your temporary files.

• Is the drive full? Please select a drive with as much free space 
as possible.

A drive/partition can't be found

• Is this volume a removable drive, or a CD-ROM? In that case, 
is the correct disk really in the drive?

• Have you renamed the Volume since you last used the pro-
gram?

A file can't be deleted or renamed

• Is the volume write protected on which the file is residing? In 
that case, turn the write protection off.

• Is the file on a CD-ROM? Files can’t be deleted from CD-
ROMs.

The program opens/doesn't open with the same files 
each time

• This is not a bug, it's a feature! You can decide to have the 
program boot up as you last left it. This is done by activating/
deactivating “Open last window layout on startup” in the Pref-
erences dialog. See Preferences Topics.

My snapshots are gone!

There are two main ways to make sure your snapshots 
“stay” from session to session:

• Make sure “Save view settings in companion file” is activated 
in the Preferences - Wave edit tab. This will automatically save 
any snapshots associated with an audio file.

• Use Open last window layout on startup (described above) to 
make all settings remain just as you left them.

The wave isn't styled as when I opened it last

There are three ways to save your window styling, etc.:

• Make sure “Save view settings in companion file” is activated 
in the Preferences–Wave edit tab. This will automatically save 
any window settings associated with an audio file.

• Use “Open last window layout on startup” in the Preferences 
dialog to make all settings remain just as you left them.

Problems with opening files
The file doesn't appear in the Open dialog.

• Does the file have the right extension? Select “All files (*.*)” 
from the pop-up in the Open dialog and check again.

• Is the drive on which the file resides currently accessible? If 
you use removable hard disks or CD-ROMs, make sure the 
right disk is in the drive.

Can't open a file

• Is the file really a supported file type?
• Is it possible to open it in other programs that support files of 

the same format? If not, it is probably damaged.
• Try opening the file in the Media Player application, included 

with Windows. If that doesn't work, the file is probably dam-
aged. Note that WaveLab Essential carefully checks the file 
headers: if any mistake in the format is found, WaveLab Es-
sential does not open the file for safety reasons. This could 
happen (rarely) with some files created by non-professional 
software.

• Is the drive on which the file resides currently accessible? If 
you use removable hard disks or CD-ROMs, make sure the 
right disk is in the drive.

Problems with saving files
Can't save

• Is the volume on which you are trying to save write protected? 
For example, you cannot save anything on a CD-ROM.

• Is there enough space on the drive?
• Is the drive to which the file was last saved currently accessi-

ble? If you use removable hard disks or CD-ROMs, make sure 
the right disk is in the drive.

• Are you trying to overwrite another file with the same name? If 
so, is that file write protected? If it is, it can't be overwritten. 
Save under another name, or remove the write protection.

• Are you trying to overwrite another file with the same name? Is 
that file open? If it is, close it and try again.

• To get around all of the problems listed above, try saving to 
another disk/folder.
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Recording problems
I can't record

• Are you trying to record at a sample rate/bit resolution that 
your card doesn't support? Check the documentation for the 
card to find out which formats it supports.

• Is the card really installed correctly? Try using some applica-
tion included with the card to see if that works. Also try the 
“Sound recorder” included with Windows.

• Do you have the latest drivers for your card? Contact your 
dealer for the latest drivers.

• Is your temporary files location set up correctly and do you 
have enough free space on that drive?

I can’t hear what i just recorded

• Do the meters move when you record? Do you get a wave-
form in the window? If you do, the recording is not the prob-
lem, it is the playback.

• Check the Mixer. Do you have the correct recording inputs ac-
tivated, and are the levels set properly?

• If you can't seem to activate the correct inputs and levels from 
WaveLab Essential, try the mixer application that was included 
with your audio card. Some card drivers do not react correctly 
to the standard Windows commands transmitted by WaveLab 
Essential.

• Please check your cables and the devices you have con-
nected. Is there really a proper audio signal coming in to the 
card?

• Have you selected the appropriate recording mode for the re-
cording source? If you want to record an external audio signal 
through the active inputs on your audio hardware, you must 
select the “Audio input (hardware)” mode in the Record dia-
log. 

There is too much noise in my recordings

• Have you adjusted your recording levels properly?
• Is the source connected to the proper input?
• Have you specified 8 bits as the bit resolution for the record-

ing? Try 16 bits instead.
• Keep in mind that microphones provided with sound cards are 

very low quality.

The mixer can't be “created”

• Have you specified your audio card in the Preferences dialog? 
A mixer can't be created if “Microsoft Sound Mapper” is se-
lected.

• Do you have the latest and correct drivers for your card? We 
have noted that some card drivers contain “bugs” that prevent 
a mixer from being created.

Playback problems
No playback at all

• Is the card really installed correctly? Try using some applica-
tion included with the card to see if that works. Also try the 
“Media Player” included with Windows. If that doesn't work, 
there's something wrong with the card or the installation.

Playback is choppy

• Are you using a compressed hard drive? You should not use 
WaveLab Essential on such drives because they eat up too 
much processor power!

• To play a quality wave (e.g. 16 bit Stereo 44,1 kHz file) from a 
CD-ROM, your CD-ROM reader must be at least of a “Double 
Speed” type.

A file can't be played

• Is the file really in a format (sample rate, bit resolution mono/
stereo) supported by your audio card? The format of the file is 
indicated on the status bar.

Playback can’t be heard

• Do you have an application for the audio card that allows you 
to adjust playback volumes? Are these settings correct?

• Check the cables and the other audio equipment you use.
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Editing problems
After editing I get clicks and pops

• Are you making “splices” in the middle of an audio section? If 
you do, we recommend that you make all cuts at zero cross-
ings, to avoid clicks and pops.

After crossfading, I get distortion

• If both sections play at full level during the crossfade, it is pos-
sible that clipping will occur (although it is unlikely). If this hap-
pens, undo the crossfade, lower the gain of both sections (by 
3 or 6 dB for example) and try again. The problem cannot oc-
cur if you check the “Inverse of Fade In” or “Inverse of Fade 
Out” options.

Troubleshooting and precautions
The following sections provide information concerning 
problems relating to CD/DVD burning, hardware devices, 
precautions for trouble-free CD writing as well as hard-
ware and setup issues.

Problems and solutions
General instructions

The following text is written for problems relating to CD 
burning, but applies to DVD as well.

• If you run into problems, the first thing to check is your hard-
ware and software setup. To isolate the problem, you could try 
using other CD burning software (for example a program sup-
plied with the CD-R unit). If this doesn't work either, the prob-
lem isn't with WaveLab Essential, but with some other 
component in the system.

• When you insert a disk into the recorder, make sure you wait 
long enough before you start using it. You might have to wait 
several seconds. Watch any possible LEDs on the front panel. 
They will indicate when the unit is ready for use (see the oper-
ation manual for the unit for details).

• If your CD recorder doesn't respond, the first thing to do is to 
eject the disc and insert it again. This will reinitialize the re-
corder.

• If this doesn't work, you might try switching off the recorder 
(even if the computer is still on), wait three seconds and then 
turn it back on again. Often, only rebooting the computer is 
not enough.

Questions and Answers
• I have problems with a Phillips CDD-2000 unit.

If you have a real Phillips drive or a drive that contains this 
Phillips mechanism, you must make sure that the firmware 
version is 1.25 or later. A firmware update can be found at 
http://www.philips.com/sv/pcaddon.

• I have other problems writing a CD and/or importing CD audio 
tracks.

Well of course there could be many reasons for this. 
Check the “Day to day precautions for trouble free CD 
writing” section below. But, here are two more things to 
try:

Open the Control Panel, and double click on System. Se-
lect the Device Manager tab, select CD-R in the list (if this 
entry exists, which is not mandatory) and click on the 
Properties button and then select Settings. Disable the 
“Insert auto notification” to prevent Windows from reading 
from the CD-R during the writing process.

If you have problems at higher speeds, try lowering it. 
Even if your system writes correctly at 8x most of the time, 
it's safer to write at lower speeds.

• I have problems writing CDs when I specify ISRC and EAN/
UPS codes, but otherwise things work fine.

If you try to write a ISRC code or EAN/UPC code, Wave-
Lab Essential might return an error if: a) the CD recorder 
does not support this (not all do, or not all firmware ver-
sions do). b) the codes are not properly formatted: UPC/
EAN: 13 numeric characters. ISRC: 5 alphanumeric fol-
lowed by 7 numeric characters.

• A CD disc that I have created doesn't play correctly on my CD 
player.

The reflections of a “normal” CD and a CD-R are different 
(a CD-R reflects less light). A dirty lens on the CD player 
might disturb playback. This is more common on old CD 
players because their lasers do not properly calibrate for 
recordable CDs. Sometimes, the combination of disc 
brand and CD recorder brand can make a difference.

! Please note that Steinberg cannot make any guaran-
tees about the validity of your recorded audio CDs.
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Day to day precautions for trouble-
free CD writing
The most important thing to remember is that CD writing 
is a real-time operation where a laser burns depressions 
into the surface of the CD. This is done at a speed which 
cannot be slowed down or interrupted. Any interruption 
will most likely be fatal, rendering the CD-R disk useless. 
For these reasons you should make sure your system 
does not interrupt the CD-R writing once it's under way. 
Read the following points:

• Keep the CD-recorder on a vibration-free surface. Sudden 
“shocks” could cause writing interruptions.

• Do not read files directly from a CD, copy them to a fast hard 
disk first.

• Do not read files over a network. Networks usually are far too 
slow for CD-R writing.

• Turn off networking, at least for the hard disk drive from which 
you are reading, since the CD writing may be interrupted by 
anyone trying to access this drive.

• It is best to store the files on a hard disk partition that is 1 gi-
gabyte in size, or smaller (since this means the sectors will be 
16kByte rather than 32kByte).

• Do not read files from a hard disk with compression enabled!
• It is highly recommended that you keep your hard disk(s) de-

fragmented at all times. Windows includes an application for 
this. 

• If you have multiple hard drives in your system, put the audio 
files on your fastest drive! Also use a fast drive for WaveLab 
Essential's “temp” files.

• Turn off any screen savers, anti-virus, schedulers, animated 
icons and alarm or reminder programs that might interrupt the 
CD burning operation.

• Make sure any fax reception or background e-mail software is 
disabled.

• If you use the System Agent, make sure no activities are 
scheduled for the time you write to the CD. Do no use the 
“When Idle” option in the System Agent.

• Disable any System Monitoring programs.
• If you use the CD-R unit as a CD-ROM reader, make sure you 

quit the Explorer and close any “My Computer” windows be-
fore writing.

• Stop audio playback in WaveLab Essential before writing.

Hardware and setup issues
CD-R Drivers

• If you have previously installed another CD-R software prod-
uct, you may run into driver conflicts. Normally this should not 
happen since WaveLab Essential has built-in drivers that are 
loaded as needed, and which usually override any other in-
stalled drivers. However, if you do have problems writing to 
CD-R, this is a point to check.

• If it isn't absolutely required, don't install any other driver for 
your CD-R unit (for example a driver that allows you to use the 
CD-R as a CD-ROM drive). The drivers might make Windows 
try to access the drive during writing, which can cause system 
interruptions.

• In the advanced BIOS settings of your SCSI host adapter, the 
following should normally be disabled:
- Plug and Play SCAM Support
- Support Removable Disks Under BIOS as Fixed Disks
- BIOS Support for Bootable CD-ROM
- BIOS Support for Int 13 Extensions 

Networking Cards

Network cards can produce hardware interrupts which 
momentarily halt operation of all software. This can cause 
various problems. For CD writing, a non-networked ma-
chine is more stable than a networked one.

• If you need to keep your machine connected to a network try 
to not load the network card drivers when you plan to write 
CDs.

About Hard disks

• Many hard disks automatically perform something called ther-
mal calibration at regular (but unpredictable) intervals. For this 
reason, drives sold as “A/V drives” are recommended, since 
they have built-in “intelligence” which delays any recalibration 
to times when the disk is not being used. Some drives not 
marketed as “A/V Drives” also have this capability, check with 
the vendor if in doubt.

CD-R disks

• There are many brands of CD-R disks. Always use one that 
has been tested and recommended by your CD-R drive man-
ufacturer.

• CD-R discs are not as solid as real CDs. Handle them with 
care! Do not expose discs to sunlight for long periods, and 
avoid heat and humidity.
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• The top (label) side of a CD-R disc is also vulnerable. Don't 
use alcohol-based pens to write on discs and don't put labels 
on unless they are specifically designed for CD-Rs (otherwise 
the glue on the label might eat through the surface).

Links and sources for more information

• A general CD-R site that might be of interest: 
http://www.osta.org/technology/cdqa.htm
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Key commands

File handling

View
The following commands scroll the window without mov-
ing the cursor:

Overview

Zooming
Main View

Processing

Key Command Function

[Ctrl]-[O] Open wave file

[Alt]-[Enter] Open wave file information window

[Ctrl]-[F2] Open Audio CD Montage

[Ctrl]-[S] Save current document

[Shift]-[S] Save current document under new name and/or in 
a new location

[Ctrl]-[Shift]-[S] Save all currently open documents

[Ctrl]-[N] Create new wave

[Ctrl]-[W] Close current document (and all its related win-
dows)

[Ctrl]-[E] Convert Wave to MP3 (Save special – Encode 
(MP3))

[Ctrl]-[Shift]-[E] Convert Wave to MP2 (Save special – Encode 
(MP2))

[Shift]-[E] Save current wave selection as a new wave file

Key Command Function

[Ctrl]-[Home] Start of Wave or Montage

[Ctrl]-[End] End of Wave or Montage

[.] (Numeric keypad) Cursor position

Key Command Function

[Ctrl]-[J] Zoom out to display the entire wave/Montage hori-
zontally

Key Command Function

[G] Zoom in horizontally

[Arrow up] Zoom in horizontally (or Zoom out if Cubase com-
patibility is enabled)

[H] Zoom out horizontally

[Arrow down] Zoom out horizontally (or Zoom in if Cubase com-
patibility is enabled)

[Ctrl]-[Arrow up] Zoom in horizontally to maximum zoom factor

[Ctrl]-[Arrow down] 
or [J]

Zoom out horizontally to display the entire wave or 
montage

[Shift]-[G] or
[Shift]-[Arrow up]

Zoom in vertically (or Zoom out if Cubase compati-
bility is enabled)

[Shift]-[H] or 
[Shift]-[Arrow down]

Zoom out vertically (or Zoom in if Cubase compati-
bility is enabled)

[Shift]-[J] Zoom in or out to get an optimized level display 
(best fit)

[K] Zoom selection

[Ctrl]-[L] Zoom in vertically to decrease the number of visible 
tracks (Montage)

[Ctrl]-[Shift]-[L] Zoom out vertically to increase the number of visi-
ble tracks (Montage)

Key Command Function

[N] Level Normalizer

[Ctrl]-[G] Change gain

[D] Dynamics

[V] Level envelope

[Ctrl]-[D] Easy Fade

[Ctrl]-[F] Fade in/out

[X] Crossfade

[Ctrl]-[R] Reverse

[R] Waveform Restorer

[T] Time stretch

[P] Pitch Correction

[Ctrl]-[Q] EQ
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Playback and cursor position
Numeric keypad

Function keys

Cursor keys

Selecting

Extending or making selections

The following commands create a new selection or extend 
the current one.

Making selections

The following commands always create a new selection:

“One the fly” numeric keypad commands

The following commands are for selecting during play-
back. Please note that the keys on the numeric keypad 
must be used.

Key Command Function

[Enter] Play (from current position)

[0] Stop / Move to selection start / Move to beginning

[1] Move cursor to selection start

[2] Move cursor to selection end

[4] Move cursor to previous marker

[5] Move cursor to next marker

[.] (full stop) Scroll to cursor

[/] Loop on/off (current wave only)

[F] Scroll during playback on/off

Key Command Function

[Space Bar] Toggle Play / Stop

[F8] Play (from current position)

[F7] Stop / Move to selection end/ Move to selection 
start / Move to beginning

[F6] Play selection

Key Command Function

[Arrow left] Move cursor one pixel to the left

[Arrow right] Move cursor one pixel to the right

[Ctrl]-[Arrow right] Move cursor 1/10 of the window width to the right 
(or left if Cubase compatibility is enabled)

[Ctrl]-[Arrow left] Move cursor 1/10 of the window width to the left 
(or right if Cubase compatibility is enabled)

[Ctrl]-[Page Up] Move cursor one window width to the left (or right if 
Cubase compatibility is enabled)

[Ctrl]-[Page Down] Move cursor one window width to the right (or left if 
Cubase compatibility is enabled)

[Home] Move cursor to beginning

[End] Move cursor to end

[Tab] Toggle Cursor between left/right/both channels 
(stereo waves only)

Key Command Function

[Esc] Toggle selection on/off

[Tab] Toggle selection between left/right/both channels 
(stereo waves only)

Key Command Function

[Shift]-[Arrow left] One pixel to the left

[Shift]-[Arrow right] One pixel to the right

[Ctrl]+[Shift]-
[Arrow left]

20 pixels to the left

[Ctrl]+[Shift]-
[Arrow right]

20 pixels to the right

[Shift]-[Page Up] 20 pixels to the left (or right if Cubase compatibility 
is enabled)

[Shift]-[Page Down] 20 pixels to the right (or left if Cubase compatibility 
is enabled)

[Ctrl]+[Shift]-
[Page Up]

One window width to the left (or right if Cubase 
compatibility is enabled)

[Ctrl]+[Shift]-
[Page Down]

One window width to the right (or left if Cubase 
compatibility is enabled)

Key Command Function

[Shift]-[Home] From cursor to start

[Shift]-[End] From cursor to end

[Ctrl]-[A] Select all

Key Command Function

[Shift]-[1] Set start of selection

[Shift]-[2] Set end of selection

[+] Press and hold to set start of selection, release to 
set end of selection.
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Editing and Recording
General

Cut and Paste

Delete and Silence

Recording

When Record dialog is open

Undo and Redo

Markers

Miscellaneous

Key Command Function

[Shift]-[A] Open Wave Attributes dialog

[Ctrl]-[U] Open Audio Properties dialog

Key Command Function

[Ctrl]-[X] Cut

[Ctrl]-[C] Copy

[Ctrl]-[V] Paste

[Ctrl]+[Shift]-[V] Paste Append

Key Command Function

[Backspace] or [Del] Delete current selection

[Ctrl]-[Space bar] Silence current selection

[Ctrl]+[Shift]-[Space] Insert silence

[Ctrl]-[Backspace] Trim (to selection)

Key Command Function

[*] (Multiply on the nu-
meric keypad)

Open Record dialog

Key Command Function

[Ctrl]-[M] Drop generic marker

[Ctrl]-[L] Drop generic region start marker

[Ctrl]-[R] Drop generic region end marker

[Ctrl]-[P] Pause

[Ctrl]-[Enter] Record

[Ctrl]-[0] 
(Numeric keypad)

Stop record

[Ctrl]-[Y] Reset meters

Key Command Function

[Ctrl]-[Z] Undo

[F3] Undo

[Ctrl]+[Shift]-[Z] Redo

[F4] Redo

Key Command Function

[Ctrl]-[M] Open marker list

[Insert] Drop new marker at cursor position (for example 
during playback)

[Ctrl]-[Insert] Create Marker

Key Command Function

[F2] Open Rename dialog

[Alt]-[Ctrl]-[M] Maximize Wave or Montage window width

[W] View Window layouts

[Ctrl]-[F9] Show/hide Master Section

[Ctrl]-[F10] Show/hide Monitor window

[Ctrl]-[P] Open Preferences dialog

[M] Magnetize Bounds on/off

[Z] Zero crossing on/off

[7] (Numeric keypad) Undo zoom/view/position change in Montage

[8] (Numeric keypad) Redo zoom/view/position change in Montage

[Shift]+[F5] Open a dialog where you can save a picture of the 
active window.
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Index

A
Accelerators 31
ACM 54
Append 47
ASIO driver 14
Audio card

Checking 13
Settings 14

Audio CD
Testing 135
Writing 136

Audio CD format 137
Audio CD track import 144
Audio files See “Wave files”
Audio Montage

About 104
Cloning 129
Creating new 106
Opening 129
Panes 104
Saving 129

Audio Properties 55
Auto Panner 191
Auto zoom for overview 38
Autopan 194

B
Backups

Audio files 51
Batch file encoding 96
Bypass (Master Section effects) 86

C
Calibrating printer 153
CD format specification 137
CD images

Creating with cue sheet 133
CD recorders

Disc-At-Once 138
Installing 16
Selecting 135

CD view (Montage) 132
CD Wizard dialog 132
CD/DVD Project

About 140
CD-Extra 136
Change Gain 69

Choirus2 194
Chorus 78
Chorus (Plug-in) 191
CleanComp 195
Clear Undo 22
Clip effects

Adding 124
Latency 125
Tail 125

Clipping
About 69

Clips
About 104
Adding 107
Deleting 116
Duplicating 115
Mouse zones 113
Moving 114
Overlapping 115
Resizing 115
Selecting 113
Source files 117
Splitting 116

Colors
Customizing (Montage) 181
Customizing (Wave window) 181

Colors (System) 13
Compression 69

Audio file formats 54
Control bars 25

Appearance 26
Button functions 26
Descriptions 26
Docking 25
Moving 26
Show tips 26
Showing/hiding 26
Un-docking 26

Convert format
Batch encoding 96
Using Save as 51

Convert sample rate 79
Copy 45
Copying wave selections 44
Crossfade 73
Crossfade Looper 172

Crossfades (Montage)
About 122
Editing 122
Options 122

Crystal Resampler (Plug-in) 192
Cue Points 116
Cursor

Appearance 181
Moving to marker 101
Scroll to 38
Setting position 40
Status bar 35

Cut 46

D
Data CD/DVD

Creating 140
Writing 142

dB (Level unit) 28
DC Offset 74
Decimal (Level unit) 28
DeClicker 195
Deleting clips 116
Deleting files and documents 53
Deleting wave selections 47
DeNoiser 196
Dialogs (Non-modal) 31
DirectX plug-ins 85
Disc-At-Once 138
Disk space 61
Dithering

About 88
Internal 89

Dockable control bars 
See “Control bars”

Drag and drop 34
Drop marker 99
Dropout 84
Duck according to other track 119
Dynamics 69

E
Easy Fade 72
Echo (Plug-in) 192
Edit Folders dialog 179
Edit Overview (Montage) 110
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Effects
About 85
Installing 87
Mute 86
Presets 87
Removing 85
Reordering 85
Selecting 85

Effects (Montage)
Copying settings 125
Effect dialog 125
Removing 124
Split mode 124

Eliminate DC Offset 74
Enable Snapping 113
Encode (ACM) 54
Encoded formats

About 54
Batch encoding to 96
Exporting to 54

Envelopes
About 117
Editing 118
Resetting 119

EQ (Processing) 79
EQ-1 192
Extend to peaks 44

F
Fade-In/Out 72
Faders (Master Section)

About 83
Offset 84
Unlink mode 84

Fades (Montage)
Creating 121
Editing 121
ROM presets 121

Favorites 34, 184
FFT

3D Frequency Analysis 161
File formats 49
File size (Unit) 28
Files (Audio) See “Wave files”
Files view 117
Folder editing 179
Frames (CD) 137

Freedb 145
Frequency Analysis, 3D 161

G
Gating 69
Generic markers 98
Global Analysis

Errors 160
Extra 159
Introduction 156
Loudness 158
Operations 156
Peaks 158
Pitch 159

Global auto-grouping 108
Groups

Plug-ins 187

H
Hard disk requirements 10
Harmonization 78
Help 22
Hi-fi Chorus 78

I
Import

Audio CD track 144
Audio files 33
Markers 98

Insert audio file 34
Insert silence 47
Installation 13
Invert Phase 74
ISRC codes

About 138

K
Key commands

About 31
Customizing 184

Key sequences 184

L
Label Editor

Edit Properties dialog 151
Editing objects 149
Grid 150
Objects menu 151
Tools 149

Label sets
About 151
Opening 152
Printing 153
Saving 152
Saving as user template 152
Templates 148

Layouts
Saving 180
Window layouts 183

Level envelope 71
Level Processing (Dynamics) 69
Level selections 43
Level/Pan Meter 64
Leveler 192
Limiting 69
Loop markers 98, 102, 172
Loop Tone Equalizer 176
Looping 58, 102, 171

M
Magnetic bounds (Montage) 113
Magnetize bounds

Cursor 40
Cursor to marker 101
Dropping audio on markers 102
Snap to 45
Wave selections 43

Magnification See “Zooming”
Magnifying Glass 36
Marker list 99
Marker toolbar 99
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Markers
Appearance 181
Creating 99
Deleting 101
Displaying/hiding 100
Dropping 99
Dropping audio on 102
Dropping while recording 62
Editing 100
Importing and Saving 98
Introduction 98
Montage 127
Moving 101
Moving cursor to 101
Selecting between 102
Types 98

Master Section
About 82
Deactivating 82
Dithering Pane 88
Effects Pane 85
Master Level Pane 83
Render 91
Window handling 83

Master Section preset groups 90
Maximize width 35
Memory requirements 10
Meta Normalizer (Montage) 126
Meter format 28, 39
Metering

Introduction 64
Level 64
Spectrum 65

Meters
Master Section 84
Meter Windows 64
Record dialog 61

Mix (Option) 47
Mixed Mode CD

About 140
Creating 142

MME/WDM Driver 14
Monitor playback 64
Monitor window

Performance display 93
Progress display 93

Mono
Master Section button 84

Mono to Stereo 48
Montage See “Audio Montage”
Mouse zones 113
Mouse zooming 37
Move cursor to 40
Moving wave selections 46
MP3 files

Batch encoding 96
MRK files 98
Multiple copies 47
Mute

Clips and tracks 111
Effects 86

N
NaturalVerb 197
Navigating

By clicking 38
Scroll menu 38
Using status bar 39

New documents, Creating 33
Noise Gate (Plug-in) 192
Noise gating 69
Non-modal dialogs 31, 68
Normalize 68
Nudge (Kicker) tools

Wave window 46
Nudging

Wave window 46

O
Online documentation 22
Open last window layout on 

startup 180
Oscilloscope 66
OSQ files

Batch conversion to 96
Saving and opening 51

Overwrite 47

P
Page layout (Labels) 153
Panes 23

Paste
Append 47
Copying wave selections 45
Mix 47
Moving wave selections 46
Overwrite 47
Prepend 47

Peak Master 193
Pencil tool 49
Percent (Level unit) 28
Phase Invert 74
Photo viewer 141
Pitch Correction 77
Play (Transport bar) 57
Play selection 59
Play tool 58
Playback Browser 59
Playing

Clips 112
Montage 111
One channel in stereo file 58
Play tool 58
Selection 59
Setting start point 40
Skipping sections 58

Plug-ins
About 85
Installing 87
Organizing 186
Presets 87

Podcast
About 164
Episodes 165
New 164
Options 166

Pop-up menus
In displays 27
Values 29

Position See “Cursor”
PQ codes 137
Pre-Emphasis 138
Preferences

Introduction 179
Saving 179
Startup 179

Prepend 47
Preset groups 90
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Presets
Creating 30
Deleting 30
Introduction 30
Loading 30
Master Section 89
Modifying 30

Printing CD Labels 153
Priorities

Master Section 92
Monitor window 93

Puncher 193

Q
Quick Cloning 129

R
RAM 10
Range indicator 38, 181
Recent audio files 34
Recording

Disk capacity 61
Dropping markers 62
File format 60
Introduction 59
Levels 61
Mixer settings 60

Redo 22, 68
Region markers

About 98
Marking takes during recording 62

Release audio hardware 57
Remember active window’s 

layout 184
Renaming files and documents 53
Rendering

Audio Montage 131
Wave windows 91

Repeating wave selections 47
Resize clips 115
Resume 93
Reverse 74
Revert to saved 52

Rulers
Appearance 181
Hiding/showing 181
Meter format 39
Montage 105
Selecting units 28
Start position 39
Wave window 35

S
Sample rate

Conflicts 45
Conversion 79
Montage 106

Samples (Unit) 28
Sampling

Editing sample attributes 170
Save All 52
Save and Save as 50
Save Copy 52
Save left/right channel as 52
Save markers 98
Scroll during playback 59
Scroll menu 38
Select menu 42
Selecting

At zero crossings 42
By dragging 40
Clips 113
Effects 85
Level selections 43
Select menu 42
Shortcuts 41
Stereo files 41
Switching between channels 41

Selection
Turning into new document 48

Set origin at cursor 39
Show tips 26
Silence (Plug-in) 193
Size ruler (CD/DVD Project) 141
Skip 58
Sliders 29
Snap (Montage) 113
Snap to time units 43
Snap to zero crossing 42, 43

Snapshots
Wave window 39

Solo (Montage) 111
Source audio files (Montage) 117
Speaker tool 58
Spectralizer 198
Spectrum Meter 65
Speed Menus 27
Spin controls 28
Split mode

Effects (Montage) 124
Splitting clips 116
Status bar

Introduction 27
Navigating from 39
Wave windows 35

Steinberg on the internet 8
Stereo Echo 199
Stereo to Mono 48
StereoExpander 193, 200
Stop button 57
Styles 180
Suspend 93
Swap channels 48
System information 11

T
Templates (Label Editor) 148
Tempo 39
Temporary files 15
The track activity indicator

About 111
Time code 28
Time format 28
Time stretch 75
Toolbox

Introduction 26
Magnifying Glass 36
Play tool 58

Tools One 200
Tracer application 16
Track auto-grouping 108
Track gain faders

About 112
Tracks (Montage)

About 104
Handling 106
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Transport bar 57
Trim 47

U
Undo

Clearing 22
Introduction 22
Limiting 22
Processing 68

Undo (Montage)
View changes 111

UPC/EAN codes 138
Use Master Section 82

V
Values (Setting) 28
Variables

About 148
Editing 152

Video track (Montage)
About 130

View settings
Saving 54

Voice Attenuator 200
Volume envelopes

About 117
Editing 118

VST plug-ins
About 85
Excluding 188
Presets 87

VSTDynamics 200

W
Wave cursor See “Cursor”
Wave files

Basic editing commands 44
Drag and drop 34
Importing from audio CD 144
Opening 33
Processing 67
Recording 59
Selecting in 40
Zooming 35

Wave selections
Copying 44
Deleting 47
Moving 46
Repeating 47

Waveform elements 181
Waveform Restorer 75
Web links 8
Wheel mouse 29
Window layouts 183
Windows

Closing 23
Duplicate view 25
Maximizing width 35
Minimizing 23
Multiple views 25
Panes 23
Saving layout 180
Switching between 23

WMA files
Batch encoding 96

Write CD 136

Z
Zero crossings 42
Zero level axis 181
Zoom controls 36
Zoom menu 37
Zooming

About 35
Auto zoom for overview 38
Magnifying Glass 36
Montage 109
Mouse zooming 37
Using the keyboard 37
Using the menu 37
Zoom selection 37
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